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Chapter 1:  Overview of SEER*DMS 

The Surveillance, Epidemiology, and End Results (SEER) Program is an initiative sponsored by the 

National Cancer Institute (NCI) to collect cancer incidence and related information from population-

based cancer registries.  Participating registries are required to obtain information on all cancers 

occurring in their area from a variety of hospitals, pathology laboratories, radiology facilities, 

physician offices and other facilities.  Data collected by the registries are submitted to the NCI and 

other organizations.  This information contributes to national surveillance data on cancer incidence 

and forms the sole source of population-based estimates of U.S. cancer survival and prevalence. 

The SEER Data Management System (SEER*DMS) provides support for all core cancer registry 

functions -- importing data, editing, linkage, consolidation, and reporting.  The individual SEER 

Registries actively participated in the requirements analysis and design of SEER*DMS.  It was 

determined that despite the variety, number, and complexity of the registries’ processes and 

corresponding functional requirements, a centrally designed data management system could be 

employed by the various SEER Registries.  SEER*DMS improves cost efficiency and reduces 

duplication of effort in terms of system maintenance and administration.  Furthermore, the 

centralized system design and development improves data quality and consistency, increases 

efficiency, and increases the sharing of knowledge and experience among registries. 

This chapter provides an introduction to SEER*DMS and an overview of the system’s support of 

registry operations.  It includes a summary of the system’s core components with references to 

relevant chapters in this manual or other technical documents. 

In this chapter, you’ll learn about 

 SEER*DMS Reference Materials 

 SEER*DMS Database 

 Getting Started 

 SEER*DMS Workflow and Worklist 

 Loading Data into SEER*DMS 

 Determining Reportability 

 Special Studies 

 Matching and Consolidating 

 Visually Editing and Resolving Patient Set Errors 

 Death Clearance and Follow-up 

 Maintaining Contact Information for Physicians and Organizational Representatives 

 Other Management Tools 

 Reports and Data Extracts 

 Managing System Accounts and Roles 

 System Administration 

SEER*DMS Reference Materials 

The SEER*DMS Web Portal (https://seer.cancer.gov/seerdms/portal) is a secure website that 

enables NCI-SEER, IMS, and registry staff to share information related to the SEER*DMS project.  

SEER*DMS reference materials, data dictionaries, system and database diagrams, Change Control 

Board (CCB) news and information, sample reports, and other information are available on this 

site.   Registry-specific materials are available in restricted-access folders.  The registry-specific 

materials include registry-specific database documentation, technical references, diagrams of 

hardware architecture, and real-time access to graphs showing resource utilization by the 

SEER*DMS servers at the registry. 
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The Help menu within SEER*DMS provides access to the SEER*DMS User Manual, detailed 

descriptions of the registry-specific configuration settings and algorithms, the version history, and 

access to technical support.  The User Manual describes the features of SEER*DMS and provides 

step-by-step instructions for using the system.  The Help menu items include documents describing 

configuration settings for the major system modules:  AFL algorithms, Auto-build, Auto-

consolidation, Edits, Field Mappings, Imports, Matching, Polishers, Record Coding, and Screening.  

The Version History contains a detailed list of changes made for each release of SEER*DMS. 

The SEER*DMS Technical Reference describes the database configuration and system 

infrastructure.  This reference includes definitions for all of the system’s configuration parameters. 

The System > Administration feature of the SEER*DMS application allows you to monitor system 

logs, review source code related to registry-specific settings and algorithms, and view SQL used in 

SEER*DMS system reports.   

SEER*DMS Database 

The SEER*DMS Web Portal is the most comprehensive resource of documentation related to the 

SEER*DMS database.   The following materials are available online:  

 Description of each table in the database 

 Diagrams showing table relationships 

 

The Field Mappings section of the SEER*DMS Help menu is a searchable tool that provides:  

 Mapping of database fields to the labels used in SEER*DMS 

 Mapping of database fields to NAACCR items 

 

A basic overview of the SEER*DMS database structures related to patient data is provided in:   

 Chapter 2: Records and Patient Sets 

Getting Started 

SEER*DMS allows the user to interact with the registry’s Oracle database through an interface 

displayed in a Web browser.  This design reduces maintenance of individual workstations by 

providing a mechanism for simultaneously delivering system upgrades to all registry desktops.  

Instructions for getting started with SEER*DMS are described in: 

 Chapter 3:  Using SEER*DMS  

Workflow and Worklist 

The workflow is the back-bone of SEER*DMS.  It is a configurable infrastructure that controls the 

flow of data through the system and identifies tasks that must be completed by registry staff.  A 

record entering the workflow is initially processed in a series of automatic tasks.  If human 

attention is required in order to complete a task, a manual task is initiated.  Once a person 

completes the manual task, the record continues to the next automatic task.  The record moves 

from automatic to manual tasks as necessary, until all required processes are complete.  

The SEER*DMS worklist provides a view of automatic tasks that are currently running and manual 

tasks that require attention.  The manual tasks displayed in the worklist are the staff’s “to do list”.  

Users can select tasks or managers can assign tasks to users, depending on registry policy.   
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Step-by-step instructions are provided in: 

 Chapter 4:  Using the Worklist   

Loading Data into SEER*DMS 

Data files may be uploaded using the SEER*DMS interface or auto-loaded from a specified network 

location.  In addition, SEER*DMS includes data entry screens that allow a user to enter data using 

the keyboard.   

Step-by-step instructions are provided in: 

 Chapter 5:  Importing Data Files   

 Chapter 6:  Data Entry     

Determining Reportability 

SEER*DMS uses a combination of automatic and manual workflow tasks to determine a record’s 

reportability.  The workflow can be configured to determine reportability automatically, based on 

local eligibility criteria, or it can be configured to defer screening decisions to registrars performing 

manual screening tasks.     

When a record enters the system, an automated task checks the record for errors based on SEER 

and local edits.  The edit logic, an error message, and a severity level are defined for each edit in 

system configuration files.  "Critical" is the severity level assigned to edit errors that must be 

resolved in order for the system to store the data.  "High" is assigned to edit errors that must be 

resolved prior to screening the record for reportability.  Edits are assigned a high severity level if 

the error must be resolved immediately (e.g., to facilitate rapid case ascertainment for special 

studies), or the data items are required to determine reportability.  A Resolve Record Errors task is 

created when errors with a critical or high severity level are encountered.  The record errors must 

be resolved in order for the record to enter the screening phase of the workflow. 

Step-by-step instructions are provided in: 

 Chapter 7:  Edit Errors   

 Chapter 8:  Resolving Record Errors 

 Chapter 9:  Screening for Reportability   

Special Studies 

In SEER*DMS, “Special Studies” consist of user-defined criteria to determine the eligibility of 

incoming records for the purpose of rapid case ascertainment.  The criteria specified for a Special 

Study are applied to the record as it moves through the workflow’s auto-screening task.  The 

criteria may define a record as “in the study”, “out of the study”, or “possible data for the study”.  

In addition, you may use the SEER*DMS editor to manually assign records or patient sets to a 

special study.   

Information and instructions related to Special Studies are provided in: 

 Chapter 28:  Special Studies 
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Matching and Consolidating 

A “patient set” is a packet of data in the SEER*DMS database which includes all data associated 

with a particular patient.  These data include patient demographics, information on all reportable 

tumors, admissions information, diagnostic procedures, treatment information, and text 

documentation.  An incoming record for a reportable cancer is matched against the database to 

determine if it needs to become a new patient set or become part of an existing patient set.  Once 

the matching process is complete, the record is either consolidated with an existing patient set or 

used to create a new patient set.  If two non-reportable records match each other but do not 

match an existing patient set, the records can be manually screened to determine if a combination 

of data from the two records can be consolidated to create a new patient set.  

Information and instructions related to matching and consolidation are provided in: 

 Chapter 10:  Matching Incoming Records to Existing Data   

 Chapter 11:  The Patient Set Editor 

 Chapter 12:  Consolidating Data 

 Chapter 15:  Re-screening of Non-reportable Records8  

Visually Editing and Resolving Patient Set Errors 

Quality control of data involves the review of edit errors identified by the computerized edits and a 

visual review of data fields.  It is recommended that, whenever possible, changes be made to the 

patient set and not to the record.  In SEER*DMS, the Visual Edit Patient Set task enables registrars 

to visually review data for a new patient, when a patient set is auto-created from a single abstract 

record.  Consolidation tasks enable registrars to visually review incoming data as they consolidate 

the data with other data previously loaded into the system.  The edit errors identified by the 

computerized edits may be resolved in these tasks, or the patient set may be saved with errors 

and forwarded to a Resolve Patient Set Errors task. 

Information and instructions related to editing and resolving patient set errors are provided in: 

 Chapter 7:  Edit Errors   

 Chapter 12:  Consolidating Data 

 Chapter 13:  Visual Editing 

 Chapter 14   Resolving Patient Set Errors   

Death Clearance and Follow-up 

“Follow-up” refers to the surveillance processes used to gather new information about a patient 

regarding treatment outcomes and survival.   Death clearance is a combination of follow-up and 

casefinding processes.  The purpose of death clearance is to link death certificate records with the 

registry database to determine deaths among registrants and to identify deaths from cancer among 

persons previously unknown to the registry.   SEER*DMS provides mechanisms for facilitating and 

monitoring follow-up and death clearance processes. 

Information and instructions related to these topics are provided in: 

 Chapter 16:  Follow-up 

 Chapter 17:  Death Clearance  
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Maintaining Contact Information for Physicians and 
Organizational Representatives 

SEER*DMS maintains information about organizations and facilities that collaborate with the cancer 

registry and contact information for physicians and representatives of collaborative organizations.  

The organization and contact lists are referenced throughout SEER*DMS when selecting values for 

data fields, tracking data and follow-back sources, and managing abstracting assignments. 

Information and instructions related to these topics are provided in: 

 Chapter 18:  The Organization and Facility List 

 Chapter 19:  The Contact List    

Other Management Tools 

SEER*DMS provides management tools for monitoring and assigning casefinding leads; for 

managing and processing follow-back needs; and for submitting and tracking requests to facilities 

for records.  In addition, SEER*DMS includes a mechanism to search the database based on patient 

identifiers.  The search utility is useful in support of a variety of management tasks.  

Information and instructions related to these topics are provided in: 

 Chapter 20:  Searching for Records and Patients   

 Chapter 21:  Managing Abstracting Assignments 

 Chapter 22:  Follow-back 

 Chapter 23:  Submitting a Request to a Facility for Records 

Reports and Data Extracts 

SEER*DMS includes a variety of integrated reports which summarize registry activities, track data 

through the system, and provide other quality control information.  Extracts for SEER and NAACCR 

data submissions are also integrated within SEER*DMS.  All reports and extracts available in 

SEER*DMS are documented in Appendix A:  SEER*DMS System Reports.  

In addition, external reports and data extracts may be generated that query the SEER*DMS 

database using any of a variety of software packages.  External reports and extract programs must 

be maintained by registry staff.  

Information and instructions related to integrated reports and extracts are provided in: 

 Chapter 24:  Creating Reports and Extracting Data   

 Appendix A:  SEER*DMS System Reports     

Managing System Accounts and Roles 

Registry managers and/or system administrators are responsible for creating SEER*DMS user 

accounts and enabling system permissions by assigning roles to those accounts.   

Information and instructions related to these topics are provided in: 

 Chapter 25:  Managing User Accounts   

 Chapter 26:  Managing System Roles   
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System Administration 

SEER*DMS is a Web-based application that interacts with the registry’s Oracle database.  The 

registry’s information technology (IT) staff are responsible for a variety of tasks related to 

maintaining the integrity and security of the database, providing ad hoc programming support to 

registry staff, and maintaining the hardware systems that support SEER*DMS. 

Information and instructions related to system administration are provided in: 

 Chapter 27:  System Administration 
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Chapter 2:  Records and Patient Sets 

In the SEER*DMS database, patient data are stored in “records” and “patient sets.”  Records 

contain the source data submitted to the registry, including medical data submitted by reporting 

facilities and follow-up information provided by non-medical organizations.  Each record contains a 

single report of data, for example, a NAACCR record contains data from a single abstract.   Patient 

sets contain all data associated with a particular patient.  Each patient set contains the data 

consolidated from the patient‟s source records and linkage information to enable access to the 

source records.  Patient set data fields contain the consolidated and/or summarized values of the 

linked source records, and values that were derived or computed by SEER*DMS polishers.  Original 

data values are maintained in record data fields (and in an archived copy of the imported data file). 

In this chapter, you‟ll learn about 

 Records 

Linked and Unlinked Records 

 Patient Sets 

Cancer/Tumor/Case (CTC) 

Summary Treatment (Summary TX) 

Treatment Procedures (TX and TXr) 

Facility Admission 

SEER Course 

Incoming and Linked Records 

Auto-building Patient Sets and CTCs 

 Audit Logs 

 Finding Patient Data in SEER*DMS 

 SEER*DMS Databases: Production, Warehouse, and Test 

Records 

In the SEER*DMS database, the record table contains the source data submitted to the registry.  

Records are created in the database when data are loaded from files or entered manually (as 

described in Chapter 5:  Importing Data Files and Chapter 6:  Data Entry).   

Each record travels through the workflow, triggering the automated and manual “tasks” that must 

be performed to process the data.  The path of a record through the workflow is determined by the 

record‟s type.  The specific workflow path of each record is documented in diagrams provided in 

the Workflow Diagrams by Record Type section of the SEER*DMS Web Portal 

(https://seer.cancer.gov/seerdms/portal).  The following is a list of all record types supported by 

SEER*DMS; some record types may not be available in your registry‟s configuration.   

 Health Record – An initial abstract record submitted by a medical facility in a registry-

defined layout.  Health records move through the main portion of the workflow which 

involves editing, screening, matching, and consolidating tasks.  If no match is found for a 

reportable health record, a new patient set will be created. 

 NAACCR Abstract – An initial abstract record submitted by a medical facility in the 

NAACCR record layout or Iowa Transmit record layout (a multi-line format with one line in 

the NAACCR format followed by optional lines for expanded text fields).  NAACCR Abstract 

records move through the main portion of the workflow which involves editing, screening, 

matching, and consolidating tasks.  If no match is found for a reportable NAACCR Abstract 

record, a new patient set will be created.  

https://seer.cancer.gov/seerdms/portal
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 NAACCR Modified Record – An abstract record that was modified and re-submitted to the 

registry.  This record is identical in format to the NAACCR record (the record type field is 

coded with an „M‟). 

 NAACCR Update – The NAACCR short format record used to submit field-specific 

corrections to data previously submitted to the registry.  SEER*DMS matches the record to 

existing patient set data but does not specifically attempt to match the update record to the 

original NAACCR record.  If SEER*DMS identifies possible matches but cannot identify a 

definite match, a manual matching task will be created.  If SEER*DMS identifies a patient 

set that is an exact match, SEER*DMS attempts to auto-consolidate the data.  A manual 

Consolidate FUP task will be created if the system cannot complete the auto-consolidation.  

 Death Certificate – A data record containing death certificate data items.  These data are 

used to update follow-up variables for existing patients.  If a death certificate indicates a 

new reportable cancer, an Abstract Facility Lead is created.  If an abstract can not be 

obtained, death clearance follow-back procedures are performed. 

 Death Notice – Contains information published in public death notices.  These records are 

used to update follow-up variables for existing patients. In the workflow, Death Notice 

records move through the edits, screening, and matching task.  If no match is found, they 

are held to be re-matched at a later time. 

 Casefinding – Data obtained from medical reports which identify new potential cases.  

These records trigger the creation of Abstract Facility Leads.  If an abstract is never 

obtained, a new CTC or patient set can be built from a casefinding record. 

 Follow-up Only – Data reported by a facility indicating a history of cancer.  These data 

may provide follow-up information for existing patient sets.  In the workflow, Follow-up Only 

records move through the automatic edit checks and the auto-matching task.  If no match 

is found, they are held to be re-matched at a later time. 

 Follow-up Transmit – A short record containing follow-up information (date, contacts, 

current address, etc) for patients previously reported by the facility.   

 HL7 E-Path – Electronically transmitted pathology reports in the NAACCR HL7 Version 

2.3.1 E-Path Standard.  These records trigger the creation of Abstract Facility Leads.  If an 

abstract is never obtained, a new CTC or patient set can be built from the HL7 record. 

 Health Index Record - Data from hospital listings such as diagnostic index, discharge 

logs, or surgery logs.  These data are used for quality assurance related to casefinding and 

may provide follow-up and treatment data that are consolidated into existing patient sets.  

 ME Cohort – Data from the Hawai‟i component of the US Public Health Service‟s Multi-

ethnic Cohort (MEC) Study which are linked annually to the Hawai‟i Tumor Registry data. 

 Registry Update – A registry-defined record used to submit field-specific corrections to 

data previously submitted to the registry.  SEER*DMS matches the record to existing 

patient set data but does not specifically attempt to match the update record to the original 

abstract record.  If SEER*DMS identifies possible matches but cannot identify a definite 

match, a manual matching task will be created.  If SEER*DMS identifies a patient set that is 

an exact match, SEER*DMS attempts to auto-consolidate the data.  A manual Consolidate 

FUP task will be created if the system cannot complete the auto-consolidation.  

 Short Health Record – A SEER*DMS short health record is a partial or incomplete 

abstract.  A partial abstract may include some patient demographic information, complete 

or partial histopathology information, treatment information, or other information not 

sufficient to complete a full case abstract.   Typically, these records provide additional 

information regarding follow-up, treatment, and admissions related to a previously 

abstracted case.  In rare situations, a short health record may contain the only data related 

to a case and may be used to build a new CTC. 
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 Supplemental – Follow-up information received from non-medical organizations.  These 

data are matched to the database and used in passive follow-up procedures.  Typically, data 

from supplemental imports are not stored in the record table of the database.  The data are 

matched against the database and used to update patient set data via automated tasks.  

Updates made to patient set data are recorded in the patient sets‟ audit logs.   In general, 

supplemental data are only stored if a manual matching or consolidation task is required to 

process the data.  However, some registries choose to store certain types of supplemental 

data.  

Record type is a general classification that can be assigned to various kinds of data provided in 

multiple file formats.  For example, the Supplemental record type is used for department of motor 

vehicle, CMS/HCFA, and voter registration data.  Health Records may come from multiple sources 

(including your registry's abstracting tool) and in different file formats.  Specific file layouts are 

defined in registry-specific configuration files.  For information about your registry‟s configuration, 

please refer to Imports section of the SEER*DMS Help menu, the System Files section of System 

Administration, and your registry‟s SEER*DMS Technical Reference:  Registry-specific Information. 

In SEER*DMS, records provide a mechanism for storing and accessing the original data values 

submitted to the registry.  Record data do not have to be error-free; records may have null data 

fields or fields with errors.  Problems with the data are generally resolved in the patient set data 

fields at the time of consolidation.  This is a new concept for most cancer registry data editors.  In 

general, it is recommended that registry staff do not change record data fields except to correct 

errors that prevent the record from being processed in SEER*DMS (see Chapter 7:  Resolving 

Record Errors for more information).   All changes are documented in the record's audit log which 

includes the original data value for each field that was modified.  In addition, the original data files 

are archived and can be accessed by your registry's system administrators. 

Linked and Unlinked Records 

A “link” is an association between a source record and a patient set.  The link is established after 

the record has been matched against the database.  Based on the outcome of the matching 

process, the incoming record will either be linked to an existing patient set during consolidation or 

linked to a newly created patient set.  These processes are briefly described below.  Complete 

details are provided in your registry‟s workflow diagrams (see the Documentation section of the 

SEER*DMS Web Portal). 

 If the incoming record matches an existing patient set, the record is linked to the patient set 

and the data from the record are consolidated with the data in the existing patient set.  This 

involves a combination of manual and automated processes that are determined by record 

type, reportability, and registry-defined workflow algorithms.   

o For example, an abstract record for a reportable cancer and its matching patient set 

are forwarded to a manual Consolidate task.  In this task, a registrar uses the tools 

in the Patient Set Editor to complete the consolidation by linking the incoming record 

and incorporating its data into the summarized patient set data fields.   

o On the other hand, a non-reportable Death Certificate record is linked and 

consolidated to a matching patient set in an automated task as part of the passive 

follow-up process.  A manual Consolidate FUP task is only created if discrepancies 

between the record and patient set prevent auto-consolidation.  In most registry 

configurations, records that follow a passive follow-up route through the workflow 

include Supplemental, Death Notice, non-reportable Death Certificates, and Follow-

up Only records. 

 Supplemental data are only stored in the record table if a manual matching or consolidation 

task is required to process the data.  If a record is created, the record is linked and 

consolidated to a matching patient set as part of the passive follow-up workflow.  If there is 
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no need to create a record, the changes are made to the patient set in an automatic 

consolidation task.  The following information is recorded in an audit log entry:  ID of the 

import in which the data were loaded, name of the data file, line number in the file, original 

and new value of each data field that was changed. 

 If an abstract record contains reportable data for a new patient, a new patient set is auto-

built using the record data and the record is linked to the newly created patient set.  

NAACCR Abstract and Health Records contain abstracted medical data and are used to auto-

build patient sets. 

 “Unlinked” records are records that are not consolidated into a patient set, including: 

o Records that have entered the system but are in the initial tasks of the workflow and 

have yet to be matched.   

o Records that do not match an existing patient set and do not contain enough data to 

create a patient set.  In most registry configurations, only abstract records are used 

to create patient sets as they enter the workflow.  A patient set can be manually 

created from unlinked, reportable Casefinding, Death Certificate, or Short Health 

records using the record editor or by executing one of the build system tasks (see 

Chapter 28: System Administration). 

The Patient Set Editor provides access to all linked records, enabling users to review the raw data 

that contributed to the summarized and consolidated Patient Set. 

Patient Sets 

A "patient set" is a packet of data in the SEER*DMS database which includes all data associated 

with a particular patient.  These data include patient demographics, information on all reportable 

cancers, admissions information, diagnostic procedures, treatment information and text 

documentation.  A "patient set" also includes direct links to the original records that contributed to 

the patient set data.   

Cancer/Tumor/Case (CTC) 

Cancer/Tumor/Case (CTC) refers to an instance of the disease of interest.  Generally speaking, a 

Cancer/Tumor/Case is a neoplasm with topography, histology, and behavior codes that meet the 

SEER, local or special study case reporting guidelines.  While this is usually a cancer or a tumor, 

some code combinations are not truly tumors and others are arguably not cancer.  Case is 

sometimes used interchangeably with "tumor" or "cancer" but case can also be used to refer to a 

person in the database. 

In the documentation, we sometimes use “tumor” instead of CTC, usually within a standard data 

item name. We may also use “cancer” or “tumor” or “case” to refer to an instance of a disease that 

has not yet been registered in the database.  

In the SEER*DMS database, CTC is the name of a data entity within a patient set.  All diagnostic, 

staging, and treatment data for a reportable neoplasm are stored in a CTC.  The CTC data include 

summarized treatment information, as well as data regarding each admission and treatment for 

that particular CTC.  A patient set may include multiple CTCs, one for each primary cancer 

diagnosed for the patient. 

Summary Treatment (Summary TX) 

Summary treatment fields are stored in the CTC table of the database and displayed on the 

Summary TX page of the patient set editor.  These fields contain the consolidated treatment values 

and associated dates for the treatments related to the CTC.  SEER*DMS applies an algorithm to 

arrive at a suggested summary treatment value for each treatment modality (i.e., surgery, 
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chemotherapy, radiation).  A summarized date of therapy is also provided.  The suggested 

summary value may or may not be the best value when combinations of treatment are being 

consolidated.  For example; two single agent chemotherapy entries may be consolidated to either a 

single agent chemotherapy summary treatment or multi-agent chemotherapy.   

Visual editing and confirmation is required to ensure the best summary treatment values are 

entered into the consolidated patient set data.  When a case is consolidated, all treatments (TX) for 

a given CTC should be carefully reviewed.  A review flag must also be set to confirm that all of the 

treatment data (including dates) have been reviewed and confirmed for best values. 

Treatment Procedures (TX and TXr) 

CTC treatment data are stored in the treatment_procedure table of the database and displayed on 

TX and TXr pages of the patient set editor.  The Facility ID number associated with the place of 

treatment is listed next to the page link in the patient navigation box.  For example, TX (2344) 

indicates that this treatment was reported by and administered at facility FAC-2344. 

TXr is typically used to identify a treatment that was reported by one facility, but given at a 

different facility.  TXr may also be used for registry-specific designations, for example, it is also 

used to identify treatment procedures with Previous Flag = Yes in SEER*DMS MDCSS. 

If the treatment facility is known, the facility number of both the reporting facility and the 

treatment facility will appear following the TXr.  For example, TXr (6431~2344) indicates that 

according to a cancer report submitted by facility FAC-2344, this treatment was given at facility 

FAC-6431. A code of 9999 indicates that the facility is unknown.  For example, TXr (9999~2344) 

indicates that according to a record submitted by facility FAC-2344, this treatment was given at an 

unknown facility.  If the reporting facility field is blank for TXr data, ???? will be displayed in the 

navigation (this is not possible if the definition of TXr is limited to “a treatment reported by one 

facility, but given at another”). 

When treatment data are incorporated into a CTC from a NAACCR abstract record, TX and TXr 

pages are created if there are treatment data in the NAACCR summary fields that are not included 

in the NAACCR hospital fields.  A TX data page is created from the NAACR RX hospital fields.  A TXr 

data page would be created for the data stored in the NAACCR summary fields that is additional to 

the hospital information.  The performing hospital for the TXr data is set to the “unknown” facility 

code which is usually FAC-9999. 

Facility Admission 

The Facility Admission data catalogues information gathered from each patient encounter at a 

given facility.  If a patient has multiple admissions or encounters at the same facility, the facility 

may provide admission data for each encounter.  These data are stored in the facility_admission 

tables of the database. 

SEER Course 

SEER requires that all treatment administered during the first course of therapy be included for 

each reported case.  See the SEER Program Coding and Staging Manual for definitions of first 

course of therapy.  Some registries also collect information on subsequent therapy.  This could be 

treatment for recurrence of cancer or for disease progression.  SEER*DMS allows the registry to 

identify the treatment course and will distinguish between treatment courses when deriving 

suggested best values for treatment.  The default value for treatment course is first course of 

therapy. 
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Incoming and Linked Records 

When a patient set is viewed during a consolidation task, records are listed as either “incoming” or 

“linked”.   An incoming record is a record which is a tentative match to the patient set.  The record 

is currently being processed in the workflow.  It was selected during a Match-Consolidate task for 

consolidation with the patient set data.  If the match is confirmed during the consolidation task, the 

record will be linked to the patient set and the data will be consolidated.  For more information 

please refer to Chapter 12:  Consolidating Data. 

Auto-building Patient Sets and CTCs 

An entire patient set or components of an existing patient set must be created when new 

reportable data are incorporated into the database.  For example, a new patient set must be 

created when it is determined that data for a reportable cancer are related to a new patient.  A new 

CTC must be created within an existing patient set when it is determined that data matching an 

existing patient represents a new, reportable tumor. 

To reduce the work involved in creating a new patient set, SEER*DMS auto-builds patient set 

components based on record data.  The transfer of record data to the patient set is automated, 

when possible.  The values of the appropriate data fields are auto-filled, as determined by registry-

specific algorithms which are specified for each record type.  For some fields, the value is copied 

directly from a record field to a corresponding patient set field.  The values of other patient set 

data fields are imputed based on multiple fields in the record, or by recoding the value of a single 

field in the record.  The field mappings and recoding algorithms are documented in the SEER*DMS 

Technical Reference: Registry-Specific Information. 

These are the circumstances under which auto-building occurs: 

 A reportable abstract record does not match an existing patient set.  The system auto-builds 

a new patient set based on that record.   A single CTC is created within the patient set.  

Within that CTC, the number of auto-built admissions and treatments will vary based on the 

record type and the amount of data available on the record. 

 A reportable abstract record matches a patient already in the database, but describes a 

cancer for which that patient has no CTC.  During the Consolidate task, a CTC is auto-built 

when the record is linked to a “New CTC” in the patient set.  Within that CTC, the number of 

auto-built admissions and treatments will vary based on the record type and the amount of 

data available on the record. 

 A reportable record matches an existing patient and CTC, but describes a new facility 

admission or treatment relevant to this CTC.  In this case, the system attempts to auto-

build new facility and treatment data fields for that CTC. 

SEER*DMS auto-builds patient set data fields using data from a single record.  If multiple records 

for a new patient are consolidated, the patient set data fields are auto-built from one of the records 

when the Consolidate task is started.  SEER*DMS selects an abstract record (NAACCR Abstract, 

NAACCR Modified, or Health Record) to use for auto-building.  If there are two or more abstract 

records, the abstract record that was first loaded into SEER*DMS is used.  The other incoming 

records are then consolidated with the new patient set.    

Audit Logs 

Whenever a record or patient set data field is changed by a user or the system, an entry is made in 

an audit log.  A separate audit log is maintained for each record and patient set in the system.  The 

information in the audit log includes the user or process which modified the data, comments 

related to the change, the date and time of the modification, and the original and modified value of 
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each data field that was changed.  A user may provide separate comments for the individual data 

items or one comment for all data items changed within a single session. 

When the audit log is displayed in the record or patient set editor, the changes are grouped by 

events.  Events include workflow tasks, system tasks, and other processes that modify patient 

data.  The audit log events in SEER*DMS are: 

 Ad-hoc Editing – The change was made by a user who edited the data while accessing the 

data via the patient lookup, a worklist task was not involved. 

 AFL Update – Changes made to an AFL were incorporated into the record that triggered 

the AFL.  At this time, reportability is the only field that is changed via this process.  The 

record‟s reportability is changed to auditable when the AFL status is set to “Not a Reportable 

Cancer”. 

 AFUP Update – Patient set data were updated when a response to Active Follow-up (AFUP) 

was entered. 

 Auto-Build Pat Set – A single audit log entry is made when a patient set is auto-built from 

a record.    

 Auto-Coding - A change was made to a record as it entered the workflow.  Registry-

specific coding algorithms are implemented in this automated workflow task. 

 Auto-Consolidation - The change was made during an automated process to consolidate 

incoming data.   Typically, this would involve the consolidation of follow-up data.  In most 

registry configurations, the consolidation of other data is performed in manual tasks. 

 Auto-Screening – The change was made during the automated screening task.  This task 

sets the reportability status of an incoming record. 

 Consolidate - The change was made by a user who edited the data during a Consolidate 

worklist task. 

 Consolidate FUP- The change was made by a user who edited the data during a 

Consolidate FUP worklist task. 

 Data Entry – One audit log entry is made when a record is saved in a data entry session.  

 Direct Database Update – Record or patient set data were modified by an external script 

(audit log entries are not created by all external scripts). 

 Edits Sys Task – The change was made by a SEER*DMS “polisher” which executed after 

the Patient Set Edits system task completed.  A polisher is a background utility that, 

according to SEER or registry-defined algorithms, imputes data values based on values in 

other fields. 

 Image Data Entry – Record data were updated during a manual Image Data Entry task.  

An Image Data Entry task is created for each image record imported via the autoloader. 

 Initial Conversion – The change was made during an automated process to load data from 

the legacy system. 

 Link AFL Source – This event indicates that a record was auto-linked to a patient set.  The 

record that initiated an AFL is auto-linked to a patient set when its AFL is closed by an 

abstract linked to the patient set. 

 Mass Change – Changes were made as specified in a mass change import.  The Import ID 

is listed with the event information. 

 Rapid Follow-up – Patient set data were updated during an automated Rapid Follow-up 

worklist task. 

 Resolve Pat Set Errors – The change was made by a user who edited the data during a 

Resolve Patient Set Errors worklist task. 

 Resolve Record Errors - The change was made by a user who edited the data during a 

Resolve Record Errors worklist task. 
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 Screening - The change was made by a user who edited the data during a Screening 

worklist task. 

 Visual Edit Pat Set – The change was made by a user who edited the data during a Visual 

Edit Patient Set worklist task. 

Finding Patient Data in SEER*DMS 

You may use the SEER*DMS Patient Lookup or toolbar Quick Search to search the database for 

data related to a specific patient, or to search for a specific record or patient set by ID.  Select 

View > Patients to access the Patient Lookup: 

 

SEER*DMS uses registry-specific matching algorithms to compare the patient information specified 

in the Matching Criteria to patient sets and records in the database.  The Standard search 

provides a way to find all available data related to a specific patient.  The Advanced search and ID 

Lookup enable you to review a particular set of records or patient sets or to review a sample of 

data for research or quality control purposes. 

If your system permissions allow you to view or edit patient data, the Lookup search box will be 

displayed in the SEER*DMS User Bar.  This provides a shortcut to the Patient Lookup for searches 

by Patient Set ID, Record ID, AFL ID, Import ID, date of birth (MM-DD-YYYY), name (“last name” 

or “last name, first name”), and SSN  (dashes must be included, otherwise the system will assume 

that a numeric field is a patient set or record ID).  

 

Chapter 20:  Searching for Records and Patients contains detailed instructions for using the Patient 

Lookup and Quick Search. 

SEER*DMS Databases:  Production, Warehouse, and Test 

The Oracle database that is accessed via the production version of the SEER*DMS application is 

referred to as the “live database” or “production database”.  This database contains up-to-the-

minute changes made by the registry‟s editing or coding staff. 

The “data warehouse” is a read-only version of the live database which is created nightly.  To 

reduce load on the production database, it is recommended that external applications query the 

data warehouse unless the query requires updates made since the previous night.  The data 

warehouse contains all tables in the live database, the NAACCR mart, and materialized views which 

are optimized for extracts, reporting, and other analysis.  Views are aggregated, sometimes 

summarized, copies of data that are specifically structured for dynamic queries and analytics. 

The “test server” database contains the data accessed by the test server's version of SEER*DMS.   

This database is updated on an ad hoc basis by registry IT staff.   A registry system administrator 

executes a reload script that loads a snapshot of the production database from the previous night 
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(the data are loaded from the same snapshot as the data warehouse).  If you log into the test 

server and save a change, that change will immediately be reflected in reports and SQL queries 

that use the Test Server Database.   However, there is no data warehouse associated with the test 

server.  Therefore, you cannot use the extracts within the test server's application (SEER*DMS 

extracts use data from the data warehouse which is only available for the production database).   

In addition, some internal SEER*DMS reports require the data warehouse and will not be available. 

 

The SEER*DMS Web Portal (https://seer.cancer.gov/seerdms/portal) is the most comprehensive 

resource of documentation related to the SEER*DMS databases.   The following materials are 

available online:  

 

 Description of each table in the database 

 Mapping of database fields to the labels used in SEER*DMS 

 Mapping of database fields to NAACCR items 

 Diagrams showing table relationships 

 NAACCR Mart and NAACCR Extract Documentation 

https://seer.cancer.gov/seerdms/portal


2-10 6/18/08  SEER*DMS User Manual  

 



Using SEER*DMS    6/18/2008 3-1 

Chapter 3:  Using SEER*DMS 

SEER*DMS uses an HTML-based interface displayed via a Web browser.  Mozilla Firefox (version 

2.0 or later) or the web browser in the Mozilla Suite (version 1.7.13 or later) are the only browsers 

currently supported.  Reports generated by SEER*DMS are designed to be viewed and printed as 

PDF files.  Adobe Reader is required to view or print reports (version 7.0 or later is recommended). 

In this chapter, you’ll learn about 

 Logging into SEER*DMS 

 Changing Your Password 

 Using the Home Page 

 Worklist Summary 

 SEER*DMS Menus 

 SEER*DMS Dos and Don’ts 

 Page and Calendar Tools 

 Setting Account Preferences 

 Adding and Editing News Items 

 Automatic Logoff Due to Inactivity 

 Viewing More Information on Your Screen  

 Viewing Two Screens at Once  

 Searching for Text 

 Browser Navigation Settings 

 Display Recommendations 

 Recommended Firefox Options 

Logging into SEER*DMS 

To access SEER*DMS, direct your web browser to the address provided by your registry’s system 

administrators.  In most cases, a shortcut will be available on your desktop.  A system 

administrator must set up a SEER*DMS account for each new system user.  Once your account is 

created, a username and randomly generated password will be e-mailed to you.  (When the system 

is first installed at your registry, usernames and passwords will be assigned and provided to you 

during training.)   

When you access SEER*DMS, the Login page will be displayed as shown below.  Note:  The colors 

used in SEER*DMS are determined by the Color Scheme selected in your Account settings. 

 

Enter your Username and Password.  Click Login.  Once you have successfully logged in, the 

Home page will be displayed.  If this is your first login or your password was reset, you should 

immediately change your password.  Do not continue to use a password that was assigned to you 

or sent via e-mail.  Please refer to the Changing Your Password section of this chapter. 
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 If your login attempt is unsuccessful: 

 User names and passwords are case sensitive.  Make certain Caps Lock is turned off. 

 Contact your supervisor to determine whether your account has been deactivated, or if you 

are subject to a login restriction. 

 If you have forgotten your password, contact a system administrator to reset your 

password.  A new, randomly generated password will be e-mailed to you.  You should 

immediately log in and change your password to something you will remember. 

Login restrictions: 

 If you are unable to log in to SEER*DMS, your account may be subject to a Business 

Hours Restriction.  This restriction blocks access to the system outside of the registry’s 

standard hours of operation.  Your registry’s system administrators have the ability to 

specify the standard business hours in the system configuration settings.  

It is strongly recommended that you log off SEER*DMS when you are not using the system.  If you 

do not log off, confidential data may be displayed on your monitor or be accessible from your 

computer.  Save your current work, if necessary.  To log off, click the Logoff link which appears in 

the top right corner of each page.  Your session will be ended and the Login page will be displayed. 

Changing Your Password 

When logging in for the first time or when your password is reset, you should change your assigned 

or randomly generated password to a secure password that is easy for you to remember.   

SEER*DMS provides access to confidential data.  It is your responsibility to protect and maintain 

your password according to registry policy.  If you forget your password, a system administrator 

can reset it.  Your password will be set to a random string and you will be notified of the change via 

e-mail.  Log in with the new password and immediately change your password. 

To change your password: 

1. Click the Account link in the User Bar at the top right corner of the page. 

2. Enter your Old Password. 

3. Enter a New Password.  All passwords must be at least six characters in length.  Security 

measures to protect the confidentiality of patient data must include the use of strong 

system passwords.  Your password should: 

a. Include symbols, digits, and letters of both upper and lower case.  You should use at 

least one symbol or character in a position other than the first or last character. 

b. Be significantly different from passwords that you have used in the past. 

c. Not include your name, your username, your child’s name, or your pet’s name. 

d. Not be a common word or name.  

4. Re-enter your new password in the Verify Password field. 

5. Click Save.  Your new password will be effective immediately. 

Your password may also be reset by an administrator for security reasons.  In this case, an e-mail 

containing your new password will be automatically sent to the e-mail address associated with your 

account.  You should immediately log in and change this password as described above. 
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Using the Home Page 

Each time you log in to SEER*DMS, you will start at your personalized Home page.  This page is 

your gateway to the specialized tools and features in the system.   At any time, you can return to 

the home page by clicking the SEER*DMS logo in the banner or selecting View > Home. 

 

 A summary of the worklist is displayed on the left side of the home page.  The links and 

counts are described in the Worklist Summary section of this chapter. 

 The Latest News section displays News items posted by registry staff. 

 The version of the SEER*DMS software is displayed at the bottom of every SEER*DMS 

screen.  The date and time of the build are displayed in parentheses. 

 The SEER*DMS Logo, User Bar, and Toolbar appear at the top of every page in the 

system.   

o Click the SEER*DMS Logo to return to the home page from any page in the system.   

o The User Bar includes your user name, access to your Account Preferences, and the 

Logoff link.  If you have a system permission to view or edit patient data, it will also 

include the “Lookup” search box.  Please refer to Chapter 20:  Searching for Records 

and Patients for information about the toolbar quick search and other searching 

techniques. 

o The name of the current page is displayed in the left side of the Toolbar.  The 

Toolbar also includes menus that provide access to all pages and features in the 

system (see the SEER*DMS Menus section of this chapter). 

o To avoid the loss of effort when using these features, follow the guidelines specified 

in the SEER*DMS Dos and Don’ts section of this chapter. 

Worklist Summary 

 

A personalized worklist summary is displayed on the left 

side of the home page.  My Tasks summarizes the tasks 

assigned to you and provides shortcut links to those tasks.  

Click Worklist to view a list of all tasks assigned to you.  

Click one of the task types in My Tasks to view tasks of 

that type that are assigned to you. 

The number of tasks currently assigned to you is displayed 

to the left of the task type.  For example, in the sample 

shown on the left, two Consolidate tasks are assigned to the 

user.  Clicking on the Consolidate link in this sample will 

bring up a filtered Worklist showing the two Consolidate 

tasks which are currently assigned to this user. 
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The Unassigned Tasks list on the Home page summarizes 

the unassigned tasks that you are permitted to access, and 

provides shortcut links for each type of task.  The number 

of tasks per type is displayed to the left of each link.     

Clicking on the Resolve Record Errors link in this sample 

will bring up a filtered Worklist that displays the 22 

unassigned Resolve Record Errors tasks. 

 

SEER*DMS Menus 

A Toolbar is displayed on every page in SEER*DMS. 

 

The name of the current page is always displayed on the left of the toolbar.  On the right, the 

toolbar displays pull-down menus which you can use to navigate the various features of the 

SEER*DMS system.  Some menu items are only displayed if the user has the system permission 

associated with the menu item.  A full list of menu options is shown below. 

 View 

o Home 

o Worklist (Chapter 4: Using the Worklist) 

o Patients (Chapter 20:  Searching for Records and Patients) 

o Contacts (Chapter 19: Maintaining the Contact List) 

o Facilities (Chapter 18: Maintaining the Facility List) 

o Reports (Chapter 24: Creating Reports and Extracting Data) 

 Manage 

o Abstract Facility Leads (Chapter 21: Managing Abstracting Assignments) 

o Active Follow-up (Chapter 16:  Follow-up) 

o Follow-back (Chapter 22: Follow-back) 

o Record Request (Chapter 23: Submitting a Request to a Facility for Records) 

o Special Studies (Chapter 28: Special Studies) 

 System 

o Staff (Chapter 25: Managing User Accounts) 

o Roles (Chapter 26: System Roles) 

o Import (Chapter 5: Importing Data Files and Chapter 6: Data Entry) 

o Tasks (Chapter 27: System Administration) 

o Edits (Chapter 7: Edit Errors) 

o Administration (Chapter 27: System Administration) 

 Help 

o User Manual 

o Registry-defined configuration settings and algorithms 

o Version History 

o Support (Technical Support section of Chapter 27: System Administration) 

o About SEER*DMS 
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SEER*DMS Dos and Don’ts 

Since SEER*DMS is a Web-based system, you will modify data and access features on system 

“pages”.  You must use the page buttons to exit pages that enable you to make modifications to 

patient or system data.  These buttons include “Save & Exit”, “OK”, “Close”, and “Cancel”.  If you 

use the links or menus in the User Bar or Toolbar to go to another page, changes made on the 

current page will not be saved.  Likewise, if you exit a page by using your browser’s navigation 

controls, unsaved changes will not be saved.  This may be a new concept for some users.  If you 

use the Internet, you have probably become accustomed to this behavior.  For example, if you are 

purchasing airline tickets on an Internet site but change your mind before clicking “Buy”, going to 

another Web site will void the incomplete transaction.  

Do 

 Use the links, buttons, and menus located in the body of the page to complete the current 

task.  If you have made changes that must be saved, do not use the navigation in the 

SEER*DMS logo, User Bar, or Toolbar to exit a page.  

 Click the SEER logo to return to the home page, but only if you saved any changes made on 

the current page or do not wish to save them. 

 Use the links and menus in the User Bar and Toolbar to access system features, but only if 

you have already saved changes made on the current page or do not wish to save them. 

 

Don’t 

 Don’t use any browser controls to navigate.  Never use the Back button, Forward button, or 

enter a URL in the address box.  The Setting Browser Preferences section of this chapter 

provides more information about the browser controls to avoid; and methods for hiding 

navigation features that you should not use.   

 Don’t use the backspace key unless you are editing a field.  In a browser application, 

backspace is a shortcut for the browser’s Back button. 

 Don’t use the links or menus in the User Bar or Toolbar when you have made changes that 

must be saved.  (Help > User Manual is the exception to this rule.  The SEER*DMS Help 

System opens in a separate window, your work will be unchanged and will continue to be 

displayed in the original window.) 

 Don’t click the SEER*DMS logo to return to the home page when you have made changes 

that must be saved.  

 

Note:  SEER*DMS is a Web-based application that is maintained on a server located within the 

registry.  The system is not connected to the Internet.  Access to the system from remote locations 

is controlled by a firewall configuration designed, installed, and maintained by registry IT staff. 

Page and Calendar Tools 

The lists in SEER*DMS, such as the Worklist, often contain too many results to fit on the screen all 

at once.  In these cases, the list will be broken into several pages.  Use the Page Selection links 

displayed at the top or bottom of the list to navigate the list, as in the example below. 

 

Click Prev or Next to advance one page back or forward.  Click First or Last to move to the 

beginning or end of the entire list.  Click an individual page number to jump to a specific page.  A 

maximum of eight page numbers will be displayed; there may be additional pages that are not 

listed.  Additional page numbers will be displayed when you click the eighth page in the current set.   
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The calendar tool can be used to enter a correctly formatted date in the field adjacent to a calendar 

icon:  

Click on the icon to bring up a calendar of the current month.  The calendar will open with the 

current date highlighted, as shown below. 

 
 

To browse by month, use the < and > buttons at the top of the calendar.  Use the << and >> 

buttons to browse by year.  Use the mouse to click a specific date.  This date will be automatically 

formatted and displayed in the adjacent date field. 

To close the calendar without selecting a date, click the x button in the upper right corner. 

Setting Account Preferences 

To modify your account information: 

Click the Account link in the User Bar at the top right corner of the page. 

You may edit the First Name, Last Name, and E-mail address fields.  These are required fields 

and cannot be blank.  Note: Your username cannot be modified. 

Add or modify your phone number and street address, if appropriate. 

You may change to one of several Color Schemes available in SEER*DMS.   

If you add a Signature, it will be displayed in e-mail communications sent via SEER*DMS. 

To change your password: 

a. Enter your Old Password. 

b. Enter a New Password.  All passwords must be at least six characters in length. 

c. Re-enter your new password in the Verify Password field. 

Click Save. 

Adding and Editing News Items 

System permissions:  news_add, news_edit, news_delete 

To make an announcement to the entire registry staff, you can add a news item to the Home page.  

The Latest News list displays messages in the order in which they are added, with the most 

recent item appearing at the top of the page.  All SEER*DMS users can view the news list, but 

system permissions are required to add, edit, or delete news. 
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To add a News Item: 

1. Select the Add Item link at the top of the Latest News list. 

2. Enter a Title for your news item.  This field can hold a maximum of 100 characters. 

3. Enter the text of your message in the Body field.  You may enter up to 4000 characters in a 

news item. 

4. Click Save.  Your message will appear at the top of the news list. 

To edit a News Item: 

1. Click the Edit link displayed below the news item's title bar. 

2. In the Edit News Item page, you can edit the text of the Title and Body. 

3. Click Save to save your changes. 

To delete a News Item: 

1. Click the Delete link displayed below the news item’s title bar. 

2. SEER*DMS will query you to confirm that you really want to delete the item.  Click OK to 

delete the item or click Cancel to return to the Home page. 

To send an email to the author of a news item: 

1. Click the Author’s Name displayed below the news item's title bar. 

2. SEER*DMS will open your email client software and create a blank message addressed to 

the author of the news item.  Complete and send the email message. 

Automatic Logoff Due to Inactivity 

SEER*DMS will automatically end your session and log you off after a long period of inactivity.  The 

last screen that you viewed will continue to be displayed on your monitor and may include 

confidential patient data.  Therefore, it is strongly recommended that you use the logoff link to end 

your session when not using the system.   

The system is initially configured to end your session after two hours of inactivity; however, the 

length of time can be changed per request of registry management.  (It is recommended that this 

time period not be set to a value less than one hour, to avoid the loss of unsaved work.)  

Note: Moving the mouse and entering text do not constitute activity between the browser and the 

SEER*DMS server.  Until you click a button, link, or   lookup to perform an action or access 

another page, your session will be considered inactive. 

After automatic logoff, any open SEER*DMS pages will continue to be displayed as long as your 

browser is open.  If you click on any button or link in the SEER*DMS window, the system will 

attempt to restore your session after prompting you for your username and password.  However, 

any unsaved changes to a record or patient set may be lost. 

Viewing More Information on Your Screen 

The data pages in SEER*DMS often contain too many data items to display on your monitor 

without scrolling.  If you would like to view more information on your screen at one time, you may 

want to consider the following: 
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 The Firefox and Mozilla browser’s have a “Full Screen” feature that enables you to hide 

toolbars and controls that use valuable screen real estate.  Press F11 to view SEER*DMS in 

full screen.  Your Windows taskbar and browser menu will be hidden, and a larger number 

of data fields will be displayed.  Press F11 again to restore the Windows taskbar and 

browser menu.  

 Monitors commonly use a landscape orientation.  However, many flat LCD monitors can be 

pivoted to portrait orientation.   If you view data pages in portrait orientation, a 

substantially larger number of fields will be displayed without scrolling. 

 SEER*DMS requires a minimum resolution of 1024x768.  Using a higher resolution will 

reduce the scrolling when editing data pages, but is not required. 

Viewing Two Screens at Once 

SEER*DMS supports the viewing of two pages during a single session.  The second page will open 

in either a new Window or Tab, depending on your Firefox option settings.  If you are using a single 

monitor, it is recommended that you set Firefox to open new pages in a new tab within a single 

Window (multiple Windows may be hidden on a single monitor).  If you are using dual monitors, it 

is recommended that you set Firefox to open new pages in a new Window and move the newly 

opened Window to the other monitor.   

To open a second SEER*DMS page: 

1. “Middle-click” a link or menu item in SEER*DMS.   To “Middle-click”, you may either click 

your mouse wheel or press CTRL as you click.   The page will open as a new tab or new 

Window depending on the settings in your Firefox options. 

2. Or right-click a menu item or link in SEER*DMS.  A menu will be displayed.  Select Open 

Link in New Window or Open Link in New Tab. 

To set the default method used by Firefox to open new pages: 

1. From the Firefox Tools menu, select Options.  

2. Click the Tabs icon at the top.  

3. It is recommended that you set New pages should open in: 

a. If you are using dual monitors, select a new window. 

b. If you are using a single monitor, select a new tab.  You should also check When I open 

a link in a new tab, switch to it immediately. 

4. Click OK to save and exit.  All of the Tabs settings are described in the Firefox help system. 

Searching for Text 

In Firefox, CTRL-F can be used to search any window.  This is a great tool to use when searching 

for a field in the Patient Set Editor or when searching for text in a popup window.   

1. Press CTRL-F 

2. Enter the search text in the bottom part of the window.  The first occurrence of the text will 

be highlighted. 

3. Click Find Next to go to the next occurrence of the search string or click Highlight All to see 

all matches. 
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Browser Navigation Settings 

The following diagram shows SEER*DMS in a window that includes the browser’s navigation 

controls.  The browser menus appear under “Home - Mozilla Firefox” at the top of the page.  

Navigation buttons (Back, Forward, Reload, Stop, and Home) and the address box are shown just 

under the menus. 

 

You should not use the browser’s navigation buttons to change pages in SEER*DMS.   It is 

recommended that you hide the browser icons to provide additional space for SEER*DMS and to 

avoid using the buttons inadvertently.    These buttons change your page view, but SEER*DMS 

does not recognize these commands and your work will not be saved. 

 

 

 

On the View menu in Firefox, select 

Toolbars.  To show or hide a 

toolbar, simply click its menu item. 

 

Make sure that both the Navigation 

Toolbar and Bookmarks Toolbar are 

not checked.  

Display Recommendations 

SEER*DMS requires a minimum resolution of 1024x768.  Using a higher resolution will reduce the 

scrolling when editing data pages, but is not required.   The browser’s default or “normal” text size 

should be used.   Images, buttons, and text may be misaligned if the Text Size is increased.    

To set the text to Normal in Firefox: 

1. From the Firefox View menu, select Text Size.  

2. Click Normal.  
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Recommended Firefox Options 

As is true of most Web browsers, Firefox “remembers” passwords and information entered into a 

form in order to provide suggestions when completing similar forms in the future.  For increased 

security of the confidential patient data in SEER*DMS, you should disable the option to save 

passwords.  To avoid entering one patient’s data into another patient’s form, you should disable 

the browser options to remember information previously saved in forms.  Recommendations for 

options related to new pages were discussed in the Viewing Two Pages at Once section of this 

chapter (the instructions are included here to enable you to set all Firefox options at one time).  

To set the Firefox options as recommended for SEER*DMS: 

1. From the Firefox Tools menu, select Options. 

2. Tabbed browsing allows you to display multiple SEER*DMS pages within a single window.  

However, dual monitor configurations would benefit from displaying multiple pages in 

separate windows.  Click the Tabs icon at the top. 

a. It is recommended that you set New pages should open in: 

i. If you are using dual monitors, select a new window. 

ii. If you are using a single monitor, select a new tab.  You should also check When 

I open a link in a new tab, switch to it immediately. 

3. SEER*DMS uses Javascript to display popup windows.   To ensure that the Text, DX Info, 

and other popups are displayed when open: 

b. Click the Content icon at the top.   

i. Verify that Enable Javascript is checked. 

ii. Click the Advanced button for Enable Javascript.  Check the box that says 

Raise or Lower Windows and click OK. 

4. Click the Privacy icon at the top.  In the History section, uncheck Remember what I enter in 

forms and the search bar. 

5. Click the Security icon and uncheck the Remember passwords for sites box. 
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Chapter 4:  Using the Worklist 

The SEER*DMS workflow provides a configurable means to direct the flow of records and other 

system data through the appropriate automatic and manual tasks.  The workflow controls the path 

of a record through the editing, screening, matching, and consolidation tasks with the ultimate goal 

of incorporating it into the patient set data.   

A record entering the workflow is initially processed in a series of automatic tasks.  If human 

attention is required in order to complete a task, a manual task is initiated.  Once a staff member 

completes the manual task, the record continues to the next automatic task in the workflow.  The 

record moves from automatic to manual processes as necessary, until it completes its journey 

through the workflow.   

The SEER*DMS worklist provides a view of the automatic tasks that are currently running and the 

manual tasks that require attention.  The manual tasks displayed in the worklist are the staff’s “to 

do list”.  Users can select tasks to complete or managers can assign tasks to users, depending on 

registry policy.  The automatic tasks are displayed in the worklist to allow you to track the flow of 

data and, in rare situations, cancel automatic processes. 

A unique Task ID is assigned to the first task created when a record enters the workflow.  As that 

record moves from task to task, the Task ID remains the same.  The same Task ID is retained until 

the record exits the workflow.    

In this chapter, you'll learn about 

 Data Shown in the Worklist 

 Sorting the Worklist 

 Searching or Filtering the Worklist: 

o Searching for a Record or Patient Set in the Worklist 

o Filtering by User Assignment, Task Type, Task Age, and Other Data Items 

 Following Data through the Worklist 

 Assigning, Releasing, or Rerouting Tasks 

 Opening a Task Assigned to You 

 Opening an Unassigned Task  

 Terminating Manual Tasks 

 Restarting Workflow Activity 

 Viewing or Aborting Automatic Tasks 

 System Failure Tasks 

 Printing the Worklist 

 Worklist Tasks 

 Workflow Reports 

Data Shown in the Worklist 

There are many ways to access the worklist; the route you take only affects the default values set 

in the filter.  Once you go to the worklist, you will be able to adjust the filters to create an 

appropriate list of tasks.  Your account’s system permissions determine which tasks you will be 

able to view and access.  
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To view all worklist tasks assigned to you, select View > Worklist or click the Worklist link on 

the Home page.  To view tasks of a certain type that are assigned to you, use the shortcut links in 

the My Tasks section of the Home page.  To view tasks of a certain type that are unassigned, use 

the shortcut links in Unassigned Tasks.   

The following data columns are shown in the worklist: 

 Task – Unique ID assigned to the series of processes used to move the data through the 

workflow  (the same ID is maintained as a record moves from one type of task to another) 

 Type – Type of workflow task, as described in the Workflow Tasks section of this chapter 

 User - The user assigned to this task 

 Age – Length of time since the task was created (shown if Show Age is checked).  Age is 

reset when the data move forward to a new task type. 

 Date – Date the task was created (shown if Show Age is unchecked).  Date is reset when 

the data move forward to a new task type. 

 Pat/Rec – ID of the Patient Set or Record ID that is the focus of the task.  If the processing 

of a record triggered the task and the record is not yet linked to a patient set, the Record ID 

will be shown.  Once the record is linked to a Patient Set, the Patient Set ID will be shown.  

Click the Information Icon  next to the record’s or patient set’s ID to see values of key 

fields.   

 Reg – Region.  This column is only displayed if your registry’s implementation of SEER*DMS 

is configured to support multiple regions. 

 Dx Year – Year of diagnosis.  If a record is the focus of the task and year of diagnosis is not 

available or not applicable for that record, this column will contain the screening year, year 

of admission, or year of last contact as determined by the type of data.  A date from the 

incoming record is used if the record has not yet been linked to a patient set.  Once the 

record is linked to a patient set, the date of diagnosis for a CTC is used.  If the Patient Set 

has multiple CTCs and all CTCs are submissible, this will be the date of diagnosis of the CTC 

to which the task’s original record is linked.  Otherwise this column will contain the year of 

diagnosis for the earliest diagnosed, non-submissible CTC.  Year is populated in this manner 

to enable you to identify tasks that must be completed for the next submission. 

 Facility – Reporting facility 

 Site – Cancer site.  The site coded on the incoming record is used if the record has not yet 

been linked to a patient set.  Once the record is linked to a patient set, the site and year of 

diagnosis are based on a CTC in the patient set.  Refer to the description of Dx Year for 

description of the CTC that is selected. 

 Information – A text field displaying additional task-specific data items (Patient Name, 

Record Type, etc.) 

The worklist often contains too many results to fit on the screen all at once. In these cases, the list 

will be broken into several pages. Use the Page Selection links to view the rest of the list, or use 

the Filter controls to search or limit the list. 

When you open a worklist item, the task is assigned to you to prevent two users from inadvertently 

working on the same task.  Once assigned, tasks may be rerouted to other users or designated as 

unassigned.  The steps and account permissions required to reroute or release tasks are described 

in Assigning, Releasing, and Rerouting Tasks. 
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Sorting the Worklist 

In SEER*DMS, a table is sorted by the column with a highlighted column header (highlighted in red 

in the example below; other colors are used in different color schemes).  In the example below, the 

worklist is sorted by Task ID.  The up arrow next to “Task” indicates that the table is sorted in 

ascending order.  To sort the worklist by any of the data items, click on the corresponding column 

heading.  To reverse the sort order, click the column header again.   

 

  

Searching or Filtering the Worklist 

System permissions are required to view and access certain task types (refer to the Worklist Tasks 

section of this chapter for more information.)   

To search for a task related to a specific patient, record, or patient set: 

1. Select View > Worklist, or click the Worklist link on the Home page. 

2. By default, only your tasks are displayed.  If you would like to search all tasks: 

a. Remove the text in the User(s) filter. 

b. Check Show Unassigned. 

3. If you know the record or patient set ID, enter it into the Pat/Rec ID(s) filter.  To enter 

multiple IDs, click the down arrow  to expand the filter. 

4. To search by patient name: 

a. If you would like to search for a specific patient by name, enter search text into the 

Information filter.  If you enter John Smith, tasks related to patients named either 

John or Smith will be returned.  If you use quotes and enter “Smith, John”, only tasks 

related to patients named John Smith will be returned. 

b. Tip:  To find tasks for patients whose names start with an M, enter “; M” into the 

Information filter.  You must include the quotes in your search text.    

5. Click Apply.   

6. If you cannot find the data in the worklist, the record or patient set may have completed 

its journey through the workflow.  If you searched by Record ID, the task will not be listed 

unless the record is still the focus of the task.  Once the record is linked to a Patient Set, 

the Patient Set ID becomes the focus ID.  To determine whether the record is still in the 

workflow, use the Patient Lookup to find the record and open it in the editor.  If the record 

is involved in a worklist task, SEER*DMS will post a message at the top of the page and 

include a link to view the task.  Detailed instructions for using the Patient Lookup are 

provided in Chapter 20:  Searching for Records and Patients. 
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To filter the worklist: 

1. Use the Type(s) filter to search for tasks by task type.  Scroll through the list in the 

Type(s) filter and click the relevant task type.  To select more than one type, hold down 

the CTRL key and click each desired type. To deselect a type, click it a second time while 

holding the CTRL key.  The entries in the Type(s) filter are described in Worklist Tasks. 

2. If you would like to search for a specific task and you know its ID, enter the ID into the 

Task ID(s) filter. To enter multiple IDs, click the down arrow  to expand the filter. 

3. If you would like to search for specific data, enter one or more IDs into the Pat/Rec 

ID(s) filter.  To enter multiple IDs, click the down arrow  to expand the filter. 

4. To search for tasks related to data loaded on a specific day or in a particular import, enter 

the Import ID or click the Lookup icon  to select the Import ID from a list.  You may 

enter two or more IDs separated by a space. 

5. Use the User(s) filter and Show Unassigned box to display tasks based on assignment: 

a. To show tasks assigned to a particular user, enter the full user name in the User(s) 

filter.  You may enter two or more user names separated by a space.  

b. To show tasks assigned to all users, remove all text from the User(s) filter.  Blank in 

any filter selects all values for the field. 

c. If you are only interested in unassigned tasks, enter unassigned in the User(s) filter. 

You must also check the Show Unassigned box as described in step 3.  (Tip:  Any 

text that is not a registered username will work.  For example, enter “X” in the User(s) 

filter and check Show Unassigned.  When you click Apply, SEER*DMS will attempt to 

show tasks assigned to user X and the unassigned tasks.  Since there is no user X, only 

unassigned tasks will be listed.) 

d. To include unassigned tasks, check the Show Unassigned box.  If you are only 

interested in tasks that are currently assigned to a SEER*DMS user, leave this box 

unchecked (and set the User(s) filter as described in step 2). 

6. Use the Information filter to search by text displayed in the Information column, such as 

patient name or record type.  The data items displayed in the Information column vary by 

task type and are documented in the chapters related to each specific task.  To match a 

complete phrase, enclose it in quotes (e.g., “Smith, John”).  If you enter John Smith or 

Smith, John without quotes, tasks related to patients named either John or Smith will be 

returned (the list could include names such as John Smith, John Doe, and William Smith). 

7. Age and Date are two expressions of the same attribute, the time that the task was 

created.  The worklist allows you to filter on this attribute using date filters.  By default, 

the worklist displays task Age instead of the exact date and time the task was created. To 

display Date instead of Age, uncheck the Show Age box.  To specify a date range, enter 

values in the From and To filters.  Use the MM-DD-YYYY format, or click the Calendar  

icon.  You may enter an open-ended range to include all dates prior to or later than a 

specific date. 

8. Use the DX Year filter to search for tasks by year of diagnosis.  You may specify a range 

of years (e.g., 2002-2004) or use a comma to select separate years (e.g., 2002, 2004).  

9. Use the Facility filter to display tasks involving records and patient sets corresponding to 

a specific reporting facility. Enter the Facility ID or click the Lookup icon  to select the 

facility from a list. 
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10. Use the Site filter to search tasks by cancer site.  Click the Lookup icon  to select a 

single code from a list or type one or more codes into the box (separate the codes by 

commas or spaces).  You may enter a partial string.  For example, enter C50 to search for 

site codes of C500 through C509. 

11. Use the Data Type filter to search for tasks by the type of data that is the focus of the 

task.  You may select one record type or patient set.  Once a record moves through the 

workflow and is linked to a patient set, the patient set will be the focus of the task.  If a 

task involves multiple records, the records other than the focus record are not considered 

when searching by record type. 

12. Use the Reportability filter to search for record tasks with a specific value for 

reportability.  Once the record is linked to a patient set, the patient set becomes the focus 

of the task.  The Reportability filter cannot be used to search for Patient Set tasks (Visual 

Edit Patient Set, Resolve Patient Set Errors, for example). 

13. If the filters are set appropriately, click Apply.  Click Reset to restore default settings. 

Following Data through the Worklist 

A Task ID is assigned when an incoming record triggers the initial task in the workflow.  As the 

record moves from task to task, the same Task ID is maintained.  This remains true until the 

record completes its journey through the workflow.  At that point, there will be no tasks in the 

workflow with that Task ID.   

The Worklist Filter provides a mechanism for searching the Worklist by several fields, including task 

ID, patient set ID, and the record ID of unlinked records (once a record is linked to a patient set, 

you must search by the patient set ID).  Filtering by Task ID, if known, is the fastest and most 

effective way to follow a record through the workflow.  Therefore, it is recommended that you take 

note of the Task IDs as you do your work. 

 
 

To facilitate tracking by Task ID, 

SEER*DMS shows the Task ID at the top of 

the page during a task. 

 

When you finish a task, a message is 

displayed at the top of the Worklist, 

notifying you that the data have been 

updated and reminding you of the Task ID.   

To follow data as you complete a task: 

1. Take note of the Task ID.  You may copy the task number to the Windows clipboard 

(highlight the text on the screen with your cursor and press Ctrl-C), or write it down. 

2. Use the Worklist Filter to determine where the data are now.  Select View > Worklist, or 

click the Worklist link on the Home page. 

3. By default, only tasks assigned to you are displayed.  The record or patient set may have 

moved forward in the workflow to a task that is not assigned to you.  To search among 

your tasks, tasks assigned to others, and unassigned tasks:  

a. Remove the text in the User(s) filter. 

b. Check Show Unassigned. 



4-6 6/18/2008  SEER*DMS User Manual 

4. Enter the worklist task ID in the Task ID(s) filter.  (If you copied the number to your 

clipboard, click your mouse in the Task ID(s) filter and press CTRL-V to paste the text into 

the filter.) 

5. Click Apply.  If the task is not found in the worklist, all workflow tasks required to process 

the record or patient set were completed.   

Assigning, Releasing, or Rerouting Tasks 

Requires system permission:  worklist_task_reassignment 

When a user opens an unassigned task, the task is assigned to that user’s account and will be 

listed in the My Tasks section of their Home Page.  Other users cannot access the task unless the 

task is released or rerouted. 

Assigned tasks can be rerouted to a different user or released.  The Release feature resets the task 

to unassigned; the Reroute feature changes the assignment from one user to another.  Tasks can 

only be rerouted to a user with the appropriate system permissions. 

To reroute or release an open worklist task: 

1. To assign the selected task(s) to another user, select Task > Reroute. 

a. Set the Action to Reroute to user, and select a user name from the pull-down list. The 

list will only include users who have the system permissions required to open all of the 

selected tasks. 

b. Enter text into the Comment box.  This text will be included in the e-mail notification 

sent to the user receiving the task. 

2. To designate the task(s) as unassigned, select Task > Release. 

3. If you have the system_administration permission, Terminate and Restart will be included 

on the Task menu (Restart will only be available in tasks related to records, not patient 

sets).  These actions should be used with care (see the Terminating Tasks and Restarting 

Tasks sections of this chapter for more information).  

To use the Worklist to assign, release, or reroute worklist tasks: 

1. Select View > Worklist or click the Worklist link on the Home page. 

2. To release or reroute a specific user’s tasks, enter their username in the User(s) filter. 

3. To modify tasks of a certain type, or to modify a specific task, use the filters to limit the 

list (as described in the Searching or Filtering the Worklist section of this chapter.)   

4. Select the task or tasks: 

a. To select a single task, check the box to the left of the Task ID. 

b. To select two or more tasks, use one of the following methods: 

i. To select specific tasks, check the box to the left of each Task ID.  You can only 

select tasks on the same page with this method.  

ii. To select all tasks displayed on the current page, check the box on the top left of 

the page, adjacent to the Task column heading. 

iii. To select all tasks on all pages of the filtered worklist, click Modify All and skip 

ahead to Step 6.   
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5. Click Modify. 

6. Set the Action: 

a. To assign the selected task(s) to a user, set the Action to Reroute to user, and select a 

user name from the pull-down list. The list will only include users who have the system 

permissions required to open all of the selected tasks. 

b. To designate the task(s) as unassigned, set the Action to Release. 

c. If you have the system_administration permission, Terminate and Restart workflow 

activity will be listed as possible Actions.  These should be used with care (see the 

Terminating Tasks and Restarting Tasks sections of this chapter for more information).  

7. Enter text into the Comment box.  This text will be included in the e-mail notification 

related to this action. 

8. Click OK. 

9. Each rerouted task will be assigned to the selected user. SEER*DMS will send an e-mail 

notification to the user, listing the Task ID for each task that is now assigned to that user. 

Each released task will be designated as unassigned. 

Opening a Task Assigned to You 

The My Tasks section of the Home page summarizes the worklist tasks assigned to you.  Only 

tasks appropriate for your system permissions will be displayed.  The number of tasks assigned to 

you is displayed to the left of the task type.  Use the shortcut links to access the worklist; the 

worklist will be filtered to show the tasks of that type that are assigned to you.  

 

To open a task assigned to you: 

1. Open the worklist: 

a. To view all the tasks assigned to you, select View > Worklist or click the Worklist 

link on the home page. 

b. To view assignments of a certain task type, click one of the shortcut links in the My 

Tasks box on the home page.  (Note:  If there is only one task of that type, that task 

will open automatically.)  

2. To reduce the list further, enter search criteria in the filter controls.  (See Searching or 

Filtering the Worklist for instructions.) 

3. Click Apply. 

4. To sort the worklist by the data in a column, click on the column heading. 
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5. To open a task, click on the ID number in the Task column.  Once you open a task, it is 

assigned to you and will remain assigned to you until you complete the task or the task is 

released or rerouted. 

Opening an Unassigned Task 

System permissions are required to view and access certain task types. (See Worklist Types for 

more information.) 

The Unassigned Tasks box on the Home page summarizes the unassigned tasks that you are 

permitted to access, and provides shortcut links for each type of task. Use the shortcut links to 

access the worklist; the worklist will be filtered to show the tasks of that type that are unassigned. 

 

To open an unassigned task: 

1. Select View > Home, or click the SEER*DMS logo to view the Home page. 

2. To view the unassigned tasks of a certain type, click one of the shortcut links in the 

Unassigned Tasks box.  (Note:  If there is only one task of that type, that task will open 

automatically.) 

3. To reduce the list further, enter search criteria in the filter controls.  (See Searching or 

Filtering the Worklist for instructions.) 

4. To sort the worklist by the data in a column, click on the column heading. 

5. To open a task, click on the ID number in the Task column.  Once you open a task, it is 

assigned to you until you complete, release, or reroute it. 

Terminating Manual Tasks 

System permissions:  system_administration 

You may use the terminate feature to end manual worklist tasks.  Instructions for ending 

automated tasks are provided in the Viewing or Aborting Automatic Tasks section of this chapter.  

The terminate feature should be used with extreme care when modifying tasks that relate to the 

processing of patient data.  The task is ended without forwarding the record or patient set to 

subsequent processes in the workflow.  Terminate is an appropriate method for removing tasks 

that are unrelated to the processing of patient data, for example, Report Output tasks. 

To terminate manual worklist task(s): 

1. Select the task or tasks.  To search for a task in the worklist, use the Worklist filters as 

described in the Searching or Filtering the Worklist section of this chapter.   

2. Specify the tasks to be terminated by checking the box to the left of each Task ID. 

3. Click Modify. 



Using the Worklist  6/18/2008 4-9 

4. Set the Action to Terminate. 

5. Click OK. 

6. Click OK to confirm.  The tasks will be removed from the workflow.  SEER*DMS will send 

an e-mail notification to you. 

Restarting Workflow Activity 

System permission:  system_administration  

You may use the restart workflow feature to terminate a task and resubmit the focus record to the 

beginning of the workflow.  If a patient set is the focus of a task, the workflow activity cannot be 

restarted.  Therefore, a record cannot be resubmitted to the workflow once it has been linked to a 

patient set.  Only the task’s focus record is resubmitted to the workflow.  Other records involved in 

the task are not affected. 

Modifications previously made to the record will be retained.  Therefore, a record may trigger a 

Resolve Record Errors task when first loaded but not trigger the task when resubmitted (if the 

relevant data items were changed). 

To restart the workflow activity of incoming record(s): 

1. Filter the worklist so that the tasks of interest are displayed in the worklist (see the 

Searching or Filtering the Worklist section of this chapter).   

2. Select the task(s) by checking the box to the left of each Task ID. 

3. Click Modify. 

4. Set the Action to Restart workflow activity. 

5. Click OK. 

6. Click OK to confirm when prompted.  The selected tasks will be ended and the focus 

records will be sent to the beginning of the workflow, triggering new tasks.  The new 

workflow tasks will be assigned new Task IDs.  SEER*DMS will send an e-mail notification 

to you indicating the number of records that were resubmitted to the workflow. 

Viewing or Aborting Automatic Tasks 

System permission:  no special permissions are required to view automatic tasks; 

system_administration is required to abort automatic tasks. 

When SEER*DMS performs an automated process, an automatic task will appear in the worklist. 

These items allow users to track the progress of automatic tasks through the workflow, and view 

additional information about an item, if necessary.  

SEER*DMS will run most automated processes quickly, and remove the item from the worklist as 

soon as the task is completed. However, if a process is taking longer than expected, a user may 

need to cancel the operation by ending the task as described in Terminating Tasks section. 

To access an automatic task in the worklist: 

1. Select View > Worklist, or click the Worklist link on the Home page. 

2. Only your tasks are displayed.  Some automated tasks are assigned to the user who 

initiated the process.  For example, Run Report tasks are assigned to a user.  Other 
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automated tasks are unassigned.  To view all automated tasks, clear the search text in the 

User(s) filter and check the Show Unassigned box. 

3. Scroll down the list in the Type(s) filter. Automatic task types are displayed at the bottom 

of the list in grey. Select one or more task types to display. 

4. Click Apply. The worklist will be filtered to display only the selected automatic task types. 

(The Task IDs for automatic worklist tasks are displayed in grey.) 

5. Click the Task ID to view additional information about an item. 

6. If you determine that this operation needs to be canceled, click Abort Task. Otherwise, 

click Close to return to the worklist. 

System Failure Tasks 

System permission:  the permission required to perform the task is also required to view a System 

Failure spawned by that task; no permissions are assigned to automated tasks for processing 

records moving through the workflow. 

A System Failure task will be created if SEER*DMS is unable to perform a process.  Open the task 

to view the name of the workflow activity, the time and date that the activity was started, and the 

runtime exception generated.  If you determine that the failure was due to a temporary problem 

such as a database deadlock, you may Retry the activity.  If you believe that a system flaw caused 

the problem, report the System Failure to the SEER*DMS technical support team.    

Printing the Worklist 

You may print a list of the tasks displayed in the worklist.  The list will include all tasks currently 

selected in the Filter settings.  It is recommended that you filter the worklist prior to printing to 

avoid an excessively large print job.  There are several reports related to tasks in the worklist and 

worklist tasks that have been completed.  See the Workflow Reports section of this chapter for 

more information. 

To print the worklist: 

1. Select View > Worklist, or click the Worklist link on the Home page. 

2. Use the Filter controls to select the worklist items that you would like to print. (See 

Searching or Filtering the Worklist for more information.) 

3. Click Print. SEER*DMS will generate a system report in a PDF file (RPT-040A). 

4. Depending on your browser settings, you may be prompted to Open or Save the report.  

If so, click Open.  The PDF will open in an Adobe Acrobat window.   

5. Use the Adobe controls to print or save the worklist report; and close the Adobe window. 

Worklist Tasks 

The task types shown in the worklist are listed in the following tables.  Each manual task is initiated 

when an automated task cannot be completed without human intervention.  The Automated Tasks 

listed here are the tasks which are triggered by a system user but completed in automated 

processes, for example, when starting a System Task.   
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Manual Tasks Function 

Consolidate Combine data from incoming records with data previously loaded 

into the system (Chapter 12:  Consolidating Data). 

Consolidate FUP Resolve conflicts encountered during the automated 

consolidation of follow-up information (Chapter 16: Follow-up). 

Image Data Entry Enter record data stored in an image file 

Import Review Review a pre-load analysis of an import in order to identify 

potential errors prior to loading the records into the workflow 

(Chapter 5:  Importing Data Files). 

Match-Consolidate Review possible matches identified for an incoming record (main 

workflow path).  Determine whether the record should be 

consolidated with an existing Patient Set, or refers to a new 

Patient Set (Chapter 10:  Matching Incoming Records to 

Database). 

Non-rpt Rescreening Review two records that match each other but do not match any 

reportable records or patient set data.  This task is only created 

if the two matching records are both auditable (not reportable); 

or if one is auditable and the other is supplemental.  Verify the 

match and determine if the combined data should be used to 

create a patient set (Chapter 15:  Re-screening of Non-

reportable Records). 

Report Output Access the output of a report that ran offline (Chapter 24:  

Creating Reports and Extracting Data). 

Resolve Patient Set Errors Resolve errors identified in the final automated review of the 

patient set (Chapter 14:  Resolving Patient Set Errors). 

Resolve Record Errors Resolve errors which must be resolved prior to screening 

(Chapter 8:  Resolving Record Errors). 

Screening Screen an incoming record for reportability (Chapter 9:  

Screening for Reportability). 

Supplemental Match Review possible matches for data that follows the supplemental 

workflow path.  This task is only created if the supplemental 

match algorithm includes weighted, possible match results. 

Visual Edit Patient Set Review a new patient set that was auto-created from an 

incoming record (Chapter 13:  Visual Editing). 

System Failure View information about a process that failed to complete. 
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Automated Tasks  Function 

Automatic Patient Edits Recalculates the edit errors for a cohort of Patient Sets (Chapter 

14:  Resolving Patient Set Errors). 

Execute Build Task Builds CTCs from non-abstract records (Chapter 27:  System 

Administration). 

Execute Import Loading imported data (Chapter 5:  Importing Data Files) 

Execute Import Analysis Performing the pre-load analysis of an import in order to identify 

possible potential errors prior to loading the records into the 

workflow (Chapter 5:  Importing Data Files). 

Execute System Task Executing one of the utilities or “tasks” that implement processes 

in batch mode (Chapter 27:  System Administration). 

Run Extract Report Create data file for a system extract (Chapter 24:  Creating 

Reports and Extracting Data). 

Run Report Generating output of a system report (Chapter 24:  Creating 

Reports and Extracting Data). 

Other Automatic Activities This allows you to search for other automated tasks not 

specifically listed in the filter. 

Workflow Reports 

These SEER*DMS system reports can be used to monitor data and tasks in the workflow.  

Report ID Title Description 

RPT-003A Tasks for Unlinked Records 

with Closed AFLs 

Lists workflow tasks for unlinked records which 

are associated with closed AFLs. 

RPT-061A Workflow Location of 

Imported Records 

For each record imported at a specified time, this 

report lists the current location of the record in 

the workflow.  It is paged by the import data file 

which contained the original record. 

RPT-062A Workflow Tasks by Facility 

and Year of Diagnosis 

Workflow tasks by source facility and diagnosis 

year. 

RPT-075A Number of Open Worklist 

Tasks by Data Type 

Number of open, manual workflow tasks by year 

of diagnosis and data type.  

RPT-075A Number of Open Worklist 

Tasks by User 

Number of open, manual workflow tasks by user 

account (total, number of unassigned tasks, and 

number assigned to each user.  

RPT-082A Number of Workflow Tasks 

Completed (by Task) 

The number of workflow tasks completed in a 

specified time period.  This report includes a list 

of users for each type of task. 

RPT-082B Number of Workflow Tasks 

Completed (by User) 

The number of workflow tasks completed by 

each user in a specified time period.  This report 

lists the number of tasks per user. 

RPT-084A Summary of Data Entry and 

Ad hoc Editing 

The number of Records and Patient Sets 

imported via data entry and modified via ad hoc 

editing. 
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Chapter 5:  Importing Data Files 

Data files may be imported using the SEER*DMS interface or auto-loaded from a specified network 

location.  All data files must adhere to file specifications documented in the Imports section of the 

Help menu.  

For most record types, the imported data are stored in the record table of the SEER*DMS database 

and can be viewed within the SEER*DMS record editor.  Each record enters the workflow and 

initiates the automated and manual tasks which are required to process the data.  You may specify 

the Import ID in the Patient Lookup, Worklist, or Import Manager to search for the records or to 

determine whether the records have completed the workflow.  The Import Manager also provides 

summary information about each import and access to the source data files. 

Supplemental import data are only stored in the record table if a manual task was necessary to 

match or consolidate the data.  If the automatic matching task does not identify any potential 

matches, the supplemental data are not retained at all.  If SEER*DMS is able to consolidate the 

data without a manual task, the patient set is updated; and the Import ID, filename, and line 

number are recorded in the patient set’s audit log.  

In this chapter, you'll learn about 

 Import Manager 

 Importing Data Files within SEER*DMS 

 Auto-Loading Data Files 

 Import Summary Information 

 Reviewing Field Frequencies 

 Import Review Task 

 Identifying Records that Could Not be Loaded 

 Notifying the Source Facility of Problems with Data Files 

 Import Info Page 

 Finding Records and Tasks Related to an Import 

 Reports Related to Data Imports 

Import Manager 

Requires system permission:  import_electronic or import_manual 

Use the Import Manager to locate records loaded in a particular import, to view or download a copy 

of the source data files, or to determine the current workflow location of each record in an import.   

To access the Import Manager, select System > Imports.  The following data columns are shown 

in the Import Manager: 

 Import ID – A unique ID assigned to each import.  Click the ID to view details about the 

import as described in the Import Summary Information section of this chapter.   

 Import Date – Date and time that the import was initiated.  

 Facility – The facility selected by the user or set in the autoloader configuration file for this 

import.  This facility is used by default as the record’s default reporting facility when the 

reporting facility is not available on the record. 

 User – The user who initiated the import.   “seerdms” will be listed as the user for 

autoloader imports and data migrated at the time of deployment. 
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 Records – The number of records imported.  This value will be zero until the Import Review 

task is completed and the data are successfully loaded.   

 Type – The import’s Media Type is displayed in this column.  The possible values are Files, 

Data Entry, or blank (migrated data). 

 Comment – The import-wide comment entered on the same page as contact when starting 

a new import or entered in the <> tag in the autoloader XML. 

 Action – Click Lookup in the Action column to search the database for records loaded in the 

import.  A maximum of 500 records will be listed. Use RPT-009A to generate a complete list 

of the records loaded in an import. 

Importing Data Files within SEER*DMS 

Requires system permission:  import_electronic and contact_view 

You may use the SEER*DMS interface to import data files from any local or network disk drive that 

you can access.  The files will be uploaded through your Web browser and are subject to HTTP size 

limitations.  Use the auto-load feature to import data files that exceed these limitations. 

To import data files using the SEER*DMS interface: 

1. Select System > Imports to access the Import Manager.  

2. Click New Import. 

3. Use the   lookup for the Facility field to specify the import facility.  You also have the 

option of specifying a Contact at that facility. 

4. Set the Media Type to Files. 

5. You may enter a Barcode or import reference number, if applicable. 

6. You may enter notes regarding the import in the Comments field. 

7. Click Next. 

8. If a Data Exchange Agreement (DEA) between the registry and facility is defined, you will 

have the option to indicate whether the data in the import are related to the agreement.  

The DEA fields in Contacts and Imports are for tracking purposes only.  Use these fields 

according to your registry’s policies.  

9. In the Add File section, click Browse.  Explore to the appropriate folder and select a file. 

10. Select the File Type.  Click the  information icon to review the layout for that file type. 

11. You may enter a Comment regarding this specific file. 

12. Click Add.  SEER*DMS will determine if the file was loaded before.  If the file is a 

duplicate, a warning message will be displayed.  To remove the file from the import, click 

the Remove link in the Action column.  (SEER*DMS will allow you to over-ride the 

warning and load a duplicate file.  Use this feature cautiously and only after consultation 

with registry managers and technical support staff). 

13. Repeat steps 9-12 for each file which is being imported from this facility.  Each file will be 

listed in the Current Files section as it is added. 

14. Click Import. 
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15. SEER*DMS will analyze the data files and create a manual Import Review task prior to 

storing the data in the database.  Refer to the Import Review Task section of this chapter 

for instructions on completing this task.  The Import Review Task provides an error 

summary and frequencies of all data fields.  Once you review these statistics, you will have 

the option of loading the data or terminating the import for some or all data files. 

Auto-Loading Data Files 

SEER*DMS can be configured to automatically load data files stored in designated locations on the 

network.  On a regular basis, an automatic workflow task imports all files in the auto-loader 

directories. The frequency of the directory scan is controlled by registry-defined configuration 

parameters. The auto-loader allows the registry to accept routine transmissions from sources such 

as ePath without human intervention; and provides a mechanism for loading files that exceed HTTP 

size limitations. Please refer to the SEER*DMS Technical Reference for more information in 

configuring the auto-loader.   

SEER*DMS will analyze the data file and create a manual Import Review task prior to loading the 

data into the database (refer to the Import Review Task section of this chapter for detailed 

instructions).  The task provides an error summary and a listing showing the frequency of each 

value for all data fields.  Once you review these statistics, you will have the option of loading the 

data or terminating the import for some or all data files. 

SEER*DMS checks auto-loaded data files to determine if the files were previously loaded.  If a 

duplicate file is copied to an auto-load directory, the file will not be loaded and email notification 

will be sent to the user specified in the auto-loader configuration. 

Import Summary Information 

The following information is listed for each file on the Import Info page and in Import Review tasks. 

 Filename – Click the filename to open or download the file. 

 Records – The total number of records in the data file. 

 Errors – The number of records which cannot be evaluated due to errors in the record 

layout, fields which define the record type, or key fields required when the data are loaded 

into the record table.  In an Import Review task, the number of errors will be a hyper link if 

the value is greater than zero.  Click the value to open the Import File Problems popup and 

review a sample of records which cannot be loaded due to layout problems.  SEER*DMS 

performs a limited amount of error checking at this point.  This error count will not identify 

invalid values in all data fields.  You must review the frequencies shown at the bottom of 

the page to verify data values. 

 Duplicate – If two records within the same file are exact duplicates, one will be loaded and 

the other will be counted here.  This count also includes records which cannot be loaded 

because they are exact duplicates of records loaded in an earlier import (based on hash 

maps).  It also includes records which are not exact matches but provide the same data as 

previously loaded records.  Non-exact duplicates may have differences in non-essential 

fields but provide the same data in key fields.  In most registries, the check for non-exact 

duplicates is only applied to death certificate records.   

 Ignored – To reduce the number of extraneous supplemental records in the database, 

some data types are evaluated to determine if they provide useful data.  A record that is 

deemed as not useful is “ignored” (it is not processed further and is not loaded into the 

record table).   In some registries, a pre-load matching algorithm is applied to specific types 

of supplemental records.  A record processed in this match is ignored if it does not match a 

patient in the database.  The number of ignored records also includes records which are not 

loaded because of a rule in the importer algorithm for the specific record type.  For 
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example, some supplemental record types are ignored if social security number is null (e.g., 

this rule applies to HCFA and CMS records in some registries).  To review the pre-load 

matching algorithms and importer rules used in your registry, please refer to SEER*DMS 

Technical Reference: Registry-specific Information. 

 Valid – The number of records which can be loaded.  Valid = (Records – (Errors + 

Duplicates + Ignored)).   If you complete the import, this is the number of new rows that 

will be created in the record table and the number of records that will enter the workflow. 

 File Type – The import file type. 

Reviewing Field Frequencies 

Requires system permission: import_resolution 

It is critical that data which are imported into the system are valid.  Some import files need to be 

pre-processed, while others can be imported as-is.  If there were problems with the data 

preparation, either at the sending facility or within the registry, an invalid import file could 

incorrectly modify a large volume of system data.  This type of problem is very difficult to remedy 

once the data are loaded into SEER*DMS; each record immediately begins to move through the 

workflow and affect changes in patient set data.  It is the responsibility of registry staff to define 

and implement comprehensive quality control procedures to prevent import errors.  This should 

include but not be limited to the review of input field frequencies to identify invalid or unacceptable 

values.  Field frequencies for each file are displayed on the Import Review and Import Info screens. 

When an import is displayed, the Statistics section lists frequencies each data field in an import file.  

If multiple files are included in the import, a drop-down list allows you to switch from one file to 

another.  The fields are listed in alphabetical order.  You may use the linked letters at the top of 

the list to view fields which begin with that letter or use Firefox search tools to search for a 

fieldname or column position. 

 
 

The figure above shows the type of information shown for each data field.  The following describes 

the information that is displayed and the text actually used in the example above. 

 Field name - shown in bold above the line:  DOLC Month 

 Column position – shown in parentheses next to the field name:  (columns 1294-1295) 

 Range of values - shown in brackets above the line in center:  [01 – 12] 

 Number of different values – only shown if there are more than five different values for 

the field.  The number of different values (“12 values” in the example) is displayed on the 

far right of the page, just above the line.  Up and down arrows enable you to toggle the 

display to show all values or hide all but the top five values.  The figure below shows all 

twelve values for the example. 

 Statistics and bar chart -   For each value encountered for the field:  the number of 

records, percent of records, and value.   The value is shown within a histogram bar.  In the 

example, 56 records have a value of “07” for DOLC Month.  56 equals 14.2% of the number 

of valid records in the file.  Note:  frequencies are not shown if the number of differing 

values exceeds display limitations.  For example, it would be impractical to show a 

frequency for street address which would be unique for every record. 
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Import Review Task 

Requires system permission: import_resolution 

Once an import is initiated, SEER*DMS will analyze the data files and create a manual Import 

Review task prior to loading the data into the database.  The Import Review Task provides an error 

summary and a listing showing the frequency of each value for all data fields.   

To complete the Import Review tasks: 

1. Click the Import Review link in the My Tasks section of the worklist summary on the 

home page. 

2. Click the Task ID to open the task.  At this stage, the files have been checked for errors 

and analyzed to create frequencies of values in all data fields.  The records have not been 

loaded into the system. 

3. Carefully review number of records listed for Records, Errors, Duplicates, Ignored, and 

Valid in the Import Files section of the page.  Each of these fields is described in the 

previous section. 

4. Follow steps 5 and 6 for each file with errors.  

5. If an incorrect file type was specified for the file: 

a. Select the correct File Type.  An asterisk is displayed next to the original File Type 

selected when the import was initiated.  The field frequencies shown in Statistics are 

based on the layout of the File Type that is displayed with the asterisk. 

b. Set Action to Accept. 

6. If the file type is correct but the file has errors: 

a. Click the value displayed in the errors column. 

b. Review the error messages.  You must determine whether you want to reject all records 

in the file or import the records that did not cause errors.  (Note:  Once an error is 

encountered, the first record with the error and all subsequent records will be displayed 

in red.) 

c. Click Close to close the Import File Problems window.  

d. Set the appropriate Action for this file.   
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i. If you would like to contact the reporting facility and obtain a replacement for a file 

with errors, select Reject to reject all records in the file (records in other files will 

not be affected).  

ii. If all errors are caused by duplicate records, you may use Re-import valid only to 

accept the non-duplicate records.  If there are other types of errors, only use this 

action if you have the technical resources to identify the records with errors.  You 

should attempt to obtain corrected versions of these records, as described in the 

Identifying Records that were Not Loaded section of this chapter. 

7. To close the Import Review task: 

a. If an Action is specified for each file, click Import to load the acceptable data and exit 

the task.  If the data cannot be loaded or a new file type was selected for a file, a 

second Import Review task will be created and assigned to you.  Otherwise, the records 

will begin entering the workflow.  Automated and manual tasks related to the records 

will be created in the worklist.  You may specify the Import ID in the Patient Lookup, 

Worklist, or Import Manager to search for the records or to determine whether the 

records have completed the workflow.  System reports provide additional information 

regarding the imported data. 

b. If you would like to close the Import Review task without importing any of the files: 

i. To request new files from the source facility and retain the Import Problems task as 

a reminder, follow the instructions in Notifying the Source Facility of Problems with 

Data Files.  If you suspect the error was in a pre-processing step, request a new file 

from your data processing department.    

ii. Click Reject All. 

c. To exit without removing the task from the workflow, click Cancel.  The task will be 

assigned to your user account. 

Identifying Records that Could Not Be Loaded 

As described in Resolving Problems with Imported Data Files, it is possible to load partial files.  This 

will commonly be used to ignore duplicate records within a file, but may also be used to ignore 

records with other errors.  If a partial file is loaded, it is the responsibility of the registry’s technical 

staff to identify and obtain corrected versions of the records that were “ignored” (not loaded). 

To identify the records that were not loaded, compare a list or extract of records to the original 

data file submitted by the reporting facility.  SEER*DMS includes a system report that provides a 

list of the records loaded from each data file (RPT-009A). Alternatively, you may use a similar 

query in an external application to create a data extract.   

Provide a list of the records with errors to the reporting facility and request replacement records.  

If you wish the request to be tracked within SEER*DMS, you may use the Record Request feature 

described in Chapter 23:  Requesting Records. 

Notifying the Source Facility of Problems with Data Files 

Requires system permission: import_resolution 

While performing an Import Review task, you may use the Query feature to request new data files 

or report errors to the organization representative. 

1. Open the task as described in the Import Review Task section of this chapter. 
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2. Click Query.  You will be able to use any communication method, provided that the 

relevant contact information is defined for the representative in the Contacts list. (See 

Chapter 19:  The Contact List for more information.) 

3. To send an e-mail: 

a. Set Type to E-mail. 

b. Click To, CC, or BCC to change the recipients.    

i. Enter text in the Search filter to find a specific person.   

ii. Check To, CC, or BCC for each contact, as appropriate.  Only one contact may be 

selected as the main recipient (To). 

iii. Click Save to exit the recipient page and continue composing the e-mail message. 

c. Enter text into the Message box (do not include confidential information). 

d. If you would like to attach the problematic data file, click Attach File.  Do not attach 

files containing confidential data unless the file is encrypted.  (SEER*DMS does not 

provide a mechanism for encrypting data files or e-mail messages.)   

e. Click Send. 

4. To print a letter to be faxed or mailed: 

a. Set Type to either Fax or Letter. 

b. Enter the text for the body of the letter into the Message box. 

c. Click Print to create a PDF file. 

d. Review the contents of the letter. If necessary, close the Acrobat window and return to 

the Communication page to make revisions. 

e. Use the Acrobat controls to print the letter. 

5. To contact the representative by phone: 

a. Set Type to Phone. 

b. The contact's phone number will be displayed on the screen as a reference while you 

make the call.  The message box is not relevant to phone communications.  

c. If you are unable to reach the contact, you may want to make a note to remind yourself 

to try again later or use an alternate method of contact. Or, click Cancel to cancel all 

changes made in this Import Problems task.  The task will remain in the worklist 

assigned to you. 

d. Once you have successfully completed the call, click OK. 

Import Info Page 

Requires system permission:  import_electronic or import_manual 

You may use the Import Info page to view or download the source data files, view a summary of 

open worklist tasks related to the imported records, search the database for a sample of records 

loaded in the import, view field frequencies or summary statistics.    
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The information described below is displayed on the Import Info page.   The statistics section is 

described in the Reviewing Field Frequencies section of this chapter. 

 Import ID – A unique ID assigned to each import.  This ID can be used throughout 

SEER*DMS to find data loaded in a particular import and is displayed when editing a record.   

 Contact – The contact selected by the user or set in the autoloader configuration file for 

this import. 

 Facility – The facility selected by the user or set in the autoloader configuration file for this 

import.  This facility is used by default as the record’s default reporting facility when the 

reporting facility is not available on the record. 

 Type – The import’s Media Type is displayed in this column.  The possible values are: Files, 

Data Entry, or blank (migrated data). 

 Barcode – Barcode or reference number entered by the user who imported the data. 

 Import Date – Date and time that the import was initiated.  

 User – The user who initiated the import.   “seerdms” will be listed as the user for 

autoloader imports and data migrated at the time of deployment. 

 Records – The number of records imported.  This value will be zero during initial pre-load 

tasks.  The value will be zero until the Import Review task is completed and the data are 

successfully loaded.   

 Comment – The import-wide comment entered on the same page as contact when starting 

a new import or entered in the <> tag in the autoloader XML. 

 Import Summary – This summary shows the total number of records in all data files and 

the number that were imported (sum of “Valid” for all data files).  The difference equals the 

sum of records with errors, duplicates, and ignored records.  Click the Imported Records 

link to view a sample of the records via the Patient Lookup (limited to 500 records). 

 Worklist Summary – A count for each type of worklist task involving records loaded in this 

import.  You may click the task type to view or open the tasks via the worklist. 

 Import Files – This section shows an error summary for each file loaded in this import.  

See the Import Summary Information section of this chapter for a description of the 

statistics displayed in this section.  Click the filename to open or download the data file.  

Finding Records and Tasks Related to an Import 

When source data submitted to the registry are imported, the data are assigned unique IDs (with a 

“REC-“ prefix) and are stored in the record table of the SEER*DMS database.  In some registries, a 

pre-load matching algorithm is used for supplemental data types and the non-matching 

supplemental records are not stored in the database.  Refer to your registry-specific Technical 

Reference and workflow diagrams to determine if all imported supplemental data are stored. 

 

Each imported record travels through the workflow, triggering the automated and manual “tasks” 

that must be performed to process the data.  There are a variety of tools in SEER*DMS for 

determining the current location of a record in the workflow and the end result of the workflow 

processing.  Use these tools to determine whether there are open tasks related to the records and 

if the records have been consolidated into the patient set data. 

To view a summary of open tasks related to the import: 

1. Select System > Import.  The most recent imports will be listed on the first page of the 

manager.  The pages of the managers include all data entry sessions, autoloaded data, 

and data loaded in the system interface.  You may use the filters to search for a specific 

import.  The filters correspond to the fields described in the Data Shown in the Import 

Manager section of this chapter. 
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2. Click the Import’s ID. 

3. The Worklist Summary on the right side of the screen will be recalculated.   

4. Click one of the links to view or access the tasks via the worklist. 

To search the worklist for open tasks related to the import: 

1. Select View > Worklist, or click the Worklist link on the Home page. 

2. Use the Import filter to display tasks related to records loaded in a specific import. Enter 

the Import ID or click the Lookup icon  to search for the Import ID by facility, date, 

and/or user. 

3. Some filters are pre-set when you enter the worklist.  To ensure that all tasks related to 

records in this import are listed: 

a. Do not select a value in the task Type(s) filter. 

b. Set the User(s) filter to blank. 

c. Check Show Unassigned.  

4. Click Apply.   

5. The results will only include record-based tasks for records loaded in the import.  When a 

record moves through the workflow and is linked to a patient set, the focus of the task 

switches from the record to the patient set.  The task would no longer be shown in a list of 

tasks related to the Import ID.   Use RPT-061A to obtain a complete list of tasks initiated 

by records in an import.  

To review a sample of records loaded in a specific import: 

1. You may initiate your search from the Import Manager or the Patient Lookup:   

a. To search from the Import Manager: 

i. Select System > Import Manager. 

ii. Click the Lookup link listed for the import of interest. 

iii. A Patient Lookup search will be executed using the import’s ID as a search field.  All 

other search fields are ignored when an Identifier Search field is used. 

b. To initiate the search from the Patient Lookup: 

i. Select View > Patients. 

ii. Click ID Lookup in the left navigation bar. 

iii. Use the   lookup to specify an Import ID. 

iv. Click Search 

2. The search results will be limited to a sample of 500 records from the import.   
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Reports Related to Data Imports 

Select View > Reports to review the current list of system reports provided in SEER*DMS. The 

reports listed below are the system reports related to data imports that were included in 

SEER*DMS when this manual was printed.  If you require information regarding imported data that 

is not included in a system report, you may generate an external report.  See Chapter 24:  

Creating Reports and Extracting Data and SEER*DMS Data Dictionary for more information. 

Report ID Title Description 

RPT-009A Imported Records A list of records imported into SEER*DMS on 

a specified date.  You may select a specific 

facility, if appropriate.  

RPT-061A Workflow Location of Records For each record imported at a specified time, 

this report lists the current location of the 

record in the workflow.   

RPT-070A Import Summary Number of records loaded per imported data 

file. 

 



Chapter 6:  Data Entry 
The SEER*DMS import feature provides access to data entry screens that allow you to enter data 
using the keyboard.  This feature is used to key in data printed on paper forms.  You may also wish 
to enter data based on images of scanned documents (referred to as “image files” in SEER*DMS).  
However, image files are typically imported rather than manually attached to a record in a data 
entry session.  When an image file is imported, SEER*DMS automatically attaches the image to an 
“empty” record and creates a manual Image Data Entry task that enables the user to enter data in 
critical fields.  Please refer to Chapter 5: Importing Data Files for instructions related to image files. 

A record created via data entry is forwarded into the workflow processes designated for its record 
type, following the same path as if it were loaded from a data file.  However, in many registries, 
Review Flags may be set during data entry but cannot be set in data stored in a file.   If the person 
performing data entry sets a Review Flag to “reviewed”, edits associated with the flag will not 
trigger a Resolve Record Errors task when the record moves forward in the workflow.  Registry 
managers must define standard operating procedures for those who manually enter new data; and 
must evaluate edits applied to record data.  

In this chapter, you'll learn about 

• Starting a Data Entry Session 

• Using the Record Editor 

• Entering Values for the Data Fields 

• Keyboard Functions for Data Entry 

• Printing a Record in SEER*DMS 

• Clearing Unsaved Data 

• Reports Related to Data Entry 

Starting a Data Entry Session 

Requires system permission:  import_manual and contact_view and rec_edit 

You may enter a set of records from the same source facility during a single data entry session. 

To start a data entry session: 

1. Select System > Imports. 

2. Click New Import. 

3. Use the   lookup for the Contact (Facility) field to specify the person who provided the 
data.  If the person is affiliated with more than one organization, select the appropriate 
facility for this import.  Contacts and facilities are described in Chapter 19:  The Contact 
List and Chapter 18:  The Organization and Facility List. 

4. Set the Media Type to Data Entry. 

5. Enter the reference Barcode if applicable for this import. 

6. You may enter notes regarding the import in the Comments field. 

7. Click Next. 

Follow the instructions in the Using the Record Editor section of this chapter to complete the data 
entry session.  As each record is saved, SEER*DMS will assign a unique record ID and forward the 
record to the initial processing tasks in the workflow.    
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Using the Record Editor 

After initiating the data entry session as described in the previous section, SEER*DMS will display a 
record editor similar to the one shown below.   
 

 
 

Use the links in the Record Navigation Box to access each page of record data.  The number of 
pages and the layout of the fields in the body of each page vary by record type.   

The following items are displayed in the Info Box during a data entry session: 

• Import ID – A unique identifier assigned to all records entered in the same data entry 
session or imported in the same set of files.  An Import ID will be assigned when you 
complete the data entry session.  The Import ID can be used to generate reports regarding 
the records entered during a data entry session (see Reports Related to Data Entry). 

• File Type – This field is only relevant for records imported from data files.  This field is not 
applicable to records entered via data entry or records migrated into SEER*DMS when the 
system was first deployed.  If N/A is displayed for file type, click the Information Icon   for 
the import to determine whether the Media Type is Migration or Data Entry. 

• Source – The facility specified as the source of the data.   

• Record Type – A drop-down list of the types of records that can be entered manually. 

The body of the record editor displays the content for the currently selected page.  The layout of 
the fields in the body of the page varies by record type.  The NAACCR record type is consistent in 
all registry configurations, other record types vary.   A variety of controls are used on the data 
pages to edit specific fields; these are described in the Entering Values for the Data Fields section 
of this chapter. 
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Entering Values for the Data Fields 

Requires system permission:  import_manual and contact_view and rec_edit 

To enter values for the data fields: 

1. Select the appropriate Record Type from the drop-down list provided in the Info box on 
the left side of the screen. 

2. The editor displays data fields in different colors to highlight fields that generated an error 
based on SEER and local edits.  At this point, errors may be indicated for missing data 
fields.  You should limit your attention to entering the raw data provided on the paper 
records; errors should be addressed during visual editing tasks.  Chapter 7: Edit Errors 
contains more information on the edits and the color codes used in the record editor. 

3. Enter values for all data fields provided on the paper record: 

a. Enter data into the fields on the current page.  You may use your mouse or keyboard 
controls to move from field to field.  The cursor may be difficult to see when it is the 
first character in a data entry box.   Therefore, the field in which the cursor is currently 
located will be highlighted in green. 

b. You may enter text directly into fields; for some fields you may use a lookup  to select 
a value from a list.  See the Keyboard Functions for Data Entry section of this chapter 
for more information. 

c. If entering data for a record with multiple pages, use the links in the Record Navigation 
Box to move between pages.  

d. If the paper record does not provide a value for a field, leave the field blank. 

4. If you mistakenly enter data for a record that you do not want to save, you may clear the 
data entry pages.  For instance, you may use this feature if you realize that you are 
entering data for a record that you previously entered.  Refer to the Clearing Unsaved 
Data section of this chapter for instructions. 

5. Click Save when you have entered all available data for the record. 

6. Enter Comments regarding the data entry session, if appropriate.  Your comments will be 
accessible on this record’s Audit Log page in all subsequent tasks. 

7. Click Save & Next to complete data entry for this record.  A record ID will be assigned 
and displayed at the top of the page. 

8. Enter data for the next record on the blank data entry screen that is displayed.  Repeat 
data entry steps until all records are entered.  You may enter data for different record 
types during a single data entry session. 

9. After the last record has been entered and saved, click Cancel to end the data entry 
session. 
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Keyboard Functions for Data Entry  

The table below lists keyboard functions that can be used to modify fields in the editor.   

Use your mouse to go directly to a field or use the following keystrokes: 
Use To 
Tab Go to the next field 
Shift + Tab Go to the previous field 
 
To edit a data field, type the new value into the text box or use the 
following controls: 
Use To 

Click  Open a lookup table to select a value from a list of the field’s 
valid values.  For some lookups, you will also be able to define 
new values (e.g., add a new physician or facility).   

Ctrl + C Copy to clipboard 
Ctrl + V Paste from clipboard to cursor location 
Ctrl + X Cut – deletes highlighted text and copies it to the clipboard 
Ctrl + A Select all text (highlight without using the mouse) 
Home and End Go to beginning or end of current field 

 

Printing a Record in SEER*DMS 

Requires system permission:  rec_read_only or rec_edit 

Use the print feature to create a PDF report showing the current entries for all data fields.  The 
report will include fields from all pages of the record.   You may print a record during a data entry 
session, when a record is opened in the editor during a worklist task, or when an unlinked record is 
opened from the Patient Lookup.  You may also print a linked record when it is viewed in the 
patient set editor. 

To print a record: 

1. Click the  menu indicator in the Record Navigation Box to open the record menu: 

 

2. Select Print to create and open a PDF file. 

3. Use the Adobe controls to save or print the report. 

4. Close the Adobe window. 
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Clearing Unsaved Data 

Requires system permission:  import_manual and rec_edit 

If you have mistakenly entered data for a record that you do not want to save, use the undo 
feature to clear the data entry pages.  You may use this feature if you realize that you are entering 
data for a record that you previously entered.    

To clear unsaved data: 

1. Click the  menu indicator in the Record Navigation Box to open the record menu: 

 

2. Select Undo Changes. 

Reports Related to Data Entry 

In SEER*DMS, a data entry session is considered to be a single, manual import.  Therefore, each 
record saved during a data entry session is assigned the same Import ID.  The Import ID can be 
used to generate reports regarding imported data files or data entry sessions.  System reports 
related to data imports are listed in the table below.  If you require additional information 
regarding imported data, you may query the database using the record’s Import ID or Date 
Loaded; or query fields stored in the Submission_file table.  See Chapter 24:  Creating Reports and 
Extracting Data for further instructions; refer to the SEER*DMS Data Dictionary for information 
related to the database tables. 

Report ID Title Description 
RPT-009A Imported Records A list of records in a specific import or a 

listing of records imported on a specific 
date. 

RPT-061A Workflow Location of 
Imported Records 

For each imported record, this report lists 
the current location of the record in the 
workflow. 

RPT-070A Import Summary Filenames, number of records, and 
comments for imports in a specified time 
period. 

RPT-084A Summary of Data Entry and 
Ad hoc Editing 

The number of records and patient sets 
imported via data entry and modified via 
ad hoc editing.  This report shows 
frequencies by user for a specified time 
period. 

 

Data Entry  7/26/2007 6-5 



6-6 7/26/2007  SEER*DMS User Manual  

 



Edit Errors  6/19/2008 7-1 

Chapter 7:  Edit Errors 

Computerized edits are automated processes that test the validity of data fields.  The following sets 

of edits are integrated into SEER*DMS:  SEER Edits, SEER Extended Edits, edits defined by and for 

the local registry, and system edits that enforce database integrity.   

 The SEER Edits cover fields submitted to SEER and represent the edits implemented in the 

SEER*Edits software.   

 The SEER Extended edits were developed by the NCI to extend edits beyond those fields 

sent to the SEER Program.  The extended edits are available to all SEER*DMS registries and 

validate fields that are not required to be transmitted to SEER.   

 Registry edits are defined and maintained by registry staff.  These would include edits to 

validate registry-specific fields, edits to implement validation not covered by SEER edits, 

and registry-specific versions of SEER edits (the registry may decide to vary the logic of a 

SEER edit by creating a registry-defined edit and disabling the SEER edit). 

 System edits are edits to enforce database constraints.  The SEER*DMS system edits 

enforce database integrity of fields common to all SEER*DMS registries.  The SEER*DMS 

Registry system edits enforce database integrity of registry-specific fields.  

SEER, SEER Extended, and all system edits are maintained and deployed by the SEER*DMS 

development team.  Registry staff are responsible for defining and maintaining registry-specific 

edits that are not system edits.  The SEER*DMS Edits Manager provides an interface for adding, 

modifying, and deleting registry edits. 

SEER*DMS data screens indicate the edits that failed and the fields associated with those edits.  It 

is recommended that, whenever possible, changes be made to the patient set and not to the 

record.   Therefore, only errors that must be resolved prior to screening should be resolved in 

record data fields (see Chapter 8:  Resolving Record Errors).  All other errors should be resolved 

when the data are incorporated into a patient set.  Patient set edit errors may be resolved in ad 

hoc editing or when performing a worklist task.  Patient Set tasks are described in detail in Chapter 

12:  Consolidating Data, Chapter 13:  Visual Editing, and Chapter 14:  Resolving Patient Set Errors. 

A patient set exits the workflow when all edits are cleared.  However, a Resolve Patient Set Errors 

task is not created if an edit error is introduced because of data modifications made via ad hoc 

editing or Mass Change imports. 

Edits are executed each time a user opens, validates, or saves a record or patient set in 

SEER*DMS.  Edits are also executed whenever an automated process updates a patient set (this 

includes updates via Mass Change imports).  The Patient Set Edits System Task can be used to 

execute the edits on all patient sets or a cohort of patient sets. The primary purpose of this task is 

to ensure that new or modified edits have been applied prior to generating an extract or report that 

is dependent on submissibility or edit frequencies.   

In this chapter, you’ll learn about 

 Viewing Edit Documentation 

o Viewing Edit Documentation while Editing Data 

o Using the Edits Help Page 

 Using the Edits Manager 

 Understanding Edits in SEER*DMS 

 Defining and Maintaining Registry Edits 

 System Task to Execute Edits in Patient Sets 

 Reports Related to Edits 

 Color Codes Used in SEER*DMS Editors 
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Viewing Edit Documentation 

SEER*DMS provides four ways to view documentation related to edits: 

 As you are editing or viewing a record or patient set, you may use the Edits page of the 

SEER*DMS editor to view edit documentation for each failed edit (see the Viewing Edit 

Documentation while Editing Data section of this chapter for instructions).   

 All system users have access to the Help menu which includes an Edits section.  You may 

use the Edits Help page to search for an edit by edit ID, group, severity level, and/or search 

text (see the Using the Edits Help Page section of this chapter for instructions).  

 If you have the system_administration permission you may use the Edits Manager to view 

documentation and source code for all edits.  You may also use the Edits Manager to modify 

registry-defined edits.  (See the Using the Edits Manager and Defining and Maintaining 

Registry Edits sections of this chapter for instructions.) 

 If you have the system_administration permission, you can search the XML configuration 

files in which the SEER, SEER Extended, and system edits are defined.  Refer to the System 

Administration Page section of Chapter 27 for instructions to access the system files.  The 

edit system files are named according to the edit group.  Once you select the XML file, use 

the Firefox search tools to find a particular edit. 

Viewing Edit Documentation while Editing Data 

All users with permission to view or edit record or patient set data may view documentation for 

edits that fail during that editing session. 

To view information related to an edit that failed for a particular patient set or record: 

1. Open the record or patient set in the SEER*DMS editor. 

2. Click Edits in the left navigation section of the editor. 

3. Click the Information Icon  shown next to the Edit ID. 

4. The edit’s ID, message, severity level, group, and list of entities will be displayed in a 

popup window.  These components are described in the Understanding Edits in SEER*DMS 

section of this chapter. 

Using the Edits Help Page 

Requires system permission:  none (all users have access to the help pages) 

To search the Edits Help page for documentation related to an edit: 

1. Select Help > Edits.   

2. By default, all edits will be listed.  You may use the filter to search by Edit Group, Severity 

Level, and/or text used in the message, ID, or source code.  

a. Use the first drop-down menu to search by Edit Group. 
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i. All Groups – This is the default setting. 

ii. <Your Registry’s Name> - Edits in this group are defined and maintained by 

registry staff. 

iii. SEER – These are the edits implemented in the SEER*Edits software package to 

validate fields submitted to SEER. 

iv. SEER*DMS – SEER*DMS edits enforce database integrity of fields common to all 

SEER*DMS registries. 

v. SEER*DMS Registry – SEER*DMS Registry edits enforce database integrity of 

registry-specific fields (fields in the patient_registry, ctc_registry, record_registry, 

and other _registry tables in the database). 

vi. SEER-Extended - Edits developed by NCI and IMS for the SEER*DMS registries 

to validate fields that are not required in data submitted to SEER. 

b. Use the second drop-down menu to search by Severity Level.   Each edit is assigned a 

severity level of low, moderate, high, or critical.  Please refer to the Understanding Edits 

in SEER*DMS section of this chapter for a detailed explanation of edit severity levels. 

c. Enter text in the keyword box to search for text in the edit message, ID, or Groovy 

source code.  

d. Click Filter to apply the search criteria.  You may use Clear to reset the filter to the 

default values (All Edit Groups, All Severity Levels, and no search text). 

The following example shows the result of using the filter to find Edit Group = SEER, Severity Level 

= All, and search text = age_at.  

 

Click the edit’s ID to expand the display of the edit information on your screen, as shown below.   

The edit’s Message is listed first, followed by Entities, Dependencies, Documentation, and the 

Groovy source code.  See the Understanding Edits in SEER*DMS section of this chapter for a 

description of each component. 

 

Using the Edits Manager 

Requires system permission:  system_administration 

Use the Edits Manager to search for an edit or view a list of edits based on search criteria.   If you 

are modifying or deleting an edit, follow the steps below to search for the edit and then refer to the 

Defining and Maintaining Registry Edits for further instructions.  
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To filter the list of edits in the Edits Manager: 

1. Select System > Edits.   

2. By default, all edits will be listed.  You may use the filters to search by Edit ID, Edit Group, 

Severity Level, database Properties, Data Type, and text used in the message, ID, or 

source code.  

3. The Edit ID is the edit’s name or label (examples:  IF104, SEER_IR09, Age_at_Diagnosis).  

Use the Edit ID filter to search for an edit based on a complete or partial Edit ID.   

4. Use the Group filter to limit the list to the edits in a particular group.  The edit groups are 

listed below. 

a. <Your Registry’s Name> - Edits defined and maintained by registry staff. 

b. SEER – These are the edits implemented in the SEER*Edits software package to 

validate fields submitted to SEER. 

c. SEER*DMS – These are system edits that enforce database integrity of fields common 

to all SEER*DMS registries. 

d. SEER*DMS Registry – These are system edits that enforce database integrity of fields 

specific to your registry. 

e. SEER-Extended - Edits developed by NCI and IMS for the SEER*DMS registries to 

validate fields that are not required in data submitted to SEER. 

5. Use the Severity filter to search for edits based on severity level. Each edit is assigned a 

severity level of low, moderate, high, or critical.  Please refer to the Understanding Edits in 

SEER*DMS section of this chapter for a detailed explanation of edit severity levels. 

6. Use the Properties filter to search for edits which reference a specific database field in 

the Groovy source code.  You may click the Lookup icon   to search for a field; or enter 

text directly into the filter (SEER*DMS will display a list of properties that match your text 

as you type).  The text used in the Properties lookup is the Description shown on the Field 

Mappings help page. 

    

7. Use the Data Type filter to search for edits based on the tables used in the edits’ Entities. 

8. Use the Info filter to search by text included in the Edit ID or Message.  

9. If the filters are set appropriately, click Apply. 

10. Click the ID of an edit to view or modify the edit’s logic, message, or documentation.  The 

specific components of an edit are described in the Understanding Edits in SEER*DMS 

section of this chapter. 

11. If you would like to restore the default filter settings, click Reset. 
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Understanding Edits in SEER*DMS 

The components of SEER*DMS edits are described below.   

Edit ID 

A unique identifier assigned to each edit.  You must specify an ID for a new registry edit (1-50 

alphanumeric characters may be used). 

Guidelines for specifying an ID for a registry edit: 

 Use your registry’s two-character abbreviation as a prefix for all registry-defined edits (AK, 

CN, CT, DT, HI, IA, LA, NM).  

 If you are creating an edit designed to replace or supplement a SEER Edit, the ID should 

consist of your registry’s prefix followed by the SEER Edit ID (e.g., DT_IF29, IA_IF02). 

Group 

In SEER*DMS, edits are organized into five groups:   

1. SEER Edits validate fields submitted to SEER.  These edits were developed and are 

maintained by the developers of the SEER*Edits software. 

2. SEER Extended Edits are defined and maintained by SEER for the SEER*DMS registries.  

These edits validate fields that are supported by SEER*DMS, but not required to be 

transmitted to SEER. 

3. Registry Edits are defined and maintained by registry staff.  These would include edits to 

validate registry-specific fields, edits to implement validation not covered by SEER edits, 

and registry-specific versions of SEER edits (the registry may decide to vary the logic of a 

SEER edit by creating a registry-defined edit and disabling the SEER edit).  

4. SEER*DMS edits enforce database integrity of fields common to all SEER*DMS registries 

5. SEER*DMS Registry edits enforce database integrity of registry-specific fields.   The 

SEER*DMS development team creates these edits, if necessary, when registry-specific 

fields are added to the database. 

Entities 

When defining an edit, you must specify the database entities to which the edit will be applied.  

The available entities include complete database tables, for example, some edits may be run 

against all patient sets (entity = patients).  Other entities are subsets of database structures (for 

example, edits may be run against “CTCs with sequence = 1” or “CTCs needing review”).   

Registry staff may not add or remove entities to the list. The list of available entities is defined by 

the SEER*DMS development team when the system is configured for the registry.   

Guidelines for specifying Entities for registry edits: 

 Record Edits:  Select an entity related to Records (“Records” may be the only appropriate 

entity or your registry may have entities that define subsets of records). 

 Patient Set Edits:  Based on the fields used in the edit’s logic, select an entity related to the 

database table at the lowest level of the patient set hierarchy.   

o Identify the database table used for each field used in the logic of the edit.   

o Refer to the Simplified DB Model of the Patient Set provided in the Database 

Documentation section of the SEER*DMS Web Portal. 
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o Determine the lowest level table used in the edit’s logic.   

o Select an entity related to that table. 

o For example, an edit comparing age at diagnosis and age at birth uses the CTC and 

Patient tables.  The CTC table is at a lower level in the patient set hierarchy than the 

patient table. Therefore, you should select an entity related to the CTC table. 

 If your edit requires an entity that is not listed, submit a change request via the SEER*DMS 

Technical Support Squish project. 

Message 

The edit message is the text that is displayed in the patient set or record editor when the edit fails.  

The Edit ID and Message are shown when you hover over a field involved in the failed edit.  The 

edit messages are also displayed in all edit reports.  The maximum length for an edit message is 

500 characters. 

Guidelines for defining Messages for registry edits: 

 The edit message should reflect the logic of the edit and should be written in language that 

is easily understood by data editors. 

 It is recommended that the message text includes “review required” if the edit is associated 

with a review flag. 

Severity 

Each edit is assigned a severity level of low, moderate, high, or critical.  The severity level is used 

to determine whether the data can be saved, whether a manual task is required, and to prioritize 

the edits for the user performing editing tasks. 

Record edits are assigned a high severity level if the data item is required in order to screen the 

record for reportability or special studies.  Therefore, a record edit with a high severity level will 

trigger a Resolve Record Errors task.  If a record only has fields with low or moderate edit errors, 

the fields are flagged but the record moves forward in the workflow and is screened for 

reportability.  If a record has one or more fields with high or critical edit errors, the record is sent 

to a manual Resolve Record Errors task for review prior to reportability screening. 

Edits with a critical error level must be resolved in order to save the record or patient set.   The 

critical error level is typically reserved for edits that check values to determine if they violate 

database constraints.   For example, a critical edit error would occur if an “A” were entered in a 

field that requires a numeric value.  Note:  It is technically possible to configure the edits to use 

the critical error level for other purposes.  However, it is recommended that you only assign the 

critical error level to edits that check for database constraints.   

Guidelines for setting the severity level of a registry edit: 

 You should rarely define an edit as critical.  Typically, the SEER*DMS development team will 

define a critical edit, if necessary, when a registry-specific data field is added to the 

database.  Remember that your editing staff will not be able to save their changes if the 

changes generate a critical error.  

 Record Edits: 

o Set the severity level to High if you want SEER*DMS to create a Resolve Record 

Errors task when a record fails this edit. 

o Set the severity level to High if the edit is tied to the record reviewed flag for the 

purpose of initiating follow-back.  A manual Resolve Record Errors task will provide a 

user with the opportunity to create the follow-back, set the reviewed flag, and save 

the record.  The record would then move forward in the workflow.  
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o If you want the edit to flag fields as having a problem but do not want a Resolve 

Record Errors task created, set the severity level to either low or moderate.  Registry 

policy dictates when to use low versus moderate. 

 Patient Set Edits: 

o Registry policy dictates whether to assign a severity of low, moderate, or high to a 

patient set edit.   

o For SEER and SEER*DMS edits, the low severity level typically indicates that a review 

flag will over-ride the edit.   

o The severity levels of failing edits do not affect the workflow routing of patient sets.  

If a patient set is saved with edit failures in a Visual Edit Patient Set or Consolidate 

task it will move to a Resolve Patient Set Errors task, regardless of the severity level 

of the failing edits.   

Dependencies 

SEER*DMS uses “dependencies” to conditionally execute an edit based on the success of other 

edits.  Typically, a dependency is added to an edit to ensure that a valid value is provided for a 

required field.  For example, several SEER edits require age at diagnosis.  These edits are not 

executed if the “age_at_diagnosis” edit fails.   

There are two sets of dependencies for each edit.  An edit is not executed if any of the edits listed 

in its “Depends on” section fail.  Similarly, if the edit fails then none of the edits in the “Depended 

on by” section will be applied. 

To view examples, review the dependencies for the following SEER edits:  Age_at_diagnosis (Age 

at diagnosis is not valid), IF118 (Age, Primary Site, Histology conflict), IF13 (Age, Birth Date and 

Date of Diagnosis conflict). 

Dependencies can only be defined between edits within the same group.  For example, a registry 

edit can only depend on registry edits and cannot depend on SEER edits. 

Groovy Code 

SEER*DMS edits are implemented in Groovy, a scripting language for the Java platform. The 

Internet has several Groovy references including the Groovy home page at 

http://groovy.codehaus.org.   You do not need to be fluent in Groovy to add or modify edits.  

SEER*DMS edits use a small subset of the Groovy syntax.  A working knowledge of regular 

expressions and Groovy logic statements are all that is needed to add and modify edits in 

SEER*DMS. To define a new edit, it is recommended that you copy-and-paste the definition from 

an existing edit and use that code as a template. 

Guidelines for writing the Groovy code for a registry edit: 

 An edit error is triggered if the code returns FALSE for the record or patient set.  The edit 

passes if the code returns TRUE. 

 Use the Groovy code of a similar edit as a template.   

 If you copy-and-paste the Groovy code of a SEER, SEER*DMS, or SEER Extended edits, 

verify that an appropriate entity is available.  If your edit requires an entity that is not 

listed, submit a change request via the SEER*DMS Technical Support Squish project. 

 The Available Contexts are displayed at the bottom of the page.  Your Groovy code may 

include references to any of the Available Contexts.  Refer to the SEER*DMS Web portal for 

tutorials on using contexts in registry edits.  

http://groovy.codehaus.org/
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Contexts 

A context is a Java naming system.  In SEER*DMS, contexts are used to define arrays, hash tables, 

and functions used by the edits.  For example, there are a large number of contexts defined for the 

SEER*Edits.  Primarily, these represent data tables required by the SEER Edits logic. 

Registry staff may not add or modify contexts in the current version of SEER*DMS. 

Documentation 

An edit’s documentation is descriptive text that is more comprehensive than the edit message.  If 

available, the edit documentation is displayed in the edit popup shown in the patient set and record 

editor.  Edit documentation is also displayed in the detailed edit report (RPT-064D). 

Documentation from the SEER*Edits software is displayed in SEER*DMS for the SEER Edits.  

Registry staff are responsible for writing and maintaining documentation for the registry edits.   

Defining and Maintaining Registry Edits 

Requires system permission:  system_administration 

 

The instructions below provide an overview of the steps required to add, delete, or modify an edit.  

Refer to the Understanding Edits in SEER*DMS section of this chapter for specific guidelines when 

selecting values for each component of the edit. 

 

To define a new registry edit: 

1. Select System > Edits.   

2. Click Add Edit.    

3. Set all components shown on the General tab (specific guidelines are provided in 

Understanding Edits in SEER*DMS). 

a. Enter the Edit ID. 

b. Select one item listed in the Entities drop-down list. 

c. Click the Severity level that you wish to assign to this edit.  Highlighting is used to 

identify the current selection.  In the example below, the Severity level is Moderate. 

    

d. Enter the Message text. 

e. An edit is not executed if any edit listed in the Depends on section fails.  To add an 

edit to the Depends On section: 

i. Click add dependency 

ii. Use the filter to search for the edit.  Dependencies can only be defined between 

edits within the same group.  Therefore, only registry edits will be listed. 

iii. Click the Edit ID.   

4. On the Definition tab, enter Groovy source code to define the logic of the edit.  The 

Definition tab also includes a list of the Available Contexts.  These Contexts are defined by 

the SEER*DMS development team, as needed.  Your Groovy code may include references 

to any of the Available Contexts.  Contexts are organized by the edit groups.  A Context is 



Edit Errors  6/19/2008 7-9 

directly available to edits within the Context’s group.  However, edits in other groups may 

reference Contexts in other groups.  Refer to the SEER*DMS Web portal for tutorials on 

using SEER edit contexts in registry edits.    

5. On the Documentation tab, enter detailed documentation related to the new edit.   

To delete a registry edit: 

1. Select System > Edits.   

2. Use the filters to find the edit as described in the Using the Edit Manager section of this 

chapter.  To search for registry-defined edits, set the Group filter to your registry’s name.  

(SEER, SEER Extended, SEER*DMS, and SEER*DMS Registry edits cannot be deleted.) 

3. Click the edit’s ID.   

4. Review the list of edits that depend on this edit (listed under the Depended on By 

heading).   Determine whether this edit must be retained in order for those edits to 

function properly; or if the listed edits require modifications due to this edit being deleted. 

5. If you determined that the edit can be deleted, delete edit.  (This link is shown in the 

upper right corner of the screen for Registry Edits.  It is not displayed for SEER, SEER 

Extended, SEER*DMS, or SEER*DMS Registry edits). 

 
 

To modify a registry edit: 

1. Select System > Edits.   

2. Use the filters to find the edit as described in the Using the Edit Manager section of this 

chapter.  To search for registry-defined edits, set the Group filter to your registry’s name.  

(SEER, SEER Extended, SEER*DMS, and SEER*DMS Registry edits cannot be modified.) 

3. Click the edit’s ID.   

4. Set all components shown on the General tab (refer to Understanding Edits in SEER*DMS 

for more specific guidelines). 

a. To modify the Edit ID, click change ID. 

b. Select one item listed in the Entities drop-down list. 

c. Click the Severity level that you wish to assign to this edit.  Highlighting is used to 

identify the current selection.  In the example below, the Severity level is Moderate. 
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d. If you will be modifying the edit logic, update the Message text to reflect the changes. 

e. An edit is not executed if edits listed in the Depends on section fail.   

i. To add an edit to the Depends On section, click add dependency. Use the filter 

to search for the edit.  Dependencies can only be defined between edits within the 

same group.  Therefore, only registry edits will be listed.  Click the Edit ID.   

ii. To delete an edit from the Depends on section, click the remove link associated 

with the edit.  The remove link is shown in the right-most column of the table. 

f. Edits listed in the Depended on by section will not execute if the edit being modified 

fails.   This section is shown for your information, but cannot be changed on this screen.  

The edits listed in this section depend on the edit that you are currently modifying.  You 

must consider how your modifications will impact these edits.  

5. On the Definition tab, modify the Groovy source code as needed.  The Definition tab also 

includes a list of the Available Contexts.  These Contexts are defined by the SEER*DMS 

development team, as needed.  Your Groovy code may include references to any of the 

Available Contexts.  Contexts are organized by the edit groups.  A Context is directly 

available to edits within the Context’s group.  However, edits in other groups may 

reference Contexts in other groups.  Refer to the SEER*DMS Web portal for tutorials on 

using SEER edit contexts in registry edits.    

6. On the Documentation tab, modify the detailed documentation to reflect the changes 

that you made to the logic.   

7. Click Save. 

8. Enter a comment describing your changes.  These comments will be displayed in the edit’s 

History table that is displayed wherever edit information is shown.   

System Task to Execute Edits in Patient Sets 

All edits are executed each time a patient set is opened, validated, or saved in the SEER*DMS 

editor.  The Patient Set Edits system task enables you to re-execute the edits on patient sets in the 

database.  You may run the edits on all patient sets or on a cohort defined by year of diagnosis.  

Use the Patient Set Edits task to ensure that new or modified edits are evaluated.  

A polisher is a system utility that derives, calculates, or assigns data field values.  For example, 

polishers are used to derive collaborative stage variables; assign census tract based on address; 

and calculate the age at diagnosis based on date of birth and date of diagnosis.  When a patient set 

is opened, saved, or validated, a polisher will be executed if the value of a related data item 

changes.  Occasionally, you may need to execute a polisher on a large number of patient sets.  The 

Patient Set Edits task enables you to run selected polishers as well as the edits. 

Polishers are assigned to “classes”.  Classes are simply categories used in SEER*DMS to define 

when the polishers are executed during various system processes.  A polisher may belong to 

multiple classes.  The Polishers help page lists the polishers and the classes to which they belong. 

The Patient Set Edits task has an option to execute the Edit Polishers.  Edit polishers are polishers 

in the “Pre-Edits” and “Post-Edits” classes (the polishers in these classes are listed on the screen 

when you open the Patient Set Edits system task).  These are polishers that need to be run with 

the Patient Set Edits task during the initial migration of data to SEER*DMS.  The edit polishers 

rarely need to be run as a group after deployment. 
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A polisher may need to be executed with the Patient Set Edits task when a new version of 

SEER*DMS is released that includes a change to that polisher.  The Patient Set Edits task allows 

you to select one to three “extra” polishers.  All of the standard polishers (polishers in the 

“Validation” class) can be executed with the Patient Set Edits task.   

To re-execute the edits for some or all patient sets in the database: 

1. Click System > Tasks. 

2. Click the Patient Set Edits link. 

3. To limit the edits to data by year of diagnosis, enter the Start Year.  Patient sets with a 

diagnosis date during or after this year will be considered. 

4. If you would like to define an end range, enter an End Year.  If the end date is not 

specified, today’s date will be used by default. 

5. To include data with unknown year of diagnosis, set Include Unknown Year to Yes. 

6. If you wish to execute all polishers in the Pre-Edit and Post-Edit classes, set Edit 

Polishers to Yes.  It is recommended that this option be set to No unless there is a 

specific need related to the transitioning of data into SEER*DMS. 

7. You may execute one to three individual polishers with the Patient Set Edits using the 

Extra Polisher drop-down menus.   These are polishers in the Validation class (as listed 

on the Polishers help page). 

8. You may enter text related to this task in the Comment field.  The comment for the last 

execution of the task is stored in the database (utility_history table). 

9. Click Start. 

The edits will be re-evaluated for each patient set in the cohort.  In order to avoid creating an 

inordinate number of worklist tasks, a Resolve Patient Set Errors task will not be created for each 

patient set with an edit error.  If the logic of a new or modified edit is implemented incorrectly, it 

could erroneously create an edit error for a large number of patient sets.   Therefore, you must use 

reports rather than tasks to identify the patient sets with errors and to evaluate the error levels in 

the patient set data.  Two system reports, RPT-064A and RPT-064B, are available for identifying 

the edit errors that were triggered and the patient sets that are involved:    

Reports Related to Edits 

Select View > Reports to access the system reports provided with SEER*DMS. The reports listed 

below are the edit reports available in SEER*DMS when this manual was printed.  

 

Report ID Title Description 

RPT-064A Frequency of Edit Errors in 

Patient Set Data 

Use this report to evaluate the error levels in the 

patient data.  Set the parameters to generate 

frequencies of errors in all patient sets when 

verifying modifications that you made to edits or 

when you run the Patient Set Edits system task. 

RPT-064B Patient Sets with Edit Errors A listing of Patient Sets with a failure related to a 

particular edit or a sample for all failing edits.   

RPT-064C SEER*DMS Edits ID, Message, Severity, and Group of all edits 

available in SEER*DMS. 

RPT-064D Detailed Listing of SEER*DMS 

Edits 

Lists all components of edits, including the Groovy 

code, entities, history, and documentation. 
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Color Codes Used in SEER*DMS Editors 

The SEER*DMS record and patient set editors display data fields in different colors to highlight 

fields that contain errors, and fields that have been modified but not validated or saved.  Although 

you can readily see the fields that require attention on data pages, it is recommended that you 

review the list of errors and related data fields on the Edit Errors page prior to making changes to a 

record or patient set.  Refer to the chapter related to your specific task for further instructions. 

 

If two or more edits are related to a field, the edit with the highest severity level will determine the 

color. 

 

 

 

 
White indicates that the field does not have an error and has not been 

changed since the last save. 

 
Dark red with white text indicates that the field triggered a Critical Error.  

The value can not be stored in the system due to database constraints.  Critical 

Errors will only be seen in patient sets, since database constraints are not 

applicable to record data. 

 
Medium red with black text indicates that the field triggered an error with a 

High severity level.  In patient set data, the value may not be valid for this 

field or an inter-field edit may have detected a conflict with other fields.  In 

record data fields, this indicates that an error was detected that must be 

resolved prior to screening. The record will not move past the Resolve Record 

Errors task until all errors with a severity level of high are resolved. 

 
Light red indicates that the field has an error with a Low or Moderate 

severity level.  The value may not be valid for this field or an inter-field edit 

may have detected a conflict with other fields.  Low and moderate errors should 

not be resolved when editing records, these editing tasks should be performed 

when consolidating the patient data. 

 
Orange indicates that a field with an error was modified, but the change has 

not been validated against the SEER and local edits.  Fields are validated when 

the record is saved or the Validate button is clicked.  Once validated, this field 

will turn to yellow if the error was corrected or to a shade of red if the field still 

contains an error. 

 
Yellow indicates that the field that did not have an error and was changed.  

The patient set or record has not been saved since the change was made.  

Once validated, this field will turn to a shade of red if there is an error. 

 
Blue with a black border indicates that the field was changed by a Polisher.   

 
Blue with no border indicates that the field is read-only and was changed by 

a Polisher. Note:  Some fields are modified when another field is changed. 

 Read-only fields that have not been changed are shown in a lighter shade (the 

color is determined by the color scheme that you are using).  
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Chapter 8:  Resolving Record Errors 

When a record enters the workflow, an automated task checks the record for errors based on SEER 

and local edits.   When the edits are configured in the system, a severity level is assigned to each 

edit (see Chapter 7:  Edit Errors).   The severity levels for the local edits are registry-defined; 

however, certain guidelines should be followed.  “Critical” should be assigned to edit errors that 

must be resolved in order for the system to store the data, that is, errors that indicate a violation 

of database constraints.  Since records are stored in a text format, these constraints only apply to 

patient set data.  For this reason, you should not encounter critical errors in record data fields.   

“High” should be assigned to edit errors that must be resolved prior to screening the record for 

reportability.  These would include errors related to data fields that are required to determine 

reportability; and errors that, according to registry policy, must be resolved as quickly as possible.    

For example, errors related to data fields required for rapid case ascertainment initiatives should be 

given a severity level of high. 

A record with a high or critical error is forwarded to a Resolve Record Errors task for review.  

Although this task provides full editing functionality, you should limit your attention to errors with 

high or critical severity levels.  The purpose of this task is to move the record forward in the 

workflow through the screening and matching processes.  Other editing tasks should be performed 

when the data are consolidated into a patient set (see Chapter 14:  Resolving Patient Set Errors). 

In this chapter, you’ll learn about 

 Opening a Resolve Record Errors Task 

 Understanding the Record Editor  

 Correcting Errors in a Record 

 Editing a Data Field 

 Saving Changes to a Record 

 Undoing Changes 

 Rerouting a Resolve Record Errors Task 

 Requesting Follow-back Information 

Opening a Resolve Record Errors Task 

Requires system permission:  rec_edit 

Resolve Record Errors tasks enable you to resolve edits that must be resolved at an early stage in 

the workflow, prior to screening.  This involves resolving edits with a high or critical severity level. 

To open a Resolve Record Errors task: 

1. Click a Resolve Record Errors link in the worklist summary on the home page.  To open 

a task assigned to you, click the link listed in My Tasks.  To open an unassigned task, 

click the link listed in the Unassigned Tasks.  

2. To search for the task in your tasks and unassigned tasks:   

a. Enter your user name in the User(s) filter. 

b. Check the Show Unassigned box. 

3. To search by other criteria, enter values into the filter controls (see Chapter 4:  Using the 

Worklist for more information).  If you made changes to the filter settings, click Apply. 

4. Click the task ID to open the Resolve Record Errors task. 



8-2 6/19/2008  SEER*DMS User Manual  

Understanding the Record Editor 

When you open a Resolve Record Errors task, the record will be displayed in an editor similar to the 

one shown below.  The format of the data pages and fields vary by record type and registry. 

 

Record Navigation Box 

You can use the links in the navigation box to: 

 View each page of record data.  The number of pages varies by record type.  

 Review the records’s Audit Log (AL).  Each change made to a record data field is 

documented in the audit log.  The information in the audit log includes the user or process 

which modified the data, comments related to the change, the date and time of 

modification, and the original and modified value of each data field that was changed.  For 

more information about audit logs, please refer to Chapter 2:  Records and Patient Sets. 

 Submit a request to the reporting facility for Follow-back (FB) information related to the 

record data.  Please refer to the Requesting Follow-back Information section of this chapter.  

 View, add, or delete Image Files (IMG) containing data related to the record.  These 

images may contain the original data submitted to the registry. 

 Review the status and outcome of each Abstract Facility Lead (AFL) associated with the 

record.  Refer to Chapter 21:  Managing Abstracting Assignments for more information. 

 View and/or resolve the Edits triggered by data fields in the record, as described in the 

Correcting Errors in a Record section of this chapter. 

 View any Special Studies to which this record is assigned.  Add or remove the record from a 

special study.   Refer to Chapter 28:  Special Studies for more information. 
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Record Menu 

In the navigation box, the arrow  next to the record type provides access to the record menu.  

Click the arrow to open the menu, as shown below. 

 

 

The record menu allows you to: 

 Add Follow-back – Submit a request to the reporting facility for more information related 

to the record (see the Requesting Follow-back Information section of this chapter). 

 Print – Create a printable version of the record data in a PDF file.  

 Undo Changes – Reload the last version of the record that was saved; this “un-does” or 

reverses changes that you have made but have not saved (see the Undoing Changes section 

of this chapter). 

 Reportability – View the reportability status.  The reportability status will always be 

unknown during a Resolve Record Errors task; it will be screened for reportability in a 

subsequent step in the workflow (see Chapter 9:  Screening for Reportability). 

 Delete – Delete the record from the database.  This is a true and permanent delete; the 

record is physically removed from the database.  This menu item is only active if your 

account has the system_administration permission; and the menu item is disabled if the 

record is linked to a patient set or is involved in a worklist task.  To delete a record in a 

Resolve Record Errors task, you must first terminate the task. 

Info Box 

The Info Box is shown whenever an unlinked record is displayed in the editor.  The following items 

are included: 

 Import ID – A unique identifier associated with records imported in the same set of files or 

entered in the same data entry session.  Click the Information Icon   next to the ID for 

details including the name of the file containing the original source data for this record (if 

multiple files were included in the import, this record’s file will be shown in bold).   

 File Type – If this file was loaded from a file, the file type will be displayed.   N/A indicates 

that the record was either entered in a data entry session or migrated into SEER*DMS when 

the system was first deployed.   Click the Information Icon   to determine the Media Type 

(Files, Migrated Data, or Data Entry).    

 Source – The ID of the record’s source or reporting facility.  For some record types, this 

field is the facility specified when the file was imported and cannot be changed.  For other 

record types, the facility is an editable field on the record (Rpt Hosp). 

 Reportability – The reportability value set during a manual or automatic screening task.  

Records are not screened for eligibility until severe and critical errors are resolved, therefore 

this value will always be unknown in Resolve Record Errors tasks.  

 Patient ID – The ID of the consolidated Patient Set.  Since the record has not yet been 

linked to a Patient Set, “unlinked” will be shown in this field during Resolve Record Errors 

tasks.   
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 Date Added – Time stamp indicating the time that this record was loaded into SEER*DMS.  

This field shows the date and time of the import, data entry session, or migration. 

 Date Last Modified – Time stamp indicating the last time this record was saved by a user 

or modified by an automatic system task. 

Text Viewer 

Click View Text to open a popup window that displays all the text fields in the record.  The Text 

Viewer provides a convenient method for viewing all the text fields at once, and enables you to 

view a data page and the supporting text fields at the same time.  You may need to resize your 

browser window to edit a field on a data page while displaying the Text Viewer. 

Data Header 

The Data Header contains a read-only display of patient and tumor fields which may assist in 

correcting severe or critical errors.  If an edit is required in one of these fields, click the link for the 

appropriate data page and edit the field in the Body of that page.  The header is only shown when 

multiple pages are used to display the record and you are not viewing the first page. 

Body 

The body of the record editor displays the content for the currently selected page.  The layout of 

the fields in the body of the page varies by record type.  The NAACCR record type is consistent in 

all registry configurations, other record types vary.   A variety of controls are used on the data 

pages to edit specific fields; the process is described in Correcting Errors in a Record. 

Save, Validate, Cancel 

The Save, Validate, and Cancel buttons enable you to: 

 Save – Save intermittent changes or to save changes when exiting.  The Review Changes 

page will be displayed.  Your changes will not be saved in the database until you review and 

confirm the modified data fields.  For specific instructions, please refer to the Saving 

Changes to a Record section of this chapter.  

 Validate – Execute polishers and the SEER and registry-defined edits.  The edits are 

executed when you first open the record in the editor.  After making changes to data fields, 

click Validate to see if your changes have resolved errors or generated additional errors. 

 Cancel – Exit the editor without saving any unsaved changes.  Changes that you saved 

during the editing session will be retained.  

In order to reduce the need to scroll, the Save, Validate, and Cancel buttons are displayed in two 

places in the record editor.  The buttons are available at the bottom of each data page and above 

the navigation box on the left side of the editor.  Although the buttons are displayed as part of 

each data page, they affect all pages.  When you click Save or Validate, the data on all pages will 

be saved or validated.  Click Cancel to exit the editor without saving changes made on any page. 

Correcting Errors in a Record 

Requires system permission:  rec_edit 

The purpose of a Resolve Record Errors task is to resolve edits that prevent the record from 

moving through the screening process in the workflow.  Edit errors with a severity level of critical 

and high must be resolved prior to screening the record for reportability.  Edit errors of lesser 

severity may also be indicated.  You are encouraged to only correct the critical and high errors.  All 

other editing tasks should be performed when the data are consolidated into a patient set.  In 

general, the majority of changes should be made to patient set data fields and as few changes as 

possible should be made to data fields in the source records. 
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Review each error prior to making changes to a data field.  To evaluate and correct the problem, 

you must determine if a single field is causing the error or if an inter-field edit has identified a 

conflict between multiple fields.   

To review and correct the errors in a record: 

1. Follow the instructions in the Opening a Resolve Record Errors Task section of this chapter.   

2. Click the Edits link in the record navigation box. 

3. Review and resolve all edits that fail.  A Resolve Record Errors task will only involve edits 

that prevent the record from moving forward in the workflow and edits designated by 

registry management as requiring immediate attention.  Edits with a severity level of 

critical or high must be resolved in order to move the record forward in the workflow.  The 

following symbols are displayed next to the error in the S (Severity) column: 

 Critical – exclamation point is used to alert you to critical errors 

 High – directional symbols indicate the relative severity level of the other levels, the 

up arrow is used for a high severity level 

 Moderate – flat indicates a moderate severity level 

 Low – a down arrow indicates a low severity level 

Tip:  If you hold your mouse over any symbol in SEER*DMS, the symbol’s meaning will be 
displayed. 

4. Review the following data listed for each error: 

a. Rule Set – SEER, SEER Extended, and registry-defined sets of edit rules are 

implemented in SEER*DMS.  In addition, SEER*DMS applies system edits (SEER*DMS 

and SEER*DMS Registry rule sets in SEER*DMS) which enforce database constraints.  

SEER Extended are edits developed and implemented by the SEER Program but not 

incorporated in the standard SEER Edits.  The extended edits may include fields that are 

not required to be transmitted to SEER.  

b. Error ID – Edit name or identifier. 

c. Error Message – A brief description of the edit error. 

d. Action – This column contains an Info link that enables you to view documentation for 

the edit.  The documentation includes the edit logic, data fields, and revision history. 

5. The Page column provides a link to a data page containing at least one of the data fields 

causing the error.  Click the link in the Page column to find and edit the fields.   All fields 

validated by an edit may not be shown on the same page, use the links in the Record 

Navigation box to go to other data pages.   

6. Review the fields with an error severity level of high or critical.  As described in Chapter 7:  

Edit Errors, these errors will be highlighted in dark red.  Hold your mouse over the field’s 

value to view a listing of the edit errors associated with the field.   If additional information 

is required as you make your determination: 

a. Use the View Text link to open a popup window displaying the supporting text. 
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b. If the original data was provided in image files, use the Img link to confirm codes and 

review the text provided in the image.   

c. Use the links in the Record Navigation Box to review fields on other data pages. 

7. If you are able to resolve the error: 

a. Depending on the field, you may either enter a value directly into the data field or use a 

lookup control to select the value.  See Editing a Data Field for a more detailed 

description of methods for modifying fields in the record editor. 

b. The color of the edited field will change when you move to another field (see Chapter 7:  

Edit Errors for a description of the color codes used in the editor).   

c. Click Validate to run the edits and to determine if your change has corrected the error.  

If the color of the field still indicates an error, hold your mouse over the field to review 

the error message. 

8. If you are unable to resolve the error, follow the standard operating procedures defined by 

your registry’s management. For example: 

a. For some edits, like edits related to physicians, the proper course of action may be to 

add a follow-back need about the data item and set the record’s review flag to 

Reviewed (the review flag is usually on the top of the first page in the editor).  Confer 

with your manager to determine your registry’s policy related to setting the review flag. 

b. If information from the reporting facility is required to resolve an error, follow the 

instructions provided in the Requesting Follow-back Information in this chapter. 

c. If you encounter a problem that you can not resolve, follow the instructions provided in 

Rerouting a Resolve Record Errors Task. 

9. If you have made a number of changes, you should save your work periodically.  You must 

save your changes when completing a task.  When you are ready to save your changes to 

the record, follow the instructions in Saving Changes to a Record.   

Editing a Data Field 

Requires system permission:  rec_edit 

The keyboard functions that can be used to modify fields in the editor are listed below.  Once you 

modify a field, it will be highlighted based on the color code described in Chapter 7:  Edit Errors.  

Use your mouse to go directly to a field or use the following keystrokes: 

Tab Go to the next field 

Shift + Tab Go to the previous field 

 

To edit a data field, type the value into the text box or use these controls: 

Click  Open a lookup table to select a value from the field’s valid values.  

You may also define new values for some lookups (e.g., physicians).   

Ctrl + C Copy to clipboard 

Ctrl + V Paste from clipboard to cursor location 

Ctrl + X Cut – deletes highlighted text and copies it to the clipboard 

Ctrl + A Select all text (highlight without using the mouse) 

Home and End Go to beginning or end of current field 
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Saving Changes to a Record 

Requires system permission:  rec_edit 

Two primary steps are required to save changes in the SEER*DMS editor.  Clicking the Save button 

on the data pages or in the left navigation box will open a page to Review Changes.  The changes 

are not actually saved until you review and confirm your changes.   

Review the following methods for saving changes and for exiting the task.  When saving any 

changes, you should enter any relevant comments regarding changes made during the task.  The 

comment box at the top can be used to add general comments pertaining to the task.  Comment 

fields next to the revised data elements can be used to add specificity.  The general and data field 

comments will be stored and displayed in the record’s audit log. 

To save a record and continue editing: 

1. Click Save.   

2. Enter comments to document your changes. 

3. Click the Save button at the bottom of the Review Changes page. 

If you have not resolved all errors with a severity level of high or critical, but you would like to 

complete the task at a later time: 

1. Click Save. 

2. Enter comments to document your changes. 

3. Click Save & Exit.  The Resolve Records Task will remain in your worklist. 

If you have resolved all errors with a severity level of high or critical: 

1. Click Save.   

2. Enter comments to document your changes. 

3. Typically, you should check the Forward to next workflow task on Save & Exit box 

and allow the record to proceed to screening.  In a Resolve Record Errors task, this should 

only be unchecked when you are waiting for follow-back information that you would like to 

obtain prior to screening the record.  

4. Click Save & Exit. 

Undoing Changes 

Requires system permission:  rec_edit 

You may use the Undo Changes menu item to undo all unsaved changes, that is, to reload the data 

from the database.  Any changes that you made and saved will not be reversed.  However, all 

changes are documented in the Audit Log.  If you need to reverse a saved change, manually edit 

the field and enter the original value as noted in the Audit Log. 

To undo changes: 

1. Click the  menu indicator next to the record type. The record menu will be displayed. 

2. Select Undo Changes.   



8-8 6/19/2008  SEER*DMS User Manual  

3. Click OK to confirm. 

Rerouting a Resolve Record Errors Task 

Requires system permission:  rec_edit and worklist_task_reassignment 

If you are unable to resolve the errors with a severity level of high or critical, release the task from 

your account as dictated by the policies defined by your registry.  You may be instructed to forward 

the task to your manager or to a coworker with a particular expertise.   Or you may be instructed 

to release the task, that is, designate the task as unassigned so that other users can open the task. 

To reroute or release an open Resolve Record Errors task: 

1. To assign the selected task(s) to a user, select Task > Reroute. 

a. Set the Action to Reroute to user, and select a user name from the pull-down list. The 

list will only include users who have the system permissions required to open all of the 

selected tasks. 

b. Enter text into the Comment box.   This text will be included in the e-mail notification 

sent to the user receiving the task. 

2. To designate the task(s) as unassigned, select Task > Release. 

To use the worklist to reroute or release a Resolve Record Errors task assigned to you: 

1. Click the Resolve Record Errors link in the list of My Tasks on the home page. 

2. Use the worklist filters to search for the task, if necessary.  Enter search text in the 

Information filter as appropriate for your needs.  The following information is listed in 

this field for Resolve Record Errors tasks: 

a. Record Type. 

b. Patient Name. 

c. Rule IDs for edits that resulted in errors.  

3. Click Apply.   

4. Check the box next to the task to be rerouted.  Click Modify. 

a. To assign a task to another user: 

i. Set Action to Reroute to user. 

ii. Select from the to user list (only users with rec_edit permission will be listed). 

iii. Enter text into the Comment field.  This text will be included in an e-mail message 

sent to the user to whom the task is assigned. 

b. To release a task to the unassigned Worklist, set Action to Release. 

5. Click OK. 
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Requesting Follow-back Information 

Requires system permission:  rec_edit and fb_initiate 

In SEER*DMS, a request for follow-back information is referred to as a “follow-back need”.   If you 

determine that additional information must be obtained from the reporting facility, you should 

submit a follow-back need for the record.  Your request will be maintained with the record, allowing 

all users to review pending follow-back issues when reviewing the record data.  After submitting 

the follow-back need, you may continue editing or save the record in a Resolve Record Errors task 

that can be continued at a later time.   Methods for saving the record and exiting the task are 

described in the Saving Changes to a Record section of this chapter. 

You will receive an e-mail notification when a response to your request is processed and the follow-

back need is closed.  You or another staff member may update data fields based on the new 

information.  As determined by registry policy, one staff member may be responsible for processing 

all follow-back responses, or the information may be given directly to the staff members who 

entered the follow-back needs.   

SEER*DMS enables users to access patient data via two routes:  1)  the data can be modified while 

completing a worklist task, or 2) the record or patient set may be edited directly, outside the 

context of a task.  If you suspended a task pending the receipt of follow-back information, you 

must re-open and complete the task to allow the record to move forward in the workflow.  You 

must either make changes to data fields based on the new information or verify that the 

appropriate changes were made.  If you completed the task but need to update the record with the 

new information, use the Patient Lookup to search for the record.  Instructions for submitting 

follow-back requests and processing the responses are provided in Chapter 22:  Follow-back. 
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Chapter 9:  Screening for Reportability 
SEER*DMS uses a combination of automatic and manual workflow tasks to determine whether a 
record meets the eligibility criteria for SEER and local agencies.  The workflow can be configured to 
determine reportability automatically, based on registry-defined algorithms, or it can be configured 
to defer screening decisions to registrars performing manual screening tasks.  At this point in the 
workflow, records are also screened for special study eligibility (see Chapter 28:  Special Studies).  
A manual screening task is generated when the automatic screening task cannot determine 
reportability; or according to your registry’s screening algorithms, the reportability value calculated 
by the auto-screener requires review; or the record was identified as a “possible” match for a 
special study. 

Use the worklist to reassign, track, and review open screening tasks according to your needs.  For 
example, you may want to release or reroute tasks assigned to a user who is on leave.  Further, a 
periodic review of the manual screening tasks could be helpful in evaluating the efficiency of your 
auto-screening configuration.  Specific instructions are provided in Chapter 4: Using the Worklist. 

In this chapter, you’ll learn about 

• Reportability Settings in SEER*DMS 

• Opening a Screening Task 

• Setting the Reportability Status 

• Determining Special Study Eligibility 

• Requesting Follow-back Information 

• Viewing a Record’s Reportability Status 

Reportability Settings in SEER*DMS 

The possible values for the reportability flag are described below.  The criteria used to define each 
value are defined in the registry’s configuration settings.  Further, “Auditable” and “Non-reportable” 
may not be used by all registries or for all record types. 

Automatic and manual screening tasks will set a record’s reportability status to one of the following 
values (some values may not be used in your registry):   

• Reportable – The record contains data related to an eligible case as defined by your 
registry’s criteria.  The record continues through the workflow, ultimately becoming part of 
a patient set in the database.  

• Auditable – The record contains cancer-related data but is not a reportable case.   The 
record is retained for use in casefinding audits.  SEER*DMS processes the record to obtain 
potential follow-up information.  If the record matches an existing patient set, the record 
should be linked at the patient level but not to a CTC.  The automatic screening task may be 
configured to forward all auditable records to manual screening for review.  

• Non-reportable - The record contains data for a disease that is of no interest to your 
registry.  It is not reportable and not to be included in audits.  For example, this may be a 
medical record that was erroneously included in a data file sent by a facility.  SEER*DMS 
processes the record to obtain potential follow-up information.  If the record matches an 
existing patient set, the record will be linked at the patient level but not to a CTC.  The 
automatic screening task may be configured to forward auditable abstract records to 
manual screening for review. 

• Unknown – The record has not yet passed through automatic screening or the reportability 
status could not be determined due to missing or invalid data.  The record is forwarded or 
maintained in a manual screening task. 
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• Not applicable – The record is not a medical record and does not require screening, for 
example, it may be a record from the department of motor vehicles or voter registration.  
This value is set in an automatic task which determines record type; records with this 
setting are not screened for reportability. 

Opening a Screening Task 

Requires system permission:  screening 

To open a screening task: 

1. Click a Screening link in the worklist summary on the home page.  To open a task assigned 
to you, click the link in My Tasks.  To open an unassigned task, click the link listed in the 
Unassigned Tasks. 

2. Typically, there is a sense of urgency associated with Screening tasks.  This is particularly 
true to facilitate rapid case ascertainment for special studies.  Enter search criteria in the 
worklist filters to find high priority tasks.   

a. If you wish to review all pending screening tasks, clear the User(s) filter and check 
Show Unassigned.   

b. To search for records that are candidates for a special study, enter “Possible special 
studies” in the Information filter. 

c. In order for the automatic screening task to calculate a value for reportability, the record 
must meet all criteria defined in the Auto-Screener rules.  For example, a valid value for 
site is required.  If the record fails any of the Auto-Screener Rules, a message describing 
the problem is written in the Information Column.  To search for tasks with a specific 
auto-screener failure, enter search text in the Information Filter.  Select Help > 
Screening to view documentation for each screening algorithm.  The Auto-Screener 
Rules are included with this documentation.  (Note:  If there is a Special Study message 
in the Information Column, the Auto-Screener message will not be displayed.) 

3. If you made changes to the filter settings, click Apply. 

4. Click the task ID to open the screening task. 

Once you open the task, the record will be displayed in a specialized version of the record editor.  
Although you can review edit errors and change data fields, it is assumed that the edit errors will 
be handled during an editing task.  For the purpose of screening, you will be reviewing data fields 
to determine reportability and special study eligibility; and using the controls on the left side of the 
page (shown below) to set the values. 
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Task type and ID are displayed in the red 
toolbar followed by a message indicating the 
results of the auto-screening task and the 
special study screener (the special study 
message is only displayed if the record is a 
possible match for at least one study). 
 
 
Click SS to define whether the record is in a 
special study. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The current Reportability status is shown 
here.  Click Modify to change this value. 

Setting the Reportability Status 

Requires system permission:  screening 

To set the reportability status for a record: 

1. Follow the instructions in the Opening a Screening Task section of this chapter.  The status 
of reportability is displayed in the Reportability box in the left navigation panel.  This value 
will be unknown if there is an auto-screener failure or if the auto-screener result (displayed 
at the top of the page) is a value that requires review according to registry policies.  

a. If the reportability status is unknown, you must review the record and set reportability.  
Proceed with step 2. 

b. If the status is a value other than unknown, the auto-screener was able to define a value 
for reportability and this screening task was generated for the sole purpose of evaluating 
the record for Special Studies (see the Determining Special Study Eligibility section of 
this chapter).   

2. Review the record to ascertain reportability: 

a. Click the links in the Record Navigation box to review fields on other data pages. 
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b. Click View Text to open a popup window showing all text fields at once.  You can then 
move the popup window so that you can view the data page and the supporting text 
fields at the same time.  Click Close to exit the Text Viewer. 

c. To review a printed copy of the record, select Print from the record menu. 

3. If you are able to ascertain reportability for this record, set the reportability status field: 

a. Click Modify in the Reportability section of the left navigation panel. 

b. Select a Reportability value from the drop-down list. 

c. If you have selected Auditable or Non-Reportable, enter text in the Reason box.  This 
documentation is useful for the purpose of casefinding audits.   

4. If the record was identified as a possible match for a special study, follow the instructions in 
the Determining Special Study Eligibility section of this chapter.   

5. Use one of the following methods to close this task: 

a. If the reportability status is set to a value other than Unknown and the screening process 
is complete, end the task and allow the record to move forward in the workflow: 

i. Click Save.   

ii. Verify that Forward to next workflow task on Save & Exit is checked.  This box 
must be checked to move the record to the next task in the workflow. 

iii. Click Save & Exit. 

b. If further information is required, submit a request for follow-back information (see the 
Requesting Follow-back Information section of this chapter). 

i. Click Save. 

ii. To keep the record in a screening task, do not check the Forward to next 
workflow task on Save & Exit box (this box will be unchecked automatically 
unless you selected a tentative value for reportability status).   

iii. Click Save & Exit. 

iv. If you require assistance, you may reroute the screening task to your manager or a 
colleague by following the instructions in Chapter 4:  Using the Worklist. 

Determining Special Study Eligibility 

Requires system permission:  study_rec_edit 

To define whether a record should be included in a special study: 

1. Follow the instructions in the Opening a Screening Task section of this chapter.   

a. If the record was identified as a “possible” match for a special study, a message will be 
displayed at the top of the page and the value next to the SS link will be greater than 
zero.  Proceed with step 2.  

b. If there is no message related to special studies, the automatic task was able to 
determine eligibility for all studies.  This screening task was generated for the sole 
purpose of setting SEER/local reportability.  Refer to the Setting the Reportability Status 
section of this chapter for further instructions. 

2. Review the record data. 
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3. If you believe the record was incorrectly flagged as a possible match for a study, delete the 
study from the record (for example, if a prostate record was identified as a possible match 
for a lung study). 

a. Click the SS link in the navigation box on the left side of the screen. 

b. Click the Delete link for the study.  You should inform registry management that the 
initial criteria for the Special Study may be incorrect.   

4. Define whether the record is eligible for the study:  

a. Click the SS link in the navigation box on the left side of the screen. 

b. Click the Edit link in the Action column for the study.   

c. Based on registry policies, set the Inclusion status to: 

i. In – The record fulfills eligibility requirements for the study. 

ii. Out - The record met initial screening criteria for the study, but upon review, it was 
determined that the record is ineligible.  For example, the physician did not give 
approval for the patient's inclusion, or the patient declined to participate.   

iii. Possible – Unable to make a definite determination of the record’s eligibility at this 
time.    

d. If you know of a study-specific ID for this record, enter the value in Participant ID. 

e. You may document your changes by adding a comment. 

f. Click Update. 

5. Refer to the Reportability box within the left navigation panel.   

a. If the reportability status is a value other than unknown, end the task and allow the 
record to move forward in the workflow. 

i. Click Save. 

ii. Verify that Forward to next workflow task on Save & Exit is checked.   

iii. Click Save & Exit. 

b. If the reportability status is unknown and you can determine and set reportability, follow 
the instructions in the Setting the Reportability Status section of this chapter. 

c. If the reportability status is unknown but you are not authorized to set reportability, save 
your changes.  You should then modify the task so that it is no longer assigned to you. 
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i. Click Save.  No changes will be listed on the Review Changes page.  Changes to 
Special Study settings are not included in the record’s audit log.   

ii. Click Save on the Review Changes page.  You will remain in the Screening task. 

iii. To assign the selected task(s) to another user, select Task > Reroute. Set the 
Action to Reroute to user, and select a user name from the pull-down list. The list 
will only include users who have the system permissions required to open all of the 
selected tasks. Enter text into the Comment box.   This text will be included in the e-
mail notification sent to the user receiving the task. 

iv. To designate the task(s) as unassigned, select Task > Release. 

Requesting Follow-back Information 

Requires system permission:  screening and fb_initiate 

In SEER*DMS, a request for follow-back information is referred to as a “follow-back need”.   If you 
determine that additional information must be obtained from the reporting facility, you should 
submit a follow-back need.  Your request will be associated with the record, allowing all users to 
review pending follow-back issues when reviewing the record data.  If the information is required 
to ascertain reportability, you should save the record in a Screening task so that the task can be 
completed at a later time.  Otherwise, you should set the reportability status and move the record 
forward in the workflow.  Methods for saving the record and exiting the task are described in the 
Setting the Reportability Status section of this chapter. 

You will receive an e-mail notification when a response to your request is processed and the follow-
back need is closed.  You or another staff member may update data fields based on the new 
information.  As determined by registry policy, one staff member may be responsible for processing 
all follow-back responses, or the information may be given directly to the staff members who 
entered the follow-back needs.   

SEER*DMS enables users to access patient data via two routes:  1)  the data can be modified while 
completing a worklist task, or 2) the record or patient set may be edited directly, outside the 
context of a task.  If you suspended a Screening task pending the receipt of follow-back 
information, you must re-open and complete the task to allow the record to move forward in the 
workflow.  You must either make changes to data fields based on the new information or verify 
that the appropriate changes were made.  If you completed the task but need to update the record 
with the new information, use the Patient Lookup to search for the record.  Instructions for 
submitting follow-back requests and processing the responses are provided in Chapter 22:  Follow-
back. 
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Viewing a Record’s Reportability Status 

If you are editing an unlinked record, the reportability status is displayed in the Info box of the 
record editor.   

 
 
 
 

 

To view the reportability status of a linked record in the 
patient set editor, hold your mouse over the Record Type.  
The Record ID and reportability status will be shown in a 
box just below type. 
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When record type is displayed in the Patient Lookup or a Match-Consolidate task, the Type field will 
include an icon indicating the record’s reportability status: 

  Non-reportable 
  Auditable 
 Unknown (the record has not yet been screened) 

 Not applicable; the record type is not screened (e.g., supplemental records) 
 

No icon is displayed if the record is reportable. 

The icons are also displayed in the Type column of search and match results tables.  If an icon is 
not displayed next to the record type, the record is reportable: 

  

 

The icons are also shown next to the Type field for the Incoming Record of a Match-Consolidate 
task.  In the first example shown below, the record is auditable. 

 
 
 
In the example below, the record is reportable (no icon is displayed): 
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Chapter 10: Matching Incoming Records to Database 

In SEER*DMS, matching is a combination of automated and manual processes which determine 

whether a set of data is for the same patient as other data in the database.  Matching algorithms 

are applied to several system functions, including:  determining whether an incoming record 

contains data for an existing patient set; implementing searches in the patient lookup; and, in 

some registry configurations, determining whether a record is an algorithmic duplicate based on 

selected data fields.    

This chapter describes the matching processes which are used to determine whether an incoming 

record contains data related to an existing patient set (linkage matches).  Please see Chapter 20:  

Searching for Records and Patients and the SEER*DMS Technical Reference for information related 

to other uses of matching algorithms. 

In this chapter, you will learn about 

 Automatic Matching 

 Manual Review of Match Results 

 Opening a Match-Consolidate Task 

 Evaluating the Possible Matches 

 Modifying the Reportability Status of the Incoming Record 

 Requesting Follow-back Information 

 Supplemental Matching Task 

Automatic Matching 

“Automatic matching” refers to the execution of the registry-specific algorithms that compare the 

patient information on an incoming record to data that were previously loaded into the database.  

Typically, several automated linkage-matching algorithms are defined for a registry.  These 

algorithms are associated with the various types of records loaded into SEER*DMS.   The matching 

algorithms can be reviewed within SEER*DMS by selecting Matching from the Help menu (see 

Chapter 29:  Registry Management and SEER*DMS).     

Records that follow the passive follow-up branch of the workflow are auto-matched using registry-

defined algorithms specific to passive follow-up.  For these records, a Supplemental Match Task is 

created if two or more patient sets are identified as “perfect” matches; or there are no perfect 

matches but at least one patient set is a possible match.  The fields and criteria used to define a 

“perfect” and “possible” match are specified by the registry management.  Some registries do not 

define “possible” matches for data used only for passive follow-up. 

For each record processed in the main branch of the workflow, an automatic matching task 

attempts to identify patient sets and unlinked records that match the incoming record (the 

incoming record is not matched against unlinked records that have not yet been screened).  For 

records that contain medical data but are not automatically used to create a patient set, a manual 

Match-Consolidate task is only created if possible matches are identified by the auto-match task.  

This enables a registrar to confirm or reject the possible matches.  If the incoming record is an 

abstract record, a manual Match-Consolidate task is always created.  The manual task is created 

regardless of the results of the automatic match to ensure that the match is refreshed prior to 

further processing of the abstract record.  

The matching algorithms are re-executed when the Match-Consolidate task is opened.  All available 

data are matched against, including data that were loaded subsequent to the initial match.  The 

refreshing of the match guarantees that all appropriate data are included in consolidation; and 

ensures that new patient sets are not created from a single record when other data are available 
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for consolidation.   This helps to reduce redundancy in worklist tasks and prevent the creation of 

duplicate patient sets.    

Once a record completes the automated matching process, the next workflow task is determined 

by the results of the automatic match algorithm, the record’s type, and reportability status.  The 

following table shows the typical path for a record as it leaves the auto-match task in the main 

workflow. 

Workflow Path of a Record as it Leaves the Automatic Match Task  

(Main workflow only, this does not apply to the automated Match FUP task) 

Match Results Incoming Record Next Step 

Automated match task 

identified records or patient 

sets that may match 

incoming record. 

Reportable or 

auditable records 

which are not NAACCR 

Modified or NAACCR 

Update records 

A Match-Consolidate Task is created to 

allow a manual review of the possible 

matches that were identified. 

The automated match task 

identified a single Patient 

Set that definitely matches 

the incoming modify or 

update record.  

NAACCR Modified or 

NAACCR Update 

(regardless of 

reportability status) 

Automated Consolidate FUP task is 

performed.  If consolidation problems 

are encountered, a manual Consolidate 

FUP is created to enable someone to 

review and consolidate the data. 

The automated match task 

did not identify a patient 

set that is a definite match 

but did identify unlinked 

records that may match; or 

2 or more patient sets were 

identified as possible 

matches to the modify or 

update records. 

NAACCR Modified or 

NAACCR Update 

(regardless of 

reportability status) 

A Match-Consolidate Task is created to 

allow a manual review of the possible 

matches that were identified. 

No matches were identified 

by the automatic matching 

task. 

Reportable NAACCR 

Abstract or Health 

Records; NAACCR 

Modified records 

A Match-Consolidate Task is always 

created for reportable abstract records.  

The match is refreshed when this task is 

opened.  This ensures that the incoming 

record has been matched against all 

appropriate data, including data that 

were loaded subsequent to the initial 

match. 

NAACCR Update An AFL is created 

Auditable NAACCR 

abstract or Health 

records; non-abstract 

records that are 

reportable 

Exits the workflow but is retained in the 

database and held for matching to data 

loaded in the future. 

N/A Non-reportable 

records other than 

NAACCR Modified and 

NAACCR Update 

Records that are screened in the main 

workflow and are not reportable are not 

processed in this automatic match task.  

They are diverted to the passive follow-

up branch of the workflow for matching. 
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Manual Review of Match Results 

A manual Match-Consolidate task is created when a manual review of the automatic match results 

is required, as described in the Automatic Matching section of this chapter.  During this task, the 

user either selects matching data for consolidation or specifies that there are no matches.  The 

record then moves forward in the workflow to a step that is determined by record type and 

reportability status.  The following two tables describe the path of the record as it leaves the 

Match-Consolidate task.    

 

When a user selects one or more matches and clicks Consolidate to end a Match-

Consolidate task…. 

Incoming Record Matching Record(s) Next Workflow Task 

Reportable abstract record 

(NAACCR, NAACCR 

Modified, and Health 

Records are abstract 

records) 

One or more  records of any 

type; or a patient set 

Consolidate 

Reportable non-abstract 

record  

One or more records that 

include a reportable abstract 

record; or a patient set 

Consolidate 

Auditable record of any 

type 

One or more records that 

include a reportable abstract 

record; or a patient set 

Consolidate 

Reportable non-abstract 

record 

One or more records – none 

of which are a reportable 

abstract record 

Warning that there isn’t enough 

data to create a patient set.  

Cannot be consolidated.  If there is 

no available abstract record or 

patient set, select No Matches. 

Auditable record of any 

type 

A single record that is not a 

reportable abstract record 

Non-Rpt Record Rescreening 

 

 

When a user clicks No Matches to end a Match-Consolidate Task… 

Incoming Record Next Workflow Task 

Reportable abstract 

record 

Auto-build a patient set.  In some registry configurations, a Visual 

Edit Patient Set task will be created to enable a manual review of 

the data.  In other configurations, the record will exit the workflow 

or enter a Resolve Patient Set Errors task, if appropriate. 

Auditable record of any 

type 

Exits the workflow but is held for future matching 

Reportable Casefinding 

record 

An AFL is auto-created; the Casefinding record exits the workflow 

but is held for future matching (see Chapter 21:  Managing 

Abstracting Assignments) 

Reportable Death 

Certificate record 

The record is forward to Death Clearance processes (see Chapter 

17:  Death Clearance) 

Reportable Record of any 

other type (Short Health, 

Death Notice, NAACCR 

Update) 

Exits the workflow but is held for future matching 
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Opening a Match-Consolidate Task 

Requires system permission:  match 

Open a Match-Consolidate task to review the records and patient sets that were determined to be 

“possible” matches by the automatic matching task.   

To open a Match-Consolidate task: 

1. Click a Match-Consolidate link in the worklist summary on the home page.  To resume a 

task assigned to you, click the link listed in My Tasks.  To open an unassigned task, click 

the link listed in the Unassigned Tasks.  

2. To search for the task in your tasks and unassigned tasks: 

a. Enter your user name in the User(s) filter. 

b. Check the Show Unassigned box. 

3. To search for a specific task, enter search criteria in the Worklist filters.  Common filters to 

use when searching for a Match-Consolidate task are: 

a. Task ID(s) – the complete task ID must be entered.  

b. Information – enter full or partial search text related to fields in the Information 

column.  In Match-Consolidate tasks, this includes record type, patient name and text 

indicating the results of the automatic match task as described below.  

i. No Matches – The auto-match did not find any Patient Sets or Records matching 

the incoming record.  

ii. X Perfect – The auto-match calculated a perfect match score of 1000 for X Patient 

Sets and/or Records. 

iii. X Possible - The number of Patient Sets and/or Records that produced a matching 

score greater than zero but less than 1000. 

c. Tip:  To find Match-Consolidate tasks for patients whose names start with an M, try 

entering “; M” into the Information filter.  You must include the quotes in your search 

text.    

d. The following filters refer to data items in the incoming record: 

i. Data Type – select a Record Type from the drop-down list.   This only refers to the 

focus record’s type and not the type of records that are possible matches.  

ii. Record ID(s) – a full or partial ID may be entered.  

iii. Facility – a full or partial ID may be entered.  Use the  lookup to select an ID. 

iv. DX Year(s) – Year of diagnosis.  Use a hyphen to select a range of years (e.g., 

2002-2004).  Use a comma to select separate years (e.g., 2002, 2004). 

4. If you made changes to the filter settings, click Apply. 

5. Click the task ID to open a Match-Consolidate task.  Refer to the Evaluating the Possible 

Matches section of this chapter for further instructions.   
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Evaluating the Possible Matches 

When you open a Match-Consolidate Task, a brief summary of the incoming record and the results 

of the automatic matching task match will be displayed as shown below.  

 

Possible Matches 

Patient sets and unlinked records identified by the automatic task as possible matches will be 

displayed at the bottom of the page.  Data fields that match the incoming record are displayed in 

bold font.  By default, the matches are sorted to show the most likely matches first.  The score 

serves solely as a ranking mechanism and is based on registry-specific weighting schemes.  The 

score is based on weighted rules which either consider a single data field or a combination of fields.  

Click the value listed for a match’s score to view the criteria used to calculate the value.  

 

Matching Algorithm 

The matching algorithm may involve fields that are not displayed such as maiden name and alias.   

If the score is high but fields are not shown in bold, you may review additional data fields by 

clicking the record or patient set IDs.  To review a description of the matching algorithm, click the 

name of the algorithm shown below the matches.  In the example above, you would click Record 

Linkage to view the matching algorithm that was used. 

The primary fields used in the automatic matching task are displayed in the list of possible 

matches; these include name, social security number (SSN), date of birth (DOB), sex, race, vital 

status (VS), and date of last contact (DOLC). 

“Patient set” or the record type of the possible match is shown in the Type column.  If the record is 

reportable, no symbol is displayed next to the record type.  An  next to record type indicates 

that the record is non-reportable.  An  indicates that the record has a reportability status of 

auditable.  An  indicates “not applicable”, that is, the record type does not require screening 

(e.g., supplemental records are not screened for reportability).   
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To complete a Match-Consolidate task: 

1. When the Match-Consolidate task is opened, the automatic match is refreshed so that the 

record is matched against the most recent data.   

2. If the automatic matching task identified possible matches: 

a. Compare the incoming record to the possible matches.  Keep in mind that the list may 

include false positives as a result of missing data fields and the limitations of 

computerized matching techniques. 

b. You may review additional data fields on the incoming record and on records and 

patient sets that are listed in the possible matches.  Click the Information Icon  next 

to the record’s or patient set’s ID to see values of key fields.  To browse all pages of the 

record or patient set, click the record’s or patient set’s ID.  This is only available to 

users with system permissions enabling read and/or write access to the matching data 

(rec_read_only, pat_read_only, etc).  Each system permission is described in Chapter 

26:  Managing System Roles.  

c. If data fields required to determine a match are missing or incomplete, click Follow-

back to submit a request for additional information from the reporting source.  (Refer to 

the Requesting Follow-back Information section of this chapter for further instructions.) 

d. If necessary, you may edit data fields in the incoming record or in records or patient 

sets listed in the possible matches.  If you make any changes to data involved in this 

task, click Refresh to refresh the screen and match. 

3. If the automatic matching task does not identify any possible matches, or if you conclude 

that the incoming record does not match any of the patient sets or unlinked records in the 

list of possible matches, click No Matches.  SEER*DMS will close the Match-Consolidate 

task and the record will continue to the next task in the workflow, as appropriate for the 

record type.  If the record is an abstract record, a new patient set will ultimately be 

created.  Other types of records will be processed via casefinding, death clearance, or 

follow-up processes. 

4. If you conclude that one or more items in the list of Matches contain data for the same 

patient as the incoming record: 

a. Check the box next to the ID of each data item that matches the incoming record. 

b. Click Consolidate.  The next step will vary depending on the data involved: 

i. A reportable abstract or a patient set is required for consolidation.  If the incoming 

and matching data include at least one reportable abstract record or patient set, a 

manual Consolidate task will be created in the workflow.  If you have the 

consolidate system permission, the Consolidate task will open automatically (see 

Chapter 12:  Consolidating Data for instructions).  If you do not have the 

consolidate permission, an unassigned task will be created in the worklist.  

ii. If the incoming record was not a reportable record and it matched to one or more 

records that could not be used to build a patient set, a manual Non-Rpt 

Rescreening task will be created.  This task allows for the manual review of two 

non-reportable records that match each other but do not match any reportable 

records or patient set data.  Verify the match and combine the data if appropriate.  

Refer to Chapter 15:  Re-screening of Non-reportable Records for instructions. 

iii. The data can be consolidated if the record is being consolidated into an existing 

patient set or there are sufficient data to create a new patient set.  If a patient set 
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or reportable abstract are not available, the following message will be displayed at 

the top of the page:  “Cannot create Consolidate task: A reportable abstract or 

patient set is required to consolidate these data at this time. Click No Matches to 

end the task; the records will remain in the database for future matching.”   Click 

No Matches.  The incoming record will be retained in the database.  A new patient 

set will be created when a reportable abstract record is loaded. 

Modifying the Reportability Status of the Incoming Record 

Requires system permission:  match and rec_edit 

If you determine that the incoming record of a Match-Consolidate task is incorrectly designated as 

reportable, you may manually modify the record’s reportability status.  Typically, a record’s 

reportability status is set by an automatic screening task using a registry-defined algorithm.   The 

reportability status may have been set by a SEER*DMS user in a manual screening task.   The 

manual screening task is generated for any record that, according to your registry’s policies, must 

be reviewed in order to ascertain reportability.  If you determine that a record’s reportability status 

was set incorrectly, you should notify a registry manager.  The registry-defined screening algorithm 

may need to be modified, or new manual screening procedures may need to be employed. 

To modify the reportability status of the incoming record for a Match-Consolidate task: 

1. Click the ID in the Incoming Record section to open the record editor.   

2. In the navigation box on the left side of the editor, hold your mouse near the arrow  next 

to the record type.  The record menu will be displayed.  Select Reportability. 

3. Select a Reportability value from the drop-down list. 

4. If you have selected Auditable or Non-Reportable, enter text in the Reason field.  This 

documentation is useful for the purpose of casefinding audits.   

5. Save your changes. 

a. Click Save. 

b. Enter comments to document your changes. 

c. Click Save & Exit.   You will be returned to the Match-Consolidate task. 

d. Click Refresh to refresh the screen and match.  The icon displayed next to the record’s 

type will indicate the new value for reportability status (no icon is shown if the record is 

reportable). 

6. Complete the Match-Consolidate task as described in the Evaluating Possible Matches 

section of this chapter. 

Requesting Follow-back Information 

Requires system permission:  match and fb_initiate 

In SEER*DMS, a request for follow-back information is referred to as a “follow-back need”.   If you 

determine that additional information must be obtained from the reporting facility, you should 

submit a follow-back need.  Your request will be maintained with the data record, allowing all users 

to review pending follow-back requests when reviewing the record data.  If you cannot complete 

the Match-Consolidate task until you receive the information, you may close the Match-Consolidate 

task and complete it at a later time. 
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You will receive e-mail notification when a response to your request is processed and the follow-

back need is closed.  You or another staff member may update data fields based on the new 

information.  As determined by registry policy, one staff member may be responsible for processing 

all follow-back responses, or the information may be given directly to the staff members who 

entered the follow-back needs.   

SEER*DMS enables users to access patient data via two routes:  1)  the data can be modified while 

completing a worklist task, or 2) the record or patient set may be edited directly, outside the 

context of a task.  If you suspended a Match-Consolidate task pending the receipt of follow-back 

information, you must re-open and complete that task to allow the record to move forward in the 

worklist.  You must either make changes to data fields based on the new information or verify that 

the appropriate changes were made.   Specific instructions for submitting follow-back requests and 

processing the responses are provided in Chapter 22:  Follow-back. 

Supplemental Matching Task 

Records that follow the passive follow-up branch of the workflow are auto-matched using registry-

defined algorithms specific to passive follow-up.  For these records, a Supplemental Match Task is 

created if two or more patient sets are identified as “perfect” matches; or there are no perfect 

matches but at least one patient set is a possible match.  The fields and criteria used to define a 

“perfect” and “possible” match are specified by the registry management.  Some registries do not 

define “possible” matches for data used only for passive follow-up. 

The supplemental matching algorithms only match the incoming record against patient sets; 

unlinked records are not considered.  The Supplemental Match Task uses the same controls and 

layout as the Match-Consolidate Task.  The passive follow-up processes are described in Chapter 

16:  Follow-up.   

To summarize, the Supplemental Match Task and the Match-Consolidate Task differ in three ways: 

1. The Supplemental Match Task is part of the passive follow-up branch of the workflow.  The 

incoming record will not be used to create a new CTC or Patient Set.  It will be used to 

provide more current follow-up data.   The Match-Consolidate Task is part of the main 

branch of the workflow designed for medical records that will be used to update or build 

CTCs and Patient Sets.  Records are routed to one task or another based on record type 

and reportability status, as specified in registry-defined algorithms.  Refer to the workflow 

diagrams provided with the SEER*DMS Technical Reference for more information. 

2. In the Match-Consolidate Task, the incoming record is matched against unlinked records 

and patient sets.  The only data not considered in this match are unlinked records that 

have not yet been screened for reportability.  In the Supplemental Match Task, the 

incoming record is only matched against patient sets. 

3. The auto-match algorithms related to these tasks are defined separately.   



Chapter 11: The Patient Set Editor  
In the SEER*DMS database, a “patient set” is used to store all data pertaining to the same patient.  
These data include patient demographics, information on all reportable cancer/tumor/cases (CTC), 
associated admissions, diagnostic and treatment procedures, and follow-up information. Data 
summarized or consolidated from the source records are stored in patient set data fields.  The 
patient set also includes direct links to the source records that contributed the data. Refer to 
Chapter 2: Records and Patient Sets for more information related to patient set and record data. 

When a patient set is opened, either from a database search or as part of a workflow task, it is 
displayed in the patient set editor.  The patient set editor provides access to the consolidated 
patient set data fields and allows users to review data on the source records.  The editor enables 
users to view all information in the database associated with an individual patient, to resolve edit 
errors, and to modify data fields in response to follow-back queries.  

Although it is possible for two users to open the same patient set simultaneously, SEER*DMS 
prevents a user from overwriting changes made by another user.  If data fields are changed by the 
system or another user while you are reviewing a patient set, you will not be allowed to save 
changes to that patient set. You will be notified that the data have been changed and will be able 
to reload the patient set.  It is also possible to open a patient set that is associated with a pending 
worklist task.  When you open the patient set, SEER*DMS will display a warning message and 
provide a link to related worklist tasks. To avoid the duplication of effort, you should review the 
tasks prior to making changes.  For more information, please review the Saving the Patient Set 
section of this chapter.  

The features and tools of the patient set editor are described in this chapter.  Step-by-step 
instructions for applying these tools to specific worklist tasks are provided in: Chapter 12: 
Consolidating Data, Chapter 13:  Visual Editing, and Chapter 14:  Resolving Patient Set Errors.  

In this chapter, you’ll learn about 

• Features of the Patient Set Editor   

o Demographic Information Viewer 

o Diagnostic Information Window 

o Text Viewer 

o Show Differences  

o Viewing the Logic of Integrated Edits 

o Polishers 

• Resolving Edit Errors  

• Linking and Unlinking Records  

• Identifying and Removing Duplicate Patient Sets 

• Printing Record or Patient Set Data  

• Undoing Changes  

• Saving Changes to a Patient Set 

• Requesting Follow-back Information 
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Features of the Patient Set Editor  

When a patient set is opened in SEER*DMS, the data are displayed in an editor similar to the one 
shown below.  The patient set’s Demographics page is shown when you first open the patient set.    

 

You can use the links in the navigation box on the left to:  

• View each page of patient set data (Demographics and CTC pages.  Links to all CTC pages 
are displayed when you click CTC).  

• Review the patient set’s Audit Log (AL).  Each change made to a data field is documented 
in the audit log.  Audit log entries include the user or process which modified the data, the 
worklist task or system event in which the change was made, comments related to the 
change, the date and time of modification, and the original and modified value of each data 
field that was changed.  For a description of each event that may be listed in the audit log, 
refer to Chapter 2:  Records and Patient Sets. 

• View, add, or delete Image Files (IMG) containing data related to the patient set.  These 
images may contain the original data submitted to the registry. 

• View and/or resolve the Edits triggered by data fields in the patient set, as described in the 
Resolving Edit Errors section of this chapter. 

• Review or submit a request to the reporting facility for Follow-back (FB) information.  
Please refer to the Requesting Follow-back Information section of this chapter.  

• Review or submit an Abstract Facility Lead (AFL) to indicate that an abstract record is 
needed for the patient (see Chapter 21:  Managing Abstracting Assignments). 

• View Special Studies (SS) to which this record is assigned.  Add or remove the patient set 
from a special study (Chapter 28:  Special Studies). 

• View a history of communications initiated via Active Follow-up (AFUP) and information 
related to the most recent AFUP Need for the patient (see Chapter 16:  Follow-up) 

• View or add to the Comments (Cmt) stored in the patient set.  The comments include 
notes added by system users and messages auto-generated by SEER*DMS. 

• The source records can be accessed within the Linked section. To see the types of records 
or view record data from a specific facility, click the down arrow  adjacent to the facility 
ID.  To expand the list for all facilities, click the down arrow  adjacent to “Linked”.  You 
may then click one of the record types to access the record data. 

• In a consolidate task, the patient set navigation box will also include a separate list of 
Incoming Records to distinguish new records from records that were previously linked. 
Please refer to Chapter 12:  Consolidating Data for more information on linking records.  

The title bar includes the name of the current page (Demographics in the example above), patient 
set or record ID, and links to tools for viewing, comparing, and consolidating data. Links to the 
Demo Info, DX Info, and Text viewers are provided on the left side of the title bar; a link to the 
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Show Differences tool is on the right side of the title bar.  The Text viewer allows you to review 
the supporting text fields for each CTC.  Demo Info and DX Info enable you to compare 
demographic and diagnostic information in the patient set with data in the source records.  The 
Show Differences tool allows you to compare data fields on source records to the same fields in the 
patient set, and to copy values from record data fields to the appropriate fields in the patient set.  

A Data Header is displayed at the top of many patient set data pages, as shown below.  Data 
fields, including patient identifiers and vital status, that can be edited on the Demographics page 
are displayed in the header as a reference when viewing other data pages.  When you are working 
on a CTC data page, the data header will include the primary site, histology, date of diagnosis, and 
other fields defining the CTC.  If an edit is required in any of the fields in the data header, use the 
links in the patient set navigation box to access the relevant data page and edit the field.  

 

Demographic Information Viewer  

The Demographic Information viewer enables you to compare demographic data fields from all 
source records including records linked to the patient set and, if in a Consolidate task, incoming 
records being considered for consolidation.  This tool provides a convenient mechanism for 
verifying that all data pertain to the same patient and for evaluating data discrepancies.   If you 
are viewing the Demographics Information during a Consolidate task, the new records being 
consolidated into the Patient Set are listed in the Incoming Records section at the top. 

 

Diagnostic Information Window  

Use the Diagnostic Information window to review basic diagnostic data items for each CTC in the 
Patient Set.   By default, values for source records are hidden during ad hoc editing and Resolve 
Patient Set Errors tasks.  You may click Show Records to review values from the source records. 
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In a Consolidation task, use the Diagnostic Information window to review diagnostic data items 
from all source records associated with the patient set.  The consolidated values for each CTC are 
shown in bold, just above the record(s) that are linked to that CTC.   

 

The linkage of a record can be set or modified within the Diagnostic Information window.  If you 
are consolidating newly received record data into the patient set, you will use this tool to link the 
record to an existing CTC, auto-build a CTC from the record, or link the record at the patient level 
(see Chapter 12:  Consolidating Data for instructions).  If at a later time you determine that a 
record was linked inappropriately, you may also use the Diagnostic Information window to unlink 
the record or assign the link to another CTC or to the patient set.  If you change the linkage of a 
record, you must manually review and modify the consolidated CTC data fields (refer to the Linking 
and Unlinking section of this chapter for instructions). 

Close popup windows (DX Info or Text Viewer) before exiting the editor or opening another patient 
set.  The popup windows will not auto-close when you exit the editor; the data will not auto-update 
when you open a new patient set.  To prevent confusion, it is particularly important to close the DX 
Info and Text Viewer windows since patient identifiers are not displayed in these windows.  To 
close the DX Info window, you may either click the  in the top right corner or the Close button at 
the bottom of the viewer.    

Text Viewer  

The Text Viewer provides a convenient method for viewing text and other supporting data.   If the 
patient set has more than one CTC, select a CTC from the drop-down list.  All text fields for that 
CTC will be shown at once, in a read-only format.  The pull-down menu also enables you to select 
the source records linked to the patient set.   

 

You may display both the Text Viewer and a data page in the editor at the same time (you may 
need to resize the windows or show one on a separate monitor).  To close the Text Viewer, either 
click the  in the top right corner or the Close button at the bottom of the viewer (not pictured).   
Close the Text Viewer before exiting the editor or accessing another patient set in the editor.   
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Show Differences 

The Show Differences feature of the editor allows you to review discrepancies between each record 
and the patient set.  If an incoming record contains more current or complete information, the 
Show Differences tool enables you to update the patient set by copying the data from the record.  
The features of Show Differences are described below.  Additional instructions are provided in 
Chapter 12:  Consolidating Data. 

 

1. The Show Differences link is in the title bar of data pages that display fields from multiple 
records (Demographics and CTC). 

2. Show Differences displays values from the patient set on the left and values from a record 
on the right (as shown in the figure above).  By default, the first incoming record is shown 
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on the right.  A drop-down menu on the top right allows you to choose which record you 
wish to compare to the patient set (an abbreviation showing the type of record, the record 
ID, and the entity to which it is linked are listed in the drop-down menu).  Once you select 
a record, fields are shown if they differ and are not blank in the record data.   You may 
include fields with blank values in the records by clicking Show Empty Data.   Once shown, 
you may click Hide Empty Data to toggle the display of these fields. 

3. To assist in your review of discrepancies in the data, supporting text fields are displayed at 
the bottom of the Show Differences page.   

4. If there are no discrepancies between the non-blank data fields in the record and the 
patient set data fields, No Differences will be displayed in the top section of the page. 

5. Records and patient sets do not have the same set of data fields.  To allow you to compare 
record data to patient set data, SEER*DMS auto-builds patient set fields from the record 
data.  The process of auto-building is described in Chapter 2:  Records and Patient Sets. 

6. In some cases, groups of fields are displayed if the value of any field within that group 
differs between the patient set and the record.  This enables you to review supporting 
information when reviewing data discrepancies.  Data fields shown in groups include data 
related to:  census tract, course of treatment, the medical practitioner care fields, address, 
aliases, cause of death, and informants.    

7. An arrow  is displayed next to each patient set field, pointing from the record toward the 
patient set.  This arrow moves data from the record into the patient set and overwrites the 
values in the patient set.  You may also paste or type values directly into patient set fields.  
For some fields, a plus sign  is displayed to allow you to append the text from the 
record’s data field to the text in the patient set field.  The record ID and facility ID are 
automatically inserted prior to text that is copied or appended using the  and . 

8. The patient set includes multiple instances of certain data:  multiple addresses, multiple 
sets of informant data fields, etc.  If there are differences between the record and the 
patient set in fields that have multiple instances, you may either overwrite the patient set 
fields or create new instances in the patient set.  Consider the example in the diagram 
above.  If you determine that the address in the record represents a second address for 
the patient, click the arrows  next to the alternate address fields to add that information 
to the patient set.  If you determine that this is the patient’s current address, click the 
arrows  next to the current address fields to overwrite the values in the patient set. 

Viewing the Logic of Integrated Edits 

The fields involved in an edit and the logic of the edit are documented in SEER*DMS Help menus 
and in the Record and Patient Set Editors.  Select Help > Edits to use the searchable Edits 
Manager.  The Edits Manager may be used by all users to review the edits implemented in 
SEER*DMS.  Users with the system_administration permission may use the manager to review, 
add, or modify edits.    

In the Patient Set Editor, click the info link on the Edit Errors page to view the fields and logic of a 
failed edit.  To view this information for other edits, select View Edits from the patient set menu.   
Select a rule set and a rule ID from the drop-down lists.  A page similar to the one shown below 
will be displayed. 
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Polishers 

A polisher is a background utility that, according to SEER or registry-defined algorithms, imputes 
data values based on values in other fields.  A polisher executes when the value of one of the fields 
changes.  All changes made by polishers are documented in the patient set’s Audit Log.  The fields 
associated with a polisher and the polisher’s algorithm are documented within SEER*DMS.  Select 
Help > Polishers to use a searchable interface to review documentation related to polishers.  To 
view documentation for a polisher within the Patient Set Editor, select View Polisher from the 
patient set menu.  Select a polisher from the drop-down list.  A page similar to the below will be 
shown. 

 

The patient set menu allows you to Force Polish, that is, run all polishers despite the fact that the 
fields were not changed.  This feature should be used with caution.  All polishers will execute and, 
therefore, there may be unexpected changes in fields unrelated to your editing task.  If you use 
Force Polish, you must carefully review the list of changes displayed when you save the Patient 
Set.  If an undesirable change was made to the data, you should either correct the data manually 
or reverse the changes before saving (see the Undo Changes section of this chapter). 
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Resolving Edit Errors  

Requires system permission:  pat_edit; other permissions that may be necessary to resolve all edit 
errors include:  pat_edit_overrides, pat_end_task 

To check modified fields for errors without leaving the current page, click Validate. SEER*DMS will 
re-run the automated patient set edits and highlight any new or recurring errors. If a modified field 
does not contain any errors, it will be highlighted in yellow (see Chapter 7:  Edit Errors for a 
description of the color codes used in the editor).  The edits are also executed each time you go to 
a different data page or click the Save button. 

Review each error prior to making changes to a data field.  To evaluate and correct the problem, 
you must determine if a single field is causing the error or if an inter-field edit has identified a 
conflict between multiple fields.   

To review and correct edit errors in a patient set: 

1. To view all errors, click the Edits link in the Patient Navigation box. 

2. The following symbols are displayed next to each error in the S (Severity) column: 

 Critical – exclamation point is used to alert you to critical errors 

 High – directional symbols indicate the relative severity level of the other levels, the 
up arrow is used for high 

 Moderate – flat indicates moderate severity level 

 Low – a down arrow indicates a low severity level 

Note:  In SEER*DMS, if you hold your mouse over any symbol its meaning will be displayed. 

3. The following information is listed for each error: 

a. Rule Set – SEER, SEER Extended, and registry-defined sets of edit rules are 
implemented in SEER*DMS.  In addition, SEER*DMS applies system edits (SEER*DMS 
and SEER*DMS Registry) which enforce database constraints.  SEER Extended Edits 
were developed by the SEER Program but have not been incorporated into the standard 
SEER Edits.  The extended edits may relate to fields that are not required to be 
transmitted to SEER.  

b. Error ID – Edit name or identifier. 

c. Error Message – A brief description of the edit error. 

d. The Page column provides a link to a data page containing at least one of the fields 
causing the error.   

e. Action – Click the info link to view full documentation for the edit including the edit 
logic, data fields that are involved, and revision history. 

4. Click the link in the Page column to find and edit the fields.   All fields validated by an edit 
may not be shown on the same page, use the links in the Patient Set Navigation box to go 
to other data pages.   
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5. A data field is highlighted in a shade of red if it is associated with an edit that has been 
triggered.  Hold your mouse over the field’s value to view a listing of the edit errors 
associated with the field.   

6. If you are able to resolve the error: 

a. Depending on the field, you may either enter a value directly into the data field or use a 
lookup control to select the value.   

b. The color of the edited field will change when you move to another field (see Chapter 7:  
Edit Errors for a description of the color codes used in the editor).   

c. Click Validate to run the edits and to determine if your change has corrected the error.  
If the color of the field still indicates an error, hold your mouse over the field to review 
the error message. 

7. There are several edit errors that can be overridden using data fields displayed in the 
Override section of each CTC data page or by setting Reviewed data fields.  

a. SEER and NAACCR overrides are implemented as data fields displayed in the Override 
section of each CTC page.  Each override is associated with a specific edit.  If you hover 
your cursor over an override’s label, the NAACCR fieldname for the flag is listed.  If the 
field overrides SEER edits, the edit IDs will also be shown. 

b. Registry-specific and SEER Extended edits that warn of discrepancies in patient 
information can be overridden by setting the Reviewed data field on the Demographics 
page to Yes.  For example, a SEER Extended edit generates a warning if gender and 
first name do not agree.  

c. Registry-specific and SEER Extended edit errors of CTC data that are warnings can be 
overridden by setting the Reviewed field on the CTC page to Yes.   

d. There are three treatment review flags on the summary treatment data page.  Each is 
associated with a set of data fields; for example, the Radiation Review field is 
associated with the radiation fields in the summarized treatment data.  If the values of 
the associated data fields trigger the need for review, an edit error is generated and  

  is displayed next to the Summary TX link in the navigation box and next to the 
data fields on the page.  You must review those fields to ensure that the summary 
values are correct.  To view treatment data fields from all treatment pages in one 
window, click the multi-page icon  that is displayed next to each review field.  If 
changes are required, enter new values into the data fields on the Summary TX data 
page.   Set the flag to Reviewed. 

8. If information from a reporting facility is required to resolve an error, follow the 
instructions provided in the Requesting Follow-back Information section of this chapter. 

9. If you encounter a problem that you can not resolve: 

a. If you are editing the data via a worklist task, select Task > Reroute to assign the task 
to another user (see in Chapter 4: Using the Worklist for specific instructions). 

b. If you are not editing the data in the context of a worklist task, take note of the Patient 
Set ID so that you can seek assistance from another editor or return to the patient set 
after researching the problem. 

10. If you have made a number of changes, you should save your work periodically.  You must 
save your changes when completing a task.  When you are ready to save your changes, 
follow the instructions in the Saving Changes to a Patient Set section of this chapter. 
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Linking and Unlinking Records  

Requires system permission: pat_edit  

If you are consolidating data from an unlinked record that is new to this patient set, please follow 
all steps described in Chapter 12:  Consolidating Data.  Use the instructions below to make 
corrections when a saved patient set includes a record that was linked inappropriately. Prior to 
making a change, review the data on the record to determine if the record and patient set data 
pertain to the same patient.  Use the Demo Info tool to review patient identifiers from all records in 
one pop-up window.   In the same manner, manually review all CTC data to determine how the 
record should be linked.  Use the DX Info tool to view a list of diagnostic data fields stored in the 
patient set and in the source records. 

To modify a record’s link or to unlink a record completely: 

1. If a record is linked inappropriately, thoroughly review the relevant patient set and/or CTC 
data fields to determine whether you must also manually modify some data fields.  Use 
the Audit Log as a reference.  You may also want to print the patient set prior to changing 
the links.   

2. When you have completed your review, you may either use the record’s menu or the DX 
Info tool to modify the record’s link.  The following instructions involve the use of the 
record’s menu. 

a. Open the record in the editor.  Click the down arrow  adjacent to the ID of the facility 
that provided the record or expand the list of all records by clicking the arrow at the top 
of the Linked section.  Then click the appropriate Record Type label in the navigation 
box.   (Tip:  If there are multiple records of the same type, the record’s ID and 
reportability status are displayed when you hover over the Record Type.) 

b. Review the data displayed in the editor to verify that you selected the correct record.    

c. Click the  menu indicator that is displayed next to the record’s type to open the record 
menu. 

i. To completely disassociate the record from this patient set, select Unlink.  The 
record will be sent into the workflow at the point of matching.  It will follow the 
workflow route designated for a record of its type. 

ii. To link the record to an existing CTC, select the appropriate CTC from the Move To 
sub-menu (sequence number is displayed for each CTC listed in the menu). 

iii. If you wish to use the record to create a new CTC, select New CTC from the Move 
To sub-menu.  This menu item will not be available if the system is unable to build 
a CTC from a record of its type.  If you are creating a CTC from a non-abstract 
record, you should perform the appropriate Casefinding and Death Clearance 
processes prior to creating a new CTC from the record.  

iv. To link the record at the patient set level, select Patient from the Move To sub-
menu.  If the incoming record is not an abstract record and is for a new CTC, you 
should temporarily link the record at the patient level and defer creating the new 
CTC until an abstract is received.  Later, when the abstract record is received and 
used to build the new CTC, you can reassign this link to the CTC.  This will minimize 
the level of effort required to consolidate the data for the new CTC. 

3. Once the record’s link is moved, the new linkage will be indicated next to the record’s type 
in the navigation box: 
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a. If the record is linked to a CTC, “C NN” will be displayed.  This indicates that the record 
is now linked to the CTC that has a central sequence number equal to NN.  SEER*DMS 
attempts to set the sequence number appropriately, based on the central sequence 
number coded in the record and the number of CTCs in the patient set.  If you have 
multiple CTCs with the same sequence number, you should review the CTCs and 
manually adjust the sequence numbers. 

b. If the record is linked at the patient level, P will be displayed. 

c. If the record is unlinked, an X will be displayed.   

4. If you created a new CTC in step 2, determine whether any records linked at the patient 
level need to be linked to the new CTC.  In the patient set navigation box, the labels for 
newly created CTCs are shown in bold type. 

5. Perform a thorough review of the patient set data, including the data pages of all CTCs 
that were affected by the change.  You must determine whether any admissions or 
treatments need to be manually deleted from the original CTC.  If you have unlinked a 
record completely, you should verify that the patient’s follow-up information has been 
modified appropriately. 

6. Save your changes by follow the instructions in the Saving Changes to a Patient Set 
section of this chapter. 

Identifying and Removing Duplicate Patient Sets  

Requires system permission: pat_edit, and pat_delete 

Execute RPT-066A to generate a listing of patient sets which are potential duplicates (see Chapter 
24:  System Reports and Extracts for instructions to execute and open SEER*DMS reports).  An 
editor should use the Patient Lookup to search for patient sets listed on the report and determine 
whether the patient sets are truly duplicates.  Tip:  Try using CSV format for the report if you 
would like to copy-and-paste Patient Set IDs into the Patient Lookup. 

If the report’s matching algorithm falsely identified a patient set as a duplicate, indicate that it is a 
false positive using the Patient Matches section of the patient set editor.  If two patient sets exist 
for the same patient, follow the steps to consolidate all of the patient’s data into one of the patient 
sets and delete the other. 

To indicate that two patient sets identified as “duplicates” are not true duplicates: 

1. Open one of the Patient Sets. 

2. Click the  menu indicator in the patient navigation box to open the patient set menu.  

3. Select Patient Matches from the Patient Set menu.  If you have reviewed both Patient 
Sets and have determined that they are not duplicates, set Action to Not a Match.  The 
two patient sets will no longer be identified as a pair of potential duplicates when you run 
RPT-066A. 

4. Save your changes by follow the instructions in the Saving Changes to a Patient Set 
section of this chapter. 

To combine data from two patient sets and remove one of the duplicates: 

1. Review all data and compare the data pages in the two patient sets.  To view two patient 
sets at one time, use the browser’s controls to open a second window or tab.  You may 
also wish to print the patient sets before consolidating the data. 
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2. Select a patient set to retain.   Ultimately, you will want to retain the patient set that has 
the most and/or best data.  In making this decision, you should consider the following: 

a. The length of time that each patient set has existed in the system.  If one of the patient 
sets was created recently, it may have been created from one or two records.  If a 
patient set was created some time ago, it may be the consolidation of data from a large 
number of records.  The sequence of the patient set IDs and the auto-generated 
messages stored in the patient set’s Comments are useful in determining the history of 
the patient set.  (To review the comments, click CMT in the patient set navigation box.) 

b. The number of records linked to each patient set.  In patient sets created within 
SEER*DMS, this provides a rough measure of the amount of data consolidated into the 
patient set.  However, source records may not be available for patient sets that were 
migrated to SEER*DMS from the registry’s previous data management system. 

c. Compare the audit logs of both patient sets.  A patient set’s audit log documents all 
changes made to patient set data fields, including changes made by registry staff and 
those made in automated processes.  The number of changes made manually by 
registry staff may impact your selection of the “best” patient set to retain.   Print the 
audit logs for future reference. 

3. The next step involves unlinking all source records from the unwanted patient set.  
Ultimately, you will be linking these records to the other patient set.  To unlink all source 
records from the unwanted patient set: 

a. Verify that the unwanted patient set is displayed in the editor. 

b. For each record listed in the Linked record section of the navigation box: 

i. Click the Record Type label to open the record in the editor. 

ii. Record each ID on paper or in a text editor.  You will need this information to verify 
that all records are ultimately consolidated into the other patient set. 

iii. Click the  menu indicator next to the record’s type to open the record menu. 

iv. Click Unlink.   

4. To prevent additional data from being consolidated into the unwanted patient set, mark 
the patient set as deleted: 

a. To open the patient set in the editor, click Demographics in the patient set’s section of 
the navigation box.  

b. Click the  menu indicator next to the patient set ID to open the patient set menu. 

c. Click Delete Patient Set.  The patient set and all of its CTCs will be marked as deleted.  
This is a reversible delete.  However, the patient set and each CTC would need to be 
undeleted individually. 

5. Save your changes to this patient set and exit the editor (see the Saving Changes to a 
Patient Set section of this chapter). 

6. Each record will be moved into the workflow at the point of a matching task (the exact 
matching task will vary by record type).  In order to consolidate the records into the 
retained patient set, search the worklist for manual tasks initiated by these records.  
(Note:  It may take a few minutes for the auto-match to be completed.) 

a. To view the worklist, select View > Worklist.   
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b. Check the Show Unassigned box.   

c. To search for one record, type or copy its ID into the Pat/Rec ID(s) filter.   

d. To search for multiple records, click the down arrow  to expand the Pat/Rec ID(s) 
filter.  Type or copy the IDs into the text box. 

e. If there are no worklist tasks related to the records that you unlinked, use the Patient 
Lookup to search for the retained patient set.  The record may have been of a type that 
allowed SEER*DMS to auto-consolidate the data. 

7. Open and complete one of the tasks: 

a. If one or more Match-Consolidate tasks were created, open and complete any one of 
those tasks.  When selecting a Match-Consolidate task, it does not matter which task 
you select.  All of the patient’s records should be available for consolidation.  After 
completing the match, SEER*DMS will auto-close the other tasks.   Instructions for 
completing the Match-Consolidate task are provided in Chapter 12:  Consolidating Data.   

b. If there are no Match-Consolidate tasks and there is a Consolidate FUP task, open and 
complete that task. 

8. Verify that each record that was unlinked from the deleted patient set has been linked to 
the retained patient set, if appropriate.   Refer to the list of Record IDs created in step 3. 

9. Once you have linked and consolidated data from all available source records, you must 
incorporate any data from the deleted patient set that was not loaded from a record.  This 
includes data that was migrated and data that was entered manually.  Even though the 
patient set was deleted, you may open it in the patient set editor to view or print it.  If you 
wish to view both patient sets, use the browser’s controls to open two windows or tabs.  

Printing Record or Patient Set Data  

To print the patient set data fields:  

1. If you are not viewing a page of the patient set data, click Demographics in the patient 
set navigation box.  

2. Click the  menu indicator in the patient navigation box to open the patient set menu.  

3. Select Print.  

To print data fields on an incoming or linked record:  

1. Click the record’s link (Record Type) in the navigation box.  

2. Open the record menu by clicking the  menu indicator that appears next to the Record ID.  

3. Select Print.  

Undoing Changes 

Requires system permission:  pat_edit 

You may use the Undo Changes menu item to undo all unsaved changes by reloading the patient 
set from the database.  Any changes that you had saved will not be undone.  However, all changes 
are documented in the Audit Log.  If you need to reverse a saved change, manually edit the field 
and enter the original value as noted in the Audit Log. 
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To reload the patient set from the database and undo changes made since your last save: 

1. Click the  menu indicator in the patient navigation box to open the patient set menu. 

2. Select Undo Changes. 

3. Click OK to confirm. 

Saving Changes to a Patient Set 

Requires system permission:  pat_edit 

Use the steps below to save changes to a patient set that you are editing in an ad hoc editing 
session.  If you are editing data in the context of a worklist task, you must consider issues related 
to the flow of data in the worklist.  If you are saving patient set data within a worklist task, please 
refer to one of the following chapters:  Chapter 12 if you are saving data in a Consolidate task; 
Chapter 13 for Visual Editing tasks; or Chapter 14 if saving a Resolve Patient Set Errors task.   

To save changes to the patient set: 

1. Click Save.   

2. Enter comments to document your changes.  Enter general comments in the box at the 
top of the Review Changes page.  Comment fields next to the revised data elements can 
be used to add specificity.  The general and data field comments will be stored and 
displayed in the patient set’s audit log 

3. Save your changes: 

a. If you would like to continue editing after saving, click the Save button at the bottom of 
the Review Changes page. 

b. If you would like to exit the editor, click Save & Exit.   

Warning:  If you exit the editor using controls on or above the menu bar, all unsaved changes will 
be lost.  The menu bar is shown in red in the figure below.  The menus (View, Manage, System) 
and the controls in the User Bar (Search, Help, Account, Logoff) will take you to other system 
components without prompting you to save your changes.  Please refer to SEER*DMS Do’s and 
Don’t’s in Chapter 3:  Using SEER*DMS. 

 

Requesting Follow-back Information 

Requires system permission: pat_edit and fb_initiate 

In SEER*DMS, a request for follow-back information is referred to as a “follow-back need”.   If you 
determine that additional information must be obtained from the reporting facility, you should 
submit a follow-back need.  It will be added to a bundle of requests to the same facility.   

Periodically, a manager will review, edit, and send the follow-back requests to a physician or other 
representative at a facility.  Subsequently, the manager will process the facility’s responses.  

You will receive an e-mail when a response to your request is processed and the follow-back need 
is closed.  You or another staff member may update data fields based on the new information.  As 
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determined by registry policy, one staff member may be responsible for processing all follow-back 
responses, or the information may be given directly to the staff members who entered the needs.   

If you suspended a task pending the receipt of follow-back information, you must re-open and 
complete the task to allow the data to move forward in the workflow.  You must either make 
changes to data fields based on the new information or verify that the appropriate changes were 
made.  If you completed the task but need to update the patient set with the new information, use 
the Patient Lookup to search for the patient set.  Instructions for submitting follow-back requests 
and processing the responses are provided in Chapter 22:  Follow-back. 
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Chapter 12:  Consolidating Data 
One of the primary functions of a central cancer registry is to consolidate cancer data from multiple 
reporting facilities for the same patient.  This involves combining data received on multiple records 
into one comprehensive data set.  In SEER*DMS, the consolidated data for a registrant are stored 
in a single packet of data known as a “patient set.”  The consolidation process may involve 
consolidating data from multiple records and creating a new patient set, or consolidating data from 
one or more records into an existing patient set.   

The SEER*DMS Patient Set Editor includes features specifically designed for consolidating data.  
You will use the Show Differences feature to compare data fields on the incoming record to the 
same fields in the patient set.  To save time and avoid potential keying errors, you will also use this 
tool to copy values from fields in the record to the appropriate fields in the patient set.  While 
reviewing the patient set data pages, you may review data values from multiple records at one 
time.  Finally, you will be able to review a log of the changes already made to the patient set and 
document the changes that you make to the data.  The features of the Patient Set Editor used 
specifically for consolidation are described in this chapter.  If you haven’t already, you should 
review the general description of the editor provided in Chapter 11: The Patient Set Editor. 

The Patient Set Editor is an extremely flexible tool.  It does not impose a specific sequence of steps 
or restrict the methods that you use to consolidate data; however, it is recommended that you 
follow the practices and guidelines described in this chapter.  First, you must confirm that all data 
pertain to the same patient.  Second, incorporate the data into the appropriate section of the 
patient set.  Once you have linked the incoming data and updated the summarized patient set 
data, you may either resolve data errors or you may save the consolidated patient set and allow 
the errors to be resolved in a Resolve Patient Set Errors task (these procedures are determined by 
registry policies). 

“Consolidate” tasks in SEER*DMS involve the consolidation of medical data from reportable 
records.  A separate discussion of the manual and automatic tasks to consolidate follow-up data 
obtained on motor vehicle records, non-reportable death certificates, and other supplemental 
records can be found in Chapter 16:  Follow-up.   

In this chapter, you’ll learn about 

• Data Consolidation in SEER*DMS 

• Opening a Consolidate Task 

• Overview of the Consolidate Task 

• Verifying the Patient Match  

• Linking the Incoming Records 

• The Show Differences Feature 

• Consolidating Demographics Data 

• Selecting a Record to Build a Patient Set  

• Consolidating CTC Data 

• Requesting Follow-back Information 

• Saving Changes 

• Undoing Changes  
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Data Consolidation in SEER*DMS 

When consolidating data in SEER*DMS, you will perform these basic steps:   

1. Confirm that the data are for the same person.  Data should not be consolidated until 
it is determined that the data to be combined are for the same person.  This determination 
is made during matching tasks and is either confirmed or rejected in the consolidate task.   

2. Link the incoming records to data in the patient set.  You must review each record to 
determine whether the data are related to a CTC previously defined for this patient or 
represent a new CTC.  Records may be linked to a CTC or linked at the patient level.  
SEER*DMS provides tools to facilitate your review and link the data. 

3. Update the demographic page of the patient set with data from the incoming 
records.  The Show Differences feature allows you to review discrepancies between each 
record and the patient set.  If an incoming record contains more current or complete 
information, use Show Differences to copy data from the record to the patient set.   

4. Update the CTC data with the best record data.  Click View Text.  Review all text 
before proceeding (you may want to leave the window open or print a copy). 

a. Review and edit data on the patient set’s CTC data page.  If you determine that 
the record contains more complete or accurate information, manually edit or use Show 
Differences to copy data from the record to the patient set.  Do not set the Review flag 
on this page until all treatment and facility data for the CTC are reviewed.  The CTC 
review flag also affects warnings on facility, treatment, and summary treatment pages. 

b. Review newly created Facility pages and new admissions on existing pages.  
Review data and resolve edits for new admissions in the patient set data.  Links to new 
pages are shown in bold.  If new admissions were added to an existing Facility page, 
the Facility link would not be shown in bold.  Check the data for each facility that 
provided an incoming record. 

c. Review newly created Treatment data pages (TX and TXr links).  Resolve edit 
errors, compare coded data to supporting text, and review associated admission data.  
Links to newly created TX and TXr pages are shown in bold. 

d. Review and resolve edit errors that are not associated with review flags.   
Typically, most edits would have been resolved as you reviewed demographics, CTC, 
facility, and treatment data pages.  The remaining edits should be related to review 
flags which ensure that the summary treatment data are reviewed.  It is important to 
confirm that all edits affecting treatment data have been resolved prior to reviewing the 
summarized treatment data.  If you do not know how to resolve an edit or do not have 
the appropriate permissions to do so, you will have the opportunity to save the patient 
set with edit errors.  They will be resolved in a Resolve Patient Set Errors task later. 

e. Review the summary treatment data (Summary TX link).  Review the 
summarized data that the polishers set for each treatment modality.  If the polisher 
could identify missing or conflicting data, the review flag associated with the treatment 
modality will be set to 0 (Needs Reviewed) and an error will be generated to ensure 
that you review the data.  If changes are required in the underlying treatment data, the 
summarized data will be updated and require a second review. 

5. Save the Patient Set and Exit the Consolidate Task.   Once you consolidate the data, 
save the patient set and allow it to move forward to the next task in the workflow.  If you 
save a patient set with edit errors, it will be forwarded to a Resolve Patient Set Errors task.   
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Opening a Consolidate Task 

Requires system permission:  consolidate and pat_edit; other permissions that may be involved 
are:  pat_delete, pat_undelete, pat_edit_overrides 

Data are not consolidated unless it is determined that the data are for the same person.  This 
process begins in automated and manual matching tasks, and continues with a final confirmation in 
the Consolidate task.  Since matching is a prerequisite to consolidation, the manual matching task 
is known as “Match-Consolidate”.  The match is refreshed when the Match-Consolidate task is 
opened to ensure that the incoming record was matched against all appropriate data, including 
data that were recently loaded.  (see Chapter 10:  Matching Incoming Records to Existing Data.)   

The person performing the Match-Consolidate task selects records and/or a patient set to 
consolidate.  If that person has the Consolidate system permission, a Consolidate task will be 
created, opened, and assigned to that user.  If the user does not have the Consolidate permission, 
an unassigned Consolidate task will be created in the worklist. 

To start a Consolidate task by completing a Match-Consolidate task: 

1. Follow the instructions in Chapter 10: Matching Incoming Records to Existing Data to begin 
a Match-Consolidate task and review the possible matches.   

2. If you conclude that one or more items in the list of Matches contain data for the same 
patient as the incoming record: 

a. Check the box in the left column for each data item that matches the incoming record. 

b. Click Consolidate.  The next step will vary depending on the data involved: 

i. A reportable abstract or a patient set is required for consolidation.  If the incoming 
and matching data include at least one reportable abstract record or patient set, a 
manual Consolidate task will be created in the worklist.  If you have the consolidate 
and pat_edit permissions, the Consolidate task will open automatically.  To 
continue, please review the information provided in the Overview of the Consolidate 
Task section of this chapter.  

ii. If the incoming record was not a reportable record and it matched to one or more 
records that could not be used to build a patient set, a manual Non-Rpt 
Rescreening task will be created.  This task allows for the manual review of two 
non-reportable records that match each other but do not match any reportable 
records or patient set data.  Verify the match and combine the data if appropriate.  
Refer to Chapter 15:  Re-screening of Non-reportable Records for instructions. 

iii. The data can be consolidated if the record is being consolidated into an existing 
patient set or there are sufficient data to create a new patient set.  If a patient set 
or reportable abstract are not available, the following message will be displayed at 
the top of the page:  “Cannot create Consolidate task: A reportable abstract or 
patient set is required to consolidate these data at this time. Click No Matches to 
end the task; the records will remain in the database for future matching.”   Click 
No Matches.  The incoming record will be retained in the database.  A new patient 
set will be created at a later time, when a reportable abstract record is loaded. 

To open a Consolidate task in the worklist: 

1. Click a Consolidate link in the worklist summary on the home page.   

2. Use the worklist filters to search for the task, if necessary.  Click Apply. 

3. Click the task ID to open a Consolidate task.   
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Overview of the Consolidate Task 

A Consolidate task enables you to combine data received on multiple records into one 
comprehensive data set, i.e., the patient set.  You may be creating a new patient set by 
consolidating data from multiple incoming records; or you may be consolidating incoming data 
from one or more records into an existing patient set.   

You will use a specialized version of the Patient Set Editor to complete the Consolidate task.  The 
navigation on the left-hand side of the editor is modified to provide information and access to 
various data, including the incoming records, the patient set data, and records that were previously 
linked to the patient set (if any exist).  If incoming records are being consolidated to create a new 
patient set, a patient set will have been auto-built from one of the incoming abstract records.  This 
provides a starting point for creating the consolidated patient set If you would prefer to build the 
patient set from a different record, refer to the instructions in the Selecting a Record to Build a 
Patient Set section of this chapter. For more information regarding auto-build, please refer to 
Chapter 2:  Records and Patient Sets. 

The navigation section of a Consolidate task has three sections as displayed in the diagrams on the 
following pages.  Codes and other visual cues are used to convey information in these navigation 
sections as described below. 
 
The following codes are displayed next to the IDs of the records involved in the Consolidate task:  

1. P - The record is linked at the patient level (non-health records are auto-linked at the 
patient level during passive follow-up processing).  P indicates that the record did not 
provide data specifically related to an existing CTC.  Death certificate, casefinding, and 
short health records may be linked at the patient level, temporarily, even though they 
indicate a new cancer.   You will link the record to the CTC that is created when the 
abstract is received.  If no abstract is received, you will be able to use the record to create 
a CTC that is an CFO, DCO, or SHO case. 

2. C NN – The record is linked to the CTC with a central sequence number equal to NN.  If 
this is an incoming record that was used to auto-build the patient set, this code will be 
displayed in a box (as shown in the table of examples on the following page).  Otherwise, 
it will be shown on a white background. 

3.  – The record has yet to be linked.  This icon will only be displayed for incoming records.  
All records must be linked to a CTC or the patient set to complete the consolidation.  

Site and facility information are indicated as follows: 

1. The site code is displayed next to the CTC label in the patient set navigation box.  For 
example, CTC 01 (C649) indicates that the sequence number of 01 and the site is C649. 
Laterality, if not zero or blank, is displayed with the site code (e.g., C508-1). 

2. The ID of the reporting facility is displayed above the incoming records from that facility.  
The incoming records are sorted by facility. 

3. The numeric segment of a facility ID is displayed in parentheses next to the links for TX 
and Facility/Admission data pages in the patient set.  For example, TX (0120) indicates 
that the treatment data were reported by FAC-0120.  If a treatment procedure was not 
performed at the reporting facility, the IDs for both facilities will be displayed.  For 
example, TX (0120 ~ 0026) indicates that FAC-0026 reported a treatment that was 
performed at FAC-0120. 
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Sample Navigation Boxes in Consolidate Tasks 

These examples illustrate the type of information displayed in the navigation boxes of a Consolidate task. 

 

Overview: A record received from FAC-0089 was loaded into SEER*DMS. The 
record contains data for a registrant in the database, i.e., it matches an existing 
patient set.   

Incoming (1):  In this task, a single incoming record is being consolidated with 
an existing patient set.  Since there is only one incoming record, the Incoming 
section provides direct links to that record’s data pages.  The reporting facility 
(FAC-0089) is displayed above the record’s type.  The  icon next to the record 
type indicates that the incoming record has not yet been linked.  

 

Pat-05458644:  The patient set ID is shown as the header of the Patient 
Navigation box.  You may click on the links in this box to view the patient set 
data.  The page currently being displayed is the patient set’s Demographics page 
(as indicated by the shading of the word Demographics).  This patient set 
includes one CTC that has C508 coded for site and 1 coded for laterality (cancer 
of the right breast). 

Linked (5):  At some point prior to this Consolidate task, five records were 
consolidated into this patient set.  Two records were received from FAC-0086, 
one from FAC-0283, and two from FAC-1000.  To see the record type or view 
record data from a facility, click the down arrow  adjacent to the facility ID.  To 
expand the list for all facilities, click the down arrow  adjacent to “Linked (5)”. 

 

Overview: Two records received from two facilities (FAC-0089 and FAC-0143) 
were loaded into SEER*DMS. The records did not match a patient set in the 
database, but matched each other.  These records provide data for a new patient.  

Incoming (2):  Data from two records for the same patient are being 
consolidated into a new patient set.  Patient set data was auto-built from the 
record that has “C 00” next to it (the CTC for the base record is displayed in a 
box).  The other record has not yet been linked, as indicated by the  icon.  If 
you click a record type, the navigation for that record will expand so that you can 
access the data pages for that record.  If you hold your cursor over a record type, 
the record ID and reportability status will be displayed. 

New Patient:  A patient set ID has not yet been assigned; therefore “New 
Patient” is displayed as the header of the Patient Navigation box.  You may click 
on the links in this box to view other patient set data pages (the shading of 
Demographics indicates that it is the current page being displayed).  This patient 
set includes one CTC that has C343 coded for site and 1 for laterality. 

Linked (0):  Since this is a new patient set, the patient set was never saved with 
linked records.  Records will not appear in this box until they are linked and the 
patient set is saved.  
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Overview: One record received from FAC-0086 was loaded into SEER*DMS. 
The record matched a migrated patient set in the database.   

Incoming (1):  This consolidation involves combining a single incoming record 
with an existing patient set.   

PAT-04607201:  The patient set ID is shown as the header of the Patient 
Navigation box.   

 
 

Linked (0):  There are no records in SEER*DMS linked to this patient set.  This 
patient’s data were entered and consolidated in the registry’s prior data 
management system.  The consolidated data were loaded into SEER*DMS when 
the registry switched to the new system, but the source records were not linked.  
Sufficient linkage information may not have been available in the migrated data; 
or the source records may be older and may not be available in electronic format.  
This situation cannot occur in patient sets created in SEER*DMS and only affects 
migrated patient sets. 

Verifying the Patient Match 

Requires system permission:  consolidate and pat_edit 

Matches are initially selected in the Match-Consolidate task.  The first step of the Consolidate task 
is to review additional data fields to confirm that the data to be combined are for the same person. 

To verify the patient match for incoming records in a Consolidate task: 

1. The Demographic Info window is displayed when you first open a Consolidate task.   The 
values of demographic data fields from each record are displayed.  New records being 
consolidated into the Patient Set are listed in the Incoming Records section at the top.  A 
record field is highlighted if the value differs from the value in the Patient Set.  The 
exception is Medical Record Number; it is highlighted if there is a discrepancy between any 
records from the same facility. 

 

2. Review all discrepancies in the data fields and determine if the records contain data for the 
same patient as each other and the patient set. 

a. If the records are for the same patient, click Accept to close the popup window.  Refer 
to the Consolidating Demographic Data section of this chapter for further instructions. 
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b. If any of the incoming records are for a different patient, click Reject.  The Consolidate 
task will be canceled.  You will be returned to the match portion of the Match-
Consolidate task.  The patient set will be unchanged.   

An incoming record may be rejected during subsequent steps in the consolidation process using the 
Reject item on the record’s menu.  However, data from the record may have been incorporated 
into the patient set.  You may need to edit data fields manually to remove that data.   

The Reject All item in the record menu is equivalent to rejecting the match in the Demo Info 
popup.  The Consolidate task will be canceled and you will be returned to the match portion of the 
Match-Consolidate task.  If the focus record that triggered the original Match-Consolidate task is 
rejected, the task must be canceled so that the focus record can be rematched.  Therefore, Reject 
All is the only option for rejecting the focus record. 

Linking the Incoming Records 

Requires system permission:  consolidate and pat_edit; 

In the SEER*DMS database, a Cancer/Tumor/Case (CTC) is a packet of data related to a single 
incident cancer; all diagnostic, staging, and treatment data for a reportable tumor are stored in a 
CTC.  The CTC includes summarized treatment information, as well as data regarding each 
admission and treatment procedure.  A patient set may include multiple CTCs, one for each 
primary cancer diagnosed for the patient. 

You must review each incoming record to determine whether the data are related to a CTC 
previously defined for this patient or represent a new CTC.  If the data on the record are related to 
an existing CTC, you will link the record to that CTC.  If the data are for a new CTC, you can create 
a new CTC based on the record.  The data entities in the new CTC will be auto-built based on 
values in the record.  If the incoming record is not an abstract record and is for a new CTC, you 
should temporarily link the record at the patient level and defer creating the new CTC until an 
abstract is received.  Later, when the abstract record is received and used to build the new CTC, 
you can reassign this link to the CTC.  This will minimize the level of effort required to consolidate 
the data for the new CTC. 

To link a record to the appropriate data structure in the patient set: 

1. If you have not verified that all data being consolidated are for the same person, refer to 
the Verifying the Patient Match section of this chapter. 

2. Click DX Info in the title bar of the page to open the Diagnostic Information window.   

 

3. The Diagnostic Information displays diagnostic data fields from all unlinked incoming 
records, records previously linked to a CTC, and records previously linked at the patient 
level.  The consolidated values for each CTC are shown in bold, just above the record(s) 
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that are linked to that CTC.  If the entire window (including the Apply and Close buttons) is 
not displayed, enlarge the window so that you see all records and the window’s buttons.  

4. Compare the diagnostic information of the first unlinked record to the CTC and patient set 
data fields (you may also click the Record ID to view additional fields).  When you 
complete your review, click the  icon next to the record’s ID.  A drop-down menu will be 
displayed. 

       

a. If you determine that the incoming record should be linked to an existing CTC, select 
that CTC. 

b. If the incoming records represent one new CTC and a reportable abstract record is 
available, use one abstract record to create the CTC.  Warning:  A CTC will be created 
for each record for which you select “New CTC”.  Do not apply “New CTC” to multiple 
records if you are trying to link them to the same, new CTC. 

i. If one of the incoming records is a reportable abstract record, select New CTC. 

ii. Click the Apply button at the bottom of the window to create the CTC.  You will 
then be able to link other incoming records to that new CTC, if appropriate.  

c. If the incoming record is not an abstract record, you should temporarily link the record 
at the patient level and defer creating the new CTC until an abstract is received.  Later, 
when the abstract record is received and used to build the new CTC, you can reassign 
this link to the CTC.   

d. Click Apply.  If the record is linked to a CTC, “C NN” will be displayed next to the 
record type in the record navigation box.  This indicates that the record is linked to the 
CTC that has a central sequence number equal to NN.  If the record is linked at the 
patient level, P is displayed.  SEER*DMS attempts to set the sequence number 
appropriately, based on the central sequence number coded in the record and the 
number of CTCs in the patient set.  If you have multiple CTCs with the same sequence 
number, you should review the CTCs and manually adjust the sequence numbers. 

5. If you created a new CTC in step 4, determine whether other records need to be linked to 
the new CTC.  Review records previously linked at the patient level as well as incoming 
records that remain unlinked.  In the patient set navigation box, the labels for newly 
created CTCs are shown in bold type. 

The Show Differences Feature 

In a consolidate task, you can use the Show Differences feature to compare data fields on a record 
to the same fields in the patient set.  To save time and avoid potential keying errors, you can also 
use this tool to copy values from fields in the record to the appropriate fields in the patient set.   
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Before consolidating demographic or CTC data, review the features of the Show Differences tool: 

1. Show Differences can be accessed via a link in the title bar of the data page.  It is only 
available on data pages that display fields from multiple records (Demographics and CTC). 

2. Show Differences displays values from the patient set on the left and values from a record 
on the right.  By default, the first incoming record is shown on the right.  A pull-down 
menu on the top right allows you to choose which record you wish to compare to the 
patient set (an abbreviation showing the type of record, the record ID, and the entity to 
which it is linked are listed in the drop-down men).  By default, fields are only shown if 
they differ and are not blank in the record data.   You may include fields with blank values 
in the records by clicking Show Empty Fields.  Once shown, you may click Hide Empty 
Fields to toggle the display of these fields. 
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3. To assist in your review of discrepancies in the data, supporting text fields are displayed at 
the bottom of the Show Differences page.   

4. If there are no discrepancies between the non-blank data fields in the record and the 
patient set data fields, No Differences will be displayed in the top section of the page.  The 
Supporting Text section of the page is always shown. 

5. Records and patient sets do not have the same set of data fields.  To allow you to compare 
record data to patient set data, SEER*DMS auto-builds patient set fields from the record 
data.  The process of auto-building is described in Chapter 2:  Records and Patient Sets. 

6. In some cases, groups of fields are displayed if the value of any field within that group 
differs between the patient set and the record.  This enables you to review supporting 
information when reviewing data discrepancies.  Data fields shown in groups include data 
related to:  census tract, course of treatment, the medical practitioner care fields, address, 
aliases, cause of death, and informants.    

7. An arrow  is displayed next to each patient set field, pointing from the record toward the 
patient set.  This arrow moves data from the record into the patient set and overwrites the 
values in the patient set.  You may also paste or type values directly into patient set fields.  
For some fields, a plus sign  is displayed to allow you to append the text from the 
record’s data field to the text in the patient set field. 

8. The patient set includes multiple instances of certain data; there are multiple addresses, 
multiple sets of informant data fields, etc.  If there are differences between the record and 
the patient set in fields that have multiple instances, you may either overwrite the patient 
set fields or create new instances in the patient set.  Consider the example shown above in 
the Show Differences diagram.  If you determine that the address in the record represents 
a second address for the patient, click the arrows  next to the alternate address fields to 
add that information to the patient set.  If you determine that this is the patient’s primary 
address, click the arrows  next to the primary address fields to overwrite the values in 
the patient set. 

Consolidating Demographics Data 

Requires system permission:  consolidate and pat_edit 

After verifying the patient match, begin the consolidation process by resolving discrepancies 
between the patient information on the demographics page of the patient set with the same data 
fields in the incoming records.  If you are consolidating multiple records to create a new patient 
set, the patient set fields will contain data from the record used to auto-build the patient set. 

If you determine that a record contains more complete or accurate information, update the patient 
set with the best data.  The Show Differences feature enables you to compare data fields on each 
incoming record with the fields in the patient set, and it provides a convenient method to copy 
values into the appropriate patient set fields. 

To consolidate the demographics data: 

1. Confirm the patient match and link each record to the patient set as described in the 
Verifying the Patient Match and Linking the Incoming Records sections of this chapter. 

2. If you are not viewing the patient set’s Demographics page, click Demographics in the 
patient set navigation box.  

3. Click the Show Differences link in the title bar of the Demographics page.  (This link 
changes to Hide Differences when clicked, allowing you to toggle back and forth.) 
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4. If there are no discrepancies between the non-blank data fields in the record and the 
patient set data fields, No Differences will be displayed in the top section of the page.  
(The Supporting Text section of the page is always shown.) 

5. Review each field that is listed.  If you determine that the data provided on the incoming 
record is more current or complete, click the arrow  to overwrite the patient set field with 
the new data.  You may also paste or type values directly into the patient set fields. 

6. Select the next incoming record in the drop-down list.  Review the differences for each of 
the incoming records. 

7. Click Hide Differences when you finish consolidating the data on the Demographics page. 

Selecting a Record to Build a Patient Set 

If incoming records are being consolidated to create a new patient set, a patient set will be built 
from one of the incoming abstract records.  If there are two abstract records for the same case, 
SEER*DMS chooses one based on dates.  You may determine that a different abstract record has 
more detailed information, for example, it may have more staging information.  You may be able to 
reduce data entry and save time by building the patient set from the other abstract record. 

If you would prefer to build the patient set from a different record, you may re-build the patient 
set.  Any changes that you entered manually will be lost.  The consolidate task will essentially start 
over and the patient set will be built from the record that you choose. 

To re-build a patient set using a different abstract record: 

1. In the left navigation panel, click the record type for the record that you wish to use to 
build the patient set. 

2. Click the  menu indicator to open the record’s menu.   

3. Select Re-build Patient Set 

Consolidating CTC Data 

Once you link a record to a CTC, SEER*DMS will use the record data to create TX (treatment), TXr 
(treatment reportedly given at a different facility), and Admissions data fields.   The SEER*DMS 
polishers will then update the Summary TX data fields based on all available TX and TXr data, 
including the treatments created from the newly linked record.   
 
As outlined in the following instructions, you will use Show Differences to review and resolve 
discrepancies between the record and patient set values on the CTC data page.  You will then 
visually edit the newly created TX and TXr data pages; and review the newly created Admissions.  
If you make changes to the TX and TXr data, the polishers will refresh the Summary TX data fields.   
Finally, you will review the summarized treatment data generated by the polishers. 

To consolidate data on an incoming record into a CTC: 

1. Confirm the patient match and link each record to the patient set as described in the 
Verifying the Patient Match and Linking the Incoming Records sections of this chapter. 

2. Review the Incoming Records section of the navigation box to determine which CTCs 
require consolidation of data from the new records (a linkage indicator is displayed next to 
each record type, e.g., “C 00”).    
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3. In the patient set navigation, click the link for the first CTC to which an incoming record is 
linked.  Review and edit the data on the main CTC page.  If you determine that the record 
contains more complete or accurate information, manually edit or use Show Differences to 
copy data from the record to the patient set: 

a. Click Show Differences in the title bar of the CTC data page.  (This link changes to 
Hide Differences when clicked, allowing you to toggle back and forth.)  To consolidate 
the data on the main CTC data page: 

i. Select the first record in the drop-down list that is linked to this CTC.   

ii. If there are no discrepancies between the non-blank data fields in the record and 
the patient set data fields, No Differences will be displayed in the top section of the 
page.  (The Supporting Text section of the page is always shown.) 

iii. Review each field that is listed.  If you determine that data provided on the 
incoming record is more current or complete, click the arrow  to overwrite the 
patient set field with the new data. You may also paste or type values directly into 
patient set fields. 

iv. Repeat the process of reviewing and updating the CTC data page for each incoming 
record that is linked to this CTC.  Use the drop-down list to select each record. 

b. Click Hide Differences when you finish consolidating the data on the CTC page. 

4. Note:  Do not set the Review flag on the main CTC page until all treatment and facility 
data for the CTC are reviewed.  The CTC review flag also affects warnings on facility, 
treatment, and summary treatment pages. 

5. Review data and resolve edits for new admissions in the patient set data.  Be sure to look 
for newly created Facility pages and new admissions on existing pages.  If a new page was 
created, the Facility link in the left navigation box will be shown in bold.  If new admissions 
were added to an existing Facility page, the Facility link will not be bold.  To be sure that 
you review all new data, check for new admissions from each facility that provided an 
incoming record.  

6. Review newly created Treatment data pages (TX and TXr links).  Links for newly created 
pages will be shown in bold.  Resolve edit errors, compare coded data to supporting text, 
and review associated admission data (if an admission is related to the treatment, a link to 
the admission will be displayed on the treatment page in the Adm FAC-ID field).  
SEER*DMS polishers use the data on the TX and TXr pages to update the consolidated 
Summary TX data.  Therefore, it is important to review and visually edit these data prior 
to completing the consolidation of the Summary TX page.  If you would like to view the 
source record during this review, the record type of the source record is displayed as a link 
on the right side of TX and TXr pages.    

7. Review and complete the consolidation of the summary treatment data page: 

a. Click the Summary TX link in the left navigation box.  Review the summarized data that 
the polishers set for each treatment modality.  If the polisher could identify missing or 
conflicting data, the review flag associated with the treatment modality will be set to 0 
(Needs Reviewed) and an error will be generated to ensure that you review the data.  
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i. Review the summarized Surgery Treatment data.  Click the  multi-page icon next 
to the Surgery Review field.  A popup window will open that displays the 
contributing data on the TX and TXr data pages.  You may move the popup window 
so that you can see the summarized and contributing data at the same time. 

ii. Modify the Summary Treatment fields, as necessary.  When you complete the 
process for Surgery Treatment data, set the Surg Rev flag to 1 (Reviewed).  As you 
work, you can re-open the popup window at any time by clicking the  icon.   

iii. The values of the SEER Course 1 dates and the Summarized Diagnostic Procedures 
are automatically set by the polishers.  Therefore, these fields are read-only and 
cannot be modified by the user.   

iv. Repeat this process for the Radiation and Systemic sections.  There is a separate 
review flag for each.  To change the set of fields shown in the popup window, you 
may either use the drop-down menu in the popup or click the  icon next to the 
appropriate variable.  

8. When you have reviewed all data pages, return to the main CTC page and set the CTC 
Review flag to reviewed. 

9. Repeat steps 2 through 8 for each CTC that requires consolidation. 

Requesting Follow-back Information 

Requires system permission:  consolidate and fb_initiate 

In SEER*DMS, a request for follow-back information is referred to as a “follow-back need”.   If you 
determine that additional information must be obtained from the reporting facility, you should 
submit a follow-back need.  It will be added to a bundle of requests to the same facility.  Note:  If 
you are creating a new patient set by consolidating record data, you must submit the follow-back 
needs using the record navigation.  

Periodically, a manager will review, edit, and send a batch of follow-back requests to a physician or 
other representative at a facility.  Subsequently, the manager will process the facility’s responses.  

You will receive an e-mail when a response to your request is processed and the need is closed.  
You or another staff member may update data fields based on the new information.  As determined 
by registry policy, one staff member may be responsible for processing all follow-back responses, 
or the information may be given directly to the staff members who entered the follow-back needs.   

If you suspended a task pending the receipt of follow-back information, you must re-open and 
complete the task to allow the data to move forward in the workflow.  You must either make 
changes to data fields based on the new information or verify that the appropriate changes were 
made.  If you completed the task but need to update the patient set with the new information, use 
the Patient Lookup to search for the patient set.  Instructions for submitting follow-back requests 
and processing the responses are provided in Chapter 22:  Follow-back. 

Saving Changes 

The following describes the procedures to save patient set data during a Consolidate task. 

Save Changes and Exit the Task 

If you have finished consolidating the data: 

1. Click Save. 
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2. Enter comments to document your changes. 

3. Check the Forward to next workflow task on Save & Exit box.  

4. Click Save & Exit.  If there are edit errors in the patient set, it will be forwarded to a 
Resolve Patient Set Errors task.  If there are no errors, the patient set will complete the 
workflow and will be accessible via the Patient Lookup, but not the worklist. 

Save Changes and Continue Editing 

This option is available if you are consolidating data into an existing patient set.  If you are creating 
a patient set from two or more records, you must use the Save & Exit feature to save changes. 

To save changes to the patient set and continue consolidating: 

1. Click Save.   

2. Enter comments to document your changes. 

3. Click the Save button at the bottom of the Review Changes page.   

Save Changes and Keep the Consolidate Task in your Worklist 

If you have made changes but are unable to complete the consolidation, you may save the task 
without forwarding the data to the next task in the workflow.  This option is only available if you 
are consolidating data into an existing patient set.  A Consolidate task cannot be saved for a 
patient set that does not yet exist in the database. 

If you would like to save changes, but need to continue the task at a later time: 

1. Click Save.   

2. Enter comments to document your changes. 

3. Uncheck the Forward to next workflow task on Save & Exit box.  When saved, the 
patient set will remain in a Consolidate task assigned to you.  You will only be able to save 
this data in a Consolidate task if you are consolidating data into an existing patient set. 

4. Click Save & Exit. 

Undoing Changes 

Requires system permission:  pat_edit 

If you made changes that you do not want to save, use the undo feature.  This will reverse all 
unsaved changes made during the consolidation process.  If consolidating data into an existing 
patient set, the values of the patient set data fields will be reloaded from the database.  In addition 
to reverting changes made to data fields, the linking of records and all other modifications will be 
reverted.  If you rejected a record during the task, that change was saved immediately and is not 
reverted by the undo feature.  If you wish to consolidate that record into this patient set, you 
would need to find the record and rematch.   

To reload the patient set from the database and revert changes in a Consolidate task: 

1. Hold your mouse near the  menu indicator in the patient navigation box.  The patient set 
menu will be displayed. 

2. Select Undo Changes.   

3. Click OK to confirm. 
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Chapter 13:  Visual Editing 
In SEER*DMS, all data for a registrant are ultimately stored in a single packet of data known as a 
"Patient Set."   Each Patient Set contains the data consolidated from the patient’s source records 
and linkage information to enable access to the source records.  Patient set data fields contain the 
consolidated and/or summarized values of the linked source records, and values that were derived 
or computed by SEER*DMS polishers.  Original data values are maintained in record data fields. 

Quality control of new data involves the review of edit errors identified by the computerized edits 
and a visual review of data fields.  Primarily, these reviews are performed during one of the 
following worklist tasks: 

• The Visual Edit Patient Set task enables registrars to visually review data when a new 
patient set is created from an incoming record or records.  This task will also be created if a 
patient set is auto-created from a death certificate, casefinding, or short health record using 
one of the Build CTC system tasks.   

• Consolidation tasks enable registrars to visually review incoming data as they consolidate 
the data with other data previously loaded into the system.   

The errors identified by the computerized edits may also be resolved in either of these tasks, or the 
patient set may be saved with errors and forwarded to a Resolve Patient Set Errors task. 

In this chapter, you’ll learn about 

• Opening a Visual Edit Patient Set Task 

• Visually Editing Patient Set Data 

• Saving Changes to a Patient Set 

• Undoing Changes 

• Requesting Follow-back Information 

Opening a Visual Edit Patient Set Task 

Requires system permission:  vis_edit_pat and pat_edit are required; pat_edit_override is needed 
if all edits are to be resolved in this task   

Unassigned Visual Edit Patient Set tasks are created by the Build CTC system tasks that may be 
periodically used to build CTCs from casefinding, death certificate, short health, or other records 
that may be used to build CTCs.  However, most Visual Edit Patient Set tasks are created at the 
conclusion of the manual Match-Consolidate task.  This occurs when no matches are found for the 
incoming record and the record can be used to create a new patient set.  If the user reviewing the 
match has the vis_edit_pat and pat_edit system permissions, the Visual Edit Patient Set task will 
be opened automatically at the end of the Match-Consolidate task.  Otherwise, the task will be 
available as an unassigned task in the worklist.   

Once any Visual Edit Patient Set task is opened by a user, it is assigned to that user’s worklist.  
Follow the steps below to open a Visual Edit Patient Set task that was created and stored in the 
worklist. 

To open a Visual Edit Patient Set task in the worklist: 

1. Click a Visual Edit Patient Set link in the worklist summary on the home page.  To 
resume a task assigned to you, click the link listed in My Tasks.  To open an unassigned 
task, click the link listed in the Unassigned Tasks.  

2. To search for the task in your tasks and unassigned tasks:   
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a. Enter your user name in the User(s) filter. 

b. Check the Show Unassigned box. 

3. To search for a specific task, enter search criteria in the Worklist filters.  Common filters to 
use when searching for a Visual Edit Patient Set task are: 

a. Task ID(s) – The complete task ID must be entered. 

b. Pat/Rec ID(s) – A full or partial patient set ID may be entered. 

c. Facility – A full or partial ID may be entered.  Use the lookup  icon to search for a 
facility ID. 

d. DX Year(s) – Use the DX Year filter to search for tasks by year of diagnosis. Use a 
hyphen to select a range of years (e.g., 2002-2004).  Use a comma to select separate 
years (e.g., 2002, 2004). 

e. Information – In a Visual Edit Patient Set task, this filter can be used to search by 
patient name. To match a complete phrase, enclose it in quotes (e.g., “Smith, John”).   
If you enter John Smith or Smith, John without quotes, tasks related to patients named 
either John or Smith will be returned (the list could include names such as John Smith, 
John Doe, and William Smith). 

4. If you made changes to the filter settings, click Apply. 

5. Click the task ID to open a Visual Edit Patient Set task. 

Visually Editing Patient Set Data 

Requires system permission:  pat_edit 

To create a new patient set, SEER*DMS auto-builds the patient set data fields from the record 
data.  Values are copied from record data fields to the corresponding patient set data fields, or 
values are computed from related record data field(s).  The process of auto-building is described in 
the SEER*DMS Technical Reference.  When you open a Visual Edit Patient Set task, the patient set 
data will be displayed in an editor similar to the one shown below (only a partial page is shown in 
the example).   

 
 
To visually edit the patient set data: 

1. The patient set data are presented on multiple pages in the editor.  You can use the links 
in the navigation box to move from page to page as you edit.  Three indicators are used to 
show which page is being displayed: 

a. The title of the page includes the page name and the patient set or record ID. 
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b. In the patient set navigation box, the name of the current page is shaded. 

c. In the patient set navigation box, a lighter background is used to indicate if the patient 
set or the linked record is being displayed.  In the example above, a lighter shade of 
green is used for the patient set’s section of the navigation box. 

2. Start with the first page of the patient set data.  If you are not viewing the patient set’s 
Demographics page, click Demographics in the patient set navigation box. 

3. SEER*DMS facilitates the visual editing process by providing a convenient mechanism to 
review supporting text fields as you edit the data.   To view the supporting text fields as 
you edit, click the Text link to the left of the page title.   The Text Viewer pop-up window 
will open.  You may need to resize or move the main and/or pop-up windows to edit a field 
on a data page while displaying the Text Viewer.  To close the pop-up, click the Close 
button or click the  in the upper right corner of the window. 

4. Review the data on the current page and modify data fields, as necessary.  More specific 
instructions for changing the value of individual data fields are provided in Chapter 11: The 
Patient Set Editor. 

5. Review and resolve edit errors in the patient set.  Specific instructions for correcting the 
errors are provided in Chapter 14:  Resolving Patient Set Errors.  You have the option of 
resolving all errors during the Visual Edit Patient Set task or forwarding the patient set to a 
Resolve Patient Set Errors task.  (Note:  Whenever you are editing patient set data, ignore 
edit errors in record data fields.  In the patient set editor, record data fields are displayed 
in read only mode by default. The errors should be resolved in the patient set data fields.) 

6. In the patient navigation box, click the CTC link.  Move through and visually edit each page 
of CTC data (CTC, Facility, each TX and TXr page, Summary TX) by repeating steps 3-5.  
Review the notes entered by other registrars and system messages in the Comment page.  
Whenever editing patient data, you may enter notes on the Comment page as appropriate. 

7. Once you have visually edited data on all pages, save your changes and exit the task 
according to the instructions in the Saving Changes to a Patient Set section of this chapter. 

Saving Changes to a Patient Set 

Requires system permission:  pat_edit 

When you complete a Visual Edit Patient Set task, the patient set is either forwarded to a Resolve 
Patient Set Errors task, or it exits the workflow.   If all edit errors were resolved during the editing 
process, the final automated checks are performed and the patient set exits the workflow.  A task 
related to the patient set will not exist in the worklist until new data for the patient enters the 
system, initiating a matching or consolidation task.  To update or view the patient set, use the 
patient lookup feature to search the database (see Chapter 20: Searching for Records and 
Patients). 

Review the following methods for saving changes and for exiting the Visual Edit Patient Set task.  
When saving the patient set, enter general comments in the box at the top of the Review Changes 
page.  Comment fields next to the revised data elements can be used to add specificity.  The 
general and data field comments will be stored and displayed in the patient set’s audit log. 

To save changes to the patient set and continue editing: 

1. Click Save.   

2. Enter comments to document your changes. 
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3. Click the Save button at the bottom of the Review Changes page. 

If you would like to save changes, but need to continue the task at a later time: 

1. Click Save.   

2. Enter comments to document your changes. 

3. Uncheck the Forward to next workflow task on Save & Exit box.  When the patient 
set is saved, it will remain in a Visual Edit Patient Set task assigned to you. 

4. Click Save & Exit. 

If you have finished editing the patient set: 

1. Click Save. 

2. Enter comments to document your changes. 

3. Check the Forward to next workflow task on Save & Exit box.  

4. Click Save & Exit.  If there are edit errors in the patient set, it will be forwarded to a 
Resolve Patient Set Errors task.  If there are no errors, the patient set will complete the 
workflow and will be accessible via the Patient Lookup, but not the worklist. 

Warning:  If you exit a task using controls on or above the menu bar, any changes that you have 
made will be lost.  The menus (View, Manage, System) and the controls in the User Bar (Lookup, 
Account, Logoff) will take you to other system components without prompting you to save your 
changes.  (Help > User Manual is the exception to this rule.  The SEER*DMS User Manual opens in 
a separate window, your work will be unchanged and will continue to be displayed in the original 
window.)  Please refer to SEER*DMS Do’s and Don’t’s in Chapter 3:  Using SEER*DMS. 

 

Undoing Changes 

Requires system permission:  pat_edit 

You may use the Undo Changes menu item to undo all unsaved changes by reloading the patient 
set from the database.  Any changes that you have saved will not be undone.  However, all 
changes are documented in the Audit Log.  If you need to reverse a saved change, manually edit 
the field and enter the original value as recorded in the Audit Log. 

To reload the patient set from the database and undo changes made since your last save: 

1. Click the  menu indicator in the patient navigation box to open the patient set menu. 

2. Select Undo Changes. 

3. Click OK to confirm. 
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Requesting Follow-back Information 

Requires system permission:  pat_edit and fb_initiate 

In SEER*DMS, a request for follow-back information is referred to as a “follow-back need”.   If you 
determine that additional information must be obtained from the reporting facility, you should 
submit a follow-back need.  Your request will be maintained with the record or patient set, allowing 
all users to review pending follow-back issues when reviewing the data.  After submitting the 
follow-back need, you may continue editing or save the record in a Visual Edit Patient Set task that 
can be continued at a later time.   Methods for saving the record and exiting the task are described 
in the Saving Changes to a Patient Set section of this chapter. 

You will receive an e-mail notification when a response to your request is processed and the follow-
back need is closed.  You or another staff member may update data fields based on the new 
information.  As determined by registry policy, one staff member may be responsible for processing 
all follow-back responses, or the information may be given directly to the staff members who 
entered the follow-back needs.   

If you suspended a task pending the receipt of follow-back information, you must re-open and 
complete the task to allow the data to move forward in the workflow.  You must either make 
changes to data fields based on the new information or verify that the appropriate changes were 
made.  If you completed the task but need to update the patient set with the new information, use 
the Patient Lookup to search for the patient set.  Instructions for submitting follow-back requests 
and processing the responses are provided in Chapter 22:  Follow-back. 
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Chapter 14:  Resolving Patient Set Errors 
Whenever a patient set is created or modified, SEER*DMS checks the data for errors based upon 
SEER and local edits (refer to Chapter 7: Edit Errors for more information).  The error check is 
performed each time a patient set is saved or validated.  If edits are revised, the edit errors may 
be refreshed for a cohort of patient sets in the database (as described in the Re-executing Edits in 
Patient Sets section of this chapter).   

Patient set errors may be resolved while editing or consolidating patient set data.  If a patient set is 
saved with errors when a visual editing or consolidation worklist task is completed, a Resolve 
Patient Set Errors task is created.  This allows the registry to separate activities specifically related 
to resolving errors from editing and consolidation, if desired. 

This chapter includes general instructions for resolving patient set errors and includes specific 
instructions for accessing Resolve Patient Set Errors tasks.  If you are correcting errors during an 
editing or consolidation task, refer to the chapters in this manual regarding the Visual Edit Patient 
Set, Consolidate, or Consolidate FUP tasks for additional information. 

The Resolve Patient Set Errors task is the last manual step in the workflow.  Once this task is 
completed, the patient set will not be accessible from the worklist unless new data for the patient 
enters the system that requires consolidation.  To update or view the patient set, you will need to 
use the patient lookup feature to search the database.  For more information, see Chapter 20: 
Searching for Records and Patients. 

In this chapter, you’ll learn about 

• Opening a Resolve Patient Set Errors Task 

• Correcting Errors in a Patient Set 

• Saving Changes to a Patient Set 

• Undoing Changes 

• Requesting Follow-back Information 

• Re-executing Edits in Patient Sets 

Opening a Resolve Patient Set Errors Task 

Requires system permission:  pat_edit 

After a Consolidate, Consolidate FUP, or Visual Edit Patient Set task is completed, any patient set 
containing one or more edit errors is forwarded to a Resolve Patient Set Errors task.  Depending on 
your registry's workflow configuration, the Resolve Patient Set Errors task may be unassigned or it 
may be assigned to the same user who completed the editing or consolidation task. 

To open a Resolve Patient Set Errors task: 

1. Click a Resolve Patient Set Errors link in the worklist summary on the home page.  To 
start or resume a task assigned to you, click the link listed in My Tasks.  To open an 
unassigned task, click the link listed in the Unassigned Tasks.  

2. To search for the task in your tasks and unassigned tasks:   

a. Enter your user name in the User(s) filter. 

b. Check the Show Unassigned box. 
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3. To search for a specific task, enter search criteria in the Worklist filters.  Common filters to 
use when searching for a Resolve Patient Set Errors task are listed below.  Descriptions of 
all worklist filters can be found in Chapter 4:  Using the Worklist. 

a. Task ID(s) – The complete task ID must be entered.  To enter multiple IDs, click the  
 adjacent to the filter.  You may then type multiple IDs into the text box. 

b. Pat/Rec ID(s) – A full or partial patient set ID may be entered.  To enter multiple IDs, 
click the   adjacent to the filter.  You may then type multiple IDs into the text box. 

c. DX Year(s) – the date of diagnosis for a CTC in the Patient Set.  If the Patient Set has 
multiple CTCs and all are submissible, this will be the date of diagnosis of the CTC to 
which the task’s original record is linked.  Otherwise this column will contain the year of 
diagnosis for the earliest diagnosed, non-submissible CTC.  Year is populated in this 
manner to enable you to identify tasks that must be completed for the next submission.  
You may enter a single year of diagnosis, multiple years separated by commas (2004, 
2006), or a range of years using a hyphen (2003-2006).  

d. Information – Enter full or partial search text related to fields in the Information 
column.  In a Resolve Patient Set Errors task, this includes patient name and the 
number of edit errors.  To match a complete phrase, enclose it in quotes (e.g., “Smith, 
John”).  If you enter John Smith or Smith, John without quotes, tasks related to 
patients named either John or Smith will be returned (the list could include names such 
as John Smith, John Doe, and William Smith). 

4. If you made changes to the filter settings, click Apply. 

5. Click the Task ID to open the Resolve Patient Set Errors task. 

Correcting Errors in a Patient Set 

Requires system permission:  pat_edit; other permissions that may be necessary to complete the 
task include:  pat_edit_overrides, pat_end_task 

Review each error prior to making changes to a data field.  To evaluate and correct the problem, 
you must determine if a single field is causing the error or if an inter-field edit has identified a 
conflict between multiple fields.   

To review and correct edit errors in a patient set: 

1. Open the patient set in the editor by opening a worklist task or using the Patient Lookup to 
access the patient set directly.   

2. To view all errors, click the Edits link in the Patient Navigation box. 

3. The following symbols are displayed next to each error in the S (Severity) column: 

 Critical – exclamation point is used to alert you to critical errors 

 High – directional symbols indicate the relative severity level of the other levels, the 
up arrow is used for high 

 Moderate – flat indicates moderate severity level 

 Low – a down arrow indicates a low severity level 
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Note:  In SEER*DMS, if you hold your mouse over any symbol its meaning will be displayed. 

4. The following information is listed for each error: 

a. Rule Set – SEER, SEER Extended, and registry-defined sets of edit rules are 
implemented in SEER*DMS.  In addition, SEER*DMS applies system edits (SEER*DMS 
and SEER*DMS Registry rule sets in SEER*DMS) which enforce database constraints.  
SEER Extended Edits were developed by the SEER Program but have not been 
incorporated into the standard SEER Edits.  The extended edits may relate to fields that 
are not required to be transmitted to SEER.  

b. Error ID – Edit name or identifier. 

c. Error Message – A brief description of the edit error. 

d. The Page column provides a link to a data page containing at least one of the fields 
causing the error.   

e. Action – Click the info link to view full documentation for the edit including the edit 
logic, data fields that are involved, and revision history. 

5. Click the link in the Page column to find and edit the fields.  All fields validated by an edit 
may not be shown on the same page, use the links in the Patient Set Navigation box to go 
to other data pages.   

6. A data field is highlighted in a shade of red if it is associated with an edit that has been 
triggered.  Hold your mouse over the field’s value to view a listing of the edit errors 
associated with the field.   

7. If you are able to resolve the error: 

a. Depending on the field, you may either enter a value directly into the data field or use a 
lookup control to select the value.  See Chapter 11: The Patient Set Editor for 
instructions in modifying data in the patient set editor. 

b. The color of the edited field will change when you move to another field (see Chapter 7:  
Edit Errors for a description of the color codes used in the editor).   

c. Click Validate to run the edits and to determine if your change has corrected the error.  
If the color of the field still indicates an error, hold your mouse over the field to review 
the error message. 

8. There are several edit errors that can be overridden using data fields displayed in the 
Override section of each CTC data page or by setting Reviewed data fields.  

a. SEER and NAACCR overrides are implemented as data fields displayed in the Override 
section of each CTC page.  Each override is associated with a specific edit.  If you hover 
your mouse over an override’s label, the NAACCR fieldname for the flag is listed.  If the 
field overrides SEER edits, the edit IDs will also be shown. 

b. Registry-specific and SEER Extended edits that warn of discrepancies in patient 
information can be overridden by setting the Reviewed data field on the Demographics 
page to Yes.  For example, a SEER Extended edit generates a warning if gender and 
first name do not agree.  

c. Registry-specific and SEER Extended edit errors of CTC data that are warnings can be 
overridden setting the Reviewed field on the CTC page to Yes.   
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d. There are three treatment review flags on the summary treatment data page.  Each is 
associated with a set of data fields; for example, the Radiation Review field is 
associated with the radiation fields in the summarized treatment data.  If the values of 
the associated data fields trigger the need for review, an edit error is generated and  

  is displayed next to the Summary TX link in the navigation box and next to the 
data fields on the page.  You must review those fields to ensure that the summary 
values are correct.  To view treatment data fields from all treatment pages in one 
window, click the multi-page icon  that is displayed next to each review field.  If 
changes are required, enter new values into the data fields on the Summary TX data 
page.  Set the flag to Reviewed. 

9. If information from a reporting facility is required to resolve an error, follow the 
instructions provided in the Requesting Follow-back Information section of this chapter. 

10. If you encounter a problem that you can not resolve, reroute the task using the 
instructions in Chapter 4: Using the Worklist. 

11. If you have made a number of changes, you should save your work periodically.  You must 
save your changes when completing a task.  When you are ready to save your changes, 
follow the instructions below for Saving Changes to a Patient Set.   

Saving Changes to a Patient Set 

Requires system permission:  pat_edit 

The Resolve Patient Set Errors task is the last manual step in the workflow.  If you complete the 
task and forward the patient set into the workflow, the final automated checks will be performed 
and the patient set will exit the workflow.  The patient set will be accessible via the Patient Lookup, 
but not the worklist (until new data for the patient enters the system, initiating a new Match-
Consolidate task). 

Typically, all patient set errors must be resolved in order to complete the Resolve Patient Set Errors 
task.  If edit errors remain in the patient set and you have the pat_end_task system permission, 
you will have the option of ending the task and removing the patient set from the workflow.  You 
may re-open the patient set in an editor at anytime; however, there will not be a task in the 
worklist to “remind” you to resolve errors.  To update or view the patient set, you will need to use 
the patient lookup feature to search the database.  For more information, see Chapter 20: 
Searching for Records and Patients. 

Review the following methods for saving changes and for exiting the task.  When saving the patient 
set, enter general comments in the box at the top of the Review Changes page.  Comment fields 
next to the revised data elements can be used to add specificity.  The general and data field 
comments will be stored and displayed in the patient set’s audit log. 

To save changes to the patient set and continue editing: 

1. Click Save.   

2. Enter comments to document your changes. 

3. Click the Save button at the bottom of the Review Changes page. 

If edit errors remain in the patient set, but you need to complete the task at a later time: 

1. Click Save 

2. Enter comments to document your changes. 
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3. Verify that the Ignore Edit Errors and Forward to Next Workflow Task on Save & 
Exit box is unchecked.  When the patient set is saved, it will remain in a Resolve Patient 
Set Errors task. 

4. Click Save & Exit.  The task will remain in your worklist. 

If you have resolved all errors, end the task and allow the patient set to complete the workflow: 

1. Click Save.   

2. Enter comments to document your changes. 

3. Verify that the Forward to next workflow task on Save & Exit box is checked. 

4. Click Save & Exit. 

To save a patient set with errors and remove it from the worklist (the pat_end_task system 
permission is required): 

1. Click Save 

2. Enter comments to document your changes. 

3. Check the Ignore Edit Errors and Forward to Next Workflow Task on Save & Exit 
box.  

4. Click Save & Exit. 

Warning:  If you exit a task using controls on or above the menu bar, any changes that you have 
made will be lost.  The menus (View, Manage, System) and the controls in the User Bar (Lookup, 
Account, Logoff) will take you to other system components without prompting you to save your 
changes.  (Help > User Manual is the exception to this rule.  The SEER*DMS Help System opens in 
a separate window, your work will be unchanged and will continue to be displayed in the original 
window.)  Please refer to SEER*DMS Do’s and Don’t’s in Chapter 3:  Using SEER*DMS. 

 
 

Undoing Changes 

Requires system permission:  pat_edit 

You may use the Undo Changes menu item to undo all unsaved changes by reloading the patient 
set from the database.  Any changes that you had saved will not be undone.  However, all changes 
are documented in the Audit Log.  If you need to reverse a saved change, manually edit the field 
and enter the original value as noted in the Audit Log. 

To reload the patient set from the database and undo changes made since your last save: 

1. Click the  menu indicator in the patient navigation box to open the patient set menu. 

2. Select Undo Changes. 

3. Click OK to confirm. 
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Requesting Follow-back Information 

Requires system permission: pat_edit and fb_initiate 

In SEER*DMS, a request for follow-back information is referred to as a “follow-back need”.  If you 
determine that additional information must be obtained from the reporting facility, you should 
submit a follow-back need.  It will be added to a bundle of requests to the same facility.   

Periodically, a manager will review, edit, and send the batch of follow-back requests to a physician 
or other representative at a facility.  Subsequently, the manager will process the facility’s 
responses.  

You will receive an e-mail notification when a response to your request is processed and the follow-
back need is closed.  You or another staff member may update data fields based on the new 
information.  As determined by registry policy, one staff member may be responsible for processing 
all follow-back responses, or the information may be given directly to the staff members who 
entered the follow-back needs.   

If you suspended a task pending the receipt of follow-back information, you must re-open and 
complete the task to allow the data to move forward in the workflow.  You must either make 
changes to data fields based on the new information or verify that the appropriate changes were 
made.  If you completed the task but need to update the patient set with the new information, use 
the Patient Lookup to search for the patient set.  Instructions for submitting follow-back requests 
and processing the responses are provided in Chapter 22:  Follow-back. 

Re-executing Edits in Patient Sets 

All edits are executed each time a patient set is opened, validated, or saved in the SEER*DMS 
editor.  The Patient Set Edits system task enables you to re-execute the edits on patient sets in the 
database.  You may run the edits on all patient sets or on a cohort defined by year of diagnosis.  
Use the Patient Set Edits task to ensure that new or modified edits are evaluated.   

Instructions for executing the Patient Set Edits system task are provided in the Chapter 7:  Edit 
Errors. 

 



 
 

Chapter 15: Rescreening of Non-reportable Records 
After being screened for reportability, incoming records that are determined to be non-reportable 
but auditable continue to the Match-Consolidate task.  A patient set cannot be created from a 
single “auditable” record, but if an appropriate match is found, the record may ultimately be 
incorporated into the patient set data.  If the incoming record matches a patient set or a reportable 
abstract record, a manual Consolidation task is created.  A manual task to reconsider the 
reportability of the data is created in the rare instance of an auditable abstract record matching a 
record that is not a reportable abstract record (Non-rpt Rescreening task).   See Chapter 9: 
Screening for Reportability for a description of the reportability settings in SEER*DMS. 

In this chapter, you’ll learn about 

• Incorporating Non-reportable Record Data into Patient Sets 

• Initiating a Rescreening Task 

• Completing a Rescreening Task 

Incorporating Non-reportable Record Data into Patient Sets 

When a user selects one or more matches during a Match-Consolidate task, the next step in the 
workflow is determined by the data type and reportability of the incoming and matching data.  If 
the incoming record matches a patient set, the record is consolidated into that patient set.  If no 
patient set is available and an abstract record is included in the data to be consolidated, an attempt 
will be made to build a patient set.  However, a patient set can only be built if a reportable abstract 
is available; or if combining the data from an auditable abstract with another record of any type 
provides reportable data.  The Non-Rpt Rescreening task is a manual task that enables a registrar 
to determine if an auditable abstract can be combined with other data to create a patient set.  This 
task is created if the following criteria are true: 

• The incoming record is determined to match one and only one record.  It does not match a 
patient set or multiple records. 

• Neither the incoming record or matching record is a reportable abstract record 

• Either the incoming record or matching record is an auditable abstract record. 

The table on the following page shows all possible outcomes of a Match-Consolidate task when 
Consolidate is clicked, that is, when data are found in the database that match the incoming 
record.  For information related to the creation and completion of the Match-Consolidate task, see 
Chapter 10:  Matching Incoming Records to Database. 
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When you select 1 or more matches & click Consolidate to end a Match-Consolidate task: 

Incoming Record Matching Record(s) Next Workflow Task 

Reportable abstract record 
(NAACCR, NAACCR Modified, 
or Health Record) 

One or more  records of any 
type; or a patient set 

Reportable non-abstract 
record  

One or more records that include 
a reportable abstract record; or 
a patient set 

Auditable record of any type One or more records that include 
a reportable abstract record; or 
a patient set 

 
 
Consolidate 

Reportable non-abstract 
record 

An auditable abstract record 

Auditable abstract record A single record that is not a 
reportable abstract record 

 
Non-rpt Rescreening 

Reportable non-abstract 
record 

One or more records – none of 
which are a reportable abstract 
record; no patient set 

Auditable abstract record Two or more records which do 
not include a reportable abstract 
record; no patient set 

Auditable non-abstract record A single record that is not a 
reportable abstract record 

A warning message will be 
displayed indicating that there 
are insufficient data to 
create a patient set.  Click 
No Matches.   
The incoming record will be 
held for matching. 

Initiating a Rescreening Task 

Requires system permissions: match, screening 

A Non-rpt Rescreening task is created when auditable data are chosen for consolidation in a Match-
Consolidate task, as described in the previous section of this chapter.  In the Match-Consolidate 
task, data from the incoming record are displayed in the top part of the screen and potential 
matches are displayed at the bottom.  The reportability status of each record is indicated by an 
icon next to the record’s type.  If the record is reportable, no symbol is displayed.   indicates 
non-reportable;   indicates auditable.   indicates “not applicable” (does not require screening, 
e.g., supplemental records are not screened).    
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The Match-Consolidate task is described in Chapter 10:  Matching Incoming Records to Database.  

A Non-rpt Rescreening task is created in a Match-Consolidate task when: 

1. The incoming record is an auditable abstract record.  NAACCR Abstract, NAACCR Modified, 
and Health Records are abstract records. 

2. You select a single record in the list of possible matches.  The matching record is not a 
reportable abstract record.  

3. You click Consolidate.  A Non-rpt Rescreening task will be created to enable you to review 
the reportability of the combined data.   

4. If you have the screening system permission, the Non-rpt Rescreening task will open 
automatically.  If you do not have the screening system permission, an unassigned task of 
this type will be created in the worklist.   

5. If you determine that the combined data are reportable, you will be able to move the data 
forward to be consolidated into a new patient set.  Please review the Completing a 
Rescreening Task section of this chapter.   

To open a Non-rpt Rescreening task in the worklist: 

1. Click a Non-rpt Rescreening link in the worklist summary on the home page.  To resume a 
task assigned to you, click the link listed in My Tasks.  To open an unassigned task, click 
the link listed in the Unassigned Tasks.  

2. To search for the task in your tasks and unassigned tasks:   

a. Enter your user name in the User(s) filter. 

b. Check the Show Unassigned box. 

c. To search by other criteria, enter values into the filter controls (see Chapter 4:  Using 
the Worklist for more information). 

d. If you made changes to the filter settings, click Apply. 

3. Click the Task ID to open a Non-rpt Rescreening task.   

Completing a Rescreening Task 

Requires system permission:  screening 

The Non-rpt Rescreening task displays all data fields from the two matching records in a split-
screen view, as shown below.  The data fields for the incoming record are displayed on the left of 
the screen, and the data fields for the matching record are displayed on the right.  This format 
enables the user to view the records side by side, and to determine whether these records in 
combination can be used to create a reportable patient set. 
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To screen the records for reportability: 

1. Review the demographic fields to verify that both records are for the same patient.  If you 
would like to view additional data fields, click the Record ID for each record to view the 
entire record. 

2. If the records do not refer to the same patient, reject the match: 

a. Click No Match. SEER*DMS will close the Non-rpt Rescreening task and return to the 
Match-Consolidate task.   

b. If you have the match system permission, the Match-Consolidate task will open 
automatically.  Reconsider the list of Possible Matches and complete the Match-
Consolidate task.  If the wrong record was inadvertently selected as a match, check the 
appropriate matches and click Consolidate.  If you conclude that the incoming record 
does not match any of the patient sets or unlinked records in the list of possible 
matches, click No Matches.   

3. If the records do refer to the same patient, review the data to ascertain if it can be used to 
build a reportable patient set.  If you need to review text or other data fields not 
displayed, click the Record ID for each record to view the entire record. 

a. If you determine that the combined data are reportable and should be used to build a 
patient set, click Reportable.  A manual Consolidate task will be created in the 
workflow.  If you have the consolidate system permission, the Consolidate task will 
open for your consideration.  If not, an unassigned Consolidate task will be added to the 
worklist.  For further instructions, refer to Chapter 12: Consolidating Data. 

b. If the data are non-reportable, click Non-Reportable.  The current task will end and 
the two records will no longer be considered as possible matches.  The incoming record 
will be removed from the workflow.  It will be retained for future matching.  Since it is 
auditable, it will also be stored in the SEER*DMS database for use in casefinding audits. 



Chapter 16:  Follow-up 
The term follow-up refers to the process whereby a registry continues to monitor the status of a 
patient's health at periodic intervals.  Data fields concerning patient vital status, date of last 
contact, treatment, and recurrence are updated to maintain accurate surveillance information.    

Follow-up data are obtained through active and passive methods.  Active follow-up refers to the 
process of identifying patients whose follow-up information is out of date and contacting someone 
who can provide more recent information.  This may involve contacting the patient, a physician, 
family member, or other informant.  SEER*DMS provides mechanisms for facilitating active follow-
up as discussed in the Active Follow-up section of this chapter. 

Active follow-up procedures can be very time and cost-intensive.  Effective passive follow-up 
processes can significantly reduce the time and effort required to obtain current follow-up 
information for patients.  Passive follow-up refers to the process of updating follow-up information 
during the linkage of data, including patient data submitted by reporting facilities as well as non-
medical data provided by other organizations.  Non-medical data are imported as supplemental 
records and include department of motor vehicle, CMS/HCFA, voter registration, and other data 
available to the registry.  The types of supplemental data that are linked will vary by registry. 

Passive follow-up processes are embedded directly into the SEER*DMS workflow as described in 
the Overview of Passive Follow-up section of this chapter. 

In this chapter, you’ll learn about 

• Passive Follow-up: 

o Overview of Passive Follow-up 

o Overview of the Consolidate FUP Task 

o Opening a Consolidate FUP Task 

o Resolving Discrepancies in Follow-up Data 

o Saving & Exiting the Consolidate FUP Task 

• Active Follow-up 

o Overview of Active Follow-up 

o Identifying Patients for Active Follow-up 

o Searching or Filtering the AFUP List 

o Data Shown in the AFUP Manager 

o Assign Patients to a Communication Group 

o Active Follow-up Reports 

o Update Follow-up Data 

o Update Follow-up Data for a Batch of Patient Sets 

o Modifying AFUP Status for a Batch of Patient Sets 

Overview of Passive Follow-up 

Passive follow-up processes are embedded directly into the SEER*DMS workflow.  Automated tasks 
update follow-up fields when a record is a definite match to a patient set based on deterministic 
algorithms.  These tasks are described below. 

• Rapid Follow-up Task.  To reduce delays in obtaining follow-up data from records that 
require manual consolidation, the Rapid Follow-up task incorporates follow-up data prior to 
the full consolidation of the records.  This only occurs for records which are processed in the 
main branch of the workflow and are a definite match to the patient set.  The fields that are 
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changed and the record’s ID are documented in the patient set’s audit log.  The record 
continues to the weighted auto-match task followed by a manual match task.  It is 
ultimately linked to the patient set in a consolidate task. 

• Auto-consolidation of Non-medical Records.  Automated tasks in the follow-up branch 
of the workflow link the records when the patient set fields are updated.  The records are 
matched to patient set data in the Match FUP task or in a pre-load matching task (the 
matching task that is used is determined by record type and registry rules).  The record is 
processed based on the outcome of the match. 

o If the record is a match to two or more patient sets, the matching determination will 
be made manually in a Supplemental Match worklist task.  The record will then follow 
the same path as described for the situations below. 

o If the record is a match to a single patient set, data fields in the patient set are 
updated based on registry-defined algorithms.  The fields would include but would 
not be limited to date of last contact, vital status, and follow-up source (refer to your 
registry’s auto-consolidation rules for more information).  An entry is made in the 
patient set’s audit log documenting that the record was linked and any modifications 
made to data fields.  If automatic updates cannot be completed due to a discrepancy 
between the record and patient set data, a registrar will be able to review the data 
and resolve the discrepancy in a manual Consolidate FUP task.   

o If no match was found in the Match FUP task, the record is retained in the database 
and may be used for passive follow-up later.  If no match was found by the pre-load 
matching task, the record is not loaded and no further processing is performed. 

Overview of the Consolidate FUP Task 

In most registry configurations, records that follow the passive follow-up route through the 
workflow include Supplemental, Death Notice, Health Index, non-reportable Death Certificate, and 
Follow-up Only records.  In this branch of the workflow, a Consolidate Follow-Up (FUP) task is 
created when a record cannot be auto-consolidated into a matching patient set.  This occurs when 
data on the incoming record conflict with data in the matching patient set.  For example, a 
Consolidate FUP task will be created if a supplemental record indicates that a patient was alive on a 
given date, but the patient set data indicate that the patient had died prior to that date.  Refer to 
the Overview of Passive Follow-up section of this chapter for a more complete description of the 
tasks leading to a Consolidate FUP task. 

In the Consolidate FUP task, a failure code and message are displayed at the top of the patient set 
editor indicating the auto-consolidation issues that require attention.  The failure code is shown 
before the colon (DOLC in the example below).  The message lists the conflicts in the incoming 
record and patient set data fields, as shown in the examples below.  

 
 

 

The list of failure messages varies by registry to accommodate registry-specific fields and registry-
defined auto-consolidation rules.  A complete list of the failure codes and messages are provided in 
the Auto-Consolidation section of the SEER*DMS Technical Reference:  Registry-specific 
Information.  
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To complete a Consolidate FUP task, you must perform the following steps: 

1. Confirm that the data are for the same person.  Data should not be consolidated until 
it is determined that the data to be combined are for the same person.  Use the Demo Info 
tool to confirm the match, as described in the Resolving Discrepancies in Follow-up Data 
section of this chapter. 

2. Resolve discrepancies between the patient set and record data.  The Show 
Differences feature allows you to review discrepancies between the record and the patient 
set.  If the incoming record contains more current or complete information, Show 
Differences enables you to update the patient set by copying the data from the record.  
See the Resolving Discrepancies in Follow-up Data section of this chapter for instructions. 

3. Review and Resolve Edit Errors.  SEER*DMS gives you the option of resolving some or 
all edit errors during the consolidation task, or saving the consolidated patient set and 
allowing the errors to be resolved in a Resolve Patient Set Errors task.   

4. Save the Patient Set and Exit the Consolidate FUP Task.  Once you have resolved the 
conflicts between the follow-up data and the patient set, you may save the patient set and 
allow it to move forward to the next task in the workflow. 

The Consolidate FUP task is performed in the patient set editor, and the navigation tools used to 
complete the task are the same as those used in a Consolidate task.  For additional information 
about these features see Chapter 11: The Patient Set Editor and Chapter 12: Consolidating Data. 

Opening a Consolidate FUP Task 

Requires system permission:  consolidate_fup and (pat_edit_demographics or pat_edit) 

To open a Consolidate FUP task in the worklist: 

1. Click a Consolidate FUP link in the worklist summary on the home page.  To resume a 
task assigned to you, click the link listed in My Tasks.  To open an unassigned task, click 
the link listed in the Unassigned Tasks.  

2. To search for a task in your tasks and unassigned tasks:   

a. Enter your user name in the User(s) filter. 

b. Check the Show Unassigned box. 

3. To search for a specific task, enter search criteria in the Worklist filters.  Common filters to 
use when searching for a Consolidate FUP task include: 

a. Task ID(s) – The complete task ID must be entered. 

b. Filters for data items in the record that triggered the Consolidate FUP task:  

i. Pat/Rec ID(s) – Enter the record’s ID (REC-NNNNN format). 

ii. Facility – Enter an ID or use the  lookup to select a facility.  

iii. Information – Enter full or partial search text related to fields in the Information 
column.  In Consolidate FUP tasks, this column displays:  the record type of the 
incoming record, the patient’s name, and the failure code or codes.   The failure 
codes indicate which fields in the record conflict with the patient set.  

4. If you made changes to the filter settings, click Apply.  Click a task ID to open a 
Consolidate FUP task. 
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Resolving Discrepancies in Follow-up Data 

Requires system permissions: consolidate_fup and (pat_edit_demographics or pat_edit) 

1. The incoming record is auto-linked at the patient level.  The Demographic Information will 
be displayed when you open the Consolidate FUP task.  Verify that the incoming record 
contains data for the same patient. 

a. Data from the Incoming Record are displayed in the top section.  A field will be 
highlighted in red if its value differs from the values in the Patient Set fields.  Medical 
Record Number will be highlighted in red if its value differs from Medical Record Number 
from other records for the same facility. 

b. Consolidated patient set data fields are displayed in bold in the first row of the Patient 
Set section.  These are followed by values from the records that are linked to the 
patient set. 

c. Review all discrepancies in the data fields and confirm that the incoming record 
matches the patient set.   

i. If the incoming record is for the same patient, click Accept and continue with step 2 
to consolidate the data.   

ii. If the record does not pertain to the same patient, click Reject.  The Consolidate 
FUP task will be canceled.  The incoming record will be retained in the database as 
an unlinked record; it can be rematched at a later time.  The patient set will be 
unchanged. 

2. If the record contains data for the same person as the patient set, use the Show 
Differences tool to resolve discrepancies between the record and patient set.  If you are 
not on the Demographics page of the Patient Set, click the Demographics link in the 
Patient Set section of the navigation box. 

a. Click the Show Differences link in the title bar of the Demographics data page.  (This 
link changes to Hide Differences when clicked, allowing you to toggle back and forth.) 

b. Show Differences displays values from the patient set on the left and values from the 
record on the right.  If you determine that data provided on the incoming record is 
more complete or more accurate, click the arrow  to overwrite the patient set field 
with the new data.  You may also copy or type values directly into patient set fields. 
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c. If you do not have sufficient information to determine which set of data is correct, you 
should submit a request for more information.  See Chapter 22: Follow-back for 
instructions to add a follow-back need for this task.  

d. Click Hide Differences to return to the data page. 

3. Review and resolve edit errors, as dictated by registry policy.  SEER*DMS gives you the 
option of resolving edit errors during the consolidation task, or saving the consolidated 
patient set and allowing the errors to be resolved in a Resolve Patient Set Errors task.   

4. When you are ready to save your changes, follow the instructions in the Saving and Exiting 
the Consolidate FUP Task section of this chapter. 

Saving & Exiting the Consolidate FUP Task 

When saving your changes and exiting the task, you should enter any relevant comments 
regarding changes made during the task.  The comment box at the top can be used to add general 
comments pertaining to the task.  Comment fields next to the revised data elements can be used 
to add specificity.  The general and data field comments will be stored and displayed in the patient 
set's audit log. 

To save your changes and exit the Consolidate FUP Task: 

1. Click Save. 

2. Enter comments to document your changes. 

3. Click Save & Exit.  If there are edit errors in the patient set, it will be forwarded to a 
Resolve Patient Set Errors task.  If there are no errors, the patient set will complete the 
workflow and will be accessible via the Patient Lookup, but not the worklist. 

Overview of Active Follow-up 

The following summarizes the steps involved in using SEER*DMS to manage the registry’s active 
follow-up processes.  These steps are explained in greater detail is subsequent sections of this 
chapter. 

1. Execute the system task to identify patients for active follow-up.  This task uses 
registry-specific algorithms to determine which patients require active follow-up.  These 
criteria are based on vital status, date of last contact, and whether the patient’s follow-up 
status is monitored by the registry.  If a patient set meets the task’s criteria, the patient 
set’s AFUP status will be set to open and the patient set will be added to the list of patients 
requiring follow-up on the SEER*DMS AFUP Manager page.   

2. Review the list of patients on the AFUP Manager page.  Close the AFUP for 
selected patients, as appropriate.  In some registries, the system task’s criteria include 
patients who are not routinely followed by the registry.  For example, it may be registry 
policy that patients who only have non-reportable cancers are not followed on a regular 
basis.  These may be flagged as requiring active follow-up because there are times when 
they are actively followed.  If this is not one of those times, use the filters in the AFUP 
Manager to select those patients and close their AFUPs.    

3. Group Patient Sets based on the method of communication that will be used to 
obtain follow-up information.  In this step, you will assign a Communication ID to each 
group of patients who fall into the same communication category.  The communication 
category determines the type of letter, form, or listing that will be used to obtain follow-up 
information.  As an example, you may assign a specific Communication ID to patients who 
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will be followed via physician letters; or you may assign a Communication ID to patients 
who will be followed via a particular site-specific form.  The Communication IDs will be 
used by external reports that generate the letters and forms; these are implemented via 
external reports to give the registry complete control over the number, type, and content 
of the follow-up reports.   

4. Generate reports, letters, and listings based on the communication IDs assigned 
in step 3.  Typically, the external reports will be designed to accept a Communication ID 
as a parameter.  Execute each external report using the appropriate Communication ID.   

5. Wait for a response to letters sent to physicians, facilities, patients, and 
informants.  As you wait, be aware that a patient’s follow-up status may be closed if data 
received at the registry updates follow-up fields.  A patient’s AFUP status will automatically 
be set to closed if the patient’s vital status is changed from alive to dead; or the date of 
last contact is set to a date that is more recent than the AFUP DOLC Cutoff used in step 1.   

6. Indicate whether a response was received and enter all data received.  Update the 
patient data based on information received and indicate that the communication was 
successful.  In order to refine the registry’s communication strategies, you should also 
track unsuccessful and inappropriate communication methods.   

Identifying Patients for Active Follow-up 

Requires system permission:  system_administration 

The “Identify Patients for AFUP” system task uses registry-specific algorithms to determine whether 
a patient requires active follow-up.  These criteria are typically based on vital status, date of last 
contact, and whether the patient’s follow-up status is monitored by the registry (e.g., non-
reportable cases may not be followed by some registries). 

If a patient set meets the task’s criteria, the patient set’s AFUP status will be set to open and the 
patient set will be added to the list of patients requiring follow-up on the SEER*DMS AFUP Manager 
page.  You may use the AFUP Manager to facilitate and track communications to the patients, their 
physicians or other contacts.  The AFUP Manager also enables you to enter follow-up data as it is 
received (see the Using the AFUP Manager section of this chapter).  An AFUP is closed when the 
patient’s vital status and date of last contact indicate that the need has been fulfilled.  This may 
occur when data are changed via data processed in passive follow-up processes or data received as 
a result of active follow-up procedures. 

To designate Patient Sets for active follow-up: 

1. Select System > Tasks. 

2. Click the Identify Patients for AFUP link. 

3. Enter a date in DOLC Cutoff that defines whether a patient set requires active follow-up.  
A patient set will be considered if the patient set's value for vital status is alive and the 
date of last contact is prior to this date.   

4. Click Recalculate to view the number of patient sets that meet the criteria.  If the 
number of patients sets is unacceptably high based on registry policy, adjust the DOLC 
Cutoff and recalculate. 

5. You may enter text related to this task in the Comment field.  The comment from the last 
execution of the task is stored in the database (utility_history table). 
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6. Click Start.  SEER*DMS will create an AFUP Need for each patient set which matches the 
registry’s active follow-up criteria.   Once the task completes, the follow-up staff may use 
the AFUP Manager to initiate follow-up procedures for these patients. 

Searching or Filtering the AFUP List 

Requires system permission:  afup_manager 

A Patient Set is listed in the AFUP Manager if its AFUP Status was set to Open during the execution 
of the Identify Patients for AFUP system task.  Please verify that the system task was executed 
with the appropriate options prior to using the AFUP Manager.  

To search or review Patient Sets flagged for active follow-up: 

1. Select Manage > Active Follow-up.  

2. No Patient Sets are shown when you first open the AFUP Manager.  To use the default filter 
settings and view all Patient Sets currently flagged as requiring follow-up, click Apply.  

3. To search for AFUPs by Patient Set or AFUP ID, enter the IDs into the Patient ID(s) filter.  
The PAT- or AFUP- prefixes may be entered, but are not required.  To expand the filter so 
that more than one ID can be entered, click the   adjacent to the ID filter.  You may type 
or paste as many IDs as you wish.  Separate one ID from the other by entering a space or 
by pressing Enter.  (Note:  The AFUP ID consists of the numeric portion of the Patient Set 
ID appended to the AFUP- prefix.   This ID is for display purposes only.  It is used in the 
AFUP Manager to make it clear that clicking the ID opens the AFUP page and not the 
Patient Set itself.) 

4. To search for AFUPs related to a particular communication, enter the Communication ID 
into the Comm ID(s) filter.  To expand the filter so that more than one ID can be 
entered, click the   adjacent to the ID filter.  You may type or paste as many IDs as you 
wish.  Separate one ID from the other by entering a space or by pressing Enter.   

5. To select a set of AFUPs based on the DOLC Cutoff Date used by the system task to 
identify patients for active follow-up, select a value in the Cutoff Dt filter.   

6. If you wish to view a list of AFUPs that have yet to be sent, check the Exclude Sent box.  
Use this control to view AFUPs that were never assigned to a communication group. 

7. The date of last contact (DOLC) filter allows you to search on DOLC month, day, and year 
separately.  For example, if you wish to limit the list to patients with December as their 
month of last contact enter 12 in the first box.  To search for patients with a certain year 
of last contact, enter the value in the third box.  To search for patients with the same full 
date of last contact, enter values in all three boxes. 

8. Use the Age at DX filter to search for Patient Sets by age of diagnosis.  You may specify a 
range of values (e.g., 0-20 for patients 20 and younger).  If a Patient Set has multiple 
CTCs, the age at diagnosis for each CTC is considered. 

9. Use the Year of DX filter to search for Patient Sets by year of diagnosis.  You may specify 
a range of years (e.g., 2002-2004) or use a comma to select separate years (e.g., 2002, 
2004). If a Patient Set has multiple CTCs, the year of diagnosis for each CTC is considered. 

10. To limit the list to Patient Sets with a particular value for Do Not Contact, use the  
lookup to select the appropriate value. 
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11. To search by facility admissions, use the  lookup or enter an ID for Admitting Facility.  
The list will be limited to Patient Sets with an admission to the facility. 

12. To search for patients by the facility specified as their last follow-up hospital or to search 
for patients with an unknown follow-up hospital, use the  lookup or enter an ID in the 
Last FU Hosp filter. 

13. To search for patients by the physician specified as their last follow-up physician or to 
search for patients with an unknown last follow-up physician, use the  lookup or enter an 
ID in the Last FU Phys filter. 

14. To limit the list to Patient Sets with at least one CTC that is reportable to SEER or local 
agencies, select the appropriate value in the Reportable filter.  Site 

15. Use the Site filter to search for Patient Sets by cancer site.  You may use the Lookup icon 
 to select a single code from a list, type one or more codes into the box (separate the 

codes by commas or spaces), or enter a range of values.  You may also enter a partial 
string.  For example, enter C50 to search for site codes of C500 through C509.  If a 
Patient Set has multiple CTCs, the site of each CTC is considered. 

16. Use the Histology filter to search for Patient Sets with at least one CTC that has a 
particular value for histology.  You may specify a range of values (e.g., 800-8999) or use a 
comma to select separate years (e.g., 8000, 8500). If a Patient Set has multiple CTCs, it 
will be included if at least one of those CTCs meets the criteria for histology. 

17. To search by behavior, use the  Lookup or enter a value in the Behavior filter.  You may 
also enter a range of values.   If a Patient Set has multiple CTCs, it will be included if at 
least one of those CTCs meets the criteria for behavior. 

18. If the filters are set appropriately, click Apply.  Click Reset to restore default settings and 
clear all filters. 

Data Shown in the AFUP Manager 

The following data columns are shown in the AFUP Manager: 

• AFUP ID – The AFUP ID consists of the numeric portion of the Patient Set ID shown with an 
AFUP- prefix.  This ID is used in this column of the AFUP Manager to make it clear that 
clicking the ID opens the AFUP page (clicking an ID shown in the PAT-NNNNNN format will 
open the Patient Set editor). 

• Last Name – The patient’s last name. 

• First Name – The patient’s first name. 

• DOLC – The current value of date of last contact stored in the Patient Set. 

• FU Hosp – The facility defined as the Last Follow-up Hospital in the Patient Set. 

• FU Phys – The person defined as the Last Follow-up Physician in the Patient Set. 

• Cutoff DT – The DOLC Cutoff date specified for the Identify Patients for AFUP system task 
that determined that this Patient Set requires active follow-up.  If a Patient Set met the 
AFUP criteria in multiple executions of the task, the most recent value is shown. 

• Created DT – The date that the Identify Patients for AFUP system task was executed and 
determined that this Patient Set requires active follow-up.  If a Patient Set met the AFUP 
criteria in multiple executions of the task, the most recent value is shown. 
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• Latest Com – The most recent communication group to which this Patient Set was 
assigned.  Click the Communication ID to view or enter data received in response to the 
communication.    

Assign Patient Sets to a Communication Group 

Requires system permission:  afup_manager 

To assign a Communication ID to a set of Patient Sets: 

1. Select Manage > Active Follow-up.  

2. No Patient Sets are shown when you first open the AFUP Manager.  To use the default filter 
settings and view all Patient Sets currently flagged as requiring follow-up, click Apply.  

3. Enter search criteria in the filters to select the Patient Sets that will be assigned to a single 
Communication Group.  Select Patient Sets that will use the same report to generate the 
appropriate mailing, forms, or listing.    Instructions for using the filters are provided in 
the Searching or Filtering the AFUP Manager section of this chapter. 

4. Select the Patient Sets: 

a. To select all Patient Sets on all pages of the filtered AFUP Manager, click Send All.   

b. To select a single Patient Set, check the box to the left of the AFUP ID.  Click Send. 

c. To select two or more Patient Sets, use one of the following methods: 

i. To select specific Patient Sets, check the box to the left of each AFUP ID.  You can 
only select Patient Sets on the same page with this method.  

ii. To select all Patient Sets displayed on the current page, check the box on the top 
left of the page, adjacent to the AFUP ID column heading.  If you would like to 
exclude a Patient Set, click the checkbox to de-select it. 

iii. Click Send. 

5. Provide the information that your external report requires to generate the mailing, forms, 
or listing to obtain follow-up data for the selected patients. 

a. Use the Communication Type field to set the RECIPIENT_TYPE field in the 
communication table.  Consult the documentation for your report to determine which 
value should be used.   For example: 

i. If the report generates a mailing addressed to a single facility or physician, set 
Communication Type to Facility/Physician.  Enter a value for physician, facility, or 
both. 

ii. If the report uses physician or facility information stored in the Patient Sets but 
requires a default value for either field, set Communication Type to 
Facility/Physician.   Enter a value for physician, facility, or both.  The report would 
use this information if the field(s) were missing for a patient. 

iii. If the report generates a mailing addressed to the patients or only uses data within 
each Patient Set, select Patient Communication.  

b. Enter a unique Report ID that identifies the external report for this communication.   
(The current version of SEER*DMS does not support internal AFUP reports.) 

6. Click OK. 
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7. SEER*DMS will create a new communication entry.  The new Communication ID will be 
displayed at the top of the screen and an AFUP Report Request will be sent to you via 
email.  Use the information in the email to generate the external report or forward the 
report request to the appropriate person at your registry. 

Active Follow-up Reports 

Registry staff must create external reports that generate mailings, forms, and listings related to the 
registry’s active follow-up procedures.  Each report should accept a Communication ID as a 
parameter.  The Communication ID defines the cohort of patients for the report and provides other 
information such as recipient type, facility (if applicable), and physician (if applicable).  Samples of 
SQL and detailed descriptions of the database tables and fields relevant to AFUP reports are 
provided on the SEER*DMS portal.  The samples include queries that select demographic patient 
set fields as well as queries that select CTC-level data fields.  

Update Follow-up Data 

Requires system permission:  pat_edit or pat_edit_demographics or afup_manager 

A patient’s AFUP status will automatically be set to closed if the patient’s vital status is changed 
from alive to dead; or the date of last contact is set to a date that is more recent than the AFUP 
DOLC Cutoff.  The AFUP status will be modified whether the patient’s data were updated via ad hoc 
editing, during a manual worklist task, in an automated passive follow-up task, or via tools 
specifically designed for active follow-up.  Instructions for modifying data field via ad hoc editing 
and worklist tasks are provided in other chapters of this manual.  The following describes methods 
for updating follow-up data using AFUP features.  These tools provide a convenient method to 
update the fields and track the effectiveness of registry active follow-up procedures. 

To update patient follow-up data: 

1. If you are entering information for a number of patients and the information was received 
in response to a particular Communication, please refer to the Updating Follow-up 
Information for a Batch of Patient Sets section of this chapter.  In batch mode, you will be 
able to update date of last contact and vital status for a number of patients.  If you need 
to modify other fields or are entering information that is unrelated to a communication, 
continue with step 2. 

2. You may access the Active Follow-up page for a patient set via the Patient Set Editor or 
the AFUP Manager: 

a. To access the Active Follow-up page of a Patient Set via the Patient Set editor: 

i. Open the patient set by entering the Patient Set ID in the Lookup box on the 
SEER*DMS toolbar (or you may use any of the search features described in Chapter 
20:  Searching for Records and Patients). 

ii. Click the AFUP link in the Patient Set’s navigation box on the left side of the screen.  
The status of the most recent AFUP is listed at the top.  A history of the 
communications used to obtain follow-up information is displayed in the 
Communication History section of the page. 

iii. If the Patient Set’s AFUP status is open and you wish to view or modify AFUP 
information, click Edit.    

b. To access the Active Follow-up page via the AFUP Manager: 
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i. Use the filters to find the Patient Set (see Searching and Filtering the AFUP List for 
detailed instructions). 

ii. Click the link in the AFUP ID column for the Patient Set.   

3. If you are entering information received as the result of a specific communication effort: 

i. Select the communication’s ID in the COM-ID drop-down list.  Fields related to that 
communication will automatically be set in the Follow-up Info section of the page.  

ii. Set the Status of the communication to Success.  The manager of follow-up will use 
this information to evaluate the effectiveness of the registry’s active follow-up 
procedures.  

iii. Date Received will automatically be to today's date.  You may override this value if 

the data arrived at the registry on a previous date.  Click the Calendar icon  to 
modify the date, if necessary. 

iv. You may enter a comment related to the communication, if you wish. 

4. Changes that you save on this form will be used to update fields in the Patient Set, as 
described below.  You may update the following fields: 

a. DOLC – The Patient Set’s current value for date of last contact is shown.  You may 
enter a more recent date.  If you enter a date that is earlier than the current value, the 
Patient Set’s field will not be changed.   

b. VS – The Patient Set’s current value for vital status is shown.  If your follow-up 
information indicates a change in vital status, enter the new value.  A change will be 
made in the Patient Set if the date of last contact is the same or later than the current 
date in the Patient Set. 

c. Follow-up Source Central – To specify the source of the follow-up data, enter the 
appropriate value in the FUP Src Cntl field.  You may either enter a code or use the  
lookup to select a code.  

d. Do Not Contact – If your information indicates a new values for the Do Not Contact 
field, you may enter it here.  

e. FU Phys – If your information indicates a new follow-up physician, you may enter the 
physician’s ID or use the  lookup to select an ID. 

f. FU Hosp –If your information indicates a new follow-up hospital, you may enter its 
facility ID or use the  lookup to select an ID. 

5. Click OK.  Changes to fields on the AFUP form will only be accepted if the date of last 
contact is the same or later than the current value in the Patient Set. 

Update Follow-up Data for a Batch of Patient Sets 

Requires system permission:  afup_manager and (pat_edit or pat_edit_demographics) 

If you receive a response to a Communication that includes data for multiple patients, you may use 
the AFUP Manager to open the Communication Response page and enter data for a batch of patient 
sets.  This feature provides a convenient method to update the date of last contact and vital status 
in a batch data entry mode.  It also allows you to indicate whether the communication was 
successful for each patient or if it failed to yield information for one or more patients.  If you wish 
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to enter additional data for a patient, you may prefer to update a single patient’s data on a screen 
that provides more fields.  See the Update Follow-up Data section of this chapter for instructions. 

To update the follow-up data for a batch of Patient Sets: 

1. Select Manage > Active Follow-up.  

2. Click Find Comm to search for the communication. 

3. Enter the Communication ID for this set of Patient Sets.  

4. Click Find.  SEER*DMS will list all Patient Sets associated with the communication.  The 
following patient identifiers are shown:  Patient Set ID, Social Security Number, and 
patient name.   These are followed by entry fields for date of last contact, vital status, and 
the communication status (success of failure), and the date that the follow-up data were 
received. 

5. Enter information related to the communication: 

a. Received Dt is automatically set to today's date. You may override this value if the 

data arrived at the registry on a previous date.  Click the Calendar icon  to modify 
the date, if necessary. 

b. Enter a value in the FUP Src Central field.  You may either enter a code or use the  
lookup to select a code. 

6. If there are 20 or fewer, all Patient Sets will be listed.  If there are more than 20, a search 
box will allow you to search for each Patient Set.  You may search by Patient Set ID, Social 
Security Number, or patient name.  Once you enter three or more characters in the search 
box, the system will begin to display matches.  Continue typing until the appropriate 
Patient Set is displayed.  Once the Patient Set is highlighted, you may click or press Enter 
to add it to the data entry form.   

7. Enter data for each Patient Set.  Changes that you save on this form will be used to 
update the Patient Set data fields, as described below.  The fields for a patient will be 
disabled if their AFUP status was set to Closed during editing or via automated passive 
follow-up tasks; they will also be disabled if the status of this communication was modified 
for the patient.  The patients are listed in alphabetical order.  Find the correct patient in 
the list based on patient name, Patient Set ID, Social Security Number.  You may update 
the following fields: 

a. DOLC – The Patient Set’s current value for date of last contact is shown.  You may 
enter a more recent date.  If you enter a date that is earlier than the current value, the 
Patient Set’s field will not be changed.  This form will not allow you to enter a less 
current value for date of last contact. 

b. VS – The Patient Set’s current value for vital status is shown.  If your follow-up 
information indicates a change in vital status, enter the new value.  A change will be 
made in the Patient Set if the date of last contact is the same or later than the current 
date in the Patient Set. 

c. Status – If this communication successfully yielded information related to this patient, 
set Status to Success.  This information will be used by a manager to evaluate the 
effectiveness of follow-up procedures. 

d. Received Dt will automatically be to today's date for all patients whose data are 
updated. 
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8. Save your changes: 

a. If you would like to continue editing after saving, click the Save button at the bottom of 
the Review Changes page. 

b. If you would like to exit the page, click Save & Exit.   

Modifying AFUP Status for a Batch of Patient Sets 

Requires system permission:  afup_manager 

You may set the AFUP statuses of a batch of patient sets to closed.  You may want to use this 
feature to clear the AFUP Manager prior to running the system task to identify patients for the next 
round of active follow-up.  In some registries, the system task’s criteria include patients who are 
not routinely followed by the registry.  For example, it may be registry policy that patients who 
only have non-reportable cancers are not followed on a regular basis.  These may be flagged as 
requiring active follow-up because there are times when they are actively followed.  If this is not 
one of those times, follow the instructions below to select those patients and close their AFUPs.    

To set AFUP status to closed for a set of Patient Sets: 

1. Select Manage > Active Follow-up.  

2. No Patient Sets are shown when you first open the AFUP Manager.  To use the default filter 
settings and view all Patient Sets currently flagged as requiring follow-up, click Apply.  

3. Enter search criteria in the filters to limit the list as needed. Instructions for using the 
filters are provided in the Searching or Filtering the AFUP Manager section of this chapter. 

4. Select the Patient Sets: 

a. To select all Patient Sets on all pages of the filtered AFUP Manager, click Modify All.   

b. To select a single Patient Set, check the box to the left of the AFUP ID.  Click Modify. 

c. To select two or more Patient Sets, use one of the following methods: 

i. To select specific Patient Sets, check the box to the left of each AFUP ID.  You can 
only select Patient Sets on the same page with this method.  

ii. To select all Patient Sets displayed on the current page, check the box on the top 
left of the page, adjacent to the AFUP ID column heading.  If you would like to 
exclude a Patient Set, click the checkbox to de-select it. 

iii. Click Modify. 

5. The number of Patient Sets will be displayed at the top of the page.  Select the Action to 
be applied to these Patient Sets: 

a. If you wish to clear these Patient Sets from the AFUP Manager, select Close AFUP & 
Communications.  The Patient Sets’ AFUP status flag will be set to closed and all 
unresolved AFUP communications for these Patient Sets will be failed. 

b. If you want to fail all unresolved communications for these Patient Sets, select Close 
Communications Only. 

6. Click OK. 
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Chapter 17:  Death Clearance 
Death Clearance is the process of linking death certificate records with the registry database in 
order to determine all deaths among registrants and to identify deaths from cancer among persons 
previously unknown to the registry.    

When a death certificate record enters the workflow, SEER*DMS attempts to move the record 
through the editing, screening, matching, and consolidating tasks.  If the record is deemed non-
reportable, it is used for passive follow-up.  If the record is deemed reportable and a registrar 
confirms that it matches a cancer/tumor/case (CTC) in the system, it is linked to the CTC and 
consolidated into the patient set data.  If the death certificate record indicates a new reportable 
tumor, an effort will be made to create an abstracting assignment for the case.  This involves 
identifying a facility in order to obtain an abstract, or following back with the physician associated 
with the death certificate.  System reports in SEER*DMS can be used to determine when follow-
back is required, and identify the appropriate source of follow-back. 

Finally, the remaining reportable death certificate records can be used to create death certificate 
only (DCO) cases.  SEER*DMS provides system reports enabling you to monitor the percentages of 
death certificate only CTCs submitted each year. 

In this chapter, you’ll learn about 

• Death Clearance and SEER*DMS 

• Performing Death Clearance Follow-back 

• Reports Related to Death Clearance 

• Using the Death Clearance Summary Report (RPT-019A) 

• Building DCO Cases 

• Monitoring Death Certificate Only Levels 

Death Clearance and SEER*DMS 

The steps involved in performing death clearance using SEER*DMS are: 

1. The death data received from a state agency are loaded into SEER*DMS (see Chapter 5: 
Importing Data Files for more information). 

2. Each record enters the workflow.  Once it moves through registry coding and edit checks, 
it is screened for reportability.  If the record is not reportable, it is used for the purpose of 
follow-up and is not directly involved in Death Clearance processes.  If the record is 
reportable, SEER*DMS compares the facility coded on the reportable death certificate 
record to organizations in the Facility List.   

a. If the facility coded on the record is an organization in the SEER*DMS Facility table and 
that facility meets registry-defined criteria, an AFL is created.  For example, some 
registries only have an AFL created if the facility is a hospital or hospice.  Please consult 
your registry’s workflow diagram to determine the exact criteria used in your registry. 

b. An AFL is not created if the facility coded on the death certificate record does not meet 
the registry-defined criteria.  The case will be tracked via Death Clearance reports.  
External procedures will be used to identify and contact a physician or facility to obtain 
more information. 

3. The death certificate record moves to the matching task in the workflow.  A manual Match-
Consolidate task will be created for nearly all reportable death certificate records.  
Reportable death certificate records only exit matching automatically if the auto-match 
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does not find any matches in the database.  Keep in mind that the weighted matching 
algorithms are often loose and will find “possible” matches based on soundex and other 
criteria.  Tasks related to the current reporting year should be completed prior to 
performing subsequent Death Clearance processes. 

a. If you determine that one or more items in the list of Matches contain data for the same 
patient as the death certificate record, click Consolidate.  Proceed with step 4.   

b. If there are no other data for the patient, click No Matches.  The death certificate record 
will exit the workflow. It will be retained in the database, waiting to be processed via 
Death Clearance procedures.  Allow this record to remain in the database as an 
unlinked record until the weeks prior to submission. Hopefully, the Death Clearance 
processes will yield an abstract.  If an abstract cannot be obtained in time for 
submission, you will use the record to build a death certificate only CTC.   

4. Consolidate the data in the normal fashion, as described in Chapter 12:  Consolidating 
Data.  The following describes considerations specific to the consolidation of reportable 
death certificate records. 

a. If the death certificate record represents a new cancer for the patient: 

i. Link the record to the Patient Set at the patient level (“P”).  Do not create a new 
CTC from this record at this time.   

ii. Consolidate the follow-up data into the patient set: vital status, date of last contact, 
causes of death, etc.   

iii. Because the record is not linked to a CTC, it will continue to be monitored via 
reports and other mechanisms related to Death Clearance.  As described in step 2 
above, there will either be an AFL associated with the record or follow-back 
procedures will be required.  This record will be listed on the Death Clearance 
Summary Report (RPT-019A). If an abstract cannot be obtained in time for 
submission, use the record to create a death certificate only CTC. 

b. If the death certificate data pertains to an existing CTC: 

i. Link the record to the CTC.   

ii. Consolidate the follow-up and cancer data into the patient set and CTC.     

iii. If an abstract record from the same facility is linked to the CTC, no further 
processing is required.  If there is no abstract from the same facility linked to the 
CTC and there is an AFL, the AFL will remain open.  If you determine that an 
abstract is not needed, you may manually close the AFL.   

iv. This record will not require any further processing related to Death Clearance. 

5. The goal is to link each reportable death certificate record to a CTC as a non-DCO case (in 
other words, to a CTC which includes abstract data).  To achieve this goal for as many 
records as possible, use the tools described below.  

a. Worklist Filters - Find and assign worklist tasks related to death certificate records for 
the current reporting year.  Completing these tasks will yield some linkages and reduce 
efforts in subsequent steps related to AFLs, abstracting, and follow-back.  

b. AFL Manager – Assign death certificate AFLs to an abstractor.  Once the abstracted data 
are received, load the abstract records into the system.  SEER*DMS will match the 
imported abstract records against the AFLs and auto-close matching AFLs.   

17-2 8/15/2007  SEER*DMS User Manual  



c. Death Clearance Reports – Use the SEER*DMS Death Clearance Reports to monitor 
reportable death certificates that are not linked to a CTC.  Throughout the year, the 
number of records should decrease as you complete worklist tasks and receive 
abstracts.  Pay particular attention to death certificates that are not associated with an 
AFL.  Per registry policies and procedures, these records may require follow-back to the 
physician or facility.   

d. External Reports and Letters – Generate registry-specific physician letters, hospital 
listings for death clearance follow-back, and other registry-defined reports and letters. 

6. If all data sources are exhausted and the only source of information about the cancer is 
from the death certificate, a patient set with limited information can be created from the 
death certificate.  In SEER*DMS, you can build a CTC from a death certificate record that 
indicates a reportable cancer and does not match an existing CTC.  For more information, 
see the Building DCO Cases section of this chapter. 

Performing Death Clearance Follow-back 

If an abstract is required but an appropriate facility could not be identified for the abstracting 
assignment, you should seek information to identify a facility or obtain additional data related to 
the case.  Typically, this involves sending a letter and/or questionnaire to the physician who signed 
the death certificate.  The letters and questionnaires are implemented in an external report; this 
implementation provides registry staff with complete control over the initial design and subsequent 
modifications. 

To create a letter addressed to a physician, the external report must be able to associate a 
physician in the Contacts List with data in the death certificate record.  This involves matching a 
value in the record to the Contact List using the physician license number, National Provider ID 
(NPI), or other identifier.  A physician letter cannot be generated if any of the following situations 
occurs: 

1. The physician indicated on the death certificate does not exist in the Contacts List.  This 
problem can be resolved by adding the physician to the Contacts List. 

2. The physician’s entry in the Contact List contains a blank or incorrect value for the 
identifier used to match death certificate records to physicians.  Consult registry 
management to determine which field is being used and set the appropriate value. 

3. The physician field on the death certificate record was missing or unknown.  If possible, 
review the image of the death certificate and attempt to identify the physician. 

SEER*DMS provides a system report, RPT-020A, to identify death certificate records that require 
follow-back. The report includes an option to limit the report to records with one of the problems 
described above (this report assumes physician license number is used for matching; registry IT 
staff may create an external, custom-version of this report to use a different field).  To automate 
the process as much as possible, review the report and resolve the issues described above, when 
possible.     

When a response to the follow-back inquiry is received, the new information should be processed 
according to registry guidelines.  If you receive data items that you would like to store in the 
database, you may either enter the data into a new record or into a patient set created from the 
death certificate record (as described below in Building DCO Cases).  If a facility can be identified 
for the purposes of obtaining an abstract, an Abstract Facility Lead should be created and assigned 
to an abstractor. 
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Reports Related to Death Clearance 

SEER*DMS includes the following system reports related to DCO cases.  If you require additional 
information regarding death certificate data, you may generate an external report.  See Chapter 
24:  Creating Reports and Extracting Data and SEER*DMS Data Dictionary for more information. 
 
Report ID Title Description 
RPT-019A Death Clearance Summary A listing of all unlinked, reportable death 

certificate records. This report indicates the 
status of each record in terms of workflow 
activity and AFLs. 

RPT-020A Death Certificate Records 
that Require Follow-back 

A list of the death certificate records that 
require follow-back; a parameter allows you 
to select only those for which follow-back 
letters cannot be auto-generated because of 
missing physician information. 

RPT-068B Frequency of Records for the 
Build DCOs System Task 

Number of records, by facility, that will be 
built into DCO cases by the Build DCO 
System Task. 

RPT-068C Candidate Records for the 
Build DCO System Task 

A list of the records that may be built into 
DCO cases.  These are the records that 
would be used to build a CTC if you ran the 
Build DCO task. 

RPT-119A Death Certificate Only CTCs, 
by Year of Diagnosis 

Frequencies and percentages of CTCs that 
are DCO by year of diagnosis. The early 
years can be collapsed into one year range 
(typically thru 1972). 

RPT-119B Death Certificate Only CTCs 
by Source 

List of the death certificate only CTCs in the 
patient set data.  These are listed by source 
(facility, physician, or medical examiner). 

 

Using the Death Clearance Summary Report (RPT-019A) 

The Death Clearance Summary Report lists all reportable death certificate records that are not 
linked to a CTC.  Use this report to monitor death certificate records which require processing.  The 
report shows the status of the record in terms of its location in the workflow and AFLs.  The 
following columns are displayed: 

• WT – Worklist Task.  If the death certificate record is the focus of a worklist task, the type 
of task will be indicated here.  This column will be blank if the record has exited the 
workflow. 

• DC Record – The Record ID of the death certificate record. 

• Patient ID – If the record is linked to a Patient Set, the ID is listed.  If this column is blank, 
the record is not linked to a Patient Set. 

• AFL – ID of the AFL created by the death certificate record. 

• Closing Rec – The ID of the record that closed the AFL.  This would typically be an abstract 
record or a Short Health record. Other record types may close AFLs in some registries. 
Please consult your registry’s workflow diagram for more information. 

• Name – Patient name. 

• SSN – Social Security Number. 
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• DOB – Date of birth. 

• DC # - Death certificate number. 

• DOLC – Date of death. 

• COD – Primary cause of death. 

• FAC – Facility coded on the death certificate record. 

• ST – State of death. 

It is recommended that you use CSV format for the report.  This will allow you to sort and subset 
the results in Excel.  In addition, you will be able to copy-and-paste Record IDs or AFL IDs into the 
Patient Lookup, AFL Manager, or Worklist filter.   

Considerations when reviewing the Death Clearance Summary Report: 

1. Review records where AFL is listed as closed and consider the following possibilities: 

a. A Record ID is not listed in the Abstract column.  This indicates that the AFL was closed 
manually.  You should use the AFL Manager to open the AFL.  Review the AFL Result 
field.  If it was set to Abstracted when the AFL was closed, you should search to see if 
there is truly an abstract.  Add a comment to the AFL to document your findings.  If the 
death certificate is inappropriately designated as reportable, change the AFL Result to 
“Not a Reportable Cancer”.  The record’s reportability status will be updated. 

b. A Record ID is listed in the Abstract column.  This indicates that an abstract record 
entered the workflow and closed the AFL associated with the death certificate record.   
The death certificate record is listed on this report because it is not linked to a CTC.  
However, it may be a matter of timing.  The Abstract record may be in the workflow.  
The two records will be consolidated when the abstract’s task is completed.  Search for 
these abstracts in the Patient Lookup.  A View link will be listed if the record is involved 
in a worklist task. 

2. Review records where a Task ID is listed in the WT (Worklist Task) column.  These are 
death certificate records for the current reporting year with outstanding worklist tasks.  
These efforts are being monitored and tracked in the worklist.  You have the option of 
excluding these from this report, if you wish.   

3. Review records where AFL is listed as open.  These records are being monitored and 
tracked via the AFL Manager.  You have the option of excluding these records from the 
report, if you wish. 

4. Review the records where AFL and WT columns are blank.  These are reportable death 
certificate records which are not in the workflow and are not associated with an AFL.  You 
must generate follow-back reports and letters to obtain further information about these 
cases. 

Building DCO Cases 

Requires system permission:  rec_build_cfo 

Once Death Clearance procedures have been completed, you may determine that one or more 
Death Certificate Records should be submitted to SEER or other sources as death certificate only 
(DCO) cases.  Follow the instructions provided below to create a CTC from an individual record.  
Alternatively, use the Build DCO system task to create CTCs from a set of records (see Chapter 27: 
System Administration for instructions).  Whether using the system task or the record editor, a 
record can only be used to create a DCO case if it is a reportable record, is not the source of an AFL 
that is closed, and is not in the worklist.   
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If the record is not linked to an existing patient set, a new patient set will be created.  If the record 
is linked to a patient set but not to a CTC, a new CTC will be created within the patient set. 

To build a DCO case from an unlinked death certificate record: 

1. Open the record in the record editor. 

2. Select Build Patient Set from the record menu.  This menu item is only available if the 
record is unlinked and you have the rec_build_dco permission.  If a patient set cannot be 
built from this record, an error message will be displayed at the top providing the reason 
(the record is either in the worklist or is the source of a closed AFL). 

3. Click OK to confirm. 

4. SEER*DMS will create an automated workflow task to create a patient set.  When the task 
completes, a Visual Edit Patient Set task related to the new patient set will be assigned to 
you. 

To build a DCO case from a record linked to a patient set: 

1. Search the database for the death certificate record or its associated patient set.  You may 
enter the Patient Set or Record ID into the quick search, or click View > Patients to use 
the Patient Lookup.  (See Chapter 20:  Searching for Patients and Records.) 

2. Verify that the record is not already linked to a CTC.  If it is linked at the patient level, you 
may proceed.   

3. Click the ID of the record in the patient set navigation box.   

4. Select Move To > New CTC from the record’s menu.   

5. SEER*DMS will create a new CTC; you may proceed with visual editing. 

Monitoring Death Certificate Only Levels 

Requires system permission:  reports 

A SEER*DMS system report is available to analyze the results of death clearance.  Report 119A 
shows the frequencies and percentages of death certificate only CTCs by year of diagnosis.   

To create a report of your registry's death clearance rate: 

1. Select View > Reports.   

2. Enter 119A in the search box. 

3. Open report specifications page for RPT-119A. 

4. If you are monitoring DCO cases for the purposes of a SEER submission, set the Select 
parameter to SEER-Reportable Only. 

5. The report includes a row of data for each year of diagnosis.  If you are only interested in 
more recent years, combine the early years into one year range by entering a value for 
the Group Years Through parameter.  For example, enter 1972 to display a single row 
for the range of years prior to 1973. 

6. Click Run or Run Offline.  (Please refer to Chapter 24: Creating Reports and Extracting 
Data for specific instructions related to running reports and viewing report output.) 
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Chapter 18:  The Facility List 

SEER*DMS maintains information about organizations and facilities that collaborate with the cancer 

registry.  The facility list includes the registry itself, organizations that provide data to the registry, 

and those receiving data or other information from the registry.  Each organization is uniquely 

identified by a Facility ID.  The list is referenced throughout SEER*DMS to set facility information in 

data fields, track sources of data, manage abstracting assignments, and provide a mechanism for 

follow-back. 

You can use the Facility Manager to view or manage the facility list.  The Facility Lookup, available 

throughout the system, provides a convenient mechanism for setting data fields.  If you have the 

appropriate permission settings, you can add facilities using either the manager or the lookup. 

In this chapter, you’ll learn about 

 Accessing the Facility List 

 Searching the Facility List 

 Adding a Facility  

 Modifying Facility Information 

Accessing the Facility List 

Requires system permission: facility_view 

To view a list of the facilities defined in SEER*DMS, select View > Facilities.  All active facilities 

will be displayed.  You may use the filter to find a specific facility or to view a list of facilities 

meeting your search criteria.  The filter is described in the Searching the Facility List section of this 

chapter. 

The following data columns are shown. 

 T – Type of facility (see the list of icons provided below). 

 ID – The unique “Facility ID” assigned when the facility was added to SEER*DMS.  “FAC” is 

used as a prefix for facility IDs. 

 Name – The name of the facility. 

 Address – The street, city, state, and postal code designated for the facility. 

 Phone – The phone number and extension provided for the facility. 

 Area – Displays I for in area and O for out of area.  The definitions of "in area" and "out of 

area" are determined by registry policy.   

 S – The status field indicating whether the facility is active or inactive (see the list of icons 

provided below).  

The T column displays each facility’s Type: 

 Clinic 

 Doctor Office 

 Hospital 

 Lab 

 Nursing Home 

 Organization 

 Radiation Therapy Unit 

Treatment Center 
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No icons are currently used for: 

      Hospice 

      Medical Examiner’s Office 

      Other Facility 

The S column displays the Status of each facility: 

  Active 

  Inactive (inactive facilities are displayed if Hide Inactive is unchecked) 

Typically, the list will contain too many results to fit on the screen all at once and will be broken 

into several pages. Use the Page Selection links to view the rest of the list, or use the Filter 

controls to search or limit the list. 

Searching the Facility List  

Requires system permission: facility_view 

To search for a facility: 

1. Select View > Facilities.  Active facilities will be listed in alphabetical order.  Hide 

Inactive will be checked by default when you first go to the Facility Manager. 

2. To sort the list by a field other than name, click one of the underlined column headers 

(you cannot sort by address).  To reverse the sort order, click the same header again.   

Tip:  In SEER*DMS, the sort order of a table is indicated by the column headers.  A unique 

color is used for the sort field’s column header.  An up arrow will be displayed next to the 

column name if the table is sorted in ascending order; a down arrow will be displayed if 

the table is sorted in descending order.   

3. To search for a facility by its SEER*DMS ID, enter search text into the FAC-ID(s) filter.  

To enter multiple IDs, click the down arrow  to expand the filter. 

4. Use the Text filter to search for a facility by name, address, National Provider ID (NPI), 

CoC Facility Identification Number (FIN), Facility Association Number (FAN), or Facility 

Identifiers used to refer to a SEER*DMS facility by other organizations. 

5. To only search the list of active facilities, check Hide Inactive.  Uncheck this box to 

include the inactive facilities in your search.  

6. Check Hide Out of Area to search for facilities that have been classified as “in area”; 

uncheck this box to search for facilities regardless of their area classification. 

7. To search for facilities of a specific type(s), select one or more items in the Type(s) filter. 

8. Click Apply.  

9. To view a snapshot of the facility’s information, click the information icon  next to the 

facility ID.  To modify fields or to view all fields, click the associated ID or edit link (these 

links will only be available if you have the contact_edit system permission). 

10. To do another search, you may return the filter to its default settings by clicking Reset.  

11. To send a message to the facility’s email address, click the email link in the Action 

column (this link will only be available if an email address is defined for the facility). 
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Adding a Facility  

Requires system permission: facility_add 

Facilities are typically added or modified using the Facility Manager (accessed from the View > 

Facilities menu).  Hospitals and other facilities can also be added or modified while editing data or 

using other parts of the system.  The Facility Lookup  is used throughout SEER*DMS to set a data 

field or filter. If you have the appropriate permissions, you can add or modify a facility while using 

the lookup. 

The Facility Lookup will include an Add button if the user has the facility_add permission; the 

lookup will include an edit link next to each facility if the user has the facility_edit permission. 

To add a facility in SEER*DMS: 

1. Select View > Facilities.  Or if you are visually editing and need to enter an organization 

that is not currently a SEER*DMS organization, click the lookup icon  next to the data 

field to open the Facility popup window. 

2. Click Add (this button will only be shown if you have the facility_add permission). 

3. If your registry requires a specific Facility ID for this facility, enter it into the FAC-ID field.  

Otherwise, an ID will be auto-generated when the new facility is saved. 

4. Enter Facility Name and select the appropriate Facility Type.   These fields are required. 

5. Enter the CoC Facility Identification Number in the FIN field, if known. 

6. Enter the National Provider Identifier in the NPI field, if known. 

7. Verify that the Active box is checked (default setting). 

8. Enter information into the Contact Information section: 

a. Primary, Alternate and Casefinding Contacts.  For these fields, SEER*DMS will only 

allow you to select persons in the Contact List who are designated as an affiliate of the 

facility.  No contacts in the Contact List could possibly be affiliated with this facility 

because the facility has yet to be saved.  Therefore, you cannot specify primary, 

alternate, or casefinding contacts at this time.  Once the organization is saved, you may 

designate people in the Contact List as affiliates of this facility (see Chapter 19: The 

Contact List).  You will then be able to set the facility’s contact fields by following the 

instructions below in Modifying Facility Information.  The facility’s contact fields are not 

used by SEER*DMS, but are available here for your convenience when contacting the 

organization. 

b. Enter information the facility’s email address, phone, postal address, and geographical 

location in the appropriate fields. 

c. You may enter a Web Address, if desired. 

9. The remaining data fields are described in detail in the Modifying Facility Information 

section of this chapter.  After following the instructions provided there, click Save to 

create the new facility.  
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Modifying Facility Information 

Requires system permission: facility_edit 

The following are instructions for modifying all data items related to a facility.  If you are setting a 

facility’s Primary, Alternate, or Casefinding contact, the contact must first be defined in the Contact 

List as an affiliate of this facility.  Use the Contact Manager (select View > Contacts) to verify that 

the contact is affiliated with this facility (see Chapter 19: The Contact List). 

To modify a facility: 

1. Select View > Facilities.  

2. Use the Filter to search for the facility: 

a. To search for a facility by its SEER*DMS ID, enter search text into the FAC-ID(s) filter.  

To enter multiple IDs, click the down arrow  to expand the filter. 

b. Use the Text filter to search for a facility by name, address, National Provider ID (NPI), 

CoC Facility Identification Number (FIN), Facility Association Number (FAN), or Facility 

Identifiers used to refer to a SEER*DMS facility by other organizations. 

c. To only search the list of active facilities, check Hide Inactive.  Uncheck this box to 

include the inactive facilities in your search.  (If you are modifying a facility that is 

designated as “inactive”, you should correct the status setting.) 

d. If you know the facility’ type, you may select it in the Type(s) list box. 

e. Click Apply.   

3. Click the ID of the facility to be modified. 

4. Update the fields identifying the facility, as needed. 

a. Facility Name and Type are required fields. 

b. CoC Facility Identification Number is stored in the FIN field. 

c. The National Provider Identifier is stored in the NPI field. 

5. Verify that the Active box is checked for current Facilities.  Uncheck this box to deactivate 

the Facility.  If unchecked, the Inactive Date will be set to today’s date.  SEER*DMS 

Facilities are permanently maintained in the database.  Inactive facilities can not be 

selected as the source facility in an import or as a source of follow-back.  However, the ID 

of an inactive facility can be entered into a hospital or facility data field in patient data.    

6. Update fields in the Contact Information section: 

a. To specify the Primary or Alternate contact, click the corresponding Lookup link. Use 

the filter to find and select the contact. You will be able to select from entries in the 

Contacts table which are affiliated with this facility. 

b. Enter information the facility’s email address, phone, postal address, and geographical 

location in the appropriate fields. 

c. You may enter a Web Address, if desired. 

7. Enter information into the Facility Information fields: 
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a. If you wish to track cost and logistical information related to visiting the facility, enter 

the Cost to Visit ($), Mileage from Registry, Season to Visit. 

b. Select the appropriate value for the Veteran’s Administration (VA) flag.  External 

extracts can access this flag in the NAACCR mart.  System extracts use the following 

logic when interpreting this flag:  

i. Not a VA Facility – do not exclude a CTC from an extract if it includes an 

admission from a non-VA facility. 

ii. VA Only Facility – exclude data from an extract if the VA exclusion is used and 

all data are from this facility, other VA Only Facilities, or facilities designated as 

“Does not Override VA”. 

iii. Does not Override VA – use this setting if the facility is not a VA facility, but its 

data should not impact the VA exclusion criteria for extracts.    

c. Check Out of Area, if appropriate.  This field may be used to identify organizations that 

do not serve the catchment area or to track other boundaries of interest to the registry.  

d. Check Under Contract if the organization is a contract facility. 

e. If you expect to receive data in specific file formats and wish to track this information, 

specify the information in the Rec. Type Expected field.  Click Add Rec Type to 

specify multiple record types. 

8. If the facility’s type is set to Hospital, update fields in the Hospital Information section.  

Registry-defined configuration settings and algorithms determine whether these fields are 

used by SEER*DMS.  They may also be used in system reports, external reports, or other 

external processes.  Consult with registry management to determine if these fields are 

maintained in your registry. 

a. FAN - Facility Association Number. 

b. Bill/Abstract ($) – Cost billed for each abstract record. 

c. Subm Schedule – You may enter text that describes how often you expect data from 

the hospital (e.g., quarterly, monthly, etc). 

d. Reporting – You may use this field to track whether the facility is required to report 

data to the registry.   

e. Report to State - You may use this field to track whether the facility is required to 

report data to the state.   

f. ACOS – Check this field if the hospital is an American College of Surgeons facility. 

g. Tumor Registrar – Check this field if the hospital is a hospital-based tumor registry.  

This field should be checked if a Reference Date is provided. 

h. Reference Date – Hospital-based registries are required to have complete data for 

cases diagnosed on or after this date.  A date should be provided if Tumor Registrar is 

checked. 

9. If you wish to track relationships between organizations, add facilities to the Affiliated 

Facilities list: 

a. Click Add Affiliation in the Facility Affiliations section. 

b. Use the  lookup to select a facility. 
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c. To remove a facility from the list, click the  remove icon next to the facility. 

10. To add a new casefinding contact: 

a. Click Add Contact in the Casefinding Contacts section (not available when adding a 

facility). 

b. Use the  lookup to select a representative who will perform casefinding activities at 

this organization.  You will be able to select from entries in the Contacts table which are 

affiliated with this facility. 

c. You may enter the Department and Location within the organization where this 

person will be casefinding, if appropriate. 

d. To remove a casefinding contact from the list, click the  remove icon adjacent to it. 

11. A facility may be referenced in data submitted by another facility.  The referring facility 

may have its own set of facility codes or IDs. For example, codes identifying hospitals may 

be included in data from a pathology lab.  Use the Facility Identifiers section to define IDs 

used by one facility to refer to another: 

a. Click Add Identifier in the Facility Identifiers section. 

b. Use the  lookup to select a Facility that provides data related to the facility that you 

are currently editing.  (In the example described above, this would be the facility ID of 

the pathology lab.) 

c. Enter the code in the Facility Identifier box.  This is the code or ID used in data to 

reference the facility that you are currently editing. 

d. To remove an entry, click the  remove icon next to the Facility Identifier. 

12. Use the Registry-defined Fields section to define other attributes of any kind.  You may 

use these fields in external reports and utilities that access the database.  In some 

registries, a Registry-defined Field may be used in automated worklist tasks.  A field is 

defined with “key = value” syntax.   

a. Click Add a field in the Registry-defined Fields section. 

b. Enter text for the Key.  The Key must meet specifications defined by the person 

responsible for the report or query that uses this field.  

c. Enter the appropriate Value as defined by the specifications for the report or query 

using this field. 

d. To remove an entry from this list, click the  remove icon next to the field’s Value. 

13. If your registry has a data exchange agreement with the facility, check the box for Data 

Exchange Agreement.  To enter or update the information about the DEA: 

a. Enter the date that the data exchange agreement went into effect in Start Date. 

b. Enter the End Date for the data exchange agreement. 

c. Use the Transfer Format, Transfer Schedule, Incoming Info, Outgoing Info, and 

Comments to track information according to your registry’s guidelines. 

14. Click Save. 
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Chapter 19:  The Contact List 

SEER*DMS maintains system IDs, contact information, and professional affiliations for physicians, 

representatives of collaborative organizations, and other individuals.  These data are used to 

support numerous tasks and processes; therefore, the maintenance of a current and complete 

Contact List is essential.  The data in the Contact List are used by SEER*DMS to code physician 

data fields on incoming records.  The reporting engine uses contact IDs to identify physicians for 

follow-back letters, follow-up letters, and reports.  Users access the Contact List throughout 

SEER*DMS to set physician information in data fields and associate organization representatives 

with data sets or queries.  For example, contacts are used to assign a follow-up physician or 

surgeon during visual editing, to set the data source for an import, and to send queries to 

organization representatives during follow-back. 

There are three system permissions which control access to the Contact List:  contact_add (create 

a new contact), contact_edit (modify existing contacts), and contact_view (read only access to 

Contact List data). 

In this chapter, you’ll learn about 

 Medical Practitioner and Organization Representatives 

 Searching the Contact List 

 Adding or Modifying a Contact 

Medical Practitioner and Organization Representatives 

SEER*DMS enables you to designate a contact as a “Medical Practitioner” and/or a representative 

of a facility.  The Medical Practitioner designation and facility affiliations must be properly 

maintained to ensure that current data are available in lookups  used throughout SEER*DMS.  

 Medical Practitioner – You must designate a contact as a Medical Practitioner in order to 

use the Contacts  lookup to enter the ID into a physician or surgeon data field. 

 Facility Affiliations – A contact may be associated with one or more facilities.  In some 

screens, SEER*DMS will prompt for a representative of a specific facility.  For example, 

when sending follow-back you are required to select a person affiliated with the facility 

designated for the follow-back bundle.    

Searching the Contact List 

Requires system permission: contact_view 

To search or view the Contact List: 

1. Select View > Contacts.  Active contacts will be listed in alphabetical order by last name. 

2. To sort the list by the data in another column, click one of the underlined column headers 

(you cannot sort by fields such as address or phone number).  To reverse the sort order, 

click the same header again.   

Tip:  In SEER*DMS, the sort order of a table is indicated by the column headers.  A unique 

color is used for the sort field’s column header.  An up arrow will be displayed next to the 

column name if the table is sorted in ascending order; a down arrow will be displayed if 

the table is sorted in descending order.   

3. To search for a contact by their SEER*DMS ID, enter search text into the PER-ID(s) filter.  

To enter multiple IDs, click the down arrow  to expand the filter. 
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4. To search for a contact by name, National Provider ID (NPI), Physician License number, 

address, academic degrees, position, or address enter search text into the Text filter 

(partial names and IDs can be used). 

5. Use the Fac-ID(s) filter to search for contacts based on facility affiliations.  Enter an ID or 

use the  lookup to select a facility.  You may enter multiple IDs separated by a space. 

6. Check Physicians Only to search for contacts who are designated as Medical 

Practitioners. 

7. Check Hide Inactive to search for contacts who are designated as active; uncheck this 

box to search for contacts regardless of their status. 

8. Click Apply. 

9. To view a snapshot of the contact’s information, click the information icon  next to the 

contact’s ID.  To modify the Contact’s data or view all fields, click the associated ID or 

edit link (these links will only be available if you have the contact_edit system 

permission). 

10. To send an email message to the Contact, click the email link in the Action column (this 

link will only be available if an email address is defined for the Contact). 

The T (Type) column identifies contacts designated as Medical Practitioners: 

    Medical Practitioner 

The S column displays the Status of each contact: 

    Active 

     Inactive (inactive contacts are displayed if Hide Inactive is unchecked) 

Adding or Modifying a Contact 

Requires system permission: contact_add or contact_edit 

Contacts are typically added or modified using the Contact Manager (accessed from the View > 

Contacts menu).  Physicians can also be added or modified while editing record or patient set 

data.  The Contacts  Lookup associated with physician and surgeon data fields enables editors to 

add new physicians to the Contact List.  The newly created ID may then be set in the data field.  

The Contacts popup will include an Add button if the user has the contact_add permission; the 

popup will include an edit link next to each contact if the user has the contact_edit permission. 

To add or modify a SEER*DMS contact: 

1. Select View > Contacts.  Or if you are editing record or patient set data, click the 

Contacts  Lookup for the appropriate data field. 

2. To create a new contact, click Add (this button will only be shown if you have the 

contact_add permission).  To modify an existing contact, follow the instructions in the 

Searching the Contact List section of this chapter to find the contact.  Click the edit link 

associated with the contact. 

3. Enter information into the fields identifying the contact (Title, First Name, Middle 

Name, Last Name, Suffix, and Position).  First Name and Last Name are required.   
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4. Verify that the Active box is checked for current Contacts.  Uncheck this box to deactivate 

the Contact.  If unchecked, the Inactive Date will be set to today’s date.  SEER*DMS 

Contacts are permanently maintained in the database.  The contact’s ID may have been 

used to code a physician data field.  Therefore, you cannot delete a contact but you should 

deactivate contacts who retired or are no longer affiliated with the registry.  SEER*DMS 

will not allow communications to inactive contacts.  However, SEER*DMS does allow you 

to enter the ID of an inactive Medical Practitioner in a data field.     

5. Enter values for the fields in the Contact Information section, as described below. 

a. If known, set the appropriate value for preferred contact Method.  You are required to 

provide the corresponding information for the selected method, e.g., if e-mail is the 

preferred method of contact then a valid e-mail address must be provided.  The contact 

method will be used as the default in SEER*DMS communications to this individual. 

(The user initiating the communication will be able to select an alternate method, if 

desired.) 

b. If the contact prefers to be contacted at a certain time of day, set it in the preferred 

contact Time.  SEER*DMS will display this information on the communication page, if 

Phone is selected as the method of contact for the communication.  

c. Phone, FAX, E-mail, and postal address fields are used for SEER*DMS 

communications throughout the system, e.g., to send a follow-back query.  Enter 

information for each communication method that you wish to allow for this contact.  For 

example, if you wish to allow SEER*DMS users to send queries to this contact via e-mail 

then you must specify an e-mail address.  SEER*DMS does not provide a method for 

encrypting e-mail messages, therefore communications that involve confidential data 

cannot be sent via e-mail.  If this contact is to receive confidential information, you 

must specify a mailing address, fax number, or phone number. 

d. Supplemental address – use this data item to store other information related to 

address such as the name of a place or facility, a nursing home, or the name of an 

apartment complex. 

e. Additional – use this data item as specified by registry policies.  For example, it may 

be used to store information defining a region or island. 

f. You may enter a Web Address, if desired. 

6. Enter values for the fields in the Roles section, as described below. 

a. Select the appropriate value for Abstractor.  This field is used in lookups that provide a 

list of the abstractors and system reports that monitor abstractor activity.   

b. If the contact is an editor, check the Editor box.  This field is not used by SEER*DMS, 

but may be used by external reports and queries defined by registry staff.  Consult with 

registry management to determine whether this field is used in your registry.   

7. If this contact is a physician, check the Medical Practitioner Designation box.  This 

designates the contact as a medical practitioner regardless of whether you provide 

professional credentials and specialties.  Once a contact is saved as a medical practitioner, 

the designation can never be changed.  Contacts with this designation are available in the 

“Medical Practitioners” lookup that is used to select a physician while editing a record or 

patient set.  Note:  you must designate the contact as a Medical Practitioner in order to 

enter the contact in a physician or surgeon data field. 

8. To define professional credentials and specialties for a medical practitioner:  
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a. Enter Physician License, Academic Degrees, and National Provider ID (NPI), if 

known.  Physician License and NPI may be used in automated worklist tasks.  Consult 

registry management to determine whether these fields are required in your registry. 

b. To add a specialty, click the Add Specialties link.  Select a specialty from the drop-

down list.  This field is not used by SEER*DMS, consult with registry management to 

determine whether the field is required in your registry. 

c. To remove a specialty, click the  remove icon. 

9. Create a list of the facilities to which this contact is associated.  The contact’s Facility 

Affiliations must be set to ensure that users can find this contact when using Contact  

lookups throughout SEER*DMS. 

a. Click Add Facility in the Facility Affiliations section. 

b. Use the  lookup to select a facility. 

c. The primary affiliation will default to the first facility that you added.  Check the button 

in the Primary column to change the value as necessary. 

d. To remove a facility from the list, click the  remove icon next to the facility. 

10. A facility that submits data to the registry may have their own set of IDs for physicians 

and other persons specified in coded data fields.  In some registries, this information is 

used by SEER*DMS in the automated registry-specific coding task.  Use the Facility 

Identifiers section to define IDs that other facilities may use for this contact.   

a. Click Add Identifier in the Facility Identifiers section. 

b. Use the  lookup to select a Facility. 

c. Enter the ID used by the facility in the Facility Identifier box. 

d. To remove an entry from this list, click the  remove icon next to the Facility 

Identifier. 

11. Use the Registry-defined Fields section to define other attributes of any kind.  You may 

use these fields in external reports and utilities that access the database.  In some 

registries, a Registry-defined Field may be used in automated worklist tasks.  A field is 

defined with “key = value” syntax.   

a. Click Add a field in the Registry-defined Fields section. 

b. Enter text for the Key.  The Key must meet specifications defined by the person 

responsible for the report or query that uses this field.  

c. Enter the appropriate Value as defined by the specifications for the report or query 

using this field. 

d. To remove an entry from this list, click the  remove icon next to the field’s Value. 

12. Click Save to save all changes and exit the Contact page. 
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Chapter 20:  Searching for Records and Patients 
SEER*DMS provides four search tools to users who have system permissions to view patient data:  
the quick search using the Lookup toolbar and the three Patient Lookup tabs.   

Use the Lookup box in the user toolbar to search by a single data field (Patient Set ID, Record ID, 
AFL ID, Import ID, date of birth, name, or SSN).  Use the Patient Lookup to create a search based 
on multiple search fields (the Patient Lookup can be accessed by selecting View > Patients in the 
SEER*DMS menu).  The Patient Lookup’s Standard Search is based on a limited number of 
personal identifiers, but can be used to search for patient data in unlinked records as well as data 
consolidated into patient sets.  The Advanced Search allows you to define more robust search 
criteria based on a large number of patient set data fields.  However, the Advanced Search is 
limited to patient set fields and does not consider the values in record data fields.  The Patient 
Lookup’s ID Search allows you to search for a set of records and/or patient sets using one or more 
Patient/Record IDs, a single Import ID, or a single Special Study ID.  

The Standard Search provides a way to find all available data related to a specific patient.  The 
Advanced and ID Searches enable you to review a particular set of records or patient sets or to 
review a sample of data for research or quality control purposes. 

Once you find the data of interest, you may view or edit the data in the record or patient set editor.  
However, you must take precautions to ensure that you do not edit data that are being processed 
by others.  To avoid the loss of effort, you should verify that the data are not involved in worklist 
tasks and are not being edited by another staff member (please refer to the Direct Editing of 
Records and Patient Sets section of this chapter for more information).   

In this chapter, you'll learn about 

• Standard Search 

• ID Lookup 

• Advanced Search 

• Search Results 

• Quick Search 

• Direct Editing of Records and Patient Sets 

Standard Search 

Select View > Patients to access the Patient Lookup.  The Standard Search tab will be displayed 
as shown below.  The Standard search enables you to search for a patient’s data based on personal 
identifiers (name, DOB, SSN, Sex, Race).  The Data Type, Facility, and Exclude criteria can be used 
to limit the search to a subset of data in the database. 
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Search Fields on the Standard Search Tab 

SEER*DMS uses registry-specific matching algorithms to compare the patient information specified 
in the Standard Search to patient sets and unlinked records in the database (see the SEER*DMS 
Technical Reference for details).  A weighted matching scheme may be implemented in the 
registry-specific algorithm.  In weighted matching, a score calculated for each possible match 
provides a mechanism to sort the results by the likelihood of the match.  Entering multiple 
identifiers quickens the search and increases the score of true matches.  It is recommended that 
you enter information into as many fields as possible or enter a unique identifier, such as Social 
Security Number.  If searching for a patient with a common name, it is particularly important to 
enter values into as many search fields as are known.  

The Standard search fields are listed below.   

• Name (L,F,M) – Three search fields are provided for searching by patient name.  You may 
enter a full or partial name in any or all of the boxes.  The boxes are displayed in the order 
of last name, first name, middle name.  However, you may enter “Last, First” into the first 
box.  SEER*DMS will automatically parse the text into the two fields for the search.   

• DOB – Enter date of birth in MMDDYYYY or MM-DD-YYYY format.  If you only know the 
patient’s year of birth, enter 99 for day and month (e.g., 99-99-1961).  A valid month and 
year are required when other patient identifiers are not specified (last name or social 
security number). 

• SSN – A complete Social Security Number must be entered.  The value may be formatted 
as 999999999 or 999-99-9999. 

• Sex – A drop-down list enables you to search for data based on a valid code for sex.   

• Race – A drop-down list enables you to search for data based on a valid code for race.  One 
value for race may be selected.  

Your must specify a value for at least one of these fields:  last name, Social Security Number, or 
date of birth.  The Standard Search is designed to search for data for a specific patient; you cannot 
use it to generate a generic list of data by sex, race, record type, or facility.  To create such a list, 
you should either use the Advanced Search, as described later in this chapter, or query the 
database using an external tool.   Sample SQL and tips for querying the database are provided on 
the SEER*DMS Web Portal (http://seer.cancer.gov/seerdms/portal).    

Limiting the Search 

You may specify the records and patient sets to be searched by entering values for facility, data 
type, and the “exclude” field.  Unlike the Search Fields, these criteria are never weighted.  They are 
used to make a definite determination of whether a record or patient set is “in” or “out” of the 
search results.  

• Facility – Limit the search to patient sets with admissions or treatments related to a 
specific facility (the facility may be the reporting or treating facility), or to unlinked records 
that were provided by the facility.  Leave this field blank to search all data regardless of 
facility. 

• Exclude – Exclude patient sets and records for patients who have been dead for more than 
the specified number of years (based on vital status and date of last contact).   Leave this 
field blank to search all data regardless of vital status. 

• Data Type – Search all patient sets and unlinked records, or limit the search to one or 
more data types.  To include linked records in the search, you must include Patient Sets.  
The patient set to which the record is linked will be returned.  To select more than one data 
type, hold down the CTRL key and click each desired type. To deselect a type, click it a 
second time while holding the CTRL key. 



Searching for Records and Patients  2/8/2008 20-3 

Executing the Standard Search 

Enter as much information as known into the form and click Search.  As many as 500 matches will 
be displayed.  The results will be sorted by score with the best matches listed first.  The results will 
include records and/or patient sets which, according to your registry’s matching algorithms, yielded 
a score greater than zero when matched against the search and exclusion criteria.  To view the 
algorithm, click the Patient and Record Lookup link shown at the bottom of the screen when 
results are returned. 

You may click an ID to open a record or patient set in an editor.  If the data are involved in a 
worklist task, a View link will be displayed in the Tasks column.   For more information on the 
data displayed, see the Search Results section of this chapter. 

To search for a new patient, click the Clear button.  Patient information that you entered will be 
removed, the Facility field will be cleared, and the Exclude field will be set to the system default.   
The Data Type is retained to allow you to search for a specific data type for multiple patients. 

Create AFL 

Casefinding or abstracting assignments are maintained and tracked in SEER*DMS as Abstract 
Facility Leads (AFLs).   If casefinding information is received via paper records or ad hoc 
communications with a facility, the database must be searched to verify that the case was not 
previously abstracted.  The Create AFL button is provided on the Patient Lookup to allow the 
casefinding manager to create an abstracting assignment, as necessary.   Please refer to Chapter 
21:  Managing Abstracting Assignments for specific instructions. 

ID Lookup 

The Patient Lookup’s ID Search allows you to search for a set of records and/or patient sets using 
one or more Patient/Record IDs, a single Import ID, or a single Special Study ID.  

Select View > Patients to access the Patient Lookup.  Click ID Lookup in the left navigation bar.  
The ID Lookup tab will be displayed, as shown below.   

 

The search fields available on the ID Lookup are listed below.  You may search by one of these 
fields, searches based on combinations of these fields are not supported.  Regardless of the field 
that is used, a maximum of 500 results will be returned. To obtain a list of all data in a large 
import or special study, use a system report or external query. 

• Pat/Rec ID – You may search by one or more Patient Set or Record IDs.  To enter multiple 
IDs, click the down arrow  to expand the filter.  You may type directly into this field or 
paste IDs from the Windows clipboard.  The "REC-" and "PAT-" prefixes are optional. 

• Import ID – To search for data loaded in a particular import, enter the Import ID or click 
the Lookup icon  to select the Import ID from a list.  No results will be returned when 
searching for an import which has an open Import Review task.   
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• Special Study – The short name assigned to a Special Study must be entered.  Enter the 
text directly or click the Lookup icon  to select the study from a list. 

Advanced Search 

Select View > Patients to access the Patient Lookup.  The Standard search tab will be displayed 
by default.  If you wish to use search fields that are not available in the Standard search and your 
search is limited to Patient Set data, click Advanced in the left navigation bar.  The Advanced 
search tab will be displayed, as shown below.  You will use the controls on this page to define a 
search statement based on Boolean logic.  The expressions in each row will be ANDed to create the 
search criteria.   

 

The Advanced Search controls are described below.  

• Field – The data field to be used in this expression.  This includes many, but not all, patient 
set data fields.  The field name is followed by the data entity, for example, “Site [CTC]” 
indicates the Site field which is part of the CTC data. 

• Operator – The relational operator to be used in the expression. 

 
• Value – A valid value for the data field. The value must be in the format that is used to 

store the data field in the database.  If the field has an associated lookup, the lookup icon 
will be displayed to the right of the value box and you may use the lookup to select the 
value. 

• Add Row - Creates a blank expression row.   

• Remove Row   icon - Removes unwanted expressions. 

• Search – Starts the search engine using the statement that you have defined.  
• Clear – Removes all expression rows. 

To search the database using the Advanced Search in the Patient Lookup: 

1. Select View > Patients. 

2. If your search is limited to Patient Set data or you wish to use search fields that are not 
available in the Standard Search, click Advanced in the left navigation.  You will create a 
Boolean statement consisting of one or more expressions.  The expressions in each row will 
be ANDed to create the search criteria. 
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3. To define an expression in each “row’ of the statement: 

a. Select the search Field from the large number of patient set fields.  To find a field, you 
may: 

i. Begin typing text into Field.  SEER*DMS will present a list of candidates that match 
the text that you have entered. 

ii. Or use the Firefox search tool to find text within the list of available fields.  Click 
the Lookup icon  to view a list of available fields.  Click CTRL-F (Firefox shortcut 
for “Find in this page”).  Click “Find Next” in the Firefox toolbar to move to the next 
match in the list. 

b. Select a relational Operator from the drop-down list.   

c. Enter a Value to be used in the relational expression.  The value must be in the format 
that is used to store the data field in the database.  If the field has an associated 
lookup, the lookup icon will be displayed to the right of the value box and you may use 
the lookup to select the value. 

d. To add an expression to the statement, click Add Row.   

4. When you complete the search statement, click Search. 

5. The results of your search will be displayed in the Possible Matches section of the page.  The 
result set is limited to 500 items.  You may click an ID to open a record or patient set in an 
editor.  If the data are involved in a worklist task, a View link will be displayed in the Tasks 
column.     

Using a Range of Values for a Search Field   

To search for a range of values for a numeric field, add two expression rows (one with the “greater 
or equal to” operator and the other row with the “less or equal to” operator).  In the example 
shown below, two expressions are used to search for patients with Age At Diagnosis from 20 
through 39.  To search for a range of cancer codes within the same major site, use the “contains” 
operator.  In the example, “Primary Site [CTC] contains C34” is used to search for patients with a 
lung cancer diagnosis (C340 through C349). 

 

Search Results 

The columns listed below are shown in the search matches.  The value in the table will be shown in 
bold if it is an exact match to a search field.  If the matching algorithm supports partial matches for 
Social Security Number and Date of Birth, only the matching fragment will be shown in bold.  Fields 
not listed may have been involved in the search.  For example, the matching algorithm may 
compare last name to maiden name or alias last name.   
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• Score – A value calculated by the matching algorithm that allows the results to be sorted 
by the likelihood of the match.  You may click the score to view a summary of the 
calculation.  Results with the highest score are displayed first.  Score is shown in all search 
results but is only relevant to the Standard search which uses a weighted matching scheme.  
The Advanced and ID searches use a determinant matching scheme; only results with a 
score of 1000 (match all criteria exactly) are returned for the Advanced and ID searches.   

• Type – Data type.  Patient Set or a record type will be listed.  If the match is a record and 
the record’s reportability status is something other than “reportable”, an icon will be 
displayed: 

  Non-reportable 
  Auditable 
 Unknown (the record has not yet been screened) 

 Not applicable; the record type is not screened (e.g., supplemental records) 
No icon is displayed if the record is reportable. 

• ID – Patient Set or Record ID.  Click the Information Icon  next to the record’s or patient 
set’s ID to see a select set of fields.  To browse all pages of the record or patient set, click 
the record’s or patient set’s ID. 

• Last Name, First Name, M – Patient’s last name, first name, and middle initial.  If the text 
is an exact match to search criteria, it will be shown in bold.  The middle initial column will 
contain the first character of the middle name field.  If additional characters are specified in 
the middle name field, the initial will be followed by an ellipsis (e.g., M…).  Hold your mouse 
over the text to view the full middle name. 

• DOB – Date of birth. 

• SSN – Social Security Number. 

• Sex – Shown in bold if  

• Race – Race indicated in the first race field of the patient set or record. 

• DOLC – Date of last contact. 

• VS – Vital status. 

• Tasks – If the data are involved in a worklist task, a View link will be displayed in the 
Tasks column.   

Quick Search 

Requires system permission:  pat_edit, pat_edit_demographics, pat_read_only, rec_edit, or 
rec_read_only 

If your system permissions allow you to view or edit patient data, the Lookup search box will be 
displayed in the SEER*DMS User Bar.  This provides a shortcut to the Patient Lookup for searches 
by Patient Set ID, Record ID, AFL ID, Import ID, date of birth, name, or Social Security Number.  

 

To use the quick search to find a specific record or patient set in the database: 

1. Enter the search text in the Lookup box on the SEER*DMS User Bar.  If you enter a string 
consisting of all digits, the search will assume that you are searching by Record or Patient 
Set ID.  The following describes the formats required for each of the quick search fields: 

a. Record or Patient Set ID: You may enter a complete ID or you may enter the 
numeric portion of the ID and omit the prefix.  Search results based on partial ID 
numbers will not be returned; for example, “REC-1234567” will not be returned if you 
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search for “123” or “REC-123.”  If you entered a numeric value without the REC or PAT 
prefix, SEER*DMS will perform two searches, using search strings created by appending 
the numeric value to the REC- and PAT- prefixes.   

b. AFL ID:  A complete ID including the prefix is required (AFL-XXXX format). 

c. Import ID:  A complete ID including the prefix is required (IMP-XXXX format). 

d. Date of Birth:  MM-DD-YYYY format is required.  A valid month and year are required 
by the Quick Search.  You may enter 99 for unknown day.   

e. Name: You may enter “last name” or “last name, first name”. 

f. Social Security Number: A complete SSN in the 99-999-9999 format is required. 

2. Press Enter. 

3. Review the results of your search: 

a. If a single record or patient set matched the search criteria, the data will be opened in 
the editor.  If the record is linked to a patient set, the patient set will be opened. 

b. If the search returns more than one possible match, the results will be displayed in the 
Matches section of the Patient Lookup page.  If necessary, you may refine your search 
as described in The Patient Lookup and Searching the Database sections of this chapter. 

c. If you searched by AFL ID, the AFL Manager will open.  The filter will be auto-filled to 
search for that AFL. If an AFL with that ID exists, it will be listed on the page.  

4. If you need to edit the record or patient set data, you must make certain that the data are 
not being modified by other staff members.  Further instructions are provided below in the 
Direct Editing of Records and Patient Sets section.  

Direct Editing of Records and Patient Sets  

Requires system permission:  pat_edit, pat_edit_demographics, pat_read_only, rec_edit, or 
rec_read_only 

SEER*DMS enables users to edit records or patient sets accessed via the Patient Lookup.  This 
feature is designed primarily to facilitate the processing of follow-up information.  However, it 
creates the possibility that two users may open the same record or patient set simultaneously.  It 
is also possible for you to open a record or patient set that is currently being processed in an 
automatic task, or that is involved in a manual task.  Prior to editing data that you access via the 
Patient Lookup or Quick Search, please review the information below and follow the appropriate 
steps to avoid having your or another user’s changes overwritten.  

If you attempt to modify data that has been modified by another user or process: 

Two users may open and edit the same record or patient set.  If this happens simultaneously, 
the first person to attempt to save the data will be able to successfully save their changes.  If 
the other person attempts to save changes, SEER*DMS will generate an error message 
indicating that the record or patient set has been modified since the data were loaded in the 
editor. SEER*DMS will post an error message with instructions: 

• Error: These data have been modified by another person or process; your changes cannot 
be saved. Print the data if you need a listing of your current values. Reload the data by 
selecting Undo Changes from the menu.  You should review the revision history in the audit 
log prior to re-entering and saving your edits.  
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• The same message will be displayed if the data were modified by a process after you 
opened the editor but before you saved the data.  In either situation, you should review the 
audit log to determine which user or process modified the data and what changes were 
made.   You may continue editing, if appropriate. 

If you attempt to modify data involved in a worklist task: 

If a record or patient set included in the search results is involved in a worklist task, a View 
link will be displayed in the Tasks column.  The data will remain in that task until the task is 
opened and completed; editing the data outside of the task will not move the data forward in 
the workflow.  

If you open a record or patient set that is involved in a worklist task, SEER*DMS will post a 
warning message and provide a link to review the task.  It is generally recommended that you 
access and edit data in the context of a pending task, if one exists.  You should certainly 
review the task prior to making changes, to ensure that you and another staff member are not 
duplicating efforts or editing the same data simultaneously. 

 



Managing Abstracting Assignments 6/18/2008 21-1 

Chapter 21:  Managing Abstracting Assignments 

Casefinding or abstracting assignments are maintained and tracked in SEER*DMS as Abstract 

Facility Leads (AFLs).  As a record or patient set is processed, an AFL is auto-created if SEER*DMS 

detects, per registry-defined algorithms, that further information must be abstracted from medical 

records.  SEER*DMS also allows ad hoc AFLs to be created manually, for example, to initiate a lead 

based on a phone conversation with a facility’s representative.   

An AFL is closed automatically when an abstract record enters the system that matches the AFL 

based on registry-defined criteria.  SEER*DMS will also review all open AFLs related to a patient 

each time a patient set is saved.  Each AFL created by a record linked to the patient set will be 

reviewed.  The AFL will be auto-closed if the AFL’s source record meets criteria defined by the 

registry.  The auto-close rules used in your registry are documented on the AFL help page (select 

AFL from the help menu). 

Several system reports are available in SEER*DMS to monitor casefinding completeness.  If you 

determine a case should be submitted to SEER or other sources as a Death Certificate Only (DCO)  

or Casefinding Only (CFO) case, you may build a CTC from the record (see Creating a CTC from a 

Non-abstract Record for more information). 

In this chapter, you’ll learn about 

 Relevant Terms 

 Understanding Abstract Facility Leads in SEER*DMS 

 Abstract Facility Leads Created in Automated Tasks 

 Manually Creating an Abstract Facility Lead  

 Assigning Leads to an Abstractor 

 Tracking Abstracting Assignments 

 Printing AFLs 

 Updates to AFL Data Fields 

 Modifying AFLs 

 Creating a CTC from a Non-abstract Record 

 Casefinding Reports 

Relevant Terms 

The following terms will be used throughout this chapter: 

Abstract Facility Lead (AFL) 

In SEER*DMS, an AFL is a mechanism for assigning and tracking a request to abstract a 

case.  The processes to create, track, and close AFLs are described in this chapter. 

 

Casefinding Record 

A record submitted to the registry containing medical data from pathology reports.  These 

data may indicate a new case or identify the need for an abstract related to an existing 

case.  Therefore, an incoming Casefinding record often triggers the creation of an Abstract 

Facility Lead.  If an abstract is never obtained, a new CTC can be built from a Casefinding 

record (see the Creating a CTC from a Non-abstract Record section of this chapter).  The 

specific file types that are processed as “Casefinding” in the workflow are listed on your 

registry’s workflow diagram.  For example, HL7, and other import file types may contain 

casefinding data and follow the workflow path defined for Casefinding Records.  
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Health Index Record 

A record type that is typically used to store data from a hospital’s diagnostic index records 

or discharge logs.  These data are used for quality assurance related to casefinding; and 

may provide follow-up and treatment data that are consolidated into existing patient sets.  

If a Health Index record indicates the need for an abstract, an AFL is auto-created. 

 

NAACCR Update Record 

The NAACCR short format record used to submit field-specific corrections to data previously 

submitted to the registry.  If a NAACCR Update record cannot be matched to a CTC, an 

abstract facility lead is auto-created. 

 

Death Certificate Record 

A data record containing death certificate data items.  These data are used to update follow-

up variables for existing patient sets.  If a death certificate indicates a new reportable 

cancer, an AFL is created.  If an abstract can not be obtained, death clearance follow-back 

procedures are performed as described in Chapter 17:  Death Clearance. 

 

Short Health Record 

A record type used by some registries that contains medical data, but is not a complete 

abstract.  Typically, these records provide additional information regarding follow-up, 

treatment, and admissions related to a previously abstracted case.  An AFL may be auto-

created if an abstract record is not linked to the same CTC as the short health record.  Short 

health record is the only record type that is used for both AFL auto-creation and AFL auto-

close algorithms.   The exact algorithms vary by registry and are described on the AFL help 

page (select AFL from the Help menu). 

Understanding Abstract Facility Leads in SEER*DMS 

The following describes the overall process for assigning and tracking abstract facility leads (AFLs).   

1. AFLs are created:   Typically, AFLs are created in automated processes as Casefinding, 

Health Index, NAACCR Update, Short Health, or Death Certificate records move through 

the workflow (a general description is provided in the Abstract Facility Leads Created in 

Automated Tasks section of this chapter; refer to the AFL help page or your registry’s 

workflow diagram for the exact algorithms used in your registry).  An AFL may also be 

created manually (see the Manually Creating an Abstract Facility Lead section of this 

chapter). 

2. AFLs are assigned to an abstractor:  A registry casefinding manager uses SEER*DMS 

to create a list of AFLs which can be assigned to an abstractor, in the form of the 

“Abstracting Assignments” report (see the Assigning Leads to an Abstractor section of this 

chapter).  AFLs must be assigned in a group for a single facility.  The “Abstracting 

Assignments” report is printed by clicking the Assignments button in the Abstract Facility 

Lead manager (see the Printing AFLs). 

3. Medical records are abstracted:  The abstractor investigates each assigned lead and 

indicates any action taken by writing the appropriate code on the “Abstracting 

Assignments” report.  The action codes may be used to track the “result” of the 

abstracting assignment.  The coding scheme includes codes indicating reasons for not 

abstracting a case and a code to indicate that an abstract was obtained. 

a. The abstractor uses the registry’s abstracting tool to create an abstract record for each 

reportable case.  Records for the abstracted cases are imported into SEER*DMS.    
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b. The abstractor returns the assignment report to a casefinding manager; a reason 

should be indicated for each case that was not abstracted.  

4. AFLs are automatically closed when abstract records are imported:  Imported 

abstract records move through the workflow.  If an abstract record matches an AFL, the 

lead is closed automatically.  Refer to the AFL help page or your registry’s workflow 

diagram for the exact algorithms used in your registry. 

5. AFLs that remain open are reviewed and processed.  The AFLs may be manually 

closed, flagged for further investigation or physician letters, or reassigned:   

a. Registry staff use SEER*DMS to manually close AFLs that are no longer needed.  This 

would include leads that were satisfied by an abstract but were not recognized as a 

match based on the AFL matching algorithm (e.g., if data fields were missing or 

incomplete), as well as leads that refer to non-reportable events.  The abstractor’s 

determination (“not a reportable cancer”, “not at hospital”, etc) may be indicated in the 

AFL’s result field.   

b. A casefinding manager reviews the “Abstracting Assignments” report returned by the 

abstractor.  There may be leads that still require an abstract, for example, if the 

medical records were not available for abstracting.  The “Abstracting Assignments” 

report can be reprinted for this group (see the Printing AFLs section of this chapter).  

The casefinding manager either re-assigns the pending leads to an abstractor; or 

ungroups the leads to allow them to be re-assigned at a later time. 

c. The result field may also be used to designate and track open AFLs for which an 

abstract could not be obtained and require further investigation.  For example, when it 

is determined by the abstractor that the information is based on a pathology report and 

the patient was not seen at the facility, a casefinding manager may set the result of the 

lead to Tissue Only.  This indicates that an abstract is not required from the facility 

associated with the AFL; the registry may need to investigate the case further to 

determine whether an abstract is required from another facility or doctor’s office. 

d. A casefinding manager uses import reports and the Abstracting Assignments report to 

investigate AFLs that were abstracted but did not match imported abstract records (as 

determined by the matching algorithm described in the Algorithms to Auto-close AFLs 

section of this chapter). 

You may use an AFL’s result field to record the determination coded by the abstractor on the 

Abstracting Assignments report.  The valid values for this field are listed below.  Registry policies 

should determine how this field is populated and maintained.  In SEER*DMS, the Abstracted and 

Not a Reportable Cancer values involve special processing as noted below. 

 Abstracted – When an abstract record is imported into SEER*DMS, the AFL is closed and 

the result field is automatically set to abstracted.   

 FUP Only  

 Not a Reportable Cancer – If a closed AFL has a result value equal to “Not a Reportable 

Cancer”, the reportability of the record that triggered the AFL is changed to auditable. 

 Tissue Only   

 Slide Only   

 Not at Hosp 

 DOA 

 Rad Only 

 Recurrence 
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 Metastatases 

 Duplicate 

 Out of Area 

 Prior to Reporting Date 

 Consultation Only 

 History Of 

 Other 

Abstract Facility Leads Created in Automated Tasks 

An AFL is auto-created when SEER*DMS determines, per registry-defined algorithms, that further 

information must be abstracted from medical records.  In general, an AFL is auto-created if there is 

an indication that a facility has diagnosed or treated a patient for cancer but an abstract record was 

not received.  The following summarizes events that trigger the auto-creation of an AFL.  The exact 

algorithms used for your registry are described in the Auto-create Rules section of the AFL help 

page (select AFL from the help menu). 

Workflow 

Auto-create AFL is an automated task in the workflow.  This task creates an AFL if the 

incoming record meets specific criteria defined by the registry.  These criteria are 

documented on the AFL help page (see the workflow section of the Auto-create Rules). 

Patient Set Updates 

Rules to auto-create AFLs are applied each time a patient set is saved.  For example, there 

may be a rule to create an AFL if the patient set is saved with a NAACCR update record that 

is linked at the patient level but contains CTC-related data.   

If auto-create rules for patient updates are defined for your registry, they will be 

documented on the AFL help page.  

 

Final Review of Patient Set Data 

The final process in the SEER*DMS workflow involves automated checks of the patient set 

data.  For example, the treatment fields may be checked to determine if additional 

information is required.  If this rule exists for your registry, SEER*DMS would create an AFL 

if data in the patient set indicates that a treatment was performed at a facility, yet the 

abstract record was not received. 

If auto-create rules for the final patient set review are defined for your registry, they will be 

documented on the AFL help page.  

Manually Creating an Abstract Facility Lead 

Requires system permission:  afl_initiate 

Information obtained via paper records or ad hoc communications with a facility can be used to 

create an Abstract Facility Lead (AFL) manually.  You should search the database to verify that this 

case was not previously abstracted.  SEER*DMS applies a matching algorithm to prevent duplicate 

AFLs from being created (see Matching Algorithm on the AFL help page). 

 

To manually create an AFL in SEER*DMS: 

1. Select View > Patients. 

2. Enter all known patient information in the search fields. 
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3. Do not restrict the search by Data Type.  You may either use the default setting for this 

field (nothing is selected) or select both Patient Sets and Unlinked Records. 

4. Click Search.  Follow the next step that is appropriate based on the search results. 

If you did not find the person in the database, i.e., there are no Patient Sets or records that match: 

1. Click Create AFL on the Patient Lookup page. 

2. The information that you entered to search the database will be auto-filled in the AFL 

page.  Use the  lookup to enter the reporting Facility. 

3. Fill in as many of the fields as are known.  If the data are available, it is particularly 

important to enter medical record number, first and last name, date of birth, social 

security number, and event date (date of service).  SEER*DMS uses these fields to match 

AFLs to incoming abstract records.  Matched AFLs are automatically closed (see the 

Algorithms to Auto-close AFLs section of this chapter). 

4. Click OK. 

If you find a record for this person, check to see if it fills the casefinding need: 

1. Click the Record ID. 

2. Compare the casefinding information to the record’s data.  

a. Is this the same person?  Check name, date of birth, SSN, and other identifiers. 

b. Is this the same tumor?  Check site and compare the record’s admission date to the 

casefinding event date. 

c. Is the record’s reporting source the same as the facility noted in the new information?    

3. If you determined that this is an abstract record related to this casefinding information, 

there is no need to create a new AFL.  You are finished processing this casefinding lead 

and can either click Cancel to return to the Patient Lookup or use the menus or toolbar to 

access other parts of SEER*DMS.   

4. If you determine that the record is not an abstract related to this casefinding lead: 

a. Click Cancel to return to the Patient Lookup page. 

b. Click the Create AFL button on the Patient Lookup page.   

c. Information that you entered to search the database will be auto-filled in the AFL page.   

d. Fill in as many of the fields as are known.  It is particularly important to enter all known 

information for medical record number, first and last name, date of birth, social security 

number, and event date.  SEER*DMS uses these fields to match AFLs to incoming 

abstract records.  Matched AFLs are automatically closed (see the Algorithms to Auto-

close AFLs section of this chapter). 

e. Click OK. 

If you find a Patient Set for this person, check to see if an abstract record that fills this casefinding 

need exists and is linked to the Patient Set: 

1. Click the Patient Set ID.   

2. Using the CTC links in the Patient Set navigation box, review each CTC.   
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3. If this casefinding lead is a report from a new facility for an existing CTC: 

a. Click the appropriate CTC link to select it (CTC 00 is selected in the figure below). 

b. Click the  menu indicator next to Patient ID to open the CTC menu.  Select Add AFL. 

 

c. Information from the CTC will be auto-filled into the AFL form.  Review these fields and 

make changes, as necessary.  The Event Date is auto-filled with the date of diagnosis 

for the CTC.  If the new information includes a more appropriate date, revise this field. 

d. Complete as many additional fields as are known.  You must specify a Facility. 

e. Click OK. 

If this casefinding lead represents a new CTC for this patient: 

1. Click the Demographics link in the Patient Set portion of the navigation box.  (To verify 

this, check to see that Demographics is shown on a shaded background.) 

2. Click the  menu indicator next to the Patient ID.  The Patient Set Demographic’s menu 

will be displayed. 

3. Select Add AFL. 

4. Demographic information from the patient set will be auto-filled into the AFL form.  Review 

these fields and make changes, as necessary.    

5. Complete as many additional fields as are known.  You must specify Facility Name.  

6. Click OK. 

Once you save the new AFL, it will be added to the system as an open, unassigned AFL.  Use the 

AFL Manager to assign this lead to an abstractor.  

Assigning Leads to an Abstractor 

Requires system permission:  afl_manager 

AFLs must be grouped by facility before they can be assigned to an abstractor.  A group may 

consist of one or more AFLs for a single facility.  If the number of AFLs for a facility is too large to 

assign, smaller groups based on event date should be created.  Event date is the date of diagnosis 

(if available), report date (Casefinding records), date of last contact (Death Certificates), admission 

date (Health Index records, these would typically be diagnostic index records) or the date of 

service entered into the Event Date field when the AFL was manually created.  
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To assign a set of AFLs to an abstractor: 

1. Select Manage > Abstract Facility Leads.     

2. Use the Filter controls to reduce the list: 

a. You may limit your selection by the type of record that triggered the AFLs.  For AFLs 

related to Casefinding records, select Casefinding in the Source filter.  For AFLs related 

to death clearance processes, select Death Cert. 

b. Click Open in the Status filter to make it the only value selected in the filter.  

c. Use the  lookup to select the facility in the Fac ID filter. 

d. If your registry manages data for multiple regions, you may select a value in the 

Region filter. (The filter is not displayed if only one region is defined for the registry). 

e. If you would like to exclude AFLs which were previously grouped and assigned to an 

abstractor, check Exclude Grouped. 

f. If an AFL was assigned to and reviewed by an abstractor, the determination made by 

the abstractor may be listed in the Result field.  To select based on this field, select an 

appropriate value for the Result filter.  You may multi-select in this filter. 

g. Click Apply.  The open AFLs for the selected facility and record type will be shown.   

The number of AFLs will be displayed at the top left.  Determine if this is an appropriate 

number of AFLs to print and assign.   

h. If the number of AFLs is too large for one assignment, you may either continue with 

step 3 and then limit the number to be modified; or you may create a smaller list by 

filtering on event date.  You may specify a closed or open-ended date range using one 

or both of the Event Date filters.   

i. To select AFLs with an event date on or after a particular date, enter the date in 

Event From. 

ii. To select AFLs with an event date prior to and including a particular date, enter 

the date in Event To. 

iii. To include AFLs within a specified range of years but with unknown month and/or 

day, check the month and/or day boxes in the Show unknown dates section.   

iv. To include AFLs with unknown year, check the year box in Show unknown dates 

section.    

v. To review a list that only includes AFLs with unknown event dates, enter a future 

date in Event From and check the year box in the Show unknown dates 

section. 

3. Review the AFLs that are displayed.  If an AFL has a group ID, the AFL may have 

previously been assigned to an abstractor.  Determine if you wish to assign the AFL in a 

new group before continuing.    

4. To assign all AFLs that are listed or a subset of those AFLs, click Modify All.  You will be 

able to specify the number of AFLs in a later step.  To assign a specific set of AFLs, check 

the box to the left of each AFL ID and click Modify (you can only check the boxes of AFLs 

that are on the same page). 

a. If you wish to limit the number of AFLs assigned in this group, enter a value in the 

Maximum Number to Modify field. 
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b. Set Group Action to Group. 

c. Click OK to exit the Modify AFLs page.   

d. You will be prompted to confirm that you wish to create a new group containing the 

AFLs.  Click OK.  A new Group ID will be assigned to each AFL. 

5. To create an Abstracting Assignments listing for the new group, click Assignments.  A 

configuration setting defined by registry management determines whether this listing will 

be presented as a printable PDF report or written to a CSV file that can be opened in Excel. 

a. Depending on your browser settings, you may have the option to Open or Save the 

listing.  If so, click Open.   

b. If the listing is in PDF format, it will open in an Adobe Acrobat window.  If it is in CSV 

format, it will open in Excel. 

c. Use the Adobe or Excel controls to print and/or save this report.  To print, you may 

need to use a printer that allows you to use 11x17 inch paper and select the correct 

paper size in Print Setup (specific instructions vary depending on your printer and the 

version of the printer driver that is installed, please contact your IT staff for further 

instructions). 

Tracking Abstracting Assignments 

Requires system permission:  afl_manager 

To track and update the status of leads assigned to an abstractor: 

1. Collect the Abstracting Assignments report from the abstractor.  The Action column of the 

report should contain a code indicating that the case was abstracted or the reason it was 

not abstracted.    

2. Consult your IT staff to ensure that the abstract records submitted with the report were 

imported into SEER*DMS.  It is important to wait for the records to be imported and 

processed in order to allow SEER*DMS to automatically close as many leads as possible.  

You will only need to update the leads that did not match abstract records.  

3. Click Manage > Abstract Facility Leads. 

4. Enter the Group ID printed on the Abstracting Assignments report into the Group ID filter.  

Tip:  If you are viewing a list of AFLs, the Group ID filter is set automatically when you 

click the Group ID of one of the AFLs. 

5. Set the Status filter. 

a. If you wish to limit your review to pending AFLs in this group, set the Status filter to 

Open.  AFLs in the group will not be listed if they were auto-closed when a matching 

abstract record was loaded and processed.  The number of items now displayed in 

SEER*DMS should be less than the number of AFLs in the printed report.  If this is not 

the case, consult your IT staff to determine if the abstract records were imported. 

b. Typically, you will only need to review and modify AFLs that remain open to determine 

if further processing is required or to indicate the reason that an abstract was not 

obtained.  However, if you wish to review all AFLs in the group, set the Status filter to 

blank.  The list should include all AFLs that were assigned and printed on the report.  

However, it is possible that some AFLs were ungrouped or re-assigned in another group 

(you may search for a specific AFL by AFL ID, if necessary).   
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6. Click Apply. 

7. As determined by registry policies and procedures, you may use one of the following 

methods to process AFLs that were not auto-closed during the processing of the imported 

records.  If you wish to document a change to an AFL, process each AFL individually.  

Otherwise, you may implement these changes on a set of AFLs that you select (steps for 

selecting sets of AFLs are discussed in the Modifying AFLs section of this chapter). 

a. If an abstract is not necessary or cannot be obtained, set the result field to the 

appropriate value and close the AFL.  Note:  If you set result to Not a Reportable 

Cancer, the record that triggered the AFL will be changed from reportable to auditable. 

b. To request an abstract from a different facility, use the  lookup to specify an ID in the 

Facility field.  The AFL will be removed from the current group.  Follow the instructions 

in Assigning Leads to an Abstractor to add the AFL to a new group. 

c. To submit a new request for an abstract from the same facility, you may either ungroup 

the AFL to allow it to be considered for a new group created at a later time; or you may 

move a set of AFLs from this group to a new group by setting Group Action to Group.  

d. If an abstract record is expected but the data file has not yet been loaded, do not 

modify the AFL.  Consult your IT staff to determine when the data will be loaded.  

Printing AFLs 

Requires system permission:  afl_manager 

The AFL Manager includes two buttons for printing reports.  The Print button generates a report 

(RPT-073A) showing the AFLs currently listed in the AFL manager.  The data in this report are the 

same as those displayed in the AFL Manager, it includes all pages.  The Assignments button can 

be used to generate the Abstracting Assignments sheet (RPT-XX013A, where XX is a code 

indicating the registry).  The layout of this report is registry-defined; and it can only be used to 

generate an assignment sheet for AFLs in the same group.  

To print AFLs: 

1. Click Manage > Abstract Facility Leads. 

2. Use one or more of the filter fields to select the AFLs to include on the report: 

a. To include both open and closed AFLs in the report, set the Status filter to blank.  

Otherwise, select a value for this filter.  

b. To print AFLs for a single facility, use the  lookup to specify an ID in the Facility filter.   

c. If your registry manages data for multiple regions, you may use the Region filter to 

limit the list.  (This filter is not displayed if only one region is defined for your registry.) 

 

d. If you are printing AFLs from a single group and know the Group ID, enter the ID in the 

Group ID filter.  To enter multiple IDs, click the   adjacent to the filter.  You may 

then type multiple IDs into the text box. 

e. To print a set of AFLs based on event date, you may specify a closed or open-ended 

date range using one or both of the Event Date filters.   
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i. To select AFLs with an event date on or after a particular date, enter the date in 

Event From. 

ii. To select AFLs with an event date prior to and including a particular date, enter 

the date in Event To. 

iii. To include AFLs within a specified range of years but with unknown month and/or 

day, check the month and/or day boxes in the Show unknown dates section.   

iv. To include AFLs with unknown year, check the year box in Show unknown dates 

section.    

v. To review a list that only includes AFLs with unknown event dates, enter a future 

date in Event From and check the year box in the Show unknown dates 

section. 

3. Click Apply.   

4. Create a PDF report file listing the AFLs currently displayed: 

a. To create a report containing the fields currently shown on your screen, click Print.   

b. To print the Abstracting Assignments report for a single group, click Assignments.  

This report cannot be generated for AFLs that are not grouped or for AFLs that are in 

multiple groups.   

5. Depending on your browser settings, the report may open automatically or you may need 

to click Open. The PDF will open in an Adobe Acrobat window. 

6. Use the Adobe controls to print or save this report. 

7. Close the Adobe window. 

Updates to AFL Data Fields 

Requires system permission:  afl_manager 

When an AFL is created, the data fields from the source record or patient set are copied into fields 

in the AFL.  If the record data fields are modified, the data fields in the associated AFL are 

automatically updated.  However, the reverse is not true.  If you modify the data fields in the AFL, 

the fields in the source record are not changed.  The only situation in which the record is changed 

due to a change in an AFL occurs when an AFL is closed with a result of Not a Reportable Cancer.  

In this situation, the reportability of the record is changed to auditable. 

Modifying AFLs 

Requires system permission:  afl_manager 

After following the steps in Tracking Abstract Assignments, you may wish to modify the Status, 

Result, Grouping, or Letter flag of an AFL.  Status indicates whether the AFL is opened or closed.  

The Result field is used to track the final determination made by the abstractor when they 

attempted to abstract the case.  Typically, this field is used to code the reason given for not 

obtaining an abstract.  The Grouping Status of an AFL may be changed to ungroup an AFL or assign 

it to a new group.  In addition, you have the ability to set a flag that indicates whether a letter is 

needed.  This flag is not used by SEER*DMS but may be referenced by an external report to create 

letters requesting additional information from a physician or reporting facility.   

If you wish to document a change to an AFL, process each AFL individually.  Otherwise, you may 

implement these changes on a set of AFLs that you select.   
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To modify a single AFL or a set of AFLs: 

1. Click Manage > Abstract Facility Leads. 

2. Use the filters to search for the AFLs that you wish to modify. 

a. To include both open and closed AFLs in the search, set the Status filter to blank.  

Otherwise, select the appropriate value for this filter.  

b. To search for an AFL group, enter the Group ID printed on the Abstracting Assignments 

report into the Group ID filter. 

c. To specify a set of AFLs by ID, enter the IDs into the AFL ID(s) or Pat/Rec ID filters. 

i. To expand the filter so that more than one ID can be entered, click the   

adjacent to the ID filter.  A text box will appear as shown below. 

 

ii. Type the numeric portion of the ID and press Enter (the AFL- and REC- prefixes 

may be entered, but are not required).  You may enter as many IDs as you wish.     

d. To select a set of AFLs based on event date, you may specify a closed or open-ended 

date range using one or both of the Event Date filters.   

i. To select AFLs with an event date on or after a particular date, enter the date in 

Event From. 

ii. To select AFLs with an event date prior to and including a particular date, enter 

the date in Event To. 

iii. To include AFLs within a specified range of years but with unknown month and/or 

day, check the month and/or day boxes in the Show unknown dates section.   

iv. To include AFLs with unknown year, check the year box in Show unknown dates 

section.    

v. To review a list that only includes AFLs with unknown event dates, enter a future 

date in Event From and check the year box in the Show unknown dates 

section. 

e. To search for a specific AFL by patient name, enter text into the Last Name and/or 

First Name filters. 

f. To select by facility, use the  lookup to specify an ID in the Facility filter.  If you are 

creating a group of AFLs you must select AFLs for a single facility. 
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g. To search by region, select a value in the Region filter.   This filter is only displayed if 

your registry manages data for multiple regions. 

3. Click Apply. 

4. Select the AFL(s): 

a. To select a single AFL, check the box to the left of the Task ID. 

b. To select two or more AFLs, use one of the following methods: 

i. To select specific AFLs, check the box to the left of each AFL ID.  You can only 

select AFLs on the same page with this method.  

ii. To select all AFLs displayed on the current page, check the box on the top left of 

the page, adjacent to the AFL ID column heading. 

iii. To select all tasks on all pages of the filtered list, click Modify All and skip ahead 

to Step 6.   

5. Click Modify. 

6. You may set the following fields for the selected AFLs.  Only specify a value for a field if 

you wish to change that field for the selected AFLs.  If you leave a field blank then each 

AFL will retain its current value for that field. 

a. Status – AFLs that require processing should be set to Open.  If no further processing is 

required, set this field to Closed. 

b. Result - use an AFL’s result field to track the determination coded by the abstractor on 

the Abstracting Assignments report.  The valid values for this field are listed below.  

Registry policies based and tracking procedures should determine how this field is 

populated and maintained.  In SEER*DMS, the Abstracted and Not a Reportable Cancer 

values involve special processing as noted below. 

c. Group Action – To create a new group containing the selected AFLs, set Group Action 

to Group.  If an AFL is currently in a group, it will be re-assigned to the new group.  To 

remove the current group ID and allow the AFls to be re-assigned at a later time, set 

Group Action to Ungroup. 

d. Send Letter – this flag is not used by SEER*DMS but may be referenced by external 

reports that create letters requesting additional information from a physician or 

reporting facility.  You may filter by this flag on the AFL Manager page. 

7. To change a limited number of the AFLs, enter a value in Maximum Number to Modify.  

Using this method, you cannot control the specific AFLs that are modified.  This provides a 

convenient mechanism for limiting the number assigned to a group and should not be used 

for other purposes. 

Creating a CTC from a Non-abstract Record 

Requires system permission:  rec_build_cfo 

If you determine that a case should be submitted to SEER despite the fact that an abstract is 

currently unavailable, you may use the record editor to create a CTC from the non-abstract record.  

This feature is available for reportable casefinding, death certificate, and short health records.  (In 

this context, casefinding includes any record processed in the workflow as “Casefinding”.  The 

specific record types will vary by registry and may include HL7 and other import types).  If the 
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record is not linked to an existing patient set, you may create a new patient set.  If the record is 

linked to a patient set but not to a CTC, you may create a new CTC within the patient set. 

Alternatively, system tasks are available to auto-build batches of cases from non-abstract records 

as described in Chapter 27:  System Administration.  The Build DCO, Build CFO, Build SHO system 

tasks incorporate reportable, unlinked records into the Patient Set data as new Patient Sets or new 

CTCs for existing Patient Sets.  

To create a Patient Set from a non-abstract record: 

1. Open the record in the record editor. 

2. If the record is a casefinding or short health record, select Build Patient Set from the 

record menu.  This menu item is only available on unlinked casefinding records and can 

only be seen by users with the rec_build_cfo permission. 

3. If the record is a death certificate record, select Build Patient Set from the record menu.  

These menu items are only available on unlinked death certificate records and can only be 

seen by users with the rec_build_cfo permission.  

4. Click OK to confirm. 

5. SEER*DMS will create an automated workflow task to create the patient set.  When the 

task completes, a Visual Edit Patient Set task for the patient set will be assigned to you. 

To create a CTC from a non-abstract record: 

1. Search the database for the record or its associated patient set.  You may enter the 

Patient Set or Record ID into the quick search, or click View > Patients to use the Patient 

Lookup.  (See Chapter 20:  Searching for Patients and Records.) 

2. Verify that the record is not already linked to a CTC.  If it is linked at the patient level, you 

may proceed.   

3. Click the ID of the record in the patient set navigation box.   

4. Select Move To > New CTC from the record’s menu.   

5. SEER*DMS will create a new CTC; you may proceed with visual editing. 
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Casefinding Reports 

The following reports are available for monitoring the completeness of casefinding.  Instructions for 

generating reports are provided in Chapter 24: Creating Reports and Extracting Data.  Consult your 

IT staff to determine if other, external casefinding reports are available at your registry.   

Report ID Title Description 

RPT-003A Tasks for Unlinked 

Records with Closed AFLs 

This report lists workflow tasks related to AFLs that 

were manually closed. 

RPT-015A Record Counts  by 

Abstractor 

Number of records abstracted by each abstractor for a 

specified period of time. 

RPT-017A CTC Frequencies by 

Month of Diagnosis 

CTC counts by month of diagnosis for three years. 

RPT-018A CTC Frequencies by SEER 

Site Recode 

CTC counts by SEER site recode for a two-year period. 

RPT-019A Death Clearance 

Summary 

A listing of records that are potential DCOs; includes 

each record’s status related to the workflow and AFLs. 

RPT-024A Abstractor’s Report of 

Active Cases 

A reference sheet for abstractors showing the active 

cases in the database for a facility.   

RPT-067B Frequency of Records for 

Build CFOs Task 

Number of records to be considered by Build CFOs 

task. 

RPT-067C Candidate Records for the 

Build CFOs System Task 

A list of the records that will be used by the Build 

CFOs system task. 

RPT-068B Frequency of Records for 

Build DCOs Task 

Number of records to be considered by the Build DCOs 

system task. 

RPT-068C Candidate Records for the 

Build DCOs System Task 

A list of the records that will be used by the Build 

DCOs system task. 

RPT-089B Frequency of Records for 

Build SHOs Task 

Number of records to be considered by the Build SHOs 

system task. 

RPT-089C Candidate Records for the 

Build SHOs System Task 

A list of the records that will be used by the Build 

SHOs system task. 

RPT-080A Abstract Facility Leads 

Closed Manually 

List of the AFLs which were closed manually on a 

specified day. 

 

 



Chapter 22:  Follow-back 

In SEER*DMS, the term “follow-back” refers to the process of contacting a reporting facility to 
obtain missing information or to resolve inconsistencies in data received at the registry.   In 
contrast, the term “follow-up” refers to the surveillance processes used to gather new information 
about a patient regarding treatment outcomes and survival.   

While editing, screening, or consolidating data, it may be determined that additional information 
must be obtained from a reporting facility.  An editor can submit a request for follow-back 
information while they are editing data.  The request will be forwarded to the Follow-back 
Management tool for processing; and it will be maintained with the record or patient set to enable 
users to review all follow-back inquiries and responses associated with a record or patient set.  In 
some automatic tasks, a request for follow-back information is auto-created when SEER*DMS 
detects that required data are missing. 

The Follow-back Management tool provides a convenient method for processing the follow-back 
inquiries in batches.  Periodically, a registry manager will review, edit, and compile the requests 
into a single communiqué that is sent to a physician or other representative at a facility.  Once a 
response is received, registry policy will determine whether one staff member is responsible for 
processing the information, or if the information is distributed to the staff members who submitted 
the individual requests.   

In this chapter, you’ll learn about 

• Understanding Follow-back 

• Follow-back Needs Created in Automatic Tasks 

• Manually Adding a Follow-back Need 

• Searching for a Follow-back Bundle 

• Reviewing and Sending Follow-back 

• Processing a Follow-back Response 

• Assigning a Follow-back Need to another Facility 

• Re-querying a Facility 

Understanding Follow-back 

The following describes the mechanisms used by SEER*DMS to facilitate follow-back processes. 

Follow-back Need:  In SEER*DMS, a request for follow-back information is entered and tracked 
as a "follow-back need".  A follow-back need can be defined manually while editing, screening, or 
consolidating data; or it may be created automatically if SEER*DMS detects that required 
information is missing (this process is indicated as an automatic “Add Follow-back” task on the 
workflow diagram).  To allow for batch processing of requests, SEER*DMS creates groups or 
“bundles” of requests designated for the same facility.  There are two status settings for follow-
back needs: 

1. Open – The need is in a bundle that has not been sent, or it has been sent but the 
response has not been processed.   This status may also be displayed as: 

o Open (Reassigned) – This status indicates that the need was assigned to a 
bundle for another facility after its original bundle was sent.  Therefore, it may be 
sent in both bundles and, therefore, can be tracked in both.
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Open (Re-queried) – The follow-back need was sent in a bundle but the issue 
was not addressed in the facility’s response.  It is being resent to the same 
facility in a different bundle.  It will be maintained in both bundles for tracking 
purposes. 

2. Closed – The status of the follow-back need was set to closed after a response was 
received and processed by a manager.  Alternatively, a manager may have determined 
that the inquiry is not necessary and closed the issue (needs closed in this manner are 
removed from the bundle).  This status may also be displayed as: 

o Closed (Reassigned) – An open need was assigned to another facility and 
subsequently closed (it may have been closed in either bundle). 

o Closed (Re-queried) – A need was sent but the issue was not addressed in the 
facility’s response.  Therefore, it was assigned to a bundle for the same facility 
(so that it could be resent).  Subsequently, the need was closed. 

Follow-back Bundle:  A set of follow-back needs intended for a single facility and processed as a 
group.  As needs are created, they are added to a bundle and held for processing.  The manager of 
follow-back periodically reviews, edits, and sends the group to the designated organization.  There 
are three status settings for bundles: 

1. Open – It has not yet been sent.  Other needs for the same organization may be added. 

2. Waiting – The bundle has been sent but a response has not been received.   

3. Closed – A manager closed the bundle, or it was automatically closed when all of the 
individual needs were closed. 

Follow-back Needs Created in Automatic Tasks 

The final process in the SEER*DMS workflow involves automated checks of the patient set data.  
SEERDMS checks the patient set to determine if a follow-back need should be created based on 
registry specific criteria.  For example, in some registry configurations, a follow-back need is auto-
generated if the date of diagnosis is missing.  In this case, the request for follow-back information 
may be directed to the diagnosing physician to obtain the date.  When a follow-back is auto-
created, it may be directed to a physician or a facility.  To determine whether follow-back needs 
are auto-generated in your registry’s system, please refer to the SEER*DMS Technical Reference:  
Registry-Specific Information. 

Manually Adding a Follow-back Need 

Requires system permission:  fb_initiate  

While editing, screening, matching, or consolidating data, you may determine that additional 
information must be obtained from a reporting facility.  Submit a request for follow-back 
information by adding a “follow-back need”.   

To request follow-back information while completing a Match-Consolidate task or editing data: 

1. To initiate a request for follow-back information: 

a. If data fields required to complete a Match-Consolidate task are missing or 
incomplete, click the Follow-back button provided at the bottom of the Incoming 
Record section.  Continue with step 2 of these instructions. 
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b. If you would like to submit a request for follow-back information when editing a record 
or patient set, click the FB link in the navigation box and then click Add Follow-back.  
Alternatively, you may select Add Follow-back directly from the menu.  (The patient 
set navigation and menu are used as an example in the figure below.  The FB link and 
Add Follow-back menu item are also available when editing a record.) 

 

i. Click the FB link to review other follow-back issues related to this record or 
patient set.  You will then be allowed to submit a new request by clicking Add 
Follow-back.  Alternatively, you can go directly to the follow-back form from the 
data editor by selecting Add Follow-back from the menu.   

ii. Note:  you will not be able to add follow-back when creating a new patient set; 
the patient set must be saved and a patient set ID must be assigned. 

2. The Add Follow-back popup will be displayed.  You may drag the popup to the side if you 
wish to refer to data items on the screen as you submit the follow-back need. 

3. Use the  lookup to specify the appropriate facility in the Facility field. 

4. Follow-back inquiries may be addressed to a representative of the organization or directly 
to a physician.  To direct your question to a physician, use the  lookup to select the 
Physician.  If no physician is specified, a registry manager will select the appropriate 
organization representative as they process and send this question with others for the 
same organization. 

5. If appropriate, create a list of data fields related to this follow-back need.  The field names 
will be listed in the communication to the facility. 

a. Click on an item in the Available Data Items box.   Use the right arrow   to 
move your choice to the Selected Data Items box.  To remove a data field, click on an 
item in the Selected Data Items box and click the left arrow .   

b. If selecting more than one data item in either list, use standard Windows techniques to 
multi-select. 
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6. Enter text in the Question field.  This text will be included in the draft letter or fax that is 
prepared.  A registry manager may review and edit the draft prior to sending it to the 
facility. 

7. Enter Comments that you wish to make available to SEER*DMS users reviewing this 
need.  These comments will not be included in the communication sent to the facility. 

8. Select an Urgency level.  Normal is the default value.  The urgency level of the bundle is 
set to the highest level of any need.  You may use this field to prioritize the processing of 
follow-back needs and bundles. 

9. Click Save to submit the follow-back need and return to the record editor, patient set 
editor, or Match-Consolidate task. 

10. If possible, complete the current worklist task.  If the requested information is required to 
complete the task, save any changes that you have made but do not forward the data to 
the next workflow task (specific instructions for saving data and exiting the task are 
provided in the task-specific chapters of this manual).    

Periodically, a manager will review, edit, and send a batch of follow-back requests to a physician or 
other representative at a facility.  Subsequently, the manager will process the facility’s responses.  
SEER*DMS will automatically notify you when a response from the facility has been received and 
processed, that is, when your follow-back need is closed by a manager.   

You or another staff member may update data fields based on the new information.  As determined 
by registry policy, one staff member may be responsible for processing all follow-back responses, 
or the information may be given directly to the staff members who entered the follow-back needs.   

If you suspended a task pending the receipt of follow-back information, you must re-open and 
complete the task to allow the data to move forward in the workflow.  You must either make 
changes to data fields based on the new information or verify that the appropriate changes were 
made.  If you completed the task but need to update the record or patient set with the new 
information, use the Patient Lookup to search for the data (see Chapter 20:  Searching for Records 
and Patients). 

Searching for a Follow-back Bundle  

Requires system permission:  fb_manager  

Use the Follow-back Manager to locate a follow-back bundle so that you may review and edit the 
needs, send the query, or process information sent by a reporting facility.   

To find a follow-back bundle: 

1. Select Manage > Follow-back. 

2. By default, the Follow-back Manager displays Open bundles and bundles with a status of 
Waiting for Response.  To search for a bundle with a specific status, select that status in 
the Bundle Status filter. 

3. If you know the ID of the follow-back bundle, enter it in the Bundle ID(s) field. 

4. Use the Source filter to find a bundle assigned to a specific organization.  Enter a full or 
partial facility ID or use the   icon to search for a facility by name. 
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5. Use the Sent to filter to find a bundle addressed to a particular organization 
representative.  Enter an ID, or use the   icon to select the organization representative. 

6. To search for a bundle sent or closed during a specific time period, enter dates into the 
Sent or Closed filters.  Enter all dates in MM-DD-YYYY format, or use the Calendar feature 
to select a date. 

7. Click Apply.   

8. To sort the list by the data in any column, click on the underlined column heading.  To 
reverse the sort order, click the column heading again. An arrow to the right of the header 
indicates the current sort order. 

9. To revert the filter settings to their default values, click Reset. 

Reviewing and Sending Follow-back 

Requires system permission:  fb_manager  

Prior to sending a follow-back bundle, you should review each follow-back need to verify that it is 
being sent to the appropriate source and that all necessary information is included. 

To review and send needs in an open follow-back bundle: 

1. Follow the steps in the Searching for a Follow-back Bundle section of this chapter. 

2. Click the ID of the bundle to be sent.  

3. All needs included in the bundle are listed at the bottom of the page.  Review each need: 

a. If you wish to view or edit a record or patient set associated with a follow-back need, 
click the link in the Pat/Rec column. 

b. If a need is assigned to the wrong facility, refer to the Assigning a Follow-back Need to 
another Facility section of this chapter. 

c. To review or edit the need, click the ID of the need.   

i. Update the text in the Question and Comment fields as necessary. 

ii. Use the  lookup to update the Physician field as necessary. 

iii. Add or Remove data items using the corresponding links. 

iv. You may change the Urgency using the drop down list box.  The urgency level of 
the bundle will be set to the highest level of any need.  You may use this field to 
prioritize the processing of follow-back requests. 

v. Click Save. 
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d. If appropriate, you may close the follow-back need without sending it to the facility. 

i. Click the link in the ID column. 

ii. Change the Need Status to Closed. 

iii. Click Save.  The need is removed from the Follow-back Management tool.  It can 
be seen on the follow-back page of the record or patient set. 

4. In the bundle’s Send To field, specify the person at the facility to receive the query.  Click 
the lookup  icon to search the list of contacts associated with the facility.  You will not be 
able to select an inactive contact or a contact associated with an inactive facility.  See 
Chapter 19: The Contact List and Chapter 18: The Organization and Facility List for more 
information. 

5. Click Send Bundle.   

a. If a valid address is available for each follow-back need, you will be prompted to 
confirm that you wish you send the bundle of needs.  Click OK.  The status of the 
bundle will change from Open to Waiting.  If a valid address cannot be identified for 
one or more of the needs, an error message will be displayed.  If a physician is 
designated for the need, a valid address must be defined for that physician in the 
Contact list.   If no physician is designated, a valid address must be defined for the 
organization listed as the bundle’s Source to Query. 

b. Click Print Bundle to create and open a PDF file containing the follow-back letters.  
There will be a separate letter for each physician and organization representative 
listed as a recipient.   Use the Acrobat controls to print the letters and mail (or fax) 
them to the appropriate follow-back sources. 

c. Click Save Bundle to return to the follow-back manager.  Note:   Do not click Close 
Bundle to close the page.  This closes the needs and is not for exiting the page. 

Processing a Follow-back Response 

Requires system permission:  fb_manager  

The response to a follow-back inquiry may come in any form -- letter, fax, e-mail, or phone call.  
As determined by registry policy, you may make necessary edits to relevant data fields or you may 
provide the follow-back information to a staff member to make the necessary edits.  You may 
provide the follow-back information to your staff by entering it into the follow-back need or in other 
formats (copies of the letter or fax, for example).   Regardless, you should close each need 
addressed by the response.  When it is closed, SEER*DMS will send e-mail notification to the staff 
member who submitted the need.   

To process the response to a follow-back inquiry: 

1. Open the appropriate bundle: 

a. Follow the steps in “Searching for a Follow-back Bundle”.   

b. Click the ID of the Bundle. 
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2. If the respondent is someone other than the addressee, use the Lookup icon  to select 
the appropriate Responding Org Rep. 

3. If the response addresses all of the needs and you want other staff members to process 
the follow-back information: 

a. Enter a general description of the response in the Response field. 

b. Click Close Bundle.  Each need will be closed and email notification will be sent to the 
staff members who submitted the needs.  The description that you entered in the 
response field will be printed in the email. 

c. If necessary, provide follow-back information specific to each need to your staff 
members so that they can update the appropriate worklist tasks, records, or patient 
sets.   The staff can search the worklist or database using the record or patient ID 
provided in the email. 

d. You are now finished and can skip the remaining steps. 

4. If you want to change the record or patient set data based on the follow-back responses, 
repeat these steps for each need: 

a. Update the record or patient set data: 

i. Open the record or patient set associated with a follow-back need by clicking its 
link in the Pat/Rec column. 

ii. Make the appropriate changes to the record or patient set data fields.  If 
appropriate based on registry policy, scan any documents received from the 
physician or facility related to this follow-back request.  Attach the scanned 
document to the patient set or record as an Image. 

iii. Click Save. 

iv. Review your changes and add relevant comments.  Click Save and Exit. 

b. Set the status of the follow-back need: 

i. Click the ID of the need. 

ii. To document your findings, enter text in the Comment field. 

iii. Change the Need Status to Closed. 

iv. Click Save to exit the Follow-back Need page. 

c. Follow-back needs are often created during worklist tasks, that is, a staff member 
working on a task may have required additional information.  If the record or patient 
set was saved in a task to be completed at a later time, you or a staff member must 
open and complete the task.  Refer to the chapter related to the task for further 
instructions. 
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5. If you want to provide the follow-back information to your staff by entering it into the 
follow-back needs, repeat these steps for each need: 

a. Click the ID of the need. 

b. Enter the response to the need in the Response field. 

c. You may enter relevant text in the Comment field. 

d. Change the Need Status to Closed. 

e. Click Save to exit the Follow-back Need page.  

6. If you are expecting to receive information for needs that are still open, click Save 
Bundle. 

7. If the response did not address one of the needs, follow the instructions in Re-querying a 
Facility to re-send the need to the same facility. 

8. If a need was inappropriately addressed to this facility, follow the instructions in the 
Assigning a Follow-back Need to another Facility section of this chapter. 

9. If you have processed each need in the bundle or wish to auto-close any remaining open 
needs, click Close Bundle.  You must close the bundle even if you manually reassigned, 
re-queried, or closed each need.   

10. As a follow-back need is closed, e-mail notification will be sent to the staff member who 
submitted the need. 

Assigning a Follow-back Need to another Facility 

Requires system permission:  fb_manager  

If you do not receive a response from the facility, you may submit the request for information to 
another facility.   Any open follow-back need can be reassigned. 

To assign a follow-back need to a different facility: 

1. Find the bundle that currently contains the follow-back need by following the instructions 
in the Searching for a Follow-back Bundle section of this chapter. 

2. Click the ID of the Bundle. 

3. Click the ID of the need. 

4. Click the  lookup to select a different Source to Query. 

5. Verify that that the Need Status is set to Reassigned. 

6. Click Save to exit the Follow-back Need page. 

7. If there are other open needs in this bundle, you will need to click Save Bundle to exit.  
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Re-querying a Facility  

Requires system permission:  fb_manager  

If follow-back information submitted by a facility does not address the issue defined in a follow-
back need, use “re-query” to move the need to an open bundle for the same facility.   If there are 
no open bundles for the facility, one will be created.   

To resend a follow-back need to the same facility: 

1. Find the bundle that currently contains the follow-back need by following the instructions 
in the Searching for a Follow-back Bundle section of this chapter. 

2. Click the ID of the bundle. 

3. Click the ID of the need. 

4. Change the Need Status to Re-query. 

5. Click Save to exit the Follow-back Need page. 

6. If there are other open needs in this bundle, you will need to click Save Bundle to exit.  
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Chapter 23:  Requesting Records 
The SEER*DMS record request feature provides a mechanism for a registry to request either a 
specific record or a specified set of records from an outside organization, and to track responses 
received by the registry. 

If you need to request records from an organization or facility, the record request feature enables 
you to generate a letter to send via email, mail, or fax. It can also be used to facilitate 
communications by phone.  The current version of SEER*DMS does not support e-mail encryption, 
so record requests related to specific patients cannot be sent via e-mail at this time.  After you 
have added a record request to the system, SEER*DMS creates a tracking page for the request. 
This page can be used to keep track of the imported file(s) which resolve the request. 

In this chapter, you'll learn about: 

• Using the Record Request Manager 

• Creating and Sending a Record Request 

• Viewing Tracking Information for a Record Request 

• Tracking Receipt of Records 

• Resending a Record Request 

• Reporting a Deficient Facility to a Supervising Agency 

Using the Record Request Manager 

Requires system permission: record_request_add or record_request_resolve 

To view a list of record requests: 

1. Select Manage > Record Request. 

2. To sort the list by the data in any column, click on the column heading. 

• ID - Record Request ID 

o A GRR prefix denotes a General Record Request, a request for all records of a certain 
record type for a specified period of time. 

o An SRR prefix denotes a Specific Record Request, a request for records for a 
specified patient. 

• Contact – The ID of the organization representative to whom the request was sent.  
Click the  information icon to view the contact’s name. 

• Facility - Facility ID for the request recipient. 

• Record Type – The type of record that was requested. 

• Years - The year of the Dx Date listed in a Specific Record Request, or the year(s) 
listed in the From and Through dates of a General Record Request. 

• Sent By – SEER*DMS user who submitted the request for records. 

• Sent Dt - Date the request was sent. 

• Date Closed – The date that the record request was processed and closed. 
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3. To search for a specific request or limit the list: 

a. To search for a particular request or group of requests, enter one or more IDs in the 
Request ID(s) filter.  Enter SRR to view only Specific Record Request; enter GRR to 
view only General Record Requests. 

b. To view requests of a particular record type, click an item in the Record Type(s) filter. 
To display more than one record type, hold down the CTRL key and click on each type 
you wish to search. 

c. To limit the list of requests by a range of the dates sent, enter beginning and end dates 
in the Sent Dt From and Sent Dt Through filters.  Use the MM-DD-YYYY format or 
select a date using the Calendar tool.   

d. To limit the list of requests by the year of the Dx Date in a Specific Record Request, or 
the year of the From and Through dates in a General Record Request, enter a value in 
the Year filter. 

e. To view requests sent to a particular facility, enter a full or partial Facility ID in the 
Facility filter or click the adjacent  lookup icon to select a facility. 

f. To view requests sent by a specific user, enter a full or partial user name in the Sent 
By filter. 

g. Check Hide Closed Request(s) to search only for open requests; uncheck this box to 
view all requests regardless of status. 

4. Click Apply. 

5. Optional: To restore the default list view, click Reset. 

Creating and Sending a Record Request 

Requires system permission: record_request_add and contact_view 

A Specific Record Request is a request for data regarding a specific patient.  A General Record 
Request is a request for all records of a certain record type for a specified period of time. 

To request records for a specific patient: 

1. Select Manage > Record Request. 

2. Click Add. 

3. Set the Request Type to Specific Patient. 

4. Enter the name of the organization representative to be contacted in the Name of 
Contact field, or click the  lookup. 

5. Select the desired Record Type from the pull-down list. 

6. You must enter either the Patient Name or the Facility Patient ID. 

7. If available, enter Med Rec # (medical record number), Site, Histology, and Dx Date. 

8. Click Send. 

9. Follow the instructions below for Completing a Record Request. 
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To request a general set of records: 

1. Select Manage > Record Request. 

2. Click Add. 

3. Set the Request Type to General. 

4. Enter the name of the organization representative to be contacted in the Name of 
Contact field, or click the  lookup. 

5. Select the desired Record Type from the pull-down list. 

6. Limit the request to records from a specific time period by entering a start date in the 
From field and an end date in the Through field. Use the MM-DD-YYYY date format, or 
click the calendar icon.   

7. Add the Payment Amount ($) for the records, if payment is required. 

8. Click Send. 

9. Follow the instructions below for Completing a Record Request. 

Completing a record request: 

The Communication page will open to the organization representative's preferred contact 
method, if one is listed in the system. The current version of SEER*DMS does not support e-
mail encryption, so record requests for a Specific Patient cannot be sent via e-mail at this time.  
Communication options are limited by the contact information listed in the system for an 
organization representative. See Chapter 19: The Contact List for more information. 

1. A message describing the record request in detail will be automatically generated.   

2. If you are sending the record request by mail or fax, set the communication Type to 
Letter or Fax. Click Print to create a PDF file that can be saved and/or printed. 

3. If you are contacting the organization representative by telephone, set the Type to Phone. 
The representative's phone number will be displayed, and you can record a summary of 
the call in the Comments box.  

4. If you are contacting the organization representative by email, set the Type to Email. You 
may use the following fields to complete the email. 

a. Click either the To, CC, or BCC link to send the email to others as a primary addressee, 
as a carbon copy, or as a blind carbon copy. 

b. Click Attach File to attach a file to the message.  Do not attach files containing 
confidential data unless the file is encrypted.  (SEER*DMS does not provide a 
mechanism for encrypting data files or e-mail messages.)   

5. You may edit the content of the Message as needed. 

6. Click OK to save the record request and designate the request as Sent. The system will 
now assume for tracking purposes that you have mailed or faxed the letter, or contacted 
the representative by phone. 

7. Click Cancel to exit without saving the request. 
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Viewing the Tracking Information for a Record Request 

Requires system permission: record_request_resolve 

To view the tracking information for any record request: 

1. Select Manage > Record Request. 

2. Use the Filter to search for a request or limit the list. See the Using the Record Request 
Manager section of this chapter for more information. 

3. Click on the Request ID of the record request you wish to view, or click the adjacent edit 
link. 

Information about the record request is displayed at the top of the page in read-only format. The 
Communication History log at the bottom of the page displays a record of each time the request 
has been sent, including any Comments added from the Communication page. 

Tracking Receipt of Records 

Requires system permission: record_request_resolve 

When the requested records are received and imported into SEER*DMS, you need to set the status 
of the Record Request to Closed. 

To track the receipt of requested records: 

1. Select Manage > Record Request. 

2. Use the Filter to search for a request or limit the list. See the Using the Record Request 
Manager section of this chapter for more information. 

3. Click on the Request ID of the record request to be modified, or click the adjacent edit 
link. 

4. Click the  lookup to the right of the Import field to bring up a window that displays a list 
of the Imports.  The latest imports will be listed first.   

5. You may sort this list by clicking any of the underlined column headings. 

6. Click the Import ID adjacent to the import that satisfies the request, or click Cancel to 
close the Lookup window. 

7. If additional records are needed to resolve this request, leave the Request Status set to 
Open, and click Save to save your revisions. 

8. If all of the requested records have been received, you should close the record request. 
Set the Status to Closed, and click Save. 

Resending a Record Request 

Requires system permission: record_request_resolve 

To resend a record request: 

1. Select Manage > Record Request. 

2. Optional: Use the Filter to search for a request or limit the list.  See Using the Record 
Request Manager for more information. 
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3. Click on the Request ID of the record request you wish to resend, or click the adjacent 
Edit link. 

4. Optional: Enter a Tracking Comment. 

5. Click Resend. 

a. If you are sending the record request by mail or fax, set the communication Type to 
Letter or Fax. A formatted letter describing the record request in detail will be 
automatically generated. This letter can be edited and printed. 

b. If you are contacting the organization representative by telephone, set the Type to 
Phone. The representative's phone number will be displayed, and you can record a 
summary of the call in the Comments box.  

6. Click OK to designate the request as Resent; click Cancel to exit without resending the 
request. 

Reporting a Deficient Facility to a Supervising Agency 

Requires system permission: record_request_resolve 

If an organization or facility fails to respond to a General Record Request, you may be required by 
local policy to report this deficiency to a supervising agency. 

To report a deficient facility to a supervising agency: 

1. Select Manage > Record Request. 

2. Optional: Use the Filter to search for a request or limit the list. See the Using the Record 
Request Manager section of this chapter for more information. 

3. Click on the Request ID of the relevant record request, or click the adjacent edit link. 

4. Click the Report As Deficient link (Note: this link is only displayed for general record 
requests) 

5. Review the automatically generated e-mail, and edit it if necessary.  The email is 
automatically addressed to the email address specified in the system.registry.report-
to.state.email configuration setting. 

6. Click the Attach File link if you would like to attach any files with the email.  Do not 
attach files containing confidential data unless the file is encrypted. (SEER*DMS does not 
provide a mechanism for encrypting data files or e-mail messages.) 

7. Click Send. 
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Chapter 24:  Creating Reports and Extracting Data 
SEER*DMS includes an integrated reporting and extract module that enables you to run pre-
defined system reports and create standard extracts.  You may create external queries to generate 
custom reports and extracts.  Tools such as Perl, Microsoft Access, Crystal Reports, SAS, 
JWorkbench, and SEER*Stat can be used to generate reports or analyze data extracted from the 
SEER*DMS database. 

Although external applications may be used to access both the live database and the data 
warehouse, it is strongly recommended that you access the data warehouse unless the analysis 
absolutely requires data from the live database.  Complex or inefficient queries to the live database 
may affect system performance and affect interaction with the system by registry staff.  Registry 
staff with the appropriate system permissions can read and write data in the live database via the 
SEER*DMS application.  Write-access to the live database through external applications is 
controlled by Oracle system permissions and should only be granted to registry system 
administrators.  See Chapter 2:  Records and Patient Sets for descriptions of the live database and 
data warehouse.   

In this chapter, you’ll learn about 

• Creating Reports 

• Data Extracts and Submissions 

• Finding a Report or Extract 

• Organizing your Reports 

• Running a Report or Extract 

• Viewing Output of Reports 

• Downloading an Extract Data File 

• Searching the Worklist for Report and Extract Tasks 

• Sending Report Output to another User 

• Viewing the SQL for a SEER*DMS Report 

Creating Reports 

Three methods can be used to create a report using SEER*DMS data: 

• Generate one of the SEER*DMS Reports listed in the Report Manager.  These include reports 
which summarize workflow activities, track imported data, list data which fail edits, and 
provide quality control information.   

• Click a Print button or select a Print menu item in the system.   Print buttons, links, and 
menu items are integrated throughout the system.  Instructions for generating these 
reports are provided in the chapters for the related activities.  

• Create a custom, external report using any of a variety of software packages to access the 
SEER*DMS data directly.   Reporting tools such as Microsoft Access, Crystal Reports, SAS, 
etc., can be used to generate reports using data in the live SEER*DMS database or the data 
warehouse.  Sample reports and SQL are available on the SEER*DMS Web Portal 
(http://seer.cancer.gov/seerdms/portal).  The development and maintenance of external 
reports are the responsibility of registry staff.  Contact your registry’s system administrator 
for information regarding the external reports available at your registry. 

Revisions and additions to reports within SEER*DMS are under the control of the Change Control 
Board.  The Documentation section of the SEER*DMS Web Portal includes a description of each 
system report and extract.  This documentation describes reports in the SEER*DMS Report 
Manager as well as reports that are integrated as print mechanisms throughout SEER*DMS.   
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Data Extracts and Submissions 

Standard data extracts, such as the SEER submission file, have been integrated into the reporting 
module of SEER*DMS.  In addition, Perl extract scripts which use imbedded SQL queries have been 
provided as examples of external scripts for creating custom extracts.  Ad-hoc extracts can easily 
be produced using any tool or programming language which can access Oracle or ODBC.  These 
include Crystal Reports, Access, Perl, Python, SAS, and many others. 

The SEER*DMS database and data warehouse can be accessed from PC applications.  To access the 
database from Windows-based software, drivers must be installed on your PC to enable 
connectivity with the Oracle databases.  For example, you may install ODBC drivers to enable 
access to the databases using Crystal Reports or Microsoft Access.  Instructions and files required 
to install ODBC drivers are provided on the SEER*DMS Web Portal.  Other applications, such as 
SAS, may require additional components provided by the vendor. 

The SEER*Stat software can be used to generate reports and to generate incidence, survival, and 
prevalence statistics.  Once you extract data to a text file, you may use the SEER*Prep software to 
create a SEER*Stat database from the data stored in the extract file.   

Please contact your registry’s system administrator for specific instructions on creating or using 
external extract programs. 

Finding a Report or Extract 

System permissions: reports is required to access the Report Manager.  Certain reports also 
require reports_management; extracts are only listed if the user also has the extract_create 
permission.  A report’s permission is displayed on its Report Specifications page. 

To find a SEER*DMS Report or Extract: 

1. Select View > Reports.   

a. Reports and extracts are organized into categories.  These include a category for 
reports that you used recently, pre-defined categories, and categories that you 
create.  When you access the Report Manager, SEER*DMS will display the category 
that you viewed when you last visited the Report Manager.  If this is your first time 
accessing reports, all reports and extracts will be displayed.   

b. Reports and extracts are listed by ID.  Report IDs have an “RPT” prefix; extract IDs 
use an “EXT” prefix.  Registry-specific reports include a 2-character registry code 
following an RPT prefix (RPT-DT013A, for example).   

2. To view a list of reports in a category, click the category name displayed on the left.  

3. To search for a report by ID, title, or description, type text in the box labeled Type to 
Search and press the Enter key.   

Organizing your Reports 

System permissions: reports 

The report categories are defined by tags associated with the reports.  A report’s categories or 
“tags” are listed next to its title in the Report Manager.  You may create new categories by adding 
tags.  
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To organize reports into your own categories: 

1. Click View > Reports.  

2. Use the search box or category links to find the report (see the Finding a Report or Extract 
section of this chapter). 

3. Hover your cursor over a report to select it.  Click the Edit Tags link shown for the report. 

 

4. To create a new category, click Specify New Tag. 

5. To add the report to a category that you created previously, click the appropriate tag in 
the Add Tag list.  You may not add a report to a pre-defined category. 

6. To remove a report from a category, click the category’s tag in the Remove Tag list. 

Running a Report or Extract 

System permissions: reports is required to access the Report and Extract Manager.  Certain reports 
also require reports_management; extracts are only listed if the user also has the extract_create 
permission.  A report’s permission is displayed on its Report Specifications page. 

To run a Standard Report or Extract in SEER*DMS: 

1. Click View > Reports.  

2. Use the search box or category links to find the report (see the Finding a Report or Extract 
section of this chapter). 

3. Hover your cursor over a report to select it.  Click anywhere in the highlighted area to 
open the report template. 
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4. You will use the Report Specifications page to define the report’s output format and set 
parameters.   

a. A detailed description of the report parameters is included in the Description section 
of the page.  If you would like to view the SQL of the report, refer to the instructions 
in the Viewing the SQL for a SEER*DMS Report section of this chapter.  

b. Specifications used previously are available in the Previous Parameters section of 
the page.  Click a row to set all specifications to the same values used in a previous 
run.   

5. If you are executing a report: 

c. Edit the Title as necessary.  This is the first title line shown in the report.  Many 
reports include sub-titles which are often used to display parameter settings.  You 
may wish to run and review the report to determine the best title.   

d. Set the Output Format to PDF or CSV (Comma Separated Values) based on the 
following considerations.   

i. PDF:   Many of the SEER*DMS reports were designed to be viewed or printed as 
PDF files.  Forms and record printouts should be output to PDF and may not 
display properly in CSV format. 

ii. CSV:  Many of the reports are tabular and can be exported to Comma Separated 
Values (CSV) format.  You may open a CSV file in Excel or in a text editor.  The 
CSV format is recommended if you wish to copy Patient Set or Record IDs from 
the report and paste them into the ID Lookup (see Chapter 20:  Searching for 
Records and Patients). Tables that do not have consistent rows and columns may 
not export correctly to CSV.   

e. Use the parameters to customize the report.  Typically, parameters are used to specify 
the cohort or define the sort order.   

i. If a parameter’s label is in bold text, it is required.   

ii. A blank setting for an optional parameter implies “all possible values” for that 
field.    

iii. Some reports have the potential to request large volumes of data from the 
database.  To prevent a report from affecting the response time for other users, 
SEER*DMS terminates report queries that exceed the time limit or generate a 
large result set.  The thresholds are defined by the reporting.time-out.minutes 
and reporting.max.rows configuration settings.  SEER*DMS enforces the value for 
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maximum rows set in the configuration settings unless a report-specific value is 
specified in the report’s XML file.  If a report exceeds the time or row limit, the 
Report Output task will display an error message.  You will then have the 
opportunity to select new parameters to reduce the amount of output. 

6. If you are creating an extract data file: 

a. Edit the Title as appropriate.  This title will be associated with the Report Output task 
and can be used to find the task in the worklist.   

b. Set the extract parameters to meet your needs. If a parameter’s label is in bold text, 
it is required.  A blank setting for an optional parameter implies “all possible values”.  
(Note:  the filename entered here will be used as the default name when you 
download the extract file.) 

7. Run the report or extract by clicking the appropriate button: 

a. Run – queries the database and creates the report as you wait.  (This option is not 
available for extracts.)  If this process is able to complete within a time limit specified 
in the SEER*DMS configuration, the Report Output task will open automatically.  If the 
time limit is exceeded, the report will automatically be run offline and the Report 
Output task will be available in the worklist when the task completes. 

b. Run Offline – creates an automated, Run Report workflow task.  You will be returned 
to the Report Manager.    

8. To open the report, follow the steps in the Viewing Output of Reports section of this 
chapter.  To download the extract data file, follow the steps in the Downloading an Extract 
Data File section of this chapter. 

In order to protect the system from a slowdown caused by a large query, SEER*DMS limits the 
number of report and extract tasks that are processed simultaneously.  Additional report and 
extract tasks are queued and are executed when others complete.   

Viewing Output of Reports 

Requires system permission:  reports (certain reports also require reports_management) 

An automated Run Report worklist task is created when a report is executed.  When the report is 
successfully generated, a manual Report Output task is created and assigned to the user who 
submitted the report.  If the report was executed using the Run command, this Report Output task 
opens automatically (proceed to step 2 in the instructions below).  If a Run Report task fails, a 
System Failure task is created. 

To view the output of a report that you submitted: 

1. To view the output from a report that ran offline: 

a. Click View > Home or click SEER*DMS in the top banner to return to the home page. 

b. Click Report Output in the My Tasks section of your worklist summary.  If this link is 
not shown, the report may have failed or may still be running (see the instructions 
below for Searching the Worklist for Report and Extract Tasks). 

c. If you are searching for a recently generated report, click the Task column header to 
reverse the sort order of the list.  This will bring the most recently run report to the 
top of the list. (The oldest worklist tasks are shown at the top of the list when you first 
go to the worklist.) 
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d. To search for a report by title, enter a full or partial title into the Information filter 
and click Apply. 

e. If the task is not displayed in the list, the report may have failed or may still be 
running (see the instructions for Searching the Worklist for Report and Extract Tasks). 

f. Click on the Task ID to open the Report Output task. 

2. Due to memory limitations in the reporting engine and the impact of exhaustive queries on 
system response time, SEER*DMS must restrict the execution time and number of result 
rows generated by each report.  The thresholds are defined by the reporting.time-
out.minutes and reporting.max.rows configuration settings.  If either limit is exceeded, an 
error message will be displayed.  Click Edit Specifications to specify parameters that 
reduce the number of records, and re-run the report. 

3. Click View.  You will be prompted to Open or Save the report.  Click Open.  If the output 
format is PDF, Open the report with Adobe Acrobat.  If the output format is CSV, open the 
report with Excel.  

a. Use the Adobe or Excel controls to print or save this report. 

b. Close the Adobe or Excel window. 

4. If you need to correct parameter values or titles, submit a new report: 

a. Click Edit Specifications. 

b. You may make modifications to the Title, Output Format, and Parameter fields. 

c. Click Run or Run Offline.   A new task will be submitted.  The existing task will 
remain in the worklist until it is removed.  You will be returned to the worklist. 

5. If you will not need to access this Report Output task again, you should remove the task 
from the worklist to prevent unnecessary clutter.  Click Remove to permanently delete 
this task and the PDF or CSV file from the worklist.  If you may need to access this Report 
Output task again, click Close to save and return to the worklist. 

Downloading an Extract Data File 

Requires system permission:  reports and extract_create 

An automated Run Extract Report task is created when a SEER*DMS extract is executed.  When 
the task completes, an email is sent to the user who initiated the task and a Report Output task is 
created and assigned to the user.  If a Run Extract Report task fails, a System Failure task is 
created. 

To download an extract data file: 

1. Open the Report Output task for the extract: 

a. Click View > Home or click SEER*DMS in the top banner to return to the home page. 

b. Click Report Output in the My Tasks section of your worklist summary.  If this link is 
not shown, the extract task may have failed or may still be running (see the 
instructions below for Searching the Worklist for Report and Extract Tasks). 

c. If you are searching for a recently generated extract, click the Task column header to 
reverse the sort order.  This will bring the most recently run report or extract to the 
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top of the list. (The oldest tasks are shown at the top when you first enter the 
worklist.) 

d. To search for an extract by its title, enter a full or partial title into the Information 
filter and click Apply. 

e. If the task is not displayed in the list, the task may have failed or may still be running 
(see the instructions below for Searching the Worklist for Report and Extract Tasks). 

f. Click the Task ID to open the Report Output task. 

2. Review the following items that are provided in the Report Output task: 

a. Num Records – the number of records included in the extract data file.  If this value 
is zero, review the parameters that were specified to determine if an error was made. 

b. Filename – the filename field in the Parameters section contains the text that you 
entered when you executed the extract.  Depending on your browser, you may or may 
not be prompted for a filename.  If not, the file will be saved to your browser’s 
Download folder with this name. 

c. Parameters – verify that the correct parameters were used to create the extract. 

3. If you need to correct parameter values, submit a new extract:  

a. Click Edit Specifications. 

b. You may make modifications to the Title and Parameter fields. 

c. Click Run Offline.   A new task will be submitted.  The existing task will remain in the 
worklist until it is removed.  You will be returned to the worklist. 

4. To download the extract data file: 

a. Tips for managing downloads in Firefox: 

i. Typically, the file will be downloaded to a folder that is defined as the “Downloads” 
folder in Firefox.  In the Firefox menus, go to Tools > Options and select the 
Downloads tab.  Verify that the downloaded data will be stored in an appropriate 
location.  Change this location, if necessary.  Pease refer to the Firefox user’s 
manual for more specific instructions. 

ii. At any time, you may access your download folder by selecting Tools > 
Downloads from the Firefox menus. 

b. Click Download on the Report Output Task page.  Depending on browser settings and 
version, the file may be saved to your download folder automatically or you may be 
prompted to Open or Save the file.  If prompted, click Save to Disk.  If you are not 
prompted to select a location, the file will be saved in the folder that is defined as the 
“Downloads” folder in Firefox.  

5. If you will not need to access this Report Output task again, you should remove the task 
from the worklist to prevent unnecessary clutter.  Click Remove to permanently delete 
this task from the worklist and delete the data file from the server.  If you may need to 
access this Report Output task again, click Close to save and return to the worklist. 

 

Creating Reports and Extracting Data         7/26/2007 24-7 



Searching the Worklist for Report and Extract Tasks 

Requires system permission:  reports 

Each submitted report or extract task will appear in the worklist as a Run Report, Run Extract 
Report, Report Output, or System Failure task.  When the task is initiated, SEER*DMS creates 
either a Run Report or Run Export Report task.  The results for both are made available in a Report 
Output task which is assigned to the user who initiated the task.   If the task fails, an unassigned 
System Failure task will be initiated.  SEER*DMS users with the system_administration permission 
can access and review System Failure tasks. 

To search the worklist for output from report or extract tasks:  

1. Click View > Worklist or click the Worklist link on the home page. 

2. If you are only interested in reports and extracts that you submitted, enter your user 
name in the User(s) filter.   

3. Place a check in the Show Unassigned filter. 

4. Select Report Output in the Type(s) filter. 

5. Click Apply. 

If a report or extract that you were expecting is not displayed, it may still be running (change the 
filter to include “Run Report” or “Run Report Extract” tasks in the search). 

Sending Report Output to another User 

Requires system permission:  worklist_task_reassignment 

Typically, you should distribute reports and extract data by saving the files to disk or providing 
printed copies of reports.  However, SEER*DMS does allow you to reroute Report Output tasks to 
other users via the same mechanism used to reroute any worklist task.   Users must have the 
appropriate permissions to access the output tasks. 

To reroute a Report Output task to another user: 

1. Select View > Home or click SEER*DMS in the top banner to return to the home page. 

2. Click Report Output in the My Tasks section of the worklist summary.  If this link is not 
shown, the report may have failed or may still be running. 

3. If you are searching for a recently generated report, click the Task column header to 
reverse the sort order of the list.  This will bring the most recently run report to the top of 
the list. (The oldest tasks are shown at the top when you first enter the worklist.) 

4. To search for a report, enter a full or partial Report ID or title into the Information filter.  
Click Apply. 

5. Check the box to the left of the Task ID. 

6. Click Modify. 

7. Set the Action to Re-route to User. 

8. Select a user name from the pull-down list.  Only system users with permission to view the 
report or open the extract will be listed.  To view report output, the user must have either 
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the reports or reports_management permission; extract_create is required to access 
output tasks related to extracts. 

9. Click OK. 

Viewing the SQL for a SEER*DMS Report 

Requires system permission:  system_administration 

XML files containing source code for system reports are included in the System Files segment of the 
System Administration page.  If a report is implemented in SQL, the query will be included in its 
System File.   

To view a SEER*DMS Report’s SQL: 

1. Click System > Administration.  The current server log will be shown when you first 
enter the page. 

2. Select System Files from the Name drop-down list. 

3. Select the appropriate XML file from the Reports section of the Files drop-down list.  
Report filenames begin with the report ID (rpt064A.patient.edit.error.summary.cfg.xml, 
for example). 

4. Search for the “query” XML tag.  If the query type is SQL, the SQL will be displayed within 
the XML file.  If the query type is Java, the source code will not be displayed.   

5. SQL for system reports include non-SQL code to implemented report parameters.  Refer to 
the Sample SQL section of the SEER*DMS Web Portal for instructions in modifying the SQL 
so that it can be used in external applications like SQL Workbench. 
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Chapter 25:  Managing User Accounts 
SEER*DMS user accounts prevent unauthorized access to data and system functions, enable e-mail 
notifications from the system to users, provide a mechanism to assign system roles to individuals, 
and provide a means to store useful information about the registry staff who use the system. 

In this chapter, you'll learn about 

• Using the Staff Manager 

• Creating a New User Account 

• Modifying a User's Contact Information 

• Tracking Professional Training and Certifications 

• Changing a User's Roles 

• Restricting a User's Access to SEER*DMS 

• Deactivating or Activating an Account 

• Deleting a User Account 

• Resetting a User's Password 

Using the Staff Manager 

Requires system permission:  user_add, user_edit, or user_delete 

To find a user or view a list of users: 

1. Select System > Staff. 

2. To search for a user or limit the list, use the following Filters. 

a. Check Hide Inactive to search for active users only; uncheck this box to search for 
users regardless of their status. 

b. Enter a full or partial username, e-mail address, last name, or first name in the Search 
Terms box. 

c. Click Apply. 

3. To sort the list by the data in any column, click on the underlined column heading. 

4. To send a message to any individual user, click on the user's E-mail address. 

5. To view other information related to a user’s account, click the User Name or the edit 
link for the account. 

6. To create a report showing the accounts in the filtered list, click Print.  

7. To create an email message addressed to all users with active accounts, click Notify. 

The S column displays the Status of each account. 

       Active 
       Inactive 
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Creating a New User Account 

Requires system permission: user_add 

To add a user account to SEER*DMS:  

1. Select System > Staff. 

2. Click Add.  Default values may be set for some fields as determined by registry 
configuration settings.  (To view the settings for your registry, search for user.default in 
the Configuration section of System Administration). 

3. Enter a User Name consisting of 2-20 alphanumeric characters.   User names are case 
sensitive; all letters are automatically converted to lower case when an account is saved.  
Once an account is saved, the User Name can not be modified. 

4. Enter the user’s First Name and Last Name. 

5. Optional: Enter the user’s primary Phone Number. 

6. Optional:  Enter an alternate number for the user in the Alt Phone field. 

7. Enter the user’s E-mail address.  SEER*DMS will send system e-mail notifications to this 
address. 

8. Optional: Enter a full mailing address using the Street, City, State/Province, and 
Postal Code fields.  

9. Place a check in the Active box (default setting) to provide this user with immediate 
access to SEER*DMS, uncheck the box to prevent the individual from accessing SEER*DMS 
at this time.  This setting can be modified at a future time by any user with the user_edit 
permission (see the Restricting a User’s Access to SEER*DMS section of this chapter). 

10. Check the Access Restricted to Business Hours box to limit the user’s access to the 
“business hours" defined in your registry’s configuration of SEER*DMS.  Leave this box 
unchecked to allow access at any time of day. (To view the settings for your registry, 
search for system.business.hours in the Configuration section of System Administration). 

11. You may use the Offsite User box to track whether this user has been given remote 
access to the SEER*DMS server. This field is for tracking purposes only, remote access to 
SEER*DMS is controlled by the registry’s firewall settings. 

12. You may use any or all of the fields provided for tracking the user’s training and 

professional certifications.  Click the Calendar icon  to modify dates for the following: 

a. Training Completed – Date that registry training sessions were completed. 

b. Receipt of Signed Agreement – Date of the most recently signed data agreement 
form. 

c. CTR Certification – Certified Tumor Registrar certification date. 

d. IRB Training Completed – Date that the user completed training in IRB regulations. 

13. Enable system permissions for the user by assigning one or more roles. 

14. Click Save to create and save the new account.  SEER*DMS will send a message to the 
user's e-mail address providing the user name and a randomly generated password. 
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Modifying a User's Contact Information 

Requires system permission: user_edit 

To modify a user’s account information: 

1. Select System > Staff. 

2. Use the Filter to search the list for a specific user. 

a. Check Hide Inactive to search for an active user; uncheck this box to search for a user 
regardless of status. 

b. Enter a full or partial user name, e-mail address, last name, or first name into the 
Search Terms box. 

c. Click Apply. 

3. Click the user name for the account to be edited, or click the adjacent edit link. 

4. Use the text boxes in Staff Information to make any necessary revisions to the name, 
phone numbers, e-mail address, and mailing address. Note: The User Name field of a 
saved account cannot be modified. 

5. Click Save to save your revisions. 

Tracking Professional Training and Certifications 

Requires system permission: user_edit 

You may track the dates when a staff member has completed registry training, submitted a signed 
data agreement form, received CTR certification, or completed training in IRB regulations. 

To enter or modify dates for training and professional certification: 

1. Select System > Staff. 

2. Use the Filter to search the list for a specific user. 

a. Check Hide Inactive to search for an active user; uncheck this box to search for a user 
regardless of status. 

b. Enter a full or partial user name, e-mail address, last name, or first name into the 
Search Terms box. 

c. Click Apply. 

3. Click the user name for the account to be edited, or click the adjacent edit link. 

4. Click the Calendar icon  to modify dates for the following fields: 

a. Training Completed – Date that registry training sessions were completed. 

b. Receipt of Signed Agreement – Date of the most recently signed data agreement form. 

c. CTR Certification – Certified Tumor Registrar certification date. 

d. IRB Certification – Date that the user completed training in IRB regulations. 

5. Click Save to save your revisions. 
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Changing a User's Roles 

Requires system permission: user_edit 

Roles are sets of system permissions which determine the type of tasks that a user will see in the 
worklist and control access to specific functions or data.  SEER*DMS allows registry managers or 
system administrators to specify the permissions associated with each role (see Chapter 26:  
Managing System Roles).  You may assign one or more roles to a user’s account. 

To modify the role assignments for a user's account: 

1. Select System > Staff. 

2. Use the Filter to search the list for a specific user. 

a. Check Hide Inactive to search for an active user; uncheck this box to search for a user 
regardless of status. 

b. Enter a full or partial user name, e-mail address, last name, or first name into the 
Search Terms box. 

c. Click Apply. 

3. Click the user name for the account to be edited, or click the adjacent edit link. 

4. Only the roles currently assigned to the account will be listed.  Click the edit link in the 
Roles title bar to expand the list to include all roles. 

5. The roles assigned to the account will be checked and highlighted in the list.  To assign a 
new role to the account, check the box adjacent to the role’s name.  To remove a role 
assignment, uncheck the appropriate box. 

6. Click Save to save your revisions.  Changes to the user's system permissions implemented 
by changing role assignments will not affect the user's current session.  The changes will 
go into effect the next time the user logs in to SEER*DMS.  Note: If a user logs off and 
immediately logs back in, the changes may not have taken effect.  A delay of 1-3 minutes 
between sessions is required. 

Restricting a User's Access to SEER*DMS 

Requires system permission: user_edit 

SEER*DMS allows you to restrict a user's access to the business hours defined by your registry in 
the SEER*DMS configuration file.  This restriction does not limit access on holidays that occur 
during the work week and only restricts login access to SEER*DMS.  Access to the Login page itself 
is controlled by the registry's firewall and the user's firewall privileges. 

SEER*DMS also allows you to track whether a user has offsite access privileges, however, 
SEER*DMS does not control this access.  Firewall configuration and privileges are controlled by 
registry operations that are separate from SEER*DMS. 
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To set restrictions on a user account or track offsite access: 

1. Select System > Staff. 

2. Use the Filter to search the list for a specific user. 

a. Check Hide Inactive to search for an active user; uncheck this box to search for a user 
regardless of status. 

b. Enter a full or partial user name, e-mail address, last name, or first name into the 
Search Terms box. 

c. Click Apply. 

3. Click the user name for the account to be edited, or click the adjacent edit link. 

4. Check the Access Restricted to Business Hours box to limit the user’s access to the 
“business hours" defined by your registry.  Leave this box unchecked to allow login access 
at any time of day. (To view the settings for your registry, search for 
system.business.hours in the Configuration section of System Administration). 

5. Check the Offsite User box if this user has firewall privileges allowing them to access the 
SEER*DMS server from a remote location.  This field is provided for tracking purposes only 
and has no impact on a user's access. 

6. Click Save to save your revisions.  If you have changed the account to restrict access to 
business hours only, the change will not affect a user’s current session.  The change will 
go into affect the next time the user attempts to login to SEER*DMS. 

Deactivating or Activating an Account 

Requires system permission:  user_edit 

You may deactivate accounts that are no longer needed or require a temporary shutdown.  This is 
a reversible process, and any account can be reactivated.   A history of each account’s activity is 
permanently maintained for the purpose of tracking. 

To change the status of a user’s account: 

1. Select System > Staff. 

2. Use the Filter to search the list. 

a. Check Hide Inactive to search for active users only; uncheck this box to search for 
users regardless of their status. 

b. Enter a full or partial username, e-mail address, last name, or first name in the Search 
Terms box. 

c. Click Apply. 

3. Click the user name for the account to be edited, or click the adjacent edit link. 

4. Check the Active box to allow this user to access SEER*DMS, uncheck this box to 
deactivate the account and prevent the individual from accessing SEER*DMS. 

5. Click Save to save your revisions. 
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Deleting a User Account 

Requires system permissions:  user_edit and user_delete 

In order to preserve tracking information, you may not delete an account that has been used to log 
into the system. See the Deactivating an Account section of this chapter to close the account of a 
staff member who has left your organization.   

To delete a user account that has never been accessed: 

1. Select System > Staff. 

2. Use the Filter to search the list. 

a. Check Hide Inactive to search for active users only; uncheck this box to search for 
users regardless of their status. 

b. Enter a full or partial username, e-mail address, last name, or first name in the Search 
Terms box. 

c. Click Apply. 

3. Click the user name for the account to be edited, or click the adjacent edit link. 

4. Click Delete (this button is only displayed if the account has never been used to log into 
SEER*DMS). 

5. Click OK to confirm the deletion. 

Resetting a User's Password 

Requires system permission:  user_edit 

You may reset a user’s password in the event of a security concern or if the user cannot remember 
their password (passwords are encrypted in the database and cannot be viewed by the database 
administrators).   

To reset a user’s password: 

1. Select System > Staff. 

2. Use the Filter to search the list. 

a. Check Hide Inactive to search for active users only; uncheck this box to search for 
users regardless of their status. 

b. Enter a full or partial username, e-mail address, last name, or first name in the Search 
Terms box. 

c. Click Apply. 

3. Click the user name for the account to be edited, or click the adjacent edit link. 

4. Click Reset Password.  A new password will be randomly generated for the user.  An e-
mail message will be sent to the user informing them of the new password.   



Chapter 26:  System Roles & Permissions 
System permissions are used in SEER*DMS to control access to specific functions or data.  Roles 
are sets of system permissions.  SEER*DMS allows registry managers to create roles as described 
in this chapter and to assign one or more roles to each user account (see Chapter 25:  Managing 
User Accounts).  

In this chapter, you’ll learn about 

• Understanding System Roles and Permissions  

• Using the Role Manager  

• Creating a New Role 

• Modifying a Role 

• Printing a Role’s Permissions 

• Printing or Viewing a Role’s User List 

• Deleting a Role 

Understanding System Roles and Permissions 

The table below lists all system permissions in SEER*DMS.   The permissions restrict access at 
three levels:  

1. A permission may control access to a full menu or to individual items on a menu.  If a user 
does not have the necessary permission, the menu or menu item will not be visible.  For 
example, users who do not have the fb_manager permission will not see Follow-back on 
the Manage menu. 

2. A permission may determine if a user can view or open a specific type of task.  For 
example, users who do not have the consolidate permission will not see Consolidate tasks 
in the worklist, or in the worklist summary on the home page.   Consolidate tasks cannot 
be assigned or re-routed to them. 

3. A permission may restrict access to specific buttons or links on a page.  For example, 
users who have the rec_edit permission will be able to perform Resolve Record Errors 
tasks.   But, unless their role also includes the fb_initiate permission, they will not be able 
to submit follow-back needs while performing the tasks. 

A set of permissions may be required to perform an operation.  Consider the consolidation of 
patient data as an example.  If a user has the consolidate and pat_edit permissions, they will be 
able to open consolidate tasks and make changes to the patient set data fields as they consolidate.   
However, they are likely to require other permissions, such as fb_initiate, to complete the task.  

Permission A user with this permission has the 
ability to: 

For more information see: 

afl_initiate Create an Abstract Facility Lead (AFL) 
 

afl_manager Assign, track, and update AFLs 

Chapter 21:  Managing 
Abstracting Assignments 

afup_manager Modify, track, and update active follow-up 
(AFUP) needs 

afup_update Limited use of the AFUP Manager.  Update a 
patient’s follow-up information in a single 
AFUP and for the batch of AFUPs in a 
communication. 

Chapter 16:  Follow-up 

consolidate Open Consolidate tasks (pat_edit is required 
to consolidate the data) 

Chapter 12:  Consolidating Data 
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Permission A user with this permission has the 
ability to: 

For more information see: 

consolidate_fup Open Consolidate FUP tasks 
(pat_edit_demographics or pat_edit is 
required to consolidate the data) 

Chapter 16:  Follow-up 

contact_add Add a physician or other contact 
(contact_edit is also required) 

contact_edit Edit information for a physician or other 
contact 

contact_view View Contact List in read-only mode 

Chapter 19:  The Contact List 

extract_create Create a data file by executing one of the 
standard extracts in the reports and 
extracts manager (View > Reports) 

Chapter 24:  Creating Reports 
and Extracting Data 

facility_add Add a facility (facility_edit is also required) 
facility_edit Edit a facility 
facility_view View Facility List in read-only mode 

Chapter 18:  The Organization 
and Facility List 

fb_initiate Add a follow-back need (in the record or 
patient set editor) 

fb_manager Modify, re-assign, or re-query follow-back 
needs; send follow-back queries and 
process responses 

Chapter 22:  Follow-back 

import_electronic Load data files through the SEER*DMS 
interface 

Chapter 5: Importing Data Files 

import_manual Perform data entry Chapter 6: Data Entry 
import_resolution Open Import Review tasks Chapter 5: Importing Data Files 
lkup_modify Add or edit codes to lookup lists (the 

lookups affected differ by registry) 
 

match Select or reject matches in Match-
Consolidate tasks 

Chapter 10: Matching Incoming 
Records to Database 

news_add Add a news item.  You may edit and delete 
items that you add. 

news_delete Delete a news item entered by another 
user. 

news_edit Edit a news item entered by another user. 

Chapter 3: Using SEER*DMS 
 

pat_delete Delete a Patient, CTC, TX, or TXr  (pat_edit 
is also required) 

pat_edit Modify patient set fields other than over-
ride flags, perform census tract resolution, 
use Patient Lookup, open Visual Edit Patient 
Set tasks 

pat_edit_demographics Modify fields on demographic and comment 
pages of a patient set, use Patient Lookup 

pat_edit_overrides Modify the over-ride flags in a patient set 
(pat_edit is also required) 

pat_end_task Forward Resolve Patient Errors task to next 
workflow task regardless of the number of 
errors; does not affect submissibility (CTC 
status) 

Chapter 11:  The Patient Set 
Editor 

pat_lookup_advanced Use an alternate search algorithm in the 
Patient Lookup (if more than one algorithm 
is defined) 

Chapter 20:  Searching for 
Records and Patients 

pat_read_only Access a patient set in read-only mode, use 
Patient Lookup 

pat_undelete Undelete a Patient, CTC, TX or TXr (pat_edit 
is also required) 

Chapter 11:  The Patient Set 
Editor 
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Permission A user with this permission has the 
ability to: 

For more information see: 

rec_build_cfo Build a CTC from a casefinding record while 
editing the record 

Chapter 21: Managing 
Abstracting Assignments 

rec_build_dco Build a CTC from a death certificate record 
while editing the record 

Chapter 17: Death Clearance 

rec_build_sho Build a CTC from a short health record while 
editing the record 

 

rec_edit Modify a record; use Patient Lookup Chapter 8: Resolving Record 
Errors 

rec_read_only  Access a record in read-only mode; use 
Patient Lookup 

Chapter 20:  Searching for 
Records and Patients 

record_request_add Create and send requests to outside 
organizations for records; view list of 
current Record Requests 

record_request_resolve Send, track, or update record requests in 
Record Request Manager 

Chapter 23:  Requesting Records 
 

reports Access and generate standard reports 
reports_management Access and generate management reports 

Chapter 24:  Creating Reports 
and Extracting Data 

res_pat_errors Open Resolve Patient Set Errors tasks 
(pat_edit is also required to complete the 
task) 

Chapter 14: Resolving Patient 
Set Errors 

res_rec_errors Open Resolve Record Errors tasks (rec_edit 
also required to complete task) 

Chapter 8: Resolving Record 
Errors 

role_add Add a new system role 
role_delete Delete a system role (role_edit permission is 

also required) 
role_edit Edit a system role 

Chapter 26:  System Roles & 
Permissions 
 

screening Set reportability status of a record Chapter 9: Screening for 
Reportability 

study_add Define a new special study 
study_delete Delete a special study 
study_edit Edit a special study 
study_pat_edit Add or remove a patient set from a special 

study; edit the patient set’s inclusion criteria 
for a study 

study_rec_edit Add or remove a record from a study; edit 
the record’s inclusion criteria for a study 

Chapter 28:  Special Studies 

system_administration Provides control of system processes: 
execute system administration tasks 
(System > Tasks); terminate tasks 
regardless of task assignment 

Chapter 28: System 
Administration 

system_errors View and manage System Error tasks Chapter 28: System 
Administration 

user_add Add a new user account 
user_delete Delete a user account (user_edit is also 

required) 
user_edit Edit a user account 

Chapter 25:  Managing User 
Accounts 

view_management_tasks Access the Tasks section of the System 
menu; execute system tasks that do not 
require the system_admin permission 

Chapter 28: System 
Administration 

vis_edit_pat Open Visual Edit Patient Set tasks (pat_edit 
also required to edit) 

Chapter 13: Visual Editing 

worklist_task_reassignment Re-route or release worklist tasks Chapter 4: Using the Worklist 
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Using the Role Manager  

Requires system permission:  role_add, role_edit, or role_delete 

The system roles available in SEER*DMS are defined by registry management and vary from 
registry to registry.  

To view the list of SEER*DMS roles defined for your registry: 

1. Select System > Roles 

2. To sort the list by the data in a column, click on the linked (underlined) column heading.  

3. To print the permissions associated with a role, click the report link. 

The Last Editor column shows the user who last edited and saved the role.  The Last Edited 
column shows the date and time stamp when it was last saved. 

The function of the copy link is described in Creating a New Role.  The edit link is described in the 
Modifying a Role section of this chapter. 

Creating a New Role 

Requires system permission:  role_add 

To create a new role in SEER*DMS: 

1. Select System > Roles 

2. There are two mechanisms for creating a new system role in SEER*DMS: 

a. To create a role by using an existing role as a template, click the copy link adjacent to 
an existing role.  Use this technique if you are creating a role with a similar set of 
permissions as an existing role. 

b. To create a role using a blank template, click Add. 

3. Enter a Role Name consisting of 2-30 alphanumeric characters. Role names must be 
unique. 

4. Enter text in the Description field.  This description will be displayed in the Role Manager 
and in reports. 

5. Check Allow for each system permission that is appropriate for this role. 

6. Click Save to create and save the new role.  

The new role will have no impact until the role is assigned to user accounts (instructions are 
provided in Chapter 25: Managing User Accounts chapter).  

Modifying a Role 

Requires system permission:  role_edit 

To make changes to the name, description, or permissions assigned to a role: 

1. Select System > Roles 

2. Click the role’s name or its adjacent edit link.  
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3. Make any necessary modifications to the role’s Name or Description.  SEER*DMS uses 
underlying role IDs to manage the assignments of users to roles.  Therefore, changing the 
name of the role does not affect the accounts of any users.  Users that had this role with 
its old name will continue to have the role with the new name. 

4. Check Allow for each system permission that is appropriate for this role.  Uncheck any 
permission that is not appropriate. 

5. Click Save to save your revisions.  Changes to the role’s permission settings will not affect 
a user’s current session.  The changes will go into affect the next time the user logs into 
SEER*DMS. 

Printing a Role’s Permissions 

Requires system permission:  role_add, role_edit, or role_delete 

To create a report showing the permission settings for a role: 

1. Select System > Roles. 

2. Click the report link for the role of interest.  The report engine will generate a system 
report in PDF. 

3. Depending on your browser settings, you may have the option to Open or Save the report.  
If so, click Open.  The PDF will open in an Adobe Acrobat window.   

4. The report includes a list of the system permissions activated for this role.  The report 
titles include the role name, description, date last modified, and the user name of the 
person who last modified this role. 

5. Use the Adobe controls to print or save this report.  

6. Close the Adobe window. 

Printing or Viewing a Role’s User List 

Requires system permission:  role_edit 

To print or view the users who have a specific role: 

1. Select System > Roles. 

2. Click the role’s name or its adjacent edit link.  

3. Click View Users (n), where n = number of active user accounts with this role.   The 
report engine will generate a system report in PDF. 

4. Depending on your browser settings, you may have the option to Open or Save the report.  
Click Open.  The PDF will open in an Adobe Acrobat window.   

5. The report lists the name and user name for the user accounts which are active and have 
this role.  The “Other Roles” column indicates if this is the user’s only role.   

6. Use the Adobe controls to print or save this report as necessary for maintaining the user 
accounts.  

7. Close the Adobe window. 
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Deleting a Role 

Requires system permission:  role_delete and role_edit 

Caution:  Users are assigned system permissions via the role or roles that are assigned to their 
user accounts.  Typically, each user account will have only one role.  If you delete a user’s only role 
then you will be removing all system permissions for that user.  They will be able to log in and use 
some functions in the View menu; all other system functions will be disabled for their account.  

To delete a system role in SEER*DMS: 

1. Select System > Roles 

2. Click the role’s name or its adjacent edit link.  

3. Click View Users to generate a report of the user accounts that currently have this role.  
This report includes a column labeled “Other Roles”.  Print or save this report so that you 
can assign alternate roles to users with an “N” in this column.  

4. Click Delete.  

5. Click OK to confirm the deletion. 

 



Chapter 27:  System Administration 
SEER*DMS is a Web-based application that interacts with the registry’s Oracle database.  The 
registry’s information technology (IT) staff are responsible for a variety of tasks related to 
maintaining the integrity and security of the database, providing ad hoc programming support to 
registry staff, and maintaining the hardware systems that support SEER*DMS.  The first sections of 
this chapter provide a broad overview of the duties of the registry system administrators and a 
cross-reference to more specific information related to these topics. 

System Tasks are available within SEER*DMS to execute processes in batch mode.  Management 
and IT staff should develop registry-specific policies and procedures for the use of these utilities.  
The System Administration page in SEER*DMS allows you to monitor system logs and review 
registry-specific configuration settings and algorithms. 

In this chapter, you’ll learn about 

• Technical Skills Required to Maintain SEER*DMS 

• Overview of IT Responsibilities 

• SEER*DMS Technical Support 

• System Tasks 

o System Tasks to Build CTCs from Non-abstract Records 

o Patient Set Edits Task 

o Identify Patients for Active Follow-up (AFUP) 

o Task to Purge Death Certificate Records 

o Task to Purge Supplemental Records 

o Task to Rematch Unlinked Records 

o Aborting a System Task 

• System Administration Page  

o Configuration 

o Environment 

o Hibernate 

o Logs 

o Memory 

o System Files 

o System Properties 

o Threads 

Technical Skills Required to Maintain SEER*DMS 

In addition to proficiency in navigating within the MS Windows environment, the collective skill sets 
of your staff should include the skills described below.    

Server Management 
The registry’s network administrator should have the skills to manage day to day 
operational issues such as server startup and shutdown, backup and recoveries, etc. 
Instructions written specifically for your registry’s system configuration are posted in the 
System Administration section of your registry folder on the SEER*DMS Web Portal.  
 

 

System Administration 7/30/2007 27-1 



Ability to Write SQL Queries 
IT staff must have the ability to write and optimize SQL queries and have a full 
understanding of the SEER*DMS database structure.  If the registry has limited SQL 
experience, formal SQL training should be considered.   The SEER*DMS Web portal 
(http://seer.cancer.gov/seerdms/portal) contains sample SQL as well as links to SQL 
references.   SQL for the system reports is embedded in the report XML that may be viewed 
via the System Administration page.    
  
Understanding of Data Structures 
In order to put the SQL to good use, the IT staff must also have a full understanding of the 
SEER*DMS database.  This would include a mapping to the legacy system, a mapping to the 
data fields displayed in the SEER*DMS editors, and a complete understanding of all table 
relationships.  Diagrams are available on the SEER*DMS Web portal and data mappings are 
provided in the Field Mappings section of the Help menu.  

 
Ability to Create Reports using an External Reporting Package 
The SEER*DMS application includes numerous reports that were determined to be useful to 
all registries and could be implemented generically.  If the registry requires additional 
reports, the registry’s IT Staff must be able to generate and maintain the reports in an 
external reporting package that interfaces with the Oracle database. 

 
Proficiency in an External Programming or Scripting Tool 
Registry IT Staff must have the ability to restructure data files into SEER*DMS supported 
file formats and to create registry-specific extracts.  To do this in a reliable and repeatable 
fashion, the IT staff must be able to write and maintain programs or scripts to perform 
these tasks.  For example, registries often need to write ad hoc programs to create text files 
in the Generic Supplemental Format containing data sent by non-medical organizations.  
The files sent by these organizations are typically text files in non-standard formats.  Any 
programming tool may be used for this purpose.  However, many external programming 
tasks require connectivity to the Oracle database.  Therefore, the IT staff must select and 
learn to use a tool that can interface directly with the Oracle database.   
 
Several scripts, written in Perl, are delivered with SEER*DMS.  If the registry wishes to 
utilize these scripts, it is the responsibility of the IT staff to maintain, update, or re-write 
them as necessary.    

Overview of IT Responsibilities 

The following summarizes the responsibilities of the registry’s IT staff.  Information and 
instructions related to these tasks are available in the SEER*DMS Technical Reference and various 
sections of this User’s Manual, as indicated below. 

1. Maintain valid licenses and maintenance agreements for Oracle, Linux, and any other 
server-side software required to implement SEER*DMS at your registry.  The specific list of 
software required is provided in the registry-specific section of the SEER*DMS Portal 
(http://seer.cancer.gov/seerdms/portal). 

2. Using the SEER*DMS system itself, registry IT staff will: 

a. Execute the System Tasks described in this chapter.  These include Build CFOs, Build 
DCOs, Patient Set Edits, etc. 
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b. Extract data from the SEER*DMS database and save the data in the format required for 
a data submission or for use in an analytic tool (see Chapter 24:  Creating Reports and 
Extracting Data). 

c. Monitor the system logs displayed in the SEER*DMS System Administration tool and 
report problems to IMS staff. 

d. Import data files as described in Chapter 5:  Importing Data Files. 

e. Provide technical support to registry staff, as needed.  This requires a general 
knowledge of the system features described throughout this manual and the registry-
defined workflow detailed in the SEER*DMS Technical References. 

3. Using registry-defined strategies and systems, registry IT staff will: 

a. Maintain on-site and off-site backups of the SEER*DMS servers. 

b. Incorporate SEER*DMS servers into the registry-wide disaster recovery plan. 

4. Using an external reporting package such as Crystal reports, IT staff will: 

a. Create new external reports as requested by registry staff.  This will require a working 
knowledge of SQL and the reporting software. 

b. Acquire and install the reporting software on the PCs of all registry staff who need to 
run external reports. 

5. Using Windows tools, registry IT staff will: 

a. Configure the registry’s personal computers and maintain current versions of client 
software required for SEER*DMS as described in Chapter 3:  Using SEER*DMS.   

b. Provide on-site technical support for all PC and network-related issues. 

c. Write, test, and execute routines to pre-process data files that are not formatted per 
the registry-defined specifications for SEER*DMS import files. 

d. Write, test, and execute routines to extract data from the SEER*DMS database 
according to registry-specific requirements.  Standard extracts for SEER, NAACCR, and 
other submissions are available within the SEER*DMS application. 

e. Write, test, and execute routines to process extracted data files (running edits, making 
data files available to staff, submitting data files to NCI and other organizations). 

f. Monitor external logs and report problems to IMS staff. 

g. Manage system disaster recovery procedures. 

6. Using an external SQL tool, registry IT staff will: 

a. Fill ad hoc requests for data, reports. 

b. Create and maintain registry-defined Oracle tables.   A schema is available on the same 
server as the data warehouse for registry-defined tables.  The registry may use this 
schema to create tables for research, linkage to SEER*DMS data warehouse tables, and 
other purposes.  Tables in this schema cannot be linked to the SEER*DMS production 
database.  Registry staff are responsible for all activities related to the maintenance and 
use of this schema. This includes the creation of tables, populating tables with values 
from SEER*DMS data warehouse tables or external sources, deletion of tables, updates 
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of values within tables, and the quality control of all scripts and programs involved in 
these tasks. 

SEER*DMS Technical Support 

Critical issues that inhibit registry operations should be reported immediately to IMS staff.  Non-
critical issues should first be triaged by the registry’s local technical support team.   

The registry must appoint a local technical support team who can respond to routine issues.  This 
team should include representatives from IT, editing, and management.  The registry team will 
triage routine technical support issues and perform an initial investigation.  If an issue cannot be 
resolved on site or requires a system change, provide a description of the problem and the results 
of the investigation to IMS.  Unresolved issues and requests for new features should be submitted 
via the Technical Support Squish project (https://www.squishlist.com/seerdms/support).  

System Tasks 

Requires system permission:  system_administration enables access to all tasks;  
view_management_tasks enables access to tasks that do not change any fields in the database 

The Tasks section of the SEER*DMS System menu provides access to utilities or “tasks” that enable 
you to implement processes in batch mode.  For example, the Build DCO system task enables you 
to auto-build batches of DCO cases from death certificate records as opposed to using the 
SEER*DMS editor to build each DCO case individually.   

The majority of the System Tasks require the system_administration permission.  Tasks that do not 
implement a change to any data in the database may only require the view_management_tasks 
permission. 

Management and IT staff should develop registry-specific standard operating procedures (SOPs) 
related to the System Tasks.   The SOPs should address these topics:  scheduling considerations, 
procedures that must be completed prior to executing the task to ensure that the task is not 
executed on data inappropriately (e.g., that all death clearance processes are performed prior to 
executing the Build DCO system task), and a systematic review of data and relevant reports when 
the task finishes execution. 

The System Tasks enabled in SEER*DMS vary by registry.  All system tasks are listed below and 
are described in subsequent sections of this chapter:  
 

• System Tasks to Build CTCs from Non-Abstract Records: 

o Build CFOs 

o Build DCOs 

o Build SHOs 

• Identify Patients for Active Follow-up (AFUP) 

• Patient Set Edits 

• Purge Death Certificate Records 

• Purge Supplemental Records 

• Rematch Unlinked Records 
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System Tasks to Build CTCs from Non-Abstract Records 

Requires system permission:  system_administration 

There are three separate, record-specific tasks for building CTCs from reportable, unlinked records.  
These tasks enable you to submit data to SEER or other sources despite the fact that an abstract is 
currently unavailable.   To reduce the number of CTCs built solely from these records, it is 
recommended that you follow your registry’s Death Clearance and Casefinding procedures prior to 
executing any of these tasks.   Refer to Chapter 17:  Death Clearance and Chapter 21:  Managing 
Abstracting Assignments for further instructions. 

• Build CFOs – build CTCs from casefinding,  HL7 E-Path, or NAACCR Abstract records with a 
value of 7 for class of case (NAACCR abstract – class of case 7 is only an option in Hawaii’s 
version of SEER*DMS). 

• Build DCOs – build CTCs from death certificate records   

• Build SHOs – build CTCs from short health records 

If a reportable record is not linked to any Patient Set in the database, a new Patient Set will be 
created.  If the record is linked to a Patient Set but not to a CTC in that Patient Set, a new CTC will 
be created in that Patient Set. An unassigned Visual Edit Patient Set task will be added to the 
worklist for each newly created or modified Patient Set. 

Alternatively, you may use the record menu in the SEER*DMS editor to create a CTC for each 
record individually.  Instructions are provided in the Chapter 21:  Managing Abstracting 
Assignments.   

To build CTCs from unlinked, reportable records: 

1. Use reports and other means to verify that all appropriate death clearance or casefinding 
procedures have been completed.  Execute system reports and registry-defined external 
reports to stratify the records by facility or other relevant factors.  If necessary, use the 
appropriate system report to list candidate records and review the records manually.  The 
reports below are available within the system.   The following system reports show the 
number of records that will be considered by each task.  Instructions for generating 
system reports are provided in Chapter 24:  Creating Reports and Extracting Data. 

a. Frequency Reports – Use these reports if you are interested in the number of records at 
a particular facility that will be used to build CFO, DCO, or SHO cases.  These reports 
show an estimate that is not as accurate as the count displayed on the screen when you 
set the build task’s options.  However, only a total count is shown in the build task. 

i. RPT-067B – Frequencies for the Build CFOs task. 

ii. RPT-068B – Frequencies for the Build DCOs task.   

iii. RPT-089B – Frequencies for the Build SHOs task 

b. Record Listings – You may use these reports if you wish to review the individual records 
being considered by the build tasks.  

i. RPT-067C – Candidates for the Build CFOs task.  

ii. RPT-089C – Candidates for the Build SHOs task. 

2. To continue with the Build CTC task, click System > Tasks. 
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3. Based on the record-type you wish to use in the build, click the link for the appropriate 
Build CTC system task.  Because of the demand on resources, the task links for the Build 
tasks will be disabled if any of the Build tasks are currently executing. 

4. Set the parameters for the task: 

a. Enter a value for Year.  The year parameter is required for all Build CTC system tasks.  
Registry-specific requirements determine which database field is used for year (e.g., 
date of diagnosis or screening year for CFO records, date of death for DCO records, 
date of diagnosis for SHO records).  Please refer to the documentation section of the 
screen to determine the year used for each record type in your registry’s configuration. 

b. If you would like to specify a particular Facility Source, enter the appropriate ID in the 
Facility field.  This parameter is not available for the Build DCOs system task. 

c. You may specify the type of record considered by the Build CFO system task.   The 
specific types of record considered by this task vary by registry.   In all registries, 
casefinding and HL7 E-Path records may be used.  NAACCR abstract records with a 
value of 7 for class of case may also be used in some registries.  Consult registry 
management to determine which types of records should be used in the build. 

5. Click Recalculate to view the number of records that will be considered by the task. 

6. You may enter text related to this task in the Comment field.  The comment for the last 
build of each type is stored in the database (utility_history table). 

7. Click Start.  SEER*DMS will begin executing the appropriate automated Build CTC task 
and return you to the System Tasks page. 

8. After the task completes, follow the instructions below to review a report showing the 
results of the task.   

SEER*DMS creates an unassigned Visual Edit Patient Set worklist task for each Patient Set created 
or modified by the build.   To find the editing tasks, enter "DCO Build", “CFO Build”, or “SHO Build” 
in the worklist’s Information filter.  To complete these editing tasks, follow your registry's 
guidelines for editing missing CTC data fields and resolving errors in patient data.  The build task 
also generates a report listing each Patient Set created or modified by the build.    

To review a Build Report for any of the Build CTCs System Tasks: 

1. Select View > Home. 

2. Click Report Output in the My Tasks section of your worklist summary.  If this link is not 
shown, then the build may have failed or may still be running. 

3. If you have a large number of Report Output tasks, use the filter to search for the results 
of the Build CTC System Task: 

a. Enter “Build” in the Information filter to search for a worklist task related to any of the 
Build CTC System Tasks.  Or you may indicate the specific task by specifying “Build 
CFOs”, “Build DCOs”, or “Build SHOs” in the filter. 

b. Click Apply. 

4. Click on the Task ID to open the Report Output task.   

5. Click View.  Depending on your browser settings, the report may open automatically or 
you may need to click Open. The PDF will open in an Adobe Acrobat window. 
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6. Use the Adobe controls to print or save this report. 

Patient Set Edits Task 

All edits are executed each time a patient set is opened, validated, or saved in the SEER*DMS 
editor.  The Patient Set Edits system task enables you to re-execute the edits on patient sets in the 
database.  You may run the edits on all patient sets or on a cohort defined by year of diagnosis.  
Use the Patient Set Edits task to ensure that new or modified edits are evaluated.   

A polisher is a system utility that derives, calculates, or assigns data field values.  For example, 
polishers are used to derive collaborative stage variables; assign census tract based on address; 
and calculate the age at diagnosis based on date of birth and date of diagnosis.  When a patient set 
is opened, saved, or validated, a polisher will be executed if the value of a related data item 
changes.  

Polisher classes are defined in the registry configuration files.   These “classes” are categories 
which are used to control their execution sequence during system processes, and to determine 
whether a polisher is available in the Patient Set Edits system task.  In the Patient Set Edits task, 
you have the option of executing the polishers in the “Pre-Edits” and “Post-Edits” classes (the 
polishers in these classes are listed on the screen when you open the Patient Set Edits system 
task).  Typically, these should not be run when this task is executed and should only be considered 
during the initial transition of data to SEER*DMS.  You also have the option of executing one 
additional polisher in the “Standard” and “Extra-Edits” polisher classes.   In SEER*DMS, the 
polisher class definitions can be viewed by selecting Configuration from the System Administration 
page (the system_administration permission is required).  Additional information related to 
polishers can be found in the SEER*DMS Technical Reference. 

To re-execute the edits for some or all patient sets in the database: 

1. Click System > Tasks. 

2. Click the Patient Set Edits link. 

3. To limit the edits to data by year of diagnosis, enter the Start Year.  Patient sets with a 
diagnosis date during or after this year will be considered. 

4. If you would like to define an end range, enter an End Year.  If the end date is not 
specified, today’s date will be used by default. 

5. To include data with unknown year of diagnosis, set Include Unknown Year to Yes. 

6. If you wish to execute polishers in the Pre-Edit and Post-Edit classes, set Run Edit 
Polishers to Yes.  It is recommended that this option be set to No unless there is a 
specific need related to the transitioning of data into SEER*DMS. 

7. To execute a single polisher from the “Standard” or “Extra-Edits” classes, select a polisher 
from the Extra Polisher drop-down list. 

8. You may enter text related to this task in the Comment field.  The comment for the last 
execution of the task is stored in the database (utility_history table). 

9. Click Start. 

The edits will be re-evaluated for each patient set in the cohort.  In order to avoid creating an 
inordinate number of worklist tasks, a Resolve Patient Set Errors task will not be created for each 
patient set with an edit error.  If the logic of a new or modified edit is implemented incorrectly, it 
could erroneously create an edit error for a large number of patient sets.   Therefore, you must use 
reports rather than tasks to identify the patient sets with errors and to evaluate the error levels in 
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the patient set data.  Two system reports are available for identifying the edit errors that were 
triggered and the patient sets that are involved:    

• RPT-064A:  Frequency of Edit Errors in the Patient Set Data- Run this report to evaluate the 
error levels in the patient data.  In order to verify that modifications to edits, polishers or 
data did not have unexpected results, set the parameters to generate frequencies of errors 
for all edits in all patient set data.    

• RPT-064B:  Patient Sets with Edit Errors - Run this report to obtain a listing of Patient Sets 
with an error related to a particular edit. 

Instructions for creating reports are provided in Chapter 24:  Creating Reports and Extracting Data. 

Identify Patients for Active Follow-up (AFUP) 

Requires system permission:  system_administration 

Registry-specific algorithms are used to identify patient sets for active follow-up (AFUP).  These 
criteria are typically based on vital status, date of last contact, and whether the patient’s follow-up 
status is monitored by the registry (e.g., non-reportable cases may not be followed by some 
registries). 

The “Identify Patients for AFUP” task creates an open 'AFUP Need' for each patient set requiring 
active follow-up.  You may use the AFUP Manager to facilitate and track communications to the 
patients, their physicians or other contacts.  The AFUP Manager also enables you to enter follow-up 
data as it is received.  An AFUP Need is closed when the patient’s vital status and date of last 
contact indicate that the need has been fulfilled.   Instructions for using the AFUP Manager are 
provided in Chapter 16: Follow-up. 

To populate the AFUP table: 

1. Click System > Tasks. 

2. Click the Identify Patients for AFUP link. 

3. Enter a date in DOLC Cutoff that defines whether a patient set requires active follow-up.  A 
patient set will be considered if the patient set's value for vital status is alive and the date 
of last contact is prior to this date.   

4. Click Recalculate to view the number of patient sets that meet the criteria.  If the 
number of patient sets is unacceptably high based on registry policy, adjust the DOLC 
Cutoff and recalculate. 

5. You may enter text related to this task in the Comment field.  The comment from the last 
execution of the task is stored in the database (utility_history table). 

6. Click Start.  SEER*DMS will create an AFUP Need for each patient set which matches the 
registry’s active follow-up criteria.   Once the task completes, the follow-up staff may use 
the AFUP Manager to initiate follow-up procedures for these patients. 

Task to Purge Death Certificate Records 

Requires system permission:  system_administration 

The purpose of the Purge Death Certificate Records system task is to permanently remove unused 
death certificate records from the system.  Typically, this task would be used to delete old, non-
reportable records.  Consult with registry management and write a query or report to review the 

27-8 7/30/2007  SEER*DMS User Manual  



records prior to executing this task.  Purge Death Certificate Records will delete records which meet 
these criteria: 

• The record is not reportable.   

• The record is unlinked.  Linked records may have contributed to patient set data and, 
therefore, cannot be deleted. 

• The record is not the focus of a workflow task.  If you need to delete a batch of records 
which are involved in workflow tasks then you must terminate the tasks prior to using the 
Purge Death Certificate Records task. 

• The record’s type and import date meet the specifications that you set in the task’s options.  

To permanently remove unlinked Death Certificate records from the database: 

1. Click System > Tasks. 

2. Click the Purge Death Certificate Records link. 

3. Specify the Date of Death Prior To.  If an Import ID is not specified, the task will delete 
records with a date of death (record.date_of_last_contact) prior to this date or a null value 
for record.date_of_last_contact_yyyy. 

4. If an Import ID is specified, all records in the import will be considered by the task (the 
date parameter will be ignored). Records in the import that are linked or in the workflow 
will not be deleted. 

5. You may enter text related to this task in the Comment field.  The comment from the last 
execution of the task is stored in the database (utility_history table). 

6. Click Recalculate to view the number of records that will be considered by the task.  
Determine whether this value is reasonable. 

7. Click Start.   

Task to Purge Supplemental Records 

Requires system permission:  system_administration 

The purpose of the Purge Supplemental Records system task is to permanently remove unused 
records from the system.  Typically, this task would be used to delete old records from non-medical 
sources (DMV, SSA, etc).  Consult with registry management and write a query or report to review 
the records prior to executing this task.  Purge Supplemental Records will delete records which 
meet these criteria: 

• The record is unlinked.  Linked records may have contributed to patient set data and, 
therefore, cannot be deleted. 

• The record is not the focus of a workflow task.  If you need to delete a batch of records 
which are involved in workflow tasks then you must terminate the tasks prior to using the 
Purge Records task. 

• The record’s DOLC and import date meet the specifications that you set in the task’s 
options.  

To permanently remove unlinked Supplemental records from the database: 

1. Click System > Tasks. 

2. Click the Purge Supplemental Records link. 
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3. Specify the DOLC Prior To.  If an Import ID is not specified, the task will delete records 
with a date of last contact prior to this date or a null value for date_of_last_contact_yyyy. 

4. If an Import ID is specified, all records in the import will be considered by the task (the 
date parameter will be ignored). Records in the import that are linked or in the workflow 
will not be deleted. 

5. You may enter text related to this task in the Comment field.  The comment from the last 
execution of the task is stored in the database (utility_history table). 

6. Click Recalculate to view the number of records that will be considered by the task.  
Determine whether this value is reasonable. 

7. Click Start.   

Task to Rematch Unlinked Records 

Requires system permission:  system_administration 

The Rematch Unlinked Records system task reloads records into the workflow.  Each record enters 
the matching task in the workflow branch that appropriate for the record type (main workflow or 
passive follow-up, for example).  The record is not sent through the tasks that precede matching:  
automatic record recoding, record edits, or screening.   The value for reportability assigned when 
the record was first loaded is retained. 

Based on the record type and match result, this task may create manual matching or consolidate 
FUP tasks in the worklist.  Consult with registry management prior to executing this task.  This task 
was originally designed to reload records for the purpose of passive follow-up.  For example, 
unlinked supplemental records that did not match a patient in the database when the record was 
first loaded.  However, the task can be used to rematch any type of record.  

Records that meet the following criteria will be loaded into the workflow and rematched: 

• The record is unlinked. 

• The record is not the focus of a workflow task. 

• The record’s type, reportability, date loaded, and Import ID correspond to the options set in 
the task. 

To rematch unlinked records: 

1. Select System > Tasks. 

2. Click Rematch Unlinked Records. 

3. Select the Record Type.   The task can only be run on one type of record at a time. 

4. You have the option of rematching records with a specific value for Reportability.  Leave 
this option blank to consider all records regardless of reportability. 

5. You have the option of restricting the rematch to records Loaded on or after a specific 
date.  Leave this option blank to consider all records regardless of date loaded. 

6. If an Import ID is specified, all records in the import will be considered by the task (the 
date parameter will be ignored). Records in the import that are linked or in the workflow 
will not be considered. 

7. You may enter text related to this task in the Comment field. The comment for the last 
Rematch Passive Follow-up Records task is stored in the database (utility_history table).  
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8. Click Recalculate to view the number of records that will be considered by the task.  
Determine whether this value is reasonable. 

9. Click Start.  The records will be loaded into the workflow and matched against the 
database.  Passive follow-up data will be auto-consolidated, if possible.  Match-consolidate, 
Consolidate FUP, Supplemental Match tasks may be created depending on the record type 
and match result.  

Aborting a System Task 

Requires system permission:  system_administration 

You may use the worklist to stop the execution of a system task.  However, all changes made by 
the task may not be reversed.  Some system tasks that update data perform the updates in 
batches. Updates that were made before you click Abort Task will not be reversed.  You may use 
reports or query audit logs, the worklist, and other data to determine what was changed.  The 
Patient Set Edits and Build tasks (Build CFOs, Build DCOs, Build SHOs) create a report. For those 
tasks, the report will still be created and will list the patient sets that were modified. 

To abort a System Task: 

1. For system tasks, the automatic task will be assigned to you and a link will be shown in 
the My Tasks section of your home page.   Click the Automated task link for the 
appropriate task type to access the worklist.   

2. Click the Task ID. 

3. Click Abort Task. 

4. Click OK to confirm. 

System Administration Page 

Requires system permission:  system_administration 

The System Administration page allows you to monitor system logs, review the registry-specific 
configuration settings and algorithms implemented in SEER*DMS, and access the version history.   

To review information provided in the System Administration page: 

1. Click System > Administration.  The current server log will be shown when you first 
enter the page. 

2. To view other logs and documents, select a topic from the Name drop-down list. 

a. Configuration – variable definitions in the registry-specific configuration files. 

b. Environment – environment variables for the SEER*DMS servers. 

c. Hibernate – technical information for the SEER*DMS development team.  This page 
shows information concerning internal data structures and caching strategies.  The 
Hibernate section may not be displayed in your registry’s version of SEER*DMS. 

d. Logs – Boot and server logs.   Use these logs to monitor system activity and to identify 
the cause of system errors.  

e. Memory – memory allocation, current usage, and memory pool status indicators. 
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f. System Files – the XML files containing the registry-specific implementation of the Edits, 
Importer, Lookups, Matching, Reports, Screening, Translator, and Workflow.   Select a 
specific file from the Files drop-down list.  These files are particularly useful for 
accessing and reviewing importer algorithms, matching criteria, and report SQL.  

g. System Properties – Linux environment settings (a resource for the SEER*DMS 
development team) 

h. Threads – list of concurrent system processes that are executing. 

 



Chapter 28:  Special Studies 
In SEER*DMS, “Special Studies” consist of user-defined criteria to determine the eligibility of 
incoming records for the purpose of rapid case ascertainment.  The criteria specified for a Special 
Study are applied to records as they move through the workflow’s auto-screening task.  The 
criteria may define a record as “in the study”, “out of the study”, or “possible data for the study”.  
In addition, you may use the SEER*DMS editor to manually assign records or patient sets to a 
special study.   

Special study criteria are applied to incoming records as they move through the automatic 
screening task.  A manual screening task is generated if the record is identified as a “possible” 
match for the study.  Refer to Chapter 9:  Screening for instructions for setting the special study 
eligibility in a screening task.   

Records are only screened for a special study if they move through auto-screening after the special 
study is defined.  Patient Set data are not auto-screened for special study eligibility.  External 
queries must be used to determine patient set eligibility and eligibility of records screened prior to 
a study’s creation.  Mass Change imports or ad hoc editing can be used to modify the special study 
fields which define whether a record or patient set is associated with one or more studies.  
Instructions for Mass Change Imports are provided SEER*DMS Technical Reference.  Instructions 
for manually setting special study fields in records and patient sets are provided in the Manually 
Defining Special Study Eligibility section of this chapter.   

External queries must be used to extract or analyze data based on special study fields.  Sample 
SQL related to special studies are available on the SEER*DMS Web Portal.   

In this chapter, you’ll learn about 

• Defining a Special Study 

• Deleting a Special Study 

• Manually Defining Special Study Eligibility 

Defining a Special Study 

Requires system permission:  study_add or study_edit 

To define a Special Study: 

1. Special Study selection criteria must be expressed in SQL statements.  Write and test the 
SQL in an external tool (e.g., SQL Workbench) prior to adding the criteria to a special 
study.   

2. Select Manage > Special Studies. All active studies will be shown in order by Study ID.   

3. To create a new study, click Add (this button will only be shown if you have the study_add 
permission).  To modify an existing study, click the study’s ID.  You may search for a 
study using text in the Study ID, Study Name, and Description fields.  To include Inactive 
Studies in your search, uncheck the Hide Inactive box. 

4. Enter a Study ID consisting of 2-20 alphanumeric characters (the underscore character is 
also permitted).  Study IDs are case sensitive; all letters are automatically converted to 
lower case when the study is created or modified. 

5. Enter a Study Name consisting of 1-50 characters of any type. 

6. You may enter a longer description of the study in the Description field. 
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7. Use the Active checkbox to set the study’s status field to the appropriate value.  Check 
this box for active studies.  Uncheck this box to change the status to inactive.  A record 
will not be screened for eligibility for inactive special studies; records and Patient Sets 
cannot be manually added to inactive special studies.  External processes could be used to 
determine eligibility for inactive special studies.  Mass Change Imports could be used to 
set special study flags in inactive studies. 

8. If you are creating a new study, you must click Save at this point.  The study will now be 
included in the list of studies in the Special Study Manager and in the Special Study 
section of the record and Patient Set editors.  Instructions for adding a record or Patient 
Set to a special study are provided in the Manually Defining Special Study Eligibility section 
of this chapter. 

9. If you are creating a new study, click Add Criteria.  If you are modifying an existing 
study, you may either add new criteria or edit existing criteria. 

a. Enter a comment describing the selection criteria. 

b. Set the Inclusion level.  If a record is screened and meets the criteria, the record will be 
added to the special study with this inclusion setting.   

i. In – Records meeting the criteria fulfill eligibility requirements for the study. 

ii. Possible – Records meeting the criteria should be reviewed by registry staff to 
determine study eligibility.  If an incoming record meets this criteria, a manual 
screening task will be created in the worklist.    

c. Enter text into the Criteria text box that completes the SQL statement which begins 
with the text in Query.  Special study screening is only available for record data. 

d. Click Validate to check for syntax errors in the SQL statement.  Validate only checks 
SQL syntax and does not perform any reasonableness checks.  As stated before, the 
SQL must be written and tested in an external tool prior to defining the study. 

e. Click Counts to determine the number of records in the database which currently meet 
this criteria.  This count should match the value that you calculated when testing the 
SQL.  The count includes records that have already been screened.  SEER*DMS 
automatically screens for special study eligibility during the screening worklist task.  If 
you wish to include records that were previously screened, use a Mass Change import 
or ad hoc editing to set the special study fields for the records. 

10. Click Save to save the criteria.  From this point forward, the criteria will be applied to 
records as they move through the screening task in the workflow.  You will then be able to 
use external queries to extract or analyze data based on the study inclusion flags 

11. Click Save to save all changes to the Special Study. 

Deleting a Special Study 

Requires system permission:  study_delete 

If you delete a special study, all traces of the study are removed from the system.  This includes 
the criteria defined in the study and indicators in records and patient sets related to the study.  To 
re-create the study, you would need to add the study in the manager.  You would then need to run 
external queries to identify data for the study.  Finally, you would need to use a Mass Change 
import or ad hoc editing to set the special study fields for the records or patient sets. 
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To delete a Special Study: 

1. Select Manage > Special Studies. All active studies will be shown in order by Study ID.   

2. You may search for a study using text in the Study ID, Study Name, and Description fields.  
To include Inactive Studies in your search, uncheck the Hide Inactive box. 

3. Click the ID of the study to be deleted. 

4. Review the study to be certain that you are deleting the appropriate study.  Pay particular 
attention to the Data Summary shown in the upper right corner.  As discussed above, 
several steps would need to be taken to redefine a study which is already populated with 
records or patient sets.  

5. To proceed, click Delete. 

6. Click OK to confirm. 

Manually Defining Special Study Eligibility 

Requires system permission: (study_pat_edit and pat_edit) or (study_rec_edit and rec_edit) 

You may open the records and patient sets in the SEER*DMS editor and indicate that the data are 
associated with one or more special studies.  If an unlinked record is flagged for a special study 
and the record is subsequently linked to a patient set, registry policy dictates whether the person 
consolidating the data should manually set the special study indicator in the patient set. 

To indicate whether data should be included in (or excluded from) a special study: 

1. Open the record or Patient Set by entering its ID in the Lookup box on the SEER*DMS 
toolbar (or you may use any of the search features described in Chapter 20:  Searching for 
Records and Patients). 

2. Review the record data. 

3. Click the SS link in the navigation box on the left side of the screen. 

4. If you believe the screening algorithm incorrectly identified a record or patient set for a 
study, click the Delete link for the study.  You should inform registry management that 
the initial criteria for the Special Study may be incorrect.  The study should only be deleted 
if your registry criteria indicates that the data should not be designated as In, Out, or 
Possible for the study.  

5. Select the study to add or modify: 

a. To add the data to a study, click Add.  Select the Study ID from the drop-down list.  
Inactive studies will not be listed. 

b. To modify settings for a study, click the Edit link in the Action column for the study.   

6. Based on registry policies, set the Inclusion status to: 

i. In – The record fulfills eligibility requirements for the study. 

ii. Out - The record meets screening criteria for the study, but upon review, you 
determined that the record is ineligible.  For example, the physician did not give 
approval for the patient's inclusion, or the patient declined to participate.   

iii. Possible – You are unable to make a definite determination of the record’s 
eligibility at this time.    
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7. If you know of a study-specific ID for this record, enter the value in Participant ID. 

8. You may document your changes by adding a comment. 

9. Save your changes to the fields for this study.  If this is a new study, click Add.  If you are 
modifying an existing study, click Update. 

10. To save your changes to the record or patient set: 

a. Click Save. 

b. If you would like to save these changes but continue editing, click the Save button at 
the bottom of the Review Changes page. 

c. If you would like to exit the editor, click Save & Exit.   

 



SEER*DMS Glossary 
Abstract Facility Lead – In SEER*DMS, an Abstract Facility Lead (AFL) is a mechanism for 
assigning and tracking a request to abstract a case at a particular facility.  An AFL is auto-created 
when an incoming record indicates a reportable cancer that requires an abstract.  In most 
configurations, an AFL is auto-created when a Casefinding, Health Index, NAACCR Update, or 
Death Certificate record moves through the workflow (refer to your registry’s workflow diagram).  
If the record is reportable, an AFL is auto-created to alert you to the need for an abstract.  The AFL 
is closed automatically when an abstract record enters the system and is matched to the AFL.  AFLs 
can also be created and closed manually.   AFLs are described in detail in Chapter 21: Managing 
Abstracting Assignments. 

Auditable – A reportability setting of Auditable indicates that a record contains cancer-related data 
but is not a reportable case.  Auditable records are retained for use in casefinding audits.  
SEER*DMS processes these records to obtain potential follow-up information.  See Chapter 9: 
Screening for Reportability. 

Audit Log – SEER*DMS maintains an audit log for each record and patient set in the system.  
Whenever a record or patient set data field is changed by a user or a system process, an entry is 
made in the associated audit log.  The information in the audit log includes the user or process 
which modified the data, comments related to the change, the date and time of the modification, 
and the original and modified value of each data field that was changed.  A user may provide 
comments related to individual data items or provide a general comment for all data items changed 
within a single session.  See Chapter 2: Records and Patient Sets. 

Consolidation – The consolidation process involves combining cancer data from multiple reporting 
facilities for the same patient into one comprehensive data set, known as the “patient set.”  This 
process may involve consolidating data from multiple records and creating a new patient set, or 
consolidating data from one or more records into an existing patient set.  See Chapter 12: 
Consolidating Data. 

CTC – Cancer/Tumor/Case (CTC) refers to an instance of a reportable disease.  Generally 
speaking, a CTC is a neoplasm with topography, histology, and behavior codes that meet the SEER, 
local, or special study case reporting guidelines.  While this is usually a cancer or a tumor, some 
code combinations are not truly tumors and others are arguably not cancer.  In the SEER*DMS 
database, a CTC is a data entity within a patient set.  All diagnostic, staging, and treatment data 
for a reportable neoplasm are stored in the CTC table.  A patient set may include multiple CTCs, 
one for each primary cancer diagnosed for the patient.  See Chapter 2: Records and Patient Sets. 

Death Clearance - Death Clearance is the process of linking death certificate records with the 
registry database in order to determine all deaths among registrants and to identify deaths from 
cancer among persons previously unknown to the registry.  These processes are described in 
Chapter 17: Death Clearance. 

Edit Errors – During various workflow processes, SEER*DMS checks records and patient sets for 
errors based on SEER and registry-defined edits.  Errors that are detected can be reviewed in the 
record or patient set editors and monitored through system reports.  A severity level is assigned to 
each edit in order to trigger specific manual tasks and prioritize errors during editing tasks.  See 
Chapter 7: Edit Errors. 

Follow-up – The term follow-up refers to the processes whereby a registry continues to monitor 
the status of a patient’s health at periodic intervals.  Data fields concerning a patient’s vital status, 
date of last contact, treatment, and recurrence are periodically updated to maintain accurate 
surveillance information.  See Chapter 16: Follow-up. 
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Follow-back – In SEER*DMS, the term “follow-back” refers to the process of contacting a 
reporting facility to obtain missing information or to resolve inconsistencies in data received at the 
registry.  While editing, screening, or consolidating data, a registrar can submit a request for 
follow-back information.  The request will be forwarded to the Follow-back Management tool for 
processing, and a copy of the request will be maintained with the record or patient set for system 
users to review.  Periodically, a registry manager will review, edit, and compile follow-back 
requests into a single communiqué that is sent to a physician or other representative at a facility.  
See Chapter 22: Follow-back. 

Follow-back Need – An individual request for follow-back information. 

Follow-back Bundle – All the follow-back needs intended for a single facility are bundled 
together and held for processing.  A registry manager will periodically review, edit, and send 
bundles to the designated organizations. 

Patient Set – A packet of data in the SEER*DMS database which includes all data associated with 
a particular patient.  These data include patient demographics, information on all reportable 
cancers, admissions information, diagnostic procedures, treatment information and text 
documentation.  The patient set also includes linkage information to enable access to the source 
records.  See Chapter 2: Records and Patient Sets. 

Record – A record contains the source data submitted to the registry.  In the SEER*DMS 
database, these data are stored in the record table.  Records are created in the database when 
data are loaded from files or entered manually.  Each record travels through the workflow, 
triggering the automated and manual tasks that must be performed to process the data.  See 
Chapter 2: Records and Patient Sets. 

Incoming Record – A record that has entered the workflow and has not yet been 
consolidated into patient set data is referred to as an incoming record. 

Focus Record – The record that triggered the creation of a workflow task is the “focus 
record” of that task.  One incoming record is the focus of Match-Consolidate and Consolidate 
tasks.  Other records that were selected as matches to that record would also be involved in 
the tasks.  

Linked Record – A “link” is an association between a source record and a patient set.  
When record data are consolidated into an existing patient set or used to auto-build a new 
patient set, the record is linked to the patient set.  The Patient Set Editor provides access to 
all linked records, enabling users to review the raw data that contributed to the summarized 
and consolidated Patient Set. 

Record Request – The record request feature provides a mechanism for a registry to request 
either a specific record or a specified set of records from an outside organization, and to track 
responses received by the registry.  See Chapter 23: Requesting Records. 

Record Type – Record type is a general classification that can be assigned to data provided in 
multiple file formats.  For example, the Supplemental record type is used for department of motor 
vehicle, CMS/HCFA, and voter registration data.  The record type setting dictates the path of an 
incoming record through the SEER*DMS workflow.  The SEER*DMS record types are defined in 
Chapter 2: Records and Patient Sets. 

Screening – Screening is the process of determining whether data are reportable to SEER or local 
agencies.  SEER*DMS uses a combination of automatic and manual workflow tasks to determine a 
record’s reportability.  A manual screening task is generated for any record that, according to 
registry policy, must be reviewed in order to ascertain reportability.  See Chapter 9: Screening for 
Reportability. 
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System Report – SEER*DMS includes an integrated reporting package that enables you to run 
pre-defined system reports.  These include reports that summarize registry activities, track data 
through the system, and provide quality control information.  Some system reports are integrated 
as print mechanisms throughout SEER*DMS, while others are listed in the Standard Reports table.  
See Chapter 24: Creating Reports and Extracting Data. 

Visual Editing – Quality control of new patient set data involves the review of edit errors identified 
by the computerized edits and a visual review of data fields.  In SEER*DMS, the Visual Edit Patient 
Set task enables registrars to visually review data for a new patient when a patient set is auto-
created from a single abstract record.  Visual editing is also conducted during consolidation tasks, 
in which registrars review incoming data as they consolidate it with data previously loaded into the 
system.  See Chapter 13: Visual Editing. 

Wizard – A utility within a computer system that guides the user through a series of steps to 
accomplish a task.  In SEER*DMS, a wizard interface is used to step the user through the process 
of uploading data files (see Chapter 5:  Importing Data Files). 

Workflow – The SEER*DMS workflow provides a configurable means to establish the flow of 
records and other system data through the appropriate automatic and manual tasks.  The workflow 
controls the path of a record through the editing, screening, matching, and consolidation tasks with 
the ultimate goal of incorporating it into the patient set data.  A record entering the workflow is 
initially processed in a series of automatic tasks.  If human attention is required in order to 
complete a task, a manual task is added to the worklist.  Once the manual task is completed, the 
record continues to the next task in the workflow.  See Chapter 4: Using the Worklist. 

Worklist – The SEER*DMS worklist provides a view of the automatic tasks that are currently 
running and the manual tasks that require attention.  The manual tasks displayed in the worklist 
are the staff’s “to do list”.  See Chapter 4: Using the Worklist. 
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